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 1
I n t r o d u c t i o n
The Structural Mechanics Module 3.5a is an optional package that extends the 
COMSOL Multiphysics® modeling environment with customized user interfaces 
and functionality optimized for structural analysis. Like all modules in the 
COMSOL family, it provides a library of prewritten ready-to-run models that make 
it quicker and easier to analyze discipline-specific problems.

This particular module solves problems in the fields of structural and solid 
mechanics, adding special elements such as beams, plates, and shells. It provides 
static, eigenfrequency, damped eigenfrequency, transient, frequency response, 
parametric, quasi-static transient, linear buckling, and fatigue analysis capabilities. 
You can use isotropic, orthotropic, and fully anisotropic material models as well as 
nonlinear material models and include large deformation effects, contact, and 
friction in an analysis. Define loads, constraints, and material models in a global 
coordinate system or in local, user-defined coordinate systems. Piezoelectric 
materials can be analyzed with the constitutive relations on either stress-charge or 
strain-charge form.

All application modes in this module are fully multiphysics enabled, making it 
possible to couple them to any other physics application mode in COMSOL 
Multiphysics or the other modules. Coupling structural analysis with thermal 
analysis is one example of multiphysics easily implemented with the Structural 
 1
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Mechanics Module, which provides predefined multiphysics couplings for 
thermal-structural analysis and other types of multiphysics. Piezoelectric materials, 
coupling the electric field and strain in both directions are fully supported inside the 
module through special application modes solving for both the electric potential and 
displacement. Structural mechanics couplings are common in simulations done with 
COMSOL Multiphysics and occur in interaction with, for example, fluid flow (FSI), 
chemical reactions, acoustics, electric fields, magnetic fields, and optical wave 
propagation.

The underlying equations for structural mechanics are automatically available in all of 
the application modes—a feature unique to COMSOL Multiphysics. This also makes 
nonstandard modeling easily accessible. For example, you can change the constitutive 
equations to model nonlinear materials. The Structural Mechanics Module also 
features extensible material and beam cross-section libraries.

Further, you can include accurate finite element models as blocks in a dynamic 
simulation performed with Simulink. This combination reduces the need for 
approximations and ad hoc models in dynamic simulations. COMSOL Multiphysics’ 
interface to the MATLAB environment makes the Structural Mechanics Module very 
versatile. For instance, you can use a function to describe loads and constraints.

The documentation set for The Structural Mechanics Module consists of four books. 
The one you are reading, the Structural Mechanics Module User’s Guide, introduces 
the basic functionalities in the module, reviews new features in the version 3.5a release, 
reviews basic modeling techniques through tutorial and benchmark example models, 
and includes reference material of interest to those working in structural mechanics. 
The second book in the set, the Structural Mechanics Module Model Library, 
contains a large number of ready-to-run models that illustrate a broad range of 
applications. Each model comes with theoretical background as well as step-by-step 
instructions that illustrate how to set it up. Further, we supply these models as Model 
MPH-files so that you can open them in COMSOL Multiphysics for immediate access. 
This way you can follow along with the printed discussion as well as use them as a 
jumping-off point for your own modeling needs. A third book, the Structural 
Mechanics Module Verification Manual, contains benchmark models, which are 
models that reproduce established benchmark cases or textbook examples with 
analytical solutions. A fourth book, the Structural Mechanics Module Reference 
Guide, contains reference material about command-line functions and programming. 
All documentation is available in HTML and PDF format from the COMSOL Help 
Desk.
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Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.

• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates code.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
 |  3
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 2
O v e r v i e w
This manual describes the Structural Mechanics Module version 3.5a. It is 
intended to give you an introduction to the modeling stages in the Structural 
Mechanics Module, provide a detailed example of how to work with the models in 
this set, and serve as a reference for more advanced modeling. The book is 
structured as follows:

• Chapter 3, “Quick Start,” gives you the knowledge necessary to start using 
COMSOL Multiphysics with the Structural Mechanics Module.

• Chapter 4, “Structural Mechanics Modeling,” contains modeling advice for 
various structural mechanics problems.

• Chapter 5, “Application Mode Guide”; Chapter 6, “Continuum Application 
Modes”; Chapter 7, “Mindlin Plates”; Chapter 8, “Beams”; Chapter 9, 
“Trusses”; Chapter 10, “Shells”; Chapter 11, “Piezoelectric Application 
Modes”; and Chapter 12, “Predefined Multiphysics Couplings,” provide 
guidelines to help you select and use the application modes in this module.

• Chapter 13, “Fatigue Analysis,” shows you how to perform fatigue analysis 
together with MATLAB.

Two separate books, the Structural Mechanics Module Model Library and the 
Structural Mechanics Module Verification Manual, describe in great detail each 
 5
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entry in the collection of software models you received with this product. Additionally, 
the Structural Mechanics Module Reference Guide describes the interface to 
MATLAB and gives details about the implementation of the application modes.

What Can the Structural Mechanics Module Do?

The Structural Mechanics Module contains a set of modeling interfaces, called 
application modes, adapted to a broad category of structural-mechanics analysis. The 
module serves as an excellent tool for the professional engineer, researcher, and 
teacher. In education the benefit of the short learning curve is especially useful because 
educators need not spend excessive time learning the software and can instead focus 
on the modeling process.

As you develop models using the Structural Mechanics Module, you can view them in 
terms of the underlying partial differential equations or the principle of virtual work. 
The software thus offers a unique way to understand the laws of physics and the 
equations that describe them. For instance, you can add additional physics like 
viscoelasticity to the constitutive equations. It is also possible to export a simulation to 
the MATLAB environment, or save it as a Model M-file script. This makes it possible 
to incorporate COMSOL Multiphysics models with products in the MATLAB family, 
such as Simulink and the Control System Toolbox.

What Problems Can It Solve?

The Structural Mechanics Module is a collection of application modes for COMSOL 
Multiphysics that handles static, eigenfrequency, damped eigenfrequency, transient, 
frequency response, parametric, and quasi-static transient analyses as well as linear 
buckling for applications in structural mechanics, solid mechanics, and piezoelectricity.

S T A T I C  A N A L Y S I S

In a static analysis the load and constraints are fixed in time.

E I G E N F R E Q U E N C Y  A N A L Y S I S

An eigenfrequency analysis finds the undamped eigenfrequencies and mode shapes of 
a model. Sometimes referred to as the free vibration of a structure.

D A M P E D  E I G E N F R E Q U E N C Y  A N A L Y S I S

A damped eigenfrequency analysis finds the damped eigenfrequencies and mode 
shapes of a model. The quality and decay factors of the structure are also calculated.
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TR A N S I E N T  A N A L Y S I S

A transient analysis finds the transient response for a time-dependent model, taking 
into account mass, mass moment of inertia, and damping. 

F R E Q U E N C Y  R E S P O N S E  A N A L Y S I S

A frequency-response analysis finds the steady-state response from harmonic loads.

P A R A M E T R I C  A N A L Y S I S

A parametric analysis finds the solution dependence due to the variation of a specific 
parameter, which could be, for instance, a material property or the position of a load.

Q U A S I - S T A T I C  T R A N S I E N T  A N A L Y S I S

A quasi-static analysis neglects mass effects, assuming the time scale in the 
structural-mechanics problem is much smaller than other dynamics. An example is a 
transient thermal problem where the time scale in the thermal problem is often much 
longer than the one in the structural dynamics.

L I N E A R  B U C K L I N G  A N A L Y S I S

A linear buckling analysis includes the stiffening effects from stresses coming from 
nonlinear strain terms. The two stiffnesses coming from stresses and material define an 
eigenvalue problem where the eigenvalue is a load factor that, when multiplied with 
the actual load, gives the critical load in a linear context. 

Linear buckling analysis uses the eigenvalue solver.

Another way to calculate the critical load is to include large deformation effects and 
increase the load until the solver fails because the load has reached its critical value.

Linear buckling analysis is only available in the continuum application modes.

L A R G E  D E F O R M A T I O N S

You can include large deformations with the restriction of small strains in all 
continuum application modes. This effect is also sometimes referred to as a nonlinear 
geometric effect. The large deformations option replaces the normal strain with the 
Green strain and the stress with the second Piola-Kirchhoff stress. COMSOL 
Multiphysics solves the problem using a total Lagrangian formulation. Large 
deformation is only available in the continuum application modes.
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E L A S T O - P L A S T I C  M A T E R I A L S

An elasto-plastic analysis involves a nonlinear material model with or without 
hardening. Two different hardening models are available:

• Isotropic 

• Kinematic 

The elasto-plastic material model is available in the continuum application modes.

H Y P E R E L A S T I C  M A T E R I A L S

In hyperelastic materials the stresses are computed from a strain energy density 
function. They are often used to model rubber, but also used in acoustoelasticity. 
Three different models are available:

• Neo-Hookean

• Mooney-Rivlin

• Murnaghan

The hyperelastic material models are available in the continuum application modes.

V I S C O E L A S T I C  M A T E R I A L S

Viscoelastic materials have a time-dependent response, even if the loading is constant. 
For this type of materials a viscoelastic transient initialization is needed to precompute 
initial states for transient and quasi-static transient analyses. The initialization is a 
regime of instantaneous deformation and/or loading. The viscoelastic material model 
is available in the continuum application modes.

F A T I G U E  A N A L Y S I S

A fatigue analysis is done in order to find the fatigue damage or fatigue life of a 
component. Fatigue analysis is divided into high-cycle and low-cycle fatigue 
depending of the number of load cycles. The Structural Mechanics Module as 
delivered can handle the following cases for both high-cycle and low-cycle fatigue:

• Proportional loading constant amplitude

• Nonproportional loading constant amplitude

• Proportional loading nonconstant amplitude 
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Note: The fatigue analysis in the Structural Mechanics Module is script based and 
requires MATLAB.

A P P L I C A T I O N S

Examples of applications include thin plates loaded in a plane (plane stress), thick 
structures with no strain in the out-of-plane direction (plane strain), axisymmetric 
structures, frame structures in 2D and 3D, thin-walled 3D structures (shells), and 
general 3D structures modeled using solid elements.

Available application modes are:

• Plane stress

• Plane strain

• Axial symmetry, stress-strain

• 2D beams, Euler theory

• 2D truss

• Thick plates, Mindlin theory

• 3D beams, Euler theory

• 3D truss

• Solid, stress-strain

• Shells

• Piezoelectric application modes

- Piezo solid

- Piezo plane stress

- Piezo plane strain

- Piezo axial symmetry

New Features in Structural Mechanics Module 3.5a

• Viscoelastic material model. See “Viscoelastic Materials” on page 189.

• Hyperelastic Murnaghan material model for modeling of nonlinear 
acoustoelasticity. See “Hyperelastic Materials” on page 120.
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• Predefined reaction forces and moments. See “Calculating Reaction Forces” on 
page 113.

• Predefined Thermal-Electric-Structural predefined multiphysics coupling. See 
“Thermal-Electric-Structural Interaction” on page 136.

• Support for mechanical heating with built-in entropy variables for 2D and 3D 
models.

• Improved interface for piezoelectric modeling with support for damping and losses 
(structural damping plus dielectric and coupling losses), initial stresses and stains, 
and large deformations. See “Piezoelectric Application Modes” on page 339.

• Efficient simulation of thermal-structural interaction using the segregated solvers

• New Generalized-α time-stepping algorithm for more efficient transient structural 
simulations.

• New models in the Structural Mechanics Module Model Library:

- Elbow bracket—a suite of 3D tutorial models

- Viscoelastic damper

- Thermal viscoelastic tube

- Viscoplastic solder joints

- Contact cellular screen—contact modeling of a cell phone display

- Aluminum extrusion FSI—fluid-structure interaction of an aluminum extrusion 
process, including thermal-structure and thermal-fluid couplings

- Rail steel—studies the elastoacoustic effect using the Murnaghan hyperelastic 
material model

- Rotating blade
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 3
Q u i c k  S t a r t
The objective of this chapter is to familiarize you with modeling procedures in the 
Structural Mechanics Module using the graphical user interface. Because this 
module is fully integrated with COMSOL Multiphysics, the modeling process is 
similar to the one used in that environment. This chapter takes a detailed 
walk-through of one model to present the various aspects of the simulation process; 
it steps through all the stages of modeling, from geometry creation to 
postprocessing.
 11
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Ba s i c  Mode l i n g  P r o c e du r e s

The various steps of defining, solving, and postprocessing a problem, which you go 
through during modeling, are reflected in the toolbar buttons and menus you find in 
the COMSOL Multiphysics graphical user interface (GUI). Thus, this manual and the 
accompanying Structural Mechanics Model Library follow a certain style convention 
when describing the models. The format includes headlines that corresponding to each 
major step in the modeling process; these headlines also roughly correspond to the 
various GUI modes and menus.

Model Navigator

The Model Navigator appears when you start COMSOL Multiphysics or when you 
restart from scratch within COMSOL Multiphysics by selecting New from the File 
menu or clicking on the New button on the Main toolbar. On the New page in the 
Model Navigator you specify the application mode, names of dependent variables, and 
the nature of the problem—the analysis type: static, static elasto-plastic, 
eigenfrequency, damped eigenfrequency, transient, frequency response, quasi-static 
transient, or parametric analysis, or viscoelastic transient initialization. By clicking on 
the Multiphysics button you can set up a combination of application modes from the 
Structural Mechanics Module, other modules, or COMSOL Multiphysics. It is also 
possible to open the Model Navigator from the Multiphysics menu at any time to add or 
remove an application mode.

Options and Settings

This section reviews basic settings, for example, those for the axes and grid spacing. All 
settings are accessible from the Options menu and some are also accessible by 
double-clicking the status bar. You might need to use the Constants dialog box to enter 
model parameters (see “Constants” on page 139 in the COMSOL Multiphysics User’s 
Guide for a more detailed description). You can also maintain libraries of user-defined 
materials, which you access through the Materials/Coefficients Library dialog box. 

It is possible to define materials, loads, and constraints in a user-defined coordinate 
system. You can create such a coordinate system in the Coordinate System Settings 
dialog box, which is accessible from the Options menu.
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Geometry Modeling

In this step you set up the model’s geometry. This stage requires knowledge of how to 
use the Draw menu and the Draw toolbar (see “Geometry Modeling and CAD Tools” 
on page 23 in the COMSOL Multiphysics User’s Guide for details). You can also 
import 3D CAD drawings using the optional CAD Import Module.

Physics Settings

In this section you define the model’s physics. Open all appropriate dialog boxes from 
the Physics menu or by double-clicking on the domain in the respective domain 
selection mode. Further, control the active selection mode from the Physics menu or 
by clicking on the appropriate domain type button on the Main toolbar.

Material properties are normally defined on subdomains. In the Structural Mechanics 
Module, however, some application modes are not defined at the subdomain level. 
This is the case, for example, in

• The Shell application mode, where you define material properties on boundaries 
(3D) / faces

• The In-plane Euler Beam application mode, where you define material properties 
on boundaries (2D) / edges.

A P P L I C A T I O N  M O D E  P R O P E R T I E S

Application mode properties are global properties controlling the analysis starting with 
which analysis to perform. Make all corresponding settings in the Application Mode 

Properties dialog box, which you open by choosing Physics>Properties.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

Application scalar variables are global variables defining an analysis. The Structural 
Mechanics Module application modes have only one variable, freq, the excitation 
frequency in a frequency response analysis. To open the Application Scalar Variables 
dialog box, choose Scalar Variables from the Physics menu.

PO I N T  S E T T I N G S

You define loads and constraints on points in Point mode. Point settings are used in 
all Structural Mechanics Module application modes, whereas point masses are defined 
in the Beam application modes. A table describes the settings in the Point Settings 

dialog box in a compact format.
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E D G E  S E T T I N G S

Edge settings are used only in the 3D application modes for shells, solids, and beams. 
In the 3D Euler Beam application mode you define physical properties as well as loads 
and constraints, whereas the other application modes define only loads and constraints. 
A table describes the settings in the Edge Settings dialog box in a compact format.

B O U N D A R Y  S E T T I N G S

In Boundary Selection mode, you specify loads and constraints on the edges (in 2D) 
or faces (in 3D). For in-plane Euler beams and shells the physical properties are also 
defined. A table describes the settings in the Boundary Settings dialog box in a compact 
format.

S U B D O M A I N  S E T T I N G S

In Subdomain Selection mode you specify material properties, body loads, and 
damping for application modes existing on the top domain in 2D and 3D. A table 
describes the settings in the Subdomain Settings dialog box in a compact format. You 
can also implement constraints, specify initial stresses and strains, and control the 
element to use from this dialog box. For all continuum application modes you can 
select the order of the Lagrange element. In addition, for time-dependent and 
nonlinear problems you set initial conditions for subdomains in this mode.

Mesh Generation

At this stage the software meshes the problem geometry. Sometimes you simply click 
one of the meshing buttons on the Main toolbar; in other cases it is necessary to set 
some parameters using the Mesh menu and the dialog boxes for the meshers, or use the 
interactive meshing and the Mesh toolbar (see “Meshing” on page 299 in the 
COMSOL Multiphysics User’s Guide for a detailed description about meshing).

Computing the Solution

To compute the solution, click the Solve button on the Main toolbar. You can specific 
settings for each solver in the Solver Parameters dialog box (see “Solving the Model” 
on page 377 in the COMSOL Multiphysics User’s Guide for details).

Postprocessing and Visualization

Powerful visualization tools are accessible in the program’s Postprocessing mode, but 
to use them you must be familiar with the Postprocessing menu (see “Postprocessing 
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and Visualization” on page 455 in the COMSOL Multiphysics User’s Guide for 
details). For additional postprocessing you can export the solution to the MATLAB 
workspace.
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V a r i o u s  Ana l y s e s  o f  an E l b ow B r a c k e t

Introduction

The component depicted in Figure 3-1 is part of a support mechanism and is subjected 
to both mechanical loads and thermal loads. This tutorial model takes you through the 
steps to carry out a detailed analysis of the part using the Structural Mechanics 
Module.

Figure 3-1: Geometry of the elbow bracket.

In the various parts of the model you are introduced to using the available seven basic 
analysis types, together with numerous postprocessing possibilities. These analysis 
types are:

• Static analysis

• Eigenfrequency analysis

• Damped eigenfrequency analysis

• Transient analysis

• Frequency response analysis

• Parametric analysis

• Quasi-static transient analysis

Modeling in COMSOL Multiphysics

This tutorial model consists of seven submodels, corresponding to the analysis types 
mentioned in the section “Introduction”. You can set up the models following the 
procedure outlined in the chapter “Basic Modeling Procedures” on page 12.
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The initial steps of geometry modeling, mesh generation, and material settings are 
shared between some of the submodels, and are only detailed in the step-by-step 
description of the static analysis model, starting on page 18. A model file containing 
these initial steps is included in the Model Library, and you can use it as a starting point 
when modeling.

Static Analysis

A static analysis has no explicit or implicit time dependencies. This situation 
corresponds to the steady state of a transient analysis with constant (in time) boundary 
conditions and material properties.

The purpose of such analysis can be to find the maximum stress level and compare it 
with the material’s yield strength, as well as to check that the deformation of the 
component is within the limits of the design criteria.

The Model Library note immediately below appears in the discussion of every model. 
The path indicates the location of the model file on the Model Library page in the Model 

Navigator.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
elbow_bracket_static

M O D E L  D E F I N I T I O N

The geometry for this part, see Figure 3-1, has been created with a CAD software, and 
it is available for you to import into COMSOL Multiphysics.

Material
Structural steel, as taken from the material library, with Young’s modulus of 200 GPa 
and Poisson’s ratio of 0.33.

Load
Apply a load of 3·106 N/m2 in both the x direction and z direction on the face shown 
in Figure 3-2.
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Constraints
Fix the displacement in all directions on the face shown in Figure 3-2.

Figure 3-2: Constraint and loading of the bracket.

R E S U L T S

The analysis shows that the von Mises effective stress has a maximum value of 
1.9·108 N/m2 = 190 MPa, which, compared with the material’s yield strength of 
350 MPa, results in a utilization factor of 54%.

The analysis also gives the following maximum static displacements at the face where 
the load is applied:

Now take a step-by-step look at how to achieve these results using the Structural 
Mechanics Module.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
1 In the Model Navigator go to the New page, then select 3D from the Space dimension 

list.

 x DIRECTION  y DIRECTION  z DIRECTION

Displacement 1.02 mm 0.12 mm 0.51 mm

Loaded face

Fixed face
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2 On that same page go to the list of application modes and select 
Structural Mechanics Module>Solid, Stress-Strain>Static analysis.

3 Click OK to close the Model Navigator.

Geometry Modeling
You can import an MPHBIN-file containing the geometry, which has been drawn in a 
CAD software and converted to the native COMSOL binary geometry format.

1 From the File menu, select Import>CAD Data From File.

2 The Import CAD Data From File dialog box appears. Select the file 
elbow_bracket.mphbin, which is located in the directory models/
Structural_Mechanics_Module/Tutorial_Models under the COMSOL 
installation directory.

3 Click Import to import the file, and to close the dialog box.

By default all imported geometry objects are selected after import. Default for 
selected objects is to visualize the faces, while wireframe rendering is the default for 
objects that are not selected.
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4 Press Ctrl+D or click in the graphics area next to the object to deselect it. The part 
then appears as shown in the figure below.

5 To get a 3D visualization as shown in Figure 3-1 first click the Render Face button 
on the Visualization/Selection toolbar then click the Headlight button on the 
Camera toolbar.

Mesh Generation
The default free mesher has nine predefined combinations of mesh parameter settings. 
These range from Extremely Fine to Extremely Coarse, with Normal as the default 
setting. The current setting is displayed on the right side of the status bar; unless any 
other mesh parameters are set, this is the setting that is used if you click the Initialize 

Mesh or Mesh All (Free) toolbar buttons to generate a mesh.
 3 :  Q U I C K  S T A R T



1 Create the mesh for the geometry by clicking the Initialize Mesh button on the Main 
toolbar.

For cases where you want to fine tune mesh generation, the Free Mesh Parameters 
dialog box, found on the Mesh menu, gives access to a number of parameters that 
control the mesh’s density and gradation.

Physics Settings

Subdomain Settings   

In subdomain mode you specify material properties. The material properties are 
selected from the material library or entered explicitly by typing the corresponding 
value or expression. This example uses the material library. Before you can use a 
material from the library, you must add it to the geometry. Do so from the Options 
menu or directly from the Subdomain Settings dialog box.

1 From the Physics menu, select Subdomain Settings.

2 Select Subdomain 1.

3 Click the Load button on the Material page to open the Materials/Coefficients Library 
dialog box.
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4 From the Basic Material Properties folder in the Materials list, select Structural steel, 
then click Apply.

You have now added the structural steel material to the geometry, an entry that you 
can see in the Model part of the Materials list.

5 Click OK to close the Material/Coefficients Library dialog box. Structural steel is now 
selected in the Library material list in the Subdomain Settings dialog box.

In tabular form, the material settings are:

6 When done, click OK.

Boundary Settings   

In boundary mode you specify loads and constraints. By default all boundaries are free, 
which means that there are no loads or constraints.

1 Open the Boundary Settings dialog box by going to the Physics menu and selecting 
Boundary Settings.

SUBDOMAIN 1

Page Material

Library material Structural steel
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2 Select Boundary 1. Click the Constraint tab, then select Fixed from the Constraint 

condition list.

3 Select Boundary 29. Click the Load tab, then enter 3e6 in the Fx the Fz edit fields.

You have set the boundary conditions according to the following table:

You frequently encounter tables such as this one, both in the remainder of this 
chapter and throughout the Model Library. The row marked “Page” indicates on 
which page in the dialog box you find the setting.

4 Click OK to close the Boundary Settings dialog box.

You can easily check that the boundary conditions are as you expect in your model 
by activating the visualization of symbols for loads and constraints in the model.

5 Click the Show Symbols button on the Visualization/Selection toolbar to turn on 
visualization of symbols for loads and constraints.

BOUNDARY 1 BOUNDARY 29

Page Constraint Load

Constraint condition Fixed Fx 3e6

Fz 3e6
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Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. Since this option is enabled by default, the stationary 
solver is selected and there is no need to change the solver settings.

To compute the solution, either click the Solve button (=) on the Main toolbar or select 
Solve Problem from the Solve menu.

Postprocessing and Visualization
In Postprocessing mode you can create various plot types, evaluate expressions or 
animate the results. The postprocessing utilities can visualize any expression 
containing, for example, the solution variables, their derivatives, and the space 
coordinates. Many frequently used expressions are predefined as postprocessing 
variables, and they are directly available from lists in the Plot Parameters dialog box.

As soon as the solution is ready, a default plot appears. In the Solid, Stress-Strain 
application mode the default slice plot visualizes the von Mises effective stress.

Now, create a subdomain plot of the von Mises stress with markers for maximum and 
minimum values together with the deformed shape of the component:
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1 From the Postprocessing menu, select Plot Parameters.

2 On the General page, clear the Slice check box.

3 Select the Deformed shape, Max/Min marker, and Subdomain check boxes.

4 Click OK to close the Plot Parameters dialog box and update the plot.
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5 Click the Zoom Extents button on the Main toolbar.

The deformation is exaggerated using automatic scaling. You can control the scaling 
of the deformation from the Plot Parameters dialog box on the Deform page.

By using the Point Evaluation dialog box you can obtain the deformation of a point 
on the geometry. The largest displacement occurs at the tip where the load is 
applied.

6 Select Postprocessing>Point Evaluation.

7 From the Point selection list select Point 38, which is a point on the loaded face of 
the geometry.

8 From the Predefined quantities list select x-displacement and from the Unit list select 
mm. Click Apply.

The displacement value is displayed in the message log, just below the graphics area.

9 Repeat the previous step for the y-displacement. The unit selection is retained and 
you do not need to select it again.

10 Select the z-displacement, then click OK to close the dialog box and display the value.

A good way to visualize stress levels inside the geometry is to create an isosurface 
plot of the von Mises stress.
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11 Click the Isosurface Plot button on the Plot toolbar.

Now evaluate reaction forces on the bracket, by using the predefined variables 
available for this purpose.

12 Select Postprocessing>Boundary Integration.

13 In the dialog box that opens select Boundary 1, which is the boundary with the 
fixed constraint.

14 From the Predefined quantities list, select Reaction force x-dir.. Click OK.

The value of the reaction force in the x-direction appears in the message log. You 
can also check that the reaction force is consistent with the applied force.

15 From the Postprocessing menu, open the Global Variables Plot dialog box.

In this dialog box you can find predefined quantities for total applied and total 
reaction forces, or moments, globally on the geometry, or on points, edges, or faces. 
As usual, you can also enter any global expression to plot in the Expression edit field. 
For the current model the total force is the same as the total force for all boundaries.
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16 From the Predefined quantities list, select Total applied force x-dir. and Total reaction 

force x-dir., then click the Add Selected Predefined Quantities button.

The two quantities should now appear in the Quantities to plot list.

17 Click OK to close the dialog box.

The plot appears in a separate figure window. Just as expected, the applied force has 
the opposite sign but the same magnitude as the reaction force. You may have to 
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click the Zoom Out button in the figure window if the lines are just on the border of 
the plot area.

Another useful postprocessing tool is the principal stress or strain plot. Information 
about principal directions can be used, for example, to determine the orientation 
and location of straingauges to be placed on the surface of a component. This way 
you can combine and compare analysis with experimental findings.

18 Click the Plot Parameters button on the Main toolbar.

19 On the General page, clear the Isosurface and Deformed shape check boxes, and select 
the Principal check box.

20 On the Principal page, enter 15 in the x points and z points edit fields and 20 in the 
y points edit field.

You also have the choice of specifying coordinates for the points for the location of 
the arrows.
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21 From the Arrow type list, choose 3D arrow.

22 Click OK.

The graphics area is updated with the principal stress plot. The length of the arrows 
is proportional to the value of the principal stresses.
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Eigenfrequency Analysis

An eigenfrequency analysis finds the eigenfrequencies and modes of deformation of a 
component. The eigenfrequencies f in the structural mechanics field are related to the 
eigenvalues λ returned by the solvers through

In COMSOL Multiphysics you can choose between working with eigenfrequencies 
and working with eigenvalues according to your preferences. Eigenfrequencies are the 
default option for all application modes in the Structural Mechanics Module.

The purpose of the following eigenfrequency analysis is to find the six lowest 
eigenfrequencies and corresponding mode shapes.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
elbow_bracket_eigen

M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis; see the 
description on page 17 for details.

R E S U L T S

The first six eigenfrequencies are:

The mode shapes corresponding to the two lowest eigenfrequencies are shown in 
Figure 3-3. The deformed plot indicates an oscillation in the xy-plane for the lowest 

EIGENFREQUENCY FREQUENCY

 f1 417 Hz

 f2 571 Hz

 f3 1930 Hz

 f4 2450 Hz

 f5 3110 Hz

 f6 3930 Hz

f −Im λ( )
2π

----------------=
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eigenfrequency, while the second lowest eigenmode shows an oscillation in the 
yz-plane.

Figure 3-3: Eigenmodes of the two lowest eigenfrequencies.

M O D E L I N G  U S I N G  C O M S O L  M U L T I P H Y S I C S

You can start setting up the model by opening an MPH-file that already contains the 
completed initial modeling stages of:

• Geometry import

• Mesh generation

• Material settings

You can also choose to start modeling from the very beginning, in which case you start 
with the instructions in section “Model Navigator” on page 18, then continue until 
you complete the section “Subdomain Settings” on page 21. After that you can jump 
to the section “Application Mode Parameters” on page 32.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
Open the model file containing the initial modeling stages.

1 In the Model Navigator go to the Model Library page.

2 From the list of models select 
Structural Mechanics Module>Tutorial Models>elbow bracket initial setup.

Physics Settings

Application Mode Parameters   

Change the analysis type to eigenfrequency analysis:

417 Hz 571 Hz
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1 From the Physics menu, choose Properties to open the Application Mode Properties 
dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 

2 Select Eigenfrequency from the Analysis type list.

3 Click OK.

Boundary Settings   

Fix the displacement in all directions on the face shown in Figure 3-2 on page 18.

1 Select Physics>Boundary Settings to open the Boundary Settings dialog box.

2 Select Boundary 1. Click the Constraint tab, then select Fixed from the Constraint 

condition list.

3 Click OK to close the Boundary Settings dialog box.

Computing the Solution
The analysis type controls the default solver through the Auto select solver option in 
the Solver Parameters dialog box. Because this option is enabled by default, you do not 
need to change the solver settings. You can examine the eigenfrequency solver 
parameters.
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1 From the Solve menu, choose Solver Parameters to open the Solver Parameters dialog 
box.

The number of eigenfrequencies to compute is controlled from the General page. 
Use the default settings to solve for the six lowest eigenfrequencies.

2 Click OK to close the Solver Parameters dialog box.

3 To compute the solution, either click the Solve button (=) on the Main toolbar or 
select Solve Problem from the Solve menu.

Postprocessing and Visualization
You can select which eigenfrequency to work with from a list on the General page in 
the Plot Parameters dialog box. The default plot shows the eigenmode corresponding 
to the lowest eigenfrequency. The eigenmodes are scaled (normalized) so the size of 
deformations should be compared only within an eigenmode and not between modes.

1 From the Postprocessing menu, choose Plot Parameters.

2 On the General page, clear the Slice check box and select the Deformed shape and 
Boundary check boxes.

The default boundary plot is the total displacement. You can change boundary plot 
parameters on the Boundary page.
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3 Select the first eigenfrequency from the Eigenfrequency list.

4 Click Apply to look at the mode shape of the first eigenfrequency.

5 Select the second eigenfrequency from the Eigenfrequency list.

6 Click OK to close the Plot Parameters dialog box and to look at the mode shape of 
the second eigenfrequency.

You can also visualize the eigenmodes by animating the oscillations of the bracket. You 
can do this on the Animate page of the Plot Parameters dialog box.

Transient Analysis

This analysis solves for the transient solution of the displacements and velocities as 
functions of time. The material properties, forces, and boundary conditions can vary 
in time.

The purpose of this analysis is to find the transient response from a harmonic load 
during the first five periods. The excitation frequency is 500 Hz, which is between the 
first and second eigenfrequency found in the eigenfrequency analysis.
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Model Library path: Structural_Mechanics_Module/Tutorial_Models/
elbow_bracket_transient

M O D E L  D E F I N I T I O N

The geometry, material, and constraint are the same as for the static analysis (see the 
description on page 17 for details).

Load
This model uses a harmonic load with an excitation frequency of 500 Hz on the face 
indicated in Figure 3-2. The expression for the load can be written

where t denotes the time in seconds.

Damping
For transient analysis, the Structural Mechanics Module supports Rayleigh damping 
and loss factor damping. You can also use no damping, which is the default option.

In this analysis you can set up Rayleigh damping, where you specify damping 
parameters that are proportional to the mass (αdM) and stiffness (βdK) in the following 
way:

where C is the damping matrix, M is the mass matrix, and K is the stiffness matrix. The 
damping is specified locally in each subdomain; this means that you can specify 
different damping parameters in different parts of the model.

To find the values for the Rayleigh damping, you can use the relations between the 
critical damping ratio and the Rayleigh damping parameters. It is often easier to 
interpret the critical damping ratios, which are given by

where ξi is the critical damping ratio at a specific angular frequency ωi. Knowing two 
pairs of corresponding ξi and ωi results in a system of equations

Fx 1.5 106 1 2π 500 t π 2⁄–⋅ ⋅( )sin+[ ]  N/m2⋅ ⋅=

C αdMM βdKK+=

ξi

αdM

ωi
----------- βdK ωi⋅+⎝ ⎠
⎛ ⎞

2
--------------------------------------------=
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with the damping parameters as the unknown variables.

Assume that the structure has a constant damping ratio of 0.1. Select two frequencies 
near the excitation frequency, 400 Hz and 600 Hz, to calculate the damping 
parameters. You can do this in MATLAB with the following commands:

b = [0.1;0.1];
A = [1/(2*400*2*pi) 2*pi*400/2; 1/(2*600*2*pi) 2*pi*600/2];
% A*damp = b
damp = A\b;
alphadM = damp(1)
betadK = damp(2)

The result is αdM = 300 and βdK = 3.2·10−5.

For more information see the section “Damping” on page 140.

R E S U L T S

The following plot shows the x-displacement at a point on the loaded face:

1
2 ω1⋅( )

-------------------
ω1
2

------

1
2 ω2⋅( )

-------------------
ω2
2

------

αdM

βdK

ξ1

ξ2

=
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The figure below shows the von Mises stress in the bracket at 0.0036 s.

M O D E L I N G  U S I N G  C O M S O L  M U L T I P H Y S I C S

You can start setting up the model by opening an MPH-file that already contains the 
completed initial modeling stages of:

• Geometry import

• Mesh generation

• Material settings

You can also choose to start modeling from the very beginning, in which case you start 
with the instructions in section “Model Navigator” on page 18, then continue until 
you complete the section “Subdomain Settings” on page 21. After that you can jump 
to the section “Application Mode Parameters” on page 38.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
Open the model file containing the initial modeling stages.

1 In the Model Navigator go to the Model Library page.

2 From the list of models select 
Structural Mechanics Module>Tutorial Models>elbow bracket initial setup.

Physics Settings

Application Mode Parameters   
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Change the analysis type to transient analysis:

1 From the Physics menu, select Properties to open the Application Mode Properties 
dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 

2 Select Transient from the Analysis type list.

3 Click OK.

Boundary Settings   

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the 
Physics menu.

2 Set boundary conditions according to the following table; when done, click OK.

Note the way you can use the unit syntax in COMSOL Multiphysics to specify the 
frequency in Hz. The variable t is used by COMSOL Multiphysics to denote the time 
in second. You specify the time steps in the Solver Parameters dialog box, which will be 
explained later in this model.

Subdomain Settings   

1 From the Physics menu, select Subdomain Settings.

BOUNDARY 1 BOUNDARY 29

Page Constraint Load

Constraint 
condition

Fixed Fx 1.5e6*(1+sin(2*pi*500[Hz]*t-pi/2))
V A R I O U S  A N A L Y S E S  O F  A N  E L B O W  B R A C K E T  |  39



40 |  C H A P T E R
2 Select Subdomain 1.

3 Click the Damping tab and select Rayleigh from the Damping model list.

4 Enter the damping properties according to the following table; when done, click OK.

You can also specify initial values for transient problems on the Init page of the 
Subdomain Settings dialog box. By default initial displacement and velocity values are 
zero, so you do not need to modify them in this model.

Computing the Solution
The analysis type controls the default solver through the Auto select solver option in 
the Solver Parameters dialog box. Solving for five periods with an excitation frequency 
of 500 Hz means solving for 10 ms.

Specify the time-dependent solver parameters:

1 From the Solve menu, choose Solver Parameters.

2 In the Times edit field, type range(0,1e-4,10e-3). This means that the solution 
is saved every 0.1 ms during the total solution time of 10 ms.

PARAMETER SETTING

 αdM 300

 βdK 3.2e-5
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3 Type 1e-5 in the Absolute tolerance edit field. This is important for an accurate 
analysis (the absolute tolerance must be smaller than the displacements).

4 Click the Time stepping tab and select Use time step increase delay (steps).

When a harmonic load is used, the time step can sometimes oscillate in an inefficient 
manner, causing longer solution times. This can be avoided by using the more 
restrictive time stepping obtained by selecting Use time step increase delay (steps). 
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For more information on the settings for the time-dependent solver, see “The 
Time-Dependent Solver” on page 391 in the COMSOL Multiphysics User’s Guide.

5 Click OK.

6 Compute the solution by clicking the Solve button (=) on the Main toolbar or by 
selecting Solve Problem from the Solve menu.
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Postprocessing and Visualization
You have access to the solution at all the time steps saved by the solver in the Plot 

Parameters dialog box. Select them from the Solution at time list on the General page. 
The default slice plot of the von Mises stress shows the last time step.

For a quantitative view of the time evolution of the displacement, plot a graph of the 
displacement in the x-direction at a point on the loaded face.

1 From the Postprocessing menu, select Domain Plot Parameters.

2 Go to the General page and check that all the time steps are selected from the 
Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 From the Point selection list, select Point 38.

5 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>x-displacement.

6 Click OK to plot the x-displacement and close the dialog box.

Generate a deformed shape plot of the von Mises stress at 0.0036 s in the following 
way:

1 Click the Plot Parameters button on the Main toolbar.

2 On the General page, clear the Slice check box and select the Deformed shape and 
Subdomain check boxes.
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3 Click OK.

Frequency Response Analysis

I N T R O D U C T I O N

A frequency response analysis solves for the steady-state response from harmonic 
excitation loads. The loads can have amplitudes and phase shifts that may depend on 
the excitation frequency, f:

where F(f) is the amplitude and FPh(f) is the phase shift of the load.

The purpose of this analysis is to find the transient response from a harmonic load with 
an excitation frequency in the range 350–650 Hz, which is near the first 
eigenfrequency found in the eigenfrequency analysis.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
elbow_bracket_frequency

M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis (see the 
static description on page 17 for details).

Loads
This model uses a harmonic load with an excitation frequency between 350 and 
650 Hz, with no phase shift and the following amplitudes:

Apply the load on the same face as in the static analysis, see Figure 3-2 on page 18.

Damping
Model the damping in the material using Rayleigh damping in the same way as for 
transient analysis (see page 36 for details). Use the following damping coefficients 
αdM = 300, βdK = 3.2·10−5.

Ffreq F f( ) 2πf t FPh f( ) π
180
----------⋅+⋅⎝ ⎠

⎛ ⎞cos⋅=

Fx 3 106⋅   N/m2
=

Fz 3 106⋅   N/m2
=
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R E S U L T S

The amplitudes of the x-, y-, and z-displacements as functions of excitation frequency, 
at a point on the face where the load is applied, appear in the following figure:

The peaks in the displacement amplitude curves are associated with the two lowest 
eigenfrequencies of the bracket. Note that, just as indicated by the eigenmode shapes 
obtained from the eigenfrequency analysis, the lowest eigenfrequency, around 
410 Hz, corresponds to the peak on the x-displacement amplitude curve, while the 
next eigenfrequency, around 570 Hz, corresponds to the peak on the z-displacement 
curve.

M O D E L I N G  U S I N G  C O M S O L  M U L T I P H Y S I C S

You can start setting up the model by opening an MPH-file that already contains the 
completed initial modeling stages of:

• Geometry import

• Mesh generation

• Material settings

You can also choose to start modeling from the very beginning, in which case you start 
with the instructions in section “Model Navigator” on page 18, then continue until 
you complete the section “Subdomain Settings” on page 21. After that you can jump 
to the section “Application Mode Parameters” on page 46.

x-displacement amplitude

y-displacement amplitude

z-displacement amplitude
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M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
Open the model file containing the initial modeling stages.

1 In the Model Navigator go to the Model Library page.

2 From the list of models select 
Structural Mechanics Module>Tutorial Models>elbow bracket initial setup.

Physics Settings

Application Mode Parameters   

Change the analysis type to frequency response analysis.

1 From the Physics menu, choose Properties to open the Application Mode Properties 
dialog box.

2 From the Analysis type list, select Frequency response.

The Analysis type list defines which analysis to perform and which equation to solve.

3 Click OK.

Boundary Settings   

The left edge is fixed in both directions. The frequency response analysis uses a 
harmonic assumption and therefore you only need to specify the amplitude of the load.

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the 
Physics menu.

2 Set boundary conditions according to the following table; when done, click OK.

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint condition Fixed Fx 3e6

Fz 3e6
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Subdomain Settings   

Because the material is already specified, you only need to enter the damping 
parameters.

1 From the Physics menu, select Subdomain Settings.

2 Select Subdomain 1.

3 On the Damping page, select Rayleigh from the Damping model list.

4 Enter the damping properties according to the following table; when done, click OK.

Computing the Solution
Usually when performing a frequency response analysis you want to sweep over a 
frequency range. This can be done using the parametric solver. The analysis type 
controls which solver to use through the Auto select solver option in the Solver 

Parameters dialog box. As this option is enabled by default, you do not need to change 
the solver settings. The parametric solver is the one associated with the frequency 
response analysis type.

Specify the parametric solver parameters.

1 From the Solve menu, select Solver Parameters to open the Solver Parameters dialog 
box.

PARAMETER VALUE

 αdM 300

 βdK 3.2e-5
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2 Go to the General page and enter freq_smsld in the Parameter names edit field.

3 Enter range(350,10,650) in the Parameter values edit field to specify an excitation 
frequency from 350 Hz to 650 Hz in steps of 10 Hz.

4 Click OK to close the Solver Parameters dialog box.

If you want to use the parametric solver to sweep a different parameter than the 
excitation frequency, enter the name of that parameter in the Parameter names edit 
field. In this case, you specify the excitation frequency in the Application Scalar 

Variables dialog box, which you can open by selecting Scalar Variables from the 
Physics menu.

5 To compute the solution, either click the Solve button (=) on the Main toolbar or 
select Solve Problem from the Solve menu.

Postprocessing and Visualization
To view the solution at all the different excitation frequencies, open the Plot 

Parameters dialog box, go to the General page and select among those frequencies. The 
default plot shows the von Mises stress for the last excitation frequency in the list.

1 From the Postprocessing menu, select Plot Parameters.
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2 Clear the Slice check box and select the Subdomain and Deformed shape check boxes.

The result of a frequency response analysis is a complex time-dependent 
displacement field, which can be interpreted as an amplitude, uamp, and a phase 
angle, uphase. The actual displacement at any point in time is the real part of the 
solution

The software can visualize the amplitudes and phases as well as the solution at a 
specific angle (time). The Solution at angle parameter, which you can find on the 
General page, makes this easy. When plotting, COMSOL Multiphysics multiplies the 
solution by , where  is the angle in radians that corresponds to the angle 
specified in degrees in the Solution at angle edit field. The plot shows the real part 
of the evaluated expression

The angle  is available as the variable phase (radians) and can be used in plot 
expressions.

u uamp 2πf t uphase+⋅( )cos=

eiφ φ

u uamp φ uphase+( )cos=

φ
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3 Click OK to close the dialog box.

For a more quantitative view of the frequency evolution of the displacement, plot the 
x-, y-, and z-displacement amplitudes versus the frequency at Point 38, which is on the 
loaded face of the part.

1 From the Postprocessing menu, select Domain Plot Parameters.

2 On the General page, select all the excitation frequencies in the Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 From the Point selection list, select Point 38.

5 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>Disp. amplitude 

x-dir..

6 Click Apply to plot the x-displacement amplitude.

7 On the General page, select the Keep current plot check box.

8 Click the Point tab.

9 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>Disp. amplitude 

y-dir.. Click Apply.

10 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>Disp. amplitude 

z-dir..

11 Click OK.
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Parametric Analysis

A parametric analysis solves for the static response as a function of a parameter. You 
freely define the parameter name and what it affects; it can be a material property, a 
load parameter, or some other expression.

The purpose of this example is to find the response to static loading of the bracket as 
a function of the direction of the load parameterized by the angle α.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
elbow_bracket_parametric

M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis (see the 
description on page 17 for details).

Load
Apply the load on the face shown in Figure 3-2 on page 18. To control the direction 
of the load in the introduce a parameter in the load expressions,

where α is the angle of the load direction in the xy-plane. Let . 

Fx 3 106 α π 180⁄⋅( )cos   N/m2⋅ ⋅=

Fz 3 106 α π 180⁄⋅( )sin   N/m2⋅ ⋅=

45°– α 45°≤ ≤
V A R I O U S  A N A L Y S E S  O F  A N  E L B O W  B R A C K E T  |  51



52 |  C H A P T E R
R E S U L T S

The following plot shows the x-, y-, and z-displacements as functions of the direction 
of the load, α, at a point where the load is applied:

M O D E L I N G  U S I N G  C O M S O L  M U L T I P H Y S I C S

You can start setting up the model by opening an MPH-file that already contains the 
completed initial modeling stages of:

• Geometry import

• Mesh generation

• Material settings

You can also choose to start modeling from the very beginning, in which case you start 
with the instructions in section “Model Navigator” on page 18, then continue until 
you complete the section “Subdomain Settings” on page 21. After that you can jump 
to the section “Application Mode Parameters” on page 53.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
Open the model file containing the initial modeling stages.

1 In the Model Navigator go to the Model Library page.

2 From the list of models, select 
Structural Mechanics Module>Tutorial Models>elbow bracket initial setup.
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Constants
Although not required, it is good modeling practice to give the solver parameter an 
initial or some other representative value in the Constants dialog box. This way you can 
verify that you have set up the problem correctly by solving the model for a single 
parameter value before changing the solver to start the parametric analysis.

1 From the Options menu, select Constants.

2 Define a constant according to the following table; when done, click OK.

Physics Settings

Application Mode Parameters   

Change the analysis type to parametric analysis.

1 From the Physics menu, select Properties to open the Application Mode Properties 
dialog box.

The Analysis type list defines which analysis to perform and which equation to solve.

2 From the Analysis type list, select Parametric. Click OK.

Boundary Settings   

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the 
Physics menu.

2 Set boundary conditions according to the following table; when done, click OK.

NAME EXPRESSION DESCRIPTION

alpha -45 Initial load direction

BOUNDARY 1 BOUNDARY 29

Page Constraint Load

Constraint condition Fixed Fx 3e6*cos(alpha*pi/180)

Fz 3e6*sin(alpha*pi/180)
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Because the cosine and sine functions take radians as input, a transformation from 
degrees to radians is done to be able to vary α from −45 to 45°.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. This option is enabled as the default so there is no 
need to change the solver settings. The parametric solver is the one associated with the 
parametric analysis type.

Specify the load direction α as the parameter to vary between −45° and 45°.

1 From the Solve menu, choose Solver Parameters to open the Solver Parameters dialog 
box.

2 In the Parameters area, type alpha in the Parameter names edit field.
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3 Type range(-45,5,45) in the Parameter values edit field to specify the direction of 
the force between −45° to 45° in steps of 5°.

4 Click OK to close the Solver Parameters dialog box.

5 To compute the solution either click the Solve button (=) on the Main toolbar or 
choose Solve Problem from the Solve menu.

Postprocessing and Visualization
To view the solution for different directions of the force, open the Plot Parameters 
dialog box, go to the General page, and then select an entry in the Parameter value list. 
The default slice plot shows the von Mises stress for the last parameter value, which is 
45°.

You can animate the deformation of the bracket as the load is changing direction. First 
create a deformed plot of the von Mises stresses, which you can then use for the 
animation.

1 Click the Plot Parameters button on the Main toolbar.
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2 On the General page, clear the Slice check box and select the Subdomain and Deformed 

shape check boxes.

Because the von Mises stress is the default expression for the subdomain plot, you 
do not need to edit the settings on the Subdomain page.

3 Click OK.

To create the movie which animates the deformation of the part open the Plot 

Parameters dialog box and switch to the Animate page. There you are able to select 
the parameter values to include, and change settings such as the size of the movie. 
When you are ready click, the Start Animation button to create the movie.

Use the Domain Plot Parameters dialog box to visualize the displacement of a point on 
the face with the applied load, as the angle of the load is changing.

1 From the Postprocessing menu, select Domain Plot Parameters.

2 On the General page, make sure that all load direction angles in the Solutions to use 
list are selected.

3 Click the Point tab (this selects a point plot automatically).

4 From the Point selection list, select Point 38.

5 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>x-displacement.

6 Click Apply to plot the x-displacement.

7 On the General page, select the Keep current plot check box.

8 Click the Point tab. From the Predefined quantities list, select Solid, Stress-Strain 

(smsld)>y-displacement. Click Apply.

9 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>z-displacement.

10 Click OK.

Thermal-Structural Interaction with Transient Heat Transfer

A common situation when modeling thermal-structural interaction is when the 
dynamics of the structure can be considered as static compared to the much longer 
time scale of the heat transfer problem. In such cases you can couple a steady-state 
structural mechanics problem to the transient temperature response and solve them 
together.

The goal of this analysis is to find out how a long time exposure of the elbow bracket 
to a temperature of 500 °C influences its deformation.
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Model Library path: Structural_Mechanics_Module/Tutorial_Models/
elbow_bracket_thermal_structural

M O D E L  D E F I N I T I O N

The geometry, material, constraints and loads are the same as for the static analysis (see 
the description on page 17 for details).

The structural mechanics analysis has a thermal load, which is the temperature field 
from the heat transfer analysis. The strain reference temperature is 20 °C.

The boundary conditions for the thermal problem are, see Figure 3-4:

• The fixed face has a constant temperature of 20 °C

• The loaded face has a constant temperature of 500 °C

• All other faces of the bracket are cooled convectively with:

- External temperature, Tinf = 20 °C

- Heat transfer coefficient, h = 5 W/(m2·°C)

Figure 3-4: Boundary conditions for the thermal-structure interaction model.

The initial condition for the temperature is T = 0 °C. Track the deformation of the 
bracket for 1000 s.

Loaded face

Fixed face
T = 20 °C

T = 500 °C

Tinf = 20 °C
h = 5 W/(m2 °C)
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R E S U L T S

Figure 3-5 shows a plot of the total displacement versus time at a point on the loaded 
face.

Figure 3-5: The total displacement at Point 38 as a function of time

From the results you can conclude that the total displacement increased by about 9% 
after 1000 s.

M O D E L I N G  U S I N G  C O M S O L  M U L T I P H Y S I C S

To model thermal-structure interaction you couple a heat transfer application mode 
and a structural mechanics application mode. You can add the application modes 
manually, but the easiest is to select the Thermal-Structure Interaction predefined 
multiphysics coupling from the Model Navigator. In this case, both application modes 
are automatically added to the model and the coupling is facilitated by the temperature 
variable which is automatically defined as the temperature for the thermal load in the 
structural mechanics application mode. 

You continue modeling by configuring each application mode as usual. This includes 
subdomain settings such as the material, and boundary settings, such as loads and 
constraints for the structural mechanics application mode, or temperature and fluxes 
for the heat transfer application mode.

Do not forget to define the reference temperature for the thermal load on the 
structure.
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M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
1 Go to the New page in the Model Navigator, then select 3D from the Space dimension 

list.

2 Select Structural Mechanics Module>Thermal-Structural Interaction> 
Solid, Stress-Strain with Thermal Expansion>Transient analysis.

This is a predefined multiphysics coupling that adds a Solid, Stress-Strain application 
mode and a heat transfer application mode (Heat Transfer by Conduction or 
General Heat Transfer if the license includes the Heat Transfer Module). The 
predefined multiphysics coupling also sets up the thermal expansion on the Load 
page in the Subdomain Settings dialog box for the Plane Stress application mode.

3 Click OK to close the Model Navigator.

Geometry Modeling
To import the file containing the geometry follow the step by step instructions in the 
section “Geometry Modeling” on page 19.

Physics Settings

Boundary Settings, Plane Stress   

This model uses the same boundary conditions for the Solid, Stress-Strain application 
mode as for the static analysis (see page 22 for details).
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1 From the Multiphysics menu, select Solid, Stress-Strain (smsld).

2 Apply boundary settings according to “Boundary Settings” on page 22.

Boundary Settings, Heat Transfer   

1 From the Multiphysics menu, select Heat Transfer by Conduction (ht), or General Heat 

Transfer (htgh) if you are using the Heat Transfer Module.

2 Set boundary conditions for the heat transfer application mode according to the 
following table. Click OK when done.

An easy way to apply the settings is to select all boundaries, then apply the Heat flux 
boundary condition according to the last two columns of the table. Finish by 
changing the settings for Boundaries 1 and 29 according to the table.

Subdomain Settings, Solid, Stress-Strain   

The material properties for the Solid, Stress-Strain application mode are the same as in 
the static analysis on page 21. In addition, specify the strain reference temperature. The 
temperature coupling is already defined because you used the predefined multiphysics 
coupling node in the Model Navigator.

BOUNDARY 1 BOUNDARY 29 BOUNDARIES 2–28, 30–46

Boundary 
condition

Temperature Temperature Heat flux

T0 20[degC] T0 500[degC] Tinf 20[degC]

h 5[W/(m^2*K)]
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1 From the Multiphysics menu, select Solid, Stress-Strain (smsld).

2 From the Physics menu, choose Subdomain Settings.

3 Enter subdomain settings for the Plane Stress application mode according to the 
following table:

You can see that the variable T, which is the temperature from the heat transfer 
application mode, appears by default in the Temp edit field.

4 Click OK.

Subdomain Settings, Heat Transfer   

Specify structural steel as the material for the heat transfer application mode, and set 
the initial value for the temperature.

1 From the Multiphysics menu, select Heat Transfer by Conduction (ht), or General Heat 

Transfer (htgh) if you are using the Heat Transfer Module.

2 From the Physics menu, choose Subdomain Settings.

SUBDOMAIN 1

Page Material

Library material Structural steel (in the Basic Material Properties library)

Page Load

Tempref 20[degC]
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3 Specify subdomain settings and initial condition for the heat transfer application 
mode according to the following table; when done, click OK.

Computing the Solution
The analysis type for the ruling application mode controls which solver to use through 
the Auto select solver option in the Solver Parameters dialog box. The option is enabled 
by default so there is no need to change the solver settings. The time-dependent 
segregated solver is the one associated with transient analysis using the 
Thermal-Structural Interaction predefined multiphysics coupling. It solves first for the 
temperature and then uses the computed temperature field as input for the structural 
equation. You still have to specify the output times for which you want to compute a 
solution:

1 From the Solve menu, select Solver Parameters to open the Solver Parameters dialog 
box.

SUBDOMAIN 1

Page Physics

Library material Structural steel (in the Basic Material Properties library)

Page Init

T(t0) 20[degC]
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2 In the Times edit field, type range(0,50,1000). This means that the software saves 
the solution every 50 s during the total solution time of 1000 s. This does not 
influence the time-stepping length, only the times when the solution is saved.

3 Click OK.

4 To compute the solution either click the Solve button (=) on the Main toolbar or 
select Solve Problem from the Solve menu.

Postprocessing and Visualization
Look at the final temperature distribution together with the deformed geometry.

1 From the Postprocessing menu, select Plot Parameters.

2 In the Plot type area on the General page, clear the Slice check box and select the 
Subdomain and the Deformed shape check boxes.

3 Go to the Subdomain page and select Heat Transfer by Conduction (ht)>Temperature 
(or General Heat Transfer (htgh)>Temperature) from the Predefined quantities list.

4 From the Unit list select °C.
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5 Click OK to close the Plot Parameters dialog box.

For a quantitative view of the time evolution of the deformation, plot the total 
displacement versus time at Point 38 on the loaded face.

1 From the Postprocessing menu, select Domain Plot Parameters.

2 On the General page, select all the time steps in the Solutions to use list.

3 Click the Point tab (this automatically selects a point plot).

4 Click at the lower-left corner or select Point 38 from the Point selection list.

5 From the Predefined quantities list, select Solid, Stress-Strain (smsld)>Total 

displacement.

6 Click OK to plot the total displacement (see Figure 3-5 on page 58) and close the 
Domain Plot Parameters dialog box.
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S t r u c t u r a l  M e c h a n i c s  M o d e l i n g
The objective of this chapter is to give you an insight on how to approach the 
modeling of various structural mechanics problems. The contents cover subjects 
like loads and constraints, units, reaction forces, and material models. There is also 
information about general features such as coordinate systems and symbols.
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L o ad s

An important aspect of structural analysis is the formulation of the forces applied to 
the modeled structure. You have the freedom of using custom expressions, predefined 
or user-defined coordinate systems, and even variables from other application modes.

You can apply loads on the Load page of either one of the following dialog boxes: 
Subdomain Settings, Boundary Settings, Edge Settings, or Point Settings. You access these 
from the Physics menu or the Model Tree. This User’s Guide includes a detailed 
description of the above functionality for each application mode in the Structural 
Mechanics Module. Use the Table 4-1 below to locate the relevant page.

Units, Orientation, and Visualization

U S I N G  U N I T S

You can enter loads in any unit, independently of the base unit system in the model, 
because COMSOL Multiphysics automatically converts any unit to the base unit 
system. To use the feature for automatic unit conversion, enter the unit in square 
brackets, for example, 100[lbf/in^2]. You can read more about unit systems in 
“Using Units” on page 187 of the COMSOL Multiphysics User’s Guide.

P R E D E F I N E D  A N D  C U S T O M  C O O R D I N A T E  S Y S T E M S

In the Structural Mechanics Module, two predefined coordinate systems are always 
available when you specify loads. These are the global coordinate system and the local 
tangent and normal coordinate system to the boundary.

Custom coordinate systems are also available and are useful, for example, to specify a 
load in any direction without breaking it up into components. To set up a coordinate 

TABLE 4-1:  LOAD SETTINGS FOR APPLICATION MODES IN THE STRUCTURAL MECHANICS MODULE

APPLICATION MODE LOAD SETTINGS

Continuum Application Modes page 222

Mindlin Plates page 265

Shells page 332

Beams page 288

Trusses page 313

Piezoelectric application modes page 368
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system open the Coordinate Systems dialog box from the Options menu. For a detailed 
explanation of coordinate systems, see “Coordinate Systems” on page 98.

V I S U A L I Z I N G  L O A D S

A convenient check for load orientation is to activate the display of load symbols on 
the geometry. You can do this on the Visualization page of the Preferences dialog box, 
which you access from the Options menu. Load symbols are listed on page 108. You 
can also read about visualization settings on page 119 of the COMSOL Multiphysics 
User’s Guide.

Another way to visualize loads is to create plots of the global force or surface tractions 
during postprocessing.

Load Cases

Similar to the familiar concept of load cases, but more powerful, is the parametric 
solver available in all the application modes. You can select the parametric solver from 
the Solver Parameters dialog box that you open from the Solve menu. Here you can 
either select Parametric from the Analysis list or just select Parametric from the Solver 
list, which works together with all of the analysis types. On the General page, you then 
name your parameter and define a list of values. The parameter defined here is available 
in any expression. You can easily control the magnitude, distribution, and even 
location of loads.

A good example on how to set up expressions for controlling position and distribution 
of loads, with the help of the parametric solver, is the model in the Structural 
Mechanics Module Model Library.

Singular Loads

In reality, loads always act on a finite area. However, in a model you can define a load 
on a point or an edge, which leads to singularities. The reason for this is that points 
and lines have no area, so the stress becomes infinite. Because of the stress singularity, 
there are high stress values in the area surrounding the applied load. The size of this 
area and the magnitude of the stresses depend on both the mesh and the material 
properties. The stress distribution at locations far from these singularities is unaffected 
according a to a well-known principle in solid mechanics, the St. Venant’s principle. It 
states that for an elastic body, statically equivalent systems of forces produce the same 
stresses in the body, except in the immediate region where the loads are applied.
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The Figure 4-1 on page 68 shows a plate with a hole in plane stress loaded with a 
distributed load and a point load of the same magnitude. The mesh consists of 
triangular elements with quadratic shape functions. The high stress around the point 
load is dissipated within the length of a few elements for both mesh cases. The stresses 
in the middle of the plate and around the hole are in agreement for the distributed load 
and the point load. The problem is that due to the high stress around the singular load 
it is easy to overlook the high stress region around the hole. When you apply the point 
load, you have to manually set the range for the stress plot to get the same visual 
feedback of the high stress region around the hole in the two cases. This is because the 
default plot settings automatically set the range based on the extreme values of the 
expression that is plotted.

Figure 4-1: A plate with a hole subject to a distributed load (left) and a point load (right).

Despite these findings it is good modeling practice to avoid singular loads because it is 
difficult to estimate the size of the singular region. In the Structural Mechanics 
Module it is possible to define loads on all boundary types. However, avoid singular 
loads altogether with nonlinear and elasto-plastic material models.

normal mesh size

finer mesh size
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Moments in the Continuum Application Modes

The continuum application modes do not have rotational degrees of freedom, which 
makes the specification of moments somewhat cumbersome. To specify moments, you 
can apply a stress distribution which corresponds to the moment.

E X A M P L E :  TO R S I O N A L  M O M E N T  O N  A  C Y L I N D E R

The following steps show how to apply a torsional moment at one end of a cylindrical 
axle in the following figure.

1 In the Model Navigator select 3D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module> 
Solid, Stress-Strain>Static analysis; then click OK.

Continue by creating a cylinder:

3 In the Draw toolbar click the Cylinder button.

Apply torsional moment at this position
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4 In the dialog box that opens, enter 0.5 as the Radius, 5 as the Height, and define the 
axis of the cylinder along the x-axis by entering 1 in the x edit field and 0 in the y 
and z edit fields in the Axis direction vector area. Click OK.

Next define the radial location as a scalar expression, which you can later use in the 
load expression.

5 Choose Options>Expressions>Scalar Expressions. Enter r in the Name column and 
sqrt(y^2+z^2) in the Expression column. Click OK.

Create a work plane that you can use to define a cylindrical coordinate system.

6 Select Draw>Work-Plane Settings.
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7 On the Face Parallel page in the Work-Plane Settings dialog box select Face 3 from 
the Face selection list. Click OK.

8 A new geometry appears with the work plane that you just created. Switch back to 
the geometry containing the cylinder by clicking the Geom1 page in the Drawing 
area.

Continue by defining a cylindrical coordinate system with the help of the work plane 
you just created.

9 Select Options>Coordinate Systems. Click New in the Coordinate System Settings 
dialog box.

10 Click OK in the New Coordinate System dialog box.

11 Back in the Coordinate System Settings dialog box make sure that Define using work 

plane is selected as well as Geom2 in the Work plane list.
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12 Click the Cylindrical coordinate system button. Enter 0.5 for both the x- and y-
coordinates of the origin, because these are the coordinates of the center of the 
circular face in the coordinate system of the work plane. Click OK.

Now you can define a shear stress distribution in the tangential direction, which is 
zero at the center and reaches its maximum at the surface of the axle.

13 Select Physics>Boundary Settings to open the Boundary Settings dialog box.

14 Select Boundary 1 from the Boundary selection list.

15 On the Load page select Coordinate system 1 (the one you just created) from the 
Coordinate system list.
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16 Enter tau_0*r in the Fyl edit field. Click OK.

Because the integral of the stress distribution over the boundary must equal the 
moment to satisfy equilibrium, you can easily specify a value for the moment based 
on the stress distribution.

17 Define the boundary integral for the moment. Select Options>Integration Coupling 

Variables>Boundary Variables.

18 In the dialog box that opens select Boundary 1, which is the one where you have 
defined the load.

19 Enter M in the Name column and Taz_smsld*y-Tay_smsld*z in the Expression 
column. Click OK.

20 In this last step you specify a value for the moment through defining an equilibrium 
equation. Choose Physics>Global Equations to open the Global Equations dialog box.
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21 Enter tau_0 in the Name column and M-100 in the Equation column. The value 100 
is the magnitude of the applied moment. This entry defined the equation M − 100 
= 0, that is, M = 100.

22 Constrain the other end face of the cylinder by fixing it before solving the model.

After solving the model you can visualize the moment on the cylinder by an arrow 
plot of the global force on the boundaries.

23 Click the Plot Parameters button on the Main toolbar.

24 On the General page clear the Slice check box and select the Arrow check box.

25 Click the Arrow tab to switch to the Arrow page.

26 From the Plot arrows on list box select Boundaries.

27 From the Predefined quantities list box select Global force.

28 From the Arrow type list box select 3D arrow.

29 From the Arrow length list box select Normalized.

30 Click OK.
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Follower Loads

Follower loads are defined with respect to the geometry and, as the geometry deforms 
locally, the orientation of the load changes. The use of follower loads is meaningful 
only if you have large deformations in your model and have activated the Large 
Deformation option in the Application Mode Properties dialog box. To define a load as 
a follower load you can select Follower load in the Load type list box on the Load page 
of the Boundary Settings dialog box.

Acceleration Loads

Acceleration loads can be found, for example, in the structural mechanics analysis of 
an airplane seat. Acceleration or deceleration of the aircraft produces a force that an 
accurate simulation must include. Because you can use expressions when specifying 
loads, it is easy to model acceleration loads. In the case of the airplane seat, you define 
the acceleration, acc_x, in the Constants dialog box. Then for the appropriate 
subdomains simply enter rho_smsld*acc_x in the Body load x dir. edit field on the 
Load page of the Subdomain settings dialog box. The density rho_smsld is already 
defined for the material and refers to the corresponding edit field. In a similar manner 
it is also possible to specify gravity loads.

For modeling rotating parts under static conditions, you can use centrifugal 
acceleration loads. The body load in the radial direction is

,  (4-1)

where ρ is the density of the material, ω is the angular frequency, and r is the radius.

E X A M P L E :  A  R O T A T I N G  D I S K

This example describes how to specify a body load according to Equation 4-1, using a 
cylindrical coordinate system. The model is that of a disk welded on a shaft, which 
rotates with a constant angular velocity of 90 rad/s.

Kr ρω2r=
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Figure 4-2: The model geometry.

1 In the Model Navigator, select 3D from the Space dimension list.

2 Select Structural Mechanics Module>Solid, Stress-Strain, then click OK.

3 Create the geometry by first drawing two cylinders, then taking the difference 
between them.

4 Click the Cylinder button on the Draw toolbar.

5 Enter 0.1 in the Radius edit field, and 0.01 in the Height edit field. Click OK.

6 Create one more cylinder with a radius of 0.02 and a height of 0.01.

7 Select both objects by typing Ctrl+A on the keyboard.

8 Click the Difference button on the Draw toolbar to create the final geometry.

9 Select Constants from the Options menu.
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10 Enter omega in the Name column and 90[rad/s] in the Expression column.When 
finished click OK.

11 Select Options>Expressions>Scalar Expressions.

12 Enter r in the Name column, and sqrt(x^2+y^2) in the Expression column. Click 
OK.

Next set up the cylindrical coordinate system by first defining a work plane.

13 Select Draw>Work-Plane Settings. 

14 Click the x-y option button on the Quick page, then click OK.

15 The new workplane is now the active geometry. Switch back to your initial 
geometry, by clicking the Geom1 tab at the top of the drawing area.

16 Select Options>Coordinate Systems to open the Coordinate System Settings dialog 
box.

17 Click New, then click OK to accept the default name.

18 On the Workplane page, click the Define using workplane button. From the Workplane 
list, select Geom2.
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19 Select the Cylindrical coordinate system and click OK.

You can now define the radial body load, by using the defined coordinate system.

20 Open the Subdomain Settings dialog box from the Physics menu.

21 Select the only subdomain and then go to the Load page.

22 From the Coordinate system list, select the coordinate system you have just defined.

23 Enter rho_smsld*omega^2*r in the Fxl edit field, and then click OK.

Before solving the model you need to constrain the disk.

24 From the Physics menu, select Boundary Settings.

25 From the list of boundaries, select boundary 5, 6, 8, and 9.

26 Select Prescribed displacement from the Constraint condition list, and then select 
Tangent and normal coord. sys. (t1,t2,n), from the Coordinate system list.

27 Select the Rn check box, and then click OK.

28 From the Physics menu select Point settings.

29 Select point 3, then select the Rz check box.

30 Click OK.

31 Open the Free Mesh Parameters dialog box from the Mesh menu.

32 From the Predefined mesh sizes list, select Finer, and then click OK.
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33 Click the Solve button on the Main toolbar to compute the solution.

Figure 4-3: The von Mises stress distribution.

34 Click the Plot Parameters toolbar button.

35 In the Plot type area, clear the Slice check box and select the Subdomain check box.

36 Click OK to create the plot shown in Figure 4-3.

Temperature Loads—Thermal Expansion

When performing thermal expansion analysis, you specify temperature loads by 
entering a temperature and a reference temperature on the Load page of the Subdomain 

Settings dialog box. You can enter a constant temperature as well as an analytic 
expression that can depend on the coordinates or dependent variables. More details are 
available in the descriptions for each application mode (see Table 4-1 on page 66).

When you use a separate application mode to model heat transfer in the material, the 
entry for the temperature is the dependent variable for the temperature from that 
application mode, typically T. Read more about how to couple heat transfer analysis 
with structural mechanics analysis on page 133.
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The Structural Mechanics Module also includes a predefined multiphysics coupling to 
a heat transfer application mode. See “Thermal-Structural Interaction” on page 384 
for more information.

Total Loads

You can specify a load either as a distributed load per unit length, area, or volume, or 
as a total force to be uniformly distributed on a boundary.

When you apply a distributed load on a boundary, the Structural Mechanics Module 
provides a way to check that the total force is correct without having to solve the 
model. After you have entered the load, choose Solve>Get Initial Value. Then choose 
Postprocessing>Boundary Integration. In the dialog box that appears, you can select a 
boundary and from the Predefined quantities list select a face load in 3D or an edge load 
in 2D. Click Apply to display the value of the integral, which is the value of the total 
force in the selected direction, in the message log.

Similarly you can check the total body load by subdomain integration of the 
appropriate component of a body load.
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Con s t r a i n t s

Defining the proper constraints for structural mechanics models is just as important as 
defining the loads. Together they make up the boundary conditions of a model. The 
Structural Mechanics Module provides many useful features to define various types of 
constraints. Besides all the predefined options, you can use any expressions to define 
constraints of your choice.

From the Physics menu, you can access the dialog boxes where you can define 
constraints. Depending on your model these can be one or more of the Subdomain 

Settings, Boundary Settings, Edge Settings or Point Settings dialog boxes. Each 
application mode description includes a complete list of available options for constraint 
settings, use the following table to find the appropriate pages.

Orientation and Visualization

You can specify constraints in both global and local coordinate systems. Beside these, 
you can use any coordinate system that you have previously defined in the Coordinate 

System Settings dialog box, which you access from the Options menu. Coordinate 
systems are further explained on page 98.

When you turn on the visualization of load and constraint symbols from the Preferences 
dialog box, COMSOL Multiphysics displays all applied constraints with symbols on 
the geometry. See page 110 for a list of the symbols for constraints.

APPLICATION MODE CONSTRAINT SETTINGS

Continuum Application 
Modes

page 219

Mindlin Plates page 262

Shells page 327

Beams page 283

Trusses page 309

Piezoelectric application 
modes

page 366
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Symmetry Constraints

In many cases you can use symmetry of the geometry and loads to your advantage in 
modeling. Symmetries can often greatly reduce the size of a model and hence reduce 
the memory requirements. When a structure exhibits axial symmetry, you can use the 
axisymmetric application modes. A solid that you can generate by rotating a planar 
shape about an axis is said to have axial symmetry.

For other types of symmetry, you can use many of the predefined symmetry constraints 
available in the user interface of the Structural Mechanics Module. This means that you 
do not have to enter any expressions—instead just select the type of constraint you 
want to apply from a list.

If the geometry exhibits two symmetry planes, as shown in the figure below, you can 
model a quarter of the geometry by selecting Symmetry plane from the Constraint 

condition list on the Constraint page in the Boundary Settings dialog box for the two 
selected surfaces.

As mentioned earlier not only the symmetry of the geometry but also that of the load 
is important in selecting the correct constraints for your model. Figure 4-4 on page 83 
illustrates symmetric and antisymmetric loading of a symmetric geometry. When 
modeling half of the geometry, the correct constraint for the face at the middle of the 

Symmetry planes
Apply Symmetry plane
boundary condition
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object would be Antisymmetry plane in the case of antisymmetric loading and Symmetry 

plane in the case of symmetric loading of the object.

Figure 4-4: Symmetry plane (left) and antisymmetry plane (right).

You can often take advantage of symmetry by using the superposition principle and 
thus reduce the size of models. The superposition principle states that for linear elastic 
materials you can solve separately for different load cases and superpose or add the 
solutions afterwards. For symmetric objects, it is possible to separate any load into a 
symmetric load and antisymmetric load. Thus, you can solve two models on half of the 
geometry and later superpose or add the solutions. Read about how to apply this 
technique to analyze a wheel rim of a car in the description of the model “Fatigue 
Analysis of an Automobile Wheel Rim” on page 278 of the Structural Mechanics 
Model Library.

Kinematic Constraints

Kinematic constraints are equations that control the motion of solids, faces, edges, or 
points. Select Prescribed displacement from the Constraint Condition list to enter 
expressions for constraints. You can define the equations using both predefined 
coordinate systems and custom coordinate systems. Special constraints, for instance to 
keep an edge of body straight or to make a boundary rotate, require such constraint 
equations.

E X A M P L E :  S T R A I G H T  E D G E  C O N S T R A I N T  B Y  E Q U A T I O N S

The following short example shows how to implement constraint equations to keep an 
edge of a solid body straight during deformation. The three linear constraints 

Symmetry plane Antisymmetry plane
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(Equation 9-18) are derived starting on page 301 and are used to keep truss elements 
straight in the 3D truss application modes.

1 In the Model Navigator select 3D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module>Solid, Stress-

Strain>Eigenfrequency analysis; then click OK.

Continue by creating a bar with a rectangular cross section.

3 On the Draw toolbar click the Block button. In the dialog box that appears enter 5 
in the X edit field under the Length label. Click OK.

Continue by defining point extrusion variables, which you can use in the constraint 
equation.

4 Select Options>Extrusion Coupling Variables>Point Variables, which opens the Point 

Extrusion Variables dialog box.

Keep this edge straight

Fixed boundary
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5 From the Point selection list select Point 2. Enter the expressions belonging to this 
point from the following table in the Name and Expression columns. Make sure to 
select General transformation for each variable.

6 Select Point 6 and enter the variables and expressions listed for this point. Select 
General transformation for each of these variables as well.

Next you define the destination for the variables. This is the edge to which you apply 
the constraint equation.

7 On the Destination page select x1 in the Variable list, then select Edge in the Level list. 
Now select the check box in front of Edge 5 in the Edge selection list.

POINT 2 POINT 6

NAME EXPRESSION NAME EXPRESSION

x1 x x2 x

y1 y y2 y

z1 z z2 z

u1 u u2 u

v1 v v2 v

w1 w w2 w
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8 Repeat the previous step for each of the variables in the Variable list. Close the dialog 
box by clicking OK.

In the next steps you specify expressions which simplify the definition of the 
constraint equations.
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9 Select Options>Expressions>Edge Expression. In the Edge Expressions dialog box 
select Edge 5 and enter the following expressions in the Name and Expression 
columns. Click OK.

In the last step you set the constraints for the edge. In the graphical user interface 
you can use the general notation which allows you to specify a system of equation 
containing any linear combination of displacement components.

NAME EXPRESSION

a21 x2-x1

b21 y2-y1

c21 z2-z1

xn (x*a21+y*b21+z*c21)/sqrt(a21^2+b21^2+c21^2)

xn1 (x1*a21+y1*b21+z1*c21)/sqrt(a21^2+b21^2+c21^2)

xn2 (x2*a21+y2*b21+z2*c21)/sqrt(a21^2+b21^2+c21^2)

xn21 xn2-xn1

xn2n xn2-xn

xnn1 xn-xn1

R1 -c21*(u1*xn2n+u2*xnn1)/xn21+a21*(w1*xn2n+w2*xnn1)/xn21

R2 -c21*(v1*xn2n+v2*xnn1)/xn21+b21*(w1*xn2n+w2*xnn1)/xn21

R3 -a21*(v1*xn2n+v2*xnn1)/xn21+b21*(u1*xn2n+u2*xnn1)/xn21
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10 Open the Edge Settings dialog box by selecting Physics>Edge Settings. Select Edge 5 
and select the General Notation check box.

11 Click the Edit button next to the H label and enter the following matrix:

The H matrix multiplied by the displacement vector makes up the left hand side of 
the equation system, while the R vector which you enter next is the right hand side.

12 Click OK.

13 Click the Edit button next to the R label and enter the following vector:

c21– 0 a21
0 c21– b21

b21 a21– 0

R1
R2
R3
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14 Click OK.

15 Click OK to close the Edge Settings dialog box.

16 In the Boundary Settings dialog box apply the Fixed constraint to Boundary 1, then 
click OK.

17 Click the Solve button on the Main toolbar to solve the problem.

Next create a deformed shape plot of the bar. For better visualization of the straight 
edge plot the last eigenfrequency, which is 467.6 Hz.

18 Click the Plot Parameters button on the Main toolbar.

19 On the General page clear the Slice check box and select the Boundary and Deformed 

shape check boxes.

20 From the Solution to use list select the last eigenfrequency, which is 467.626 Hz.

21 Click OK.

E X A M P L E :  S T R A I G H T  E D G E  C O N S T R A I N T  B Y  T R U S S  E L E M E N T S

An alternate method to that shown in the example on page 75 is to enforce the 
straight-edge constraint of a solid by adding a 3D Truss application mode to a model 
and activate it only on the edge to be constrained. Keep in mind that by adding truss 
elements to the model you add both additional mass and stiffness to the problem, 
which can influence the results.

1 Repeat Steps 1 through 3 of the example on page 83.

2 In the Boundary Settings dialog box apply the Fixed constraint to Boundary 1, then 
click OK.

Continue by adding a truss application mode to the model.
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3 Select Multiphysics>Model Navigator.

4 In the list of application modes select 
Structural Mechanics Module>3D Truss>Eigenfrequency analysis. Click Add, then click 
OK.

5 Select Physics>Edge Settings to open the Edge Settings dialog box for the truss 
application mode.

6 Select Edges 1–4 and 6–12, then clear the Active in this domain check box.

Next change the element type for the Truss application mode so that it is compatible 
with the default element type used in the Solid, Stress-Strain application mode.
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7 Select Edge 5. On the Element page select Lagrange - Quadratic from the Predefined 

elements list.

Decrease the density and Young’s modulus of the truss, so that it does not influence 
the results.

8 On the Material page, enter 1 in the E edit field and 0 in the ρ edit field. Click OK.

9 Click the Solve button on the Main toolbar to solve the problem.

10 Repeat Steps 18–21 from the previous example to verify that the solution is similar.
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Rotational Joints

Joints between elements in the In-Plane Truss and 3D Truss application modes are 
automatically rotational joints because the truss elements have no rotational degrees of 
freedom. In an application mode for beams, however, the rotational degrees of 
freedom are by default coupled between elements. To create a rotational joint between 
two beam elements, add one additional In-Plane Euler Beam or 3D Euler Beam 
application mode to your geometry. Make sure that it is only active for the boundary 
that includes the point where the joint will be positioned and that no other application 
mode is active here. Couple the translational degrees of freedom and leave the 
rotational degrees of freedom uncoupled at the joint. This procedure is described for 
a simple 2D case in the following example.

E X A M P L E :  R O T A T I O N A L  J O I N T  B E T W E E N  2 D  B E A M  E L E M E N T S

In this example you set up a rotational joint by using two In-Plane Euler Beam 
application modes. You also use boundary expressions to gain access to dependent 
variables of both application modes during postprocessing.

1 In the Model Navigator select 2D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module>In-Plane Euler 

Beam>Eigenfrequency analysis; then click OK.

Fixed point Pinned point

Rotational joint
 4 :  S T R U C T U R A L  M E C H A N I C S  M O D E L I N G



3 Hold down the Shift key and click the Line button on the Draw toolbar. Enter the 
following values for the line B1:

4 Click OK.

5 To draw the next line segment, hold down the Shift key and click the Line button 
on the Draw toolbar. Enter the following values for the line B2:

6 Click OK.

7 Select Physics>Boundary Settings. In the Boundary selection list select Boundary 2 
and clear the Active in this domain check box, then click OK.

EDIT FIELD B1

x -1 0

y 0 0

EDIT FIELD B2

x 0 1

y 0 0
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8 Select Physics>Point Settings. Select Point 1 from the Point selection list and on the 
Constraint page select Fixed from the Constraint condition list.

9 Click OK.

Continue by adding one more beam application mode to the model.

10 Select Multiphysics>Model Navigator.

11 In the list of application modes select Structural Mechanics Module>In-

Plane Euler Beam>Eigenfrequency analysis. Click Add, then click OK.

Now you can edit the physics settings of the second application mode and couple 
the two together.

12 If the Model Tree is not visible click the Model Tree button on the Main toolbar to 
make it visible.

13 In the Model Tree click the Detail button or the Inspect button.

14 Expand the In-Plane Euler Beam (smeulip2) branch and double click Boundary Settings 
to open the Boundary Settings dialog box for this application mode.

15 In the Boundary selection list select Boundary 1 and clear the Active in this domain 
check box, then click OK.

16 Under the In-Plane Euler Beam (smeulip2) branch double-click Point Settings to open 
the Point Settings dialog box for this application mode.

17 In the Point selection list select Point 3 and on the Constraint page select Pinned from 
the Constraint condition list.
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18 Now select Point 2 and select Prescribed displacement from the Constraint condition 
list.

19 Select the Rx check box and enter u in the edit field next to it.

20 Select the Ry check box and enter v in the edit field next to it. Click OK.

Now you can create boundary expressions that take the value of the displacement 
variables from both of the application modes and make them available on the entire 
geometry for postprocessing.

21 Select Options>Expressions>Boundary Expressions.

22 In Boundary Expressions dialog box select Boundary 1 and enter the following:

NAME EXPRESSION

my_u u

my_v v
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23 Select Boundary 2 and fill in the Expression column according to the table below:

24 Click OK.

25 Click the Solve button on the Main toolbar to solve the problem.

To see the deformation of the entire geometry you can use the boundary 
expressions you have defined.

26 Click the Plot Parameters button on the Main toolbar.

27 On the General page select the Boundary and Deformed shape check boxes.

28 On the Deform page, click the Boundary Data tab. Enter my_u in the x component edit 
field and my_v in the y component edit field.

NAME EXPRESSION

my_u u2

my_v v2
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29 On the Boundary page enter sqrt(my_u^2+my_v^2) in the Expression edit field. 
Click OK to plot the results.
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Coo r d i n a t e  S y s t em s

Using different coordinate systems is useful in situations such as when specifying loads, 
constraints, and anisotropic materials, and when postprocessing the results. The 
software provides a number of different coordinate systems:

• A global Cartesian coordinate system, where the geometry is created in 3D (x, y, z).

• A local geometrical coordinate system on 2D boundaries (t, n) and on 3D faces 
(t1, t2, n).

• Application-mode specific coordinate systems: a shell coordinate system and a 3D 
Euler beam coordinate system.

• A user-defined coordinate system.

To specify the coordinate system, select it from the Coordinate system list on the 
Constraint, Load, and Material pages.

The following figure shows the Load page in the Boundary Settings dialog box for the 
Plane Strain application mode:

Global Coordinate System

You can use the global coordinate system in all application modes to specify loads and 
constraints on all domain levels: points, edges, faces, and subdomains. It is the default 
setting for loads and constraints in all application modes on all domain levels except 
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boundary constraints for the Mindlin plate application mode. The default name of the 
space coordinates are the following for the different geometries:

It is possible to change the names of the space coordinates when creating a geometry 
from the Model Navigator; see “Creating Cartesian and Cylindrical Coordinate 
Systems” on page 27 in COMSOL Multiphysics User’s Guide for details.

Local Geometrical Coordinate System

Boundaries in 2D and 3D have geometric variables describing the parametrization of 
the geometry defined on them. These variables contain directions that define a local 
coordinate system that you can use when specifying loads and constraints. 

In 2D the local geometrical coordinate system is (t, n), representing the tangential and 
normal direction of the boundary. For interior boundaries and free edges this 
coordinate system is right-oriented. For exterior boundaries the normal is always 
directed out from the domain.

In 3D the local geometrical coordinate system is (t1, t2, n) representing two tangential 
directions and one normal direction. t1 and t2 depend on the parametrization of the 
geometry. For interior boundaries and free faces this coordinate system is right-
oriented but not always orthogonal. For exterior boundaries the normal is always 
directed out from the domain. Common applications for this coordinate system 
include specifying pressure or normal displacement on a surface.

Note: t1 and t2 depend on how the geometry was created and are usually 
perpendicular to each other.

Read more about this topic in “Geometric Variables” on page 170 in the COMSOL 
Multiphysics User’s Guide.

GEOMETRY DEFAULT NAME OF SPACE COORDINATES

2D  x y z

3D  x y z

Axial symmetry 2D  r zϕ
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The Constraint page in the Boundary Settings dialog box for the Solid, Stress-Strain 
application mode shows how local coordinate systems work.

Application-Mode Specific Coordinate System

The 3D Euler Beam and Shell application modes include a local coordinate system.

The 3D Euler Beam application mode defines the orientation of the cross-section 
coordinate system needed to specify the orientation of the beam. Details about the 3D 
Euler beam local coordinate system is available in “Cross Section” on page 281.

The Shell application mode defines a local coordinate system on the face needed to 
define postprocessing variables such as internal moments, normal forces, and shear 
forces. Details about the shell local coordinate system are found in “Postprocessing” 
on page 336 of this manual. 

You can also use these coordinate systems to define loads and constraints.
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The Load page in the Edge settings dialog box for the 3D Euler Beam application mode 
shows how local application-specific coordinate systems is used.

User-Defined Coordinate System

User-defined coordinate systems can be used on all domain levels in all application 
modes. For the continuum application modes, they can define orthotropic and 
anisotropic material properties in a coordinate system other than the global Cartesian 
system.

Create a user-defined coordinate system by choosing Options>Coordinate Systems, 
thereby opening the Coordinate Systems Settings dialog box. Depending on the active 
geometry, the software creates a 2D or 3D coordinate system.
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2 D  G E O M E T R Y

The New button opens the New Coordinate System dialog box.

In the Copy from list you select from which existing coordinate system you want to copy 
the coordinate-system settings.

In the Name edit field you enter the name of the coordinate system, and it is the name 
that appears in all coordinate-system lists.

The software creates a coordinate system in one of three ways, which you control with 
option buttons:

• Rotate x-axis The local xl-axis direction is specified using an angle (α) between the 
global and local x-axes.

xl

xg

ygyl

α
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• x-axis direction vector: The local xl-axis direction is specified using a direction vector 
v.

• Cylindrical coordinate system A local cylindrical coordinate system (xl, yl) with origin 
at (x0, y0) is specified.

3 D  G E O M E T R Y

The New button works in the same way as for the 2D geometry case.

xl

xg

ygyl

v

xg

yg

(x0, y0)

xl

yl
C O O R D I N A T E  S Y S T E M S  |  103



104 |  C H A P T E
The software defines the coordinate system in one of two ways, which you control with 
the Define using work plane and Define using global coordinates option buttons.

Define Using Work Plane
Define using work plane is enabled when a least one work plane/2D geometry exists.

Select the work plane that the local coordinate system is based upon from the Work 

plane list.

Four options are available, which you control with option buttons:

•  Use work plane coordinate system The local coordinate system is the same as the 
work plane. You control the definition of the work plane by going to the Draw menu 
and opening the Work-Plane Settings dialog box. Get details about the creation of 
work planes in “Creating and Using 2D Work Planes” on page 59 in the COMSOL 
Multiphysics User’s Guide.

•  Rotate x-axis The local xl-axis direction is specified using an angle (α) between the 
work planes xwp-axis and the local xl-axis.

xl

xwp

ywpyl

α
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•  x-axis direction vector The local xl-axis direction is specified using a direction vector 
v.

•  Cylindrical coordinate system A local cylindrical coordinate system (xl, yl) with origin 
at (x0, y0) in the work plane coordinates is specified.

xl

xwp

ywpyl

v

xwp

ywp

(x0, y0)

xl

yl
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Define Using Global Coordinates

There are two different options available, which you control with option buttons:

•  Direction method The local xl-axis direction is specified using a direction vector vaxi. 
The local xlyl-plane is specified using a direction vector vplane which is a vector lying 
in the local xlyl-plane.

•  Rotation angle method The local coordinate system (xl, yl, zl) is specified using three 

xl

xg

yg yl

vaxi

zg

vplane
zl
R  4 :  S T R U C T U R A L  M E C H A N I C S  M O D E L I N G



consecutive rotation angles θx, θy', and θz''.

x'xg

yg

zg

y'

θx

θx

z'

x'

y'

θy'

z'
z''

θy'

x''

y''

θz''

zl z''

θz''

x''

rotate around xg then around rotated y'

then around doubly rotated z''

yl

y''

xl
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LOAD SY
S ymbo l s  f o r  L o ad s  and Con s t r a i n t s

To make it easier to specify a model, you can display load and constraint symbols on a 
geometry. This option appears on the Visualization page in the Preferences dialog box. 
To read more about that dialog box, see the section “Saving Preferences for Labels, 
Rendering, and Highlighting” on page 119 of the COMSOL Multiphysics User’s 
Guide. In the Preferences dialog box you also have the option to select whether to plot 
the symbols from the current domain type or all domain types. The option to control 
whether to display the symbols is also available from the Options menu by choosing 
Show Symbols or by clicking the Show Symbols button on the Visualization/Selection 
toolbar. Scaling the size of the symbols is possible in the Visualization/Selection dialog 
box; see “Scaling of Load and Constraint Symbols” on page 119 of the COMSOL 
Multiphysics User’s Guide.

Load Symbols

You can plot load symbols on points, boundaries, edges, and subdomains. The loads 
are normalized with respect to the maximum value within a domain type.

The following table lists all load symbols together with the application modes where 
they appear.

MBOL DESCRIPTION APPLICATION MODES

Force at a point or in a subdomain. Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

In-Plane Euler Beam

In-Plane Truss

Boundary force. Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

In-Plane Euler Beam

In-Plane Truss
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Fl

LOAD SY
Transversal force in the z direction at point 
or in a subdomain.

Positive (left) and negative (right) z direction 
respectively.

Mindlin Plate

Point bending moment about the z-axis. In-Plane Euler Beam

Edge bending moment about the z-axis. In-Plane Euler Beam

Bending moment about the axis indicated by 
the direction of the arrow.

Mindlin Plate

Force in the direction indicated by the 
direction of the arrow.

Solid, Stress-Strain,

Piezo Solid,

Shell,

3D Euler Beam

3D Truss

Moment about the axis indicated by the 
direction of the arrow.

Shell,

3D Euler Beam

Force and/or moment defined in the local 
coordinate system.

3D Euler Beam, beam local 
coordinate system

MBOL DESCRIPTION APPLICATION MODES
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CONSTR
Constraint Symbols

Constraint symbols are available on points, boundaries, edges, and subdomains. The 
following table lists all constraint symbols together with the application modes where 
they appear.

AINT SYMBOL DESCRIPTION APPLICATION MODE

Displacement constrained in the direction 
indicated by the roller.

Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

In-Plane Euler Beam

In-Plane Truss

Displacement constrained in the x and 
y directions. 

In-Plane Euler Beam

In-Plane Truss

All degrees of freedom constrained. Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

Mindlin Plate

In-Plane Euler Beam

Rotation constrained. In-Plane Euler Beam

Rotation constrained.

Displacement constrained in the direction 
indicated by the roller.

In-Plane Euler Beam
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CONSTR
Displacement constrained in the 
z direction.

Mindlin Plate

Displacement constrained in the 
z direction.

Rotation constrained but allowed about 
the axis indicated by the line segments.

Mindlin Plate

Rotation constrained about the axis 
indicated by the space between the 
triangles.

Mindlin Plate

Rotations about all axes constrained. Mindlin Plate

Clamped edge, all degrees of freedom 
constrained.

Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

In-Plane Euler Beam,

In-Plane Truss,

Mindlin Plate

Displacement constrained in the 
z direction.

Mindlin Plate

AINT SYMBOL DESCRIPTION APPLICATION MODE
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Cl ate 

CONSTR
Rotation constrained but allowed about 
the axis indicated by the line segments.

Mindlin Plate

Displacement constrained in the 
z direction.

Rotation constrained but allowed about 
the axis indicated by the line segments.

Mindlin Plate

Rotations about all axes constrained. Mindlin Plate

Displacements constrained in the 
directions indicated by the arrows.

3D Euler Beam,

Shell,

3D Truss,

Solid, Stress-Strain,

Piezo Solid

Rotations constrained about axis 
directions indicated by the arrows.

3D Euler Beam

Shell

Displacements and/or rotations 
constrained in the local coordinate 
system.

3D Euler Beam, beam local coordin
system

AINT SYMBOL DESCRIPTION APPLICATION MODE
R  4 :  S T R U C T U R A L  M E C H A N I C S  M O D E L I N G



Ca l c u l a t i n g  R e a c t i o n  Fo r c e s

There are three different ways to evaluate reaction forces in the Structural Mechanics 
Module:

• Using predefined postprocessing variables for reaction forces and moments

• Using weak constraints

• Using the surface traction vector

Except for the special situations (noted below) when they are not available, use the 
predefined postprocessing variables, which is both the simplest and most accurate 
method. While weak constraints give equally accurate results as the predefined 
postprocessing variables, the method requires adding extra degrees of freedom to the 
model. Evaluating the surface traction on constrained boundaries, on the other hand, 
is more direct but provides only approximate values.

The following sections describe the three methods in turn.

Using Predefined Postprocessing Variables

The postprocessing capabilities of the Structural Mechanics Module include easy access 
to the reaction forces and moments in your model. Open either one of the Subdomain 

Integration, Boundary Integration, Edge Integration, or Point Evaluation dialog boxes, 
available from the Postprocessing menu, to find predefined variables for reaction force 
evaluation. Reaction forces are calculated as the sum of the nodal values over the 
selected volume, face or edge. Reaction moments are calculated as the sum of the 
moment from the reaction forces, with respect to a reference point, and explicit 
reaction moments (not available in the continuum application modes). Reaction 
moments in individual points are only available for application modes having explicit 
reaction moments like beams and shells.

You specify the coordinates of the reference point for the moment calculation in the 
Application Scalar Variables dialog box. This reference point is also used for the 
calculation of the total reaction moments. Note that after editing the reference point 
coordinates you need to select Solve>Update Model for the change to take effect on the 
reaction moment calculation.

To check that the reaction loads are consistent with the applied loads in your model 
use the predefined variables for the total reaction forces and moments available from 
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the Global Variables Plot dialog box. Total reaction forces and moments are defined 
both for individual domain levels such as subdomains, boundaries, edges, points and 
as the total over all domain types.

The solver stores the reaction forces automatically, but you can also turn off this feature 
in the Solver Manager dialog box by clearing the Store reaction forces check box on the 
Output page.

Note: Reaction forces are not available for eigenfrequency analysis or when weak 
constraints are turned on for your application mode.

Using Weak Constraints

C O N T I N U U M  A P P L I C A T I O N  M O D E S

With weak constraints turned on, you can get accurate results because extra variables 
that correspond to the reaction forces, are automatically added to the solution 
components. Begin by activating weak constraints for the application mode by 
selecting On in the Weak Constraints list in the Application Mode Properties dialog box. 
Make sure that Ideal is selected for the Constraint type.

With weak constraints activated, COMSOL Multiphysics adds the reaction forces to 
the solution components. The variables in 3D are denoted lm1, lm2, and lm3 (for 
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Lagrange multipliers). Only the first two are present in 2D application modes. The 
following table shows the interpretation of these variables on the boundaries.

It is only possible to evaluate reaction forces on constrained boundaries in the 
constraint directions. To calculate the reaction force on a boundary, you can carry out 
a boundary integration of one of the variables lm1, lm2, or lm3 in the Boundary 

Integration dialog box. COMSOL Multiphysics displays the value of the integral in the 
message log.

In a similar fashion use the Subdomain Integration, Edge Integration, or Point Evaluation 
dialog boxes to evaluate the reaction forces for constraints applied on these boundary 
types.

Because the reaction force variables are added to the solution components, the number 
of DOFs for the model increases slightly, depending on the mesh size for the 
boundaries in question.

With weak constraints activated, you can individually turn off weak constraints for 
boundaries on the Weak Constr. page of the Boundary Settings dialog box. However, 
boundaries that are adjacent to each other must have the same settings. The reason for 

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE FOLLOWING 
AXES

GLOBAL COORDINATE SYSTEMS LOCAL GEOMETRICAL 
COORDINATE SYSTEMS

USER-DEFINED 
COORDINATE 
SYSTEMS

3D 2D 2D AXI- 
SYMMETRIC

3D 2D

lm1  x  x  r  t1  t  x1

lm2  y  y  z  t2  n  x2

lm3  z - -  n -  x3
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this is that adjacent boundaries share a common node. Read more about the use of 
weak constraints in the section “Using Weak Constraints” on page 350 of the 
COMSOL Multiphysics Modeling Guide.

O T H E R  A P P L I C A T I O N  M O D E S

Evaluate the reaction forces or moments similarly as for the continuum application 
modes. Use the following tables to identify the variables and the corresponding forces 
or moments.

TABLE 4-2:  TRUSS APPLICATION MODES

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE 
FOLLOWING AXES

GLOBAL COORDINATE SYSTEM LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

3D 2D 2D

lm1  x  x  t  x1

lm2  y  y  n  x2

lm3  z - -  x3

TABLE 4-3:  BEAM APPLICATION MODES—FORCES

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE FOLLOWING AXES

GLOBAL COORDINATE 
SYSTEM

BEAM LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE SYSTEM

3D 2D 3D 2D 3D 2D

lm1  x  x  xlocal  t  x1  x1

lm2  y  y  ylocal  n  x2  x2

lm3  z  -  zlocal  -  x3 - 

TABLE 4-4:  BEAM APPLICATION MODE—MOMENTS

VARIABLE CORRESPONDS TO REACTION MOMENT AROUND THE FOLLOWING AXES

GLOBAL COORDINATE 
SYSTEM

BEAM LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE SYSTEM

3D 2D 3D 2D 3D 2D

lm3 -  z  -  z  -  x3

lm4  x  -  xlocal  -  x1  -

lm5  y  -  ylocal  -  x2  -

lm6  z  -  zlocal  -  x3  -
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TABLE 4-5:  SHELL APPLICATION MODE—FORCES

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE 
FOLLOWING AXES

GLOBAL 
COORDINATE 
SYSTEM

SHELL LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm1  x  xlocal  t1  x1

lm2  y  ylocal  t2  x2

lm3  z  zlocal  n  x3

TABLE 4-6:  SHELL APPLICATION MODE—MOMENTS

VARIABLE CORRESPONDS TO REACTION MOMENT AROUND THE FOLLOWING 
AXES

GLOBAL 
COORDINATE 
SYSTEM

SHELL LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm4  x  xlocal  t1  x1

lm5  y  ylocal  t2  x2

lm6  z  zlocal  n  x3

TABLE 4-7:  MINDLIN PLATE APPLICATION MODE—FORCES

VARIABLE CORRESPONDS TO REACTION FORCE IN THE 
DIRECTION OF THE FOLLOWING AXES

GLOBAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm1  z  z  z

TABLE 4-8:  MINDLIN PLATE APPLICATION MODE—MOMENTS

VARIABLE CORRESPONDS TO REACTION MOMENT AROUND 
THE FOLLOWING AXES

GLOBAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm2  x  t  x1

lm3  y  n  x2
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Using Surface Traction

By an alternative method, you can obtain approximations to the reaction forces on 
constrained boundaries using boundary integration of the relevant components of the 
surface traction vector.

In 2D application modes, you need to multiply the surface traction by the cross section 
thickness before integrating to calculate the total reaction force. Note that this method 
is less accurate than solving for the reaction forces using the reaction force 
postprocessing variables or weak constraints.
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Ma t e r i a l  Mode l s

The Structural Mechanics Module provides a variety of material models. You can 
modify and extend these models, and also define your own material models. The 
chapters of this book dealing with the different application modes contain theory 
background and information about entering material settings in the graphical user 
interface, as well as application-mode specific information. While all material models 
are available in the continuum application modes, the other application modes use only 
linear elastic stress-strain relationship. Use the table below to locate the appropriate 
pages.

In the present section you find tips and tricks related to the use of material models in 
the Structural Mechanics Module.

Linear Elastic Materials

While for the isotropic case two parameters are enough to describe the material 
behavior, the number of parameters increases to (at most) 21 for the anisotropic case 
in 3D. When setting up a model make sure that the parameters you use are defined in 
agreement with the definitions used in the Structural Mechanics Module. The stress-
strain relationship for linear elastic materials is discussed in the section “Linear Elastic 
Materials” on page 175. If necessary, transform the material data before entering it in 
the user interface. For example, for orthotropic materials calculate the Poisson’s ratio 
νxy by

.

APPLICATION MODE THEORY BACKGROUND MATERIAL SETTINGS

Continuum application modes page 174 page 209

Mindlin Plates page 247 page 258

Shells page 321 page 326

Beams page 272 page 279

Trusses page 300 page 307

Piezoelectric application modes page 339 page 352

νxy νyx
Ex
Ey
------=
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Hyperelastic Materials

Three phenomenological models for hyperelastic materials—the Neo-Hookean, 
Mooney-Rivlin, and Murnaghan material models—are predefined in the Structural 
Mechanics Module. You can use both the Neo-Hookean and the Mooney-Rivlin 
material models for modeling nearly incompressible hyperelastic materials such as 
rubber. The Murnaghan material model is more suitable for compressible materials 
and acoustoelastic applications involving wave propagation is solids and structures.

In addition to these three hyperelastic material models, you can specify other material 
models, using predefined and custom stress and strain measures. Read more about this 
in the section “User-Defined Materials” on page 128.

Extracting the parameters for the material models from experimental stress-strain 
curves involves curve fitting with the appropriate equations for the nominal (Piola-
Kirchhoff) stress. For a given strain state, these can be derived from the general stress-
strain relationship for hyperelastic materials (see Equation 6-5 on page 185).

For a thin sheet of incompressible hyperelastic material under uniaxial tension the 
stretch along the axis of the loading is λ1 = λ = 1 + ε, where ε is the strain. Due to 
symmetry and incompressibility the stretch ratios in the transverse directions are 
λ2 = λ3 = λ−1/2. The stress state corresponding to this state of deformation is reduced 
to P1 = P, P2 = P3 = 0, where

.  (4-2)

Assume a strain energy function, Whyp, according to the Mooney-Rivlin material 
model, for which Equation 4-2 becomes

.  (4-3)

Use Equation 4-3 to curve fit the parameters C10 and C01 from a uniaxial stress-strain 
curve, as demonstrated by the following example script.

E X A M P L E :  S C R I P T  F O R  C U R V E  F I T T I N G  O F  P A R A M E T E R S  O F  T H E  

M O O N E Y - R I V L I N  M A T E R I A L  M O D E L

Note: Running the script requires MATLAB.

P 2 λ λ 2–
–( )

∂Whyp
∂I1

----------------- 1
λ
---

∂Whyp
∂I2

-----------------+⎝ ⎠
⎛ ⎞=

P 2 λ λ 2–
–( ) C10

1
λ
---C01+⎝ ⎠

⎛ ⎞=
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In the beginning of the script, stress and strain data are stored in the vectors 
engStressExp and engStrain, respectively. Then the stretch, lam1, is calculated 
from the strain, followed by solving the equation for C10 and C01. Both the 
experimental and fitted data are plotted at the end.

% Example
% Use least-squares analysis to curve fit C01 and C10 for a
% Mooney-Rivlin material from experimental stress-strain data.
engStrain = [0, 0.075, 0.103, 0.15, 0.174, 0.2004, 0.25, ...
      0.305, 0.351, 0.37];
engStressExp = [0, 4.9e5, 8.67e5, 1.36e6, 1.55e6, 1.71e6, ...
      1.95e6, 2.10e6, 2.17e6, 2.21e6];

% Calculate stretch and set up equation system
lam1 = 1 + engStrain;
lam1 = lam1';
CoeffMatrix = zeros(length(engStrain),2);
CoeffMatrix(:,1) = 2./lam1.*(lam1.^2-1./lam1);
CoeffMatrix(:,2) = 2./(lam1.^2).*(lam1.^2-1./lam1);

% Solve for C10 and C01
C10C01 = CoeffMatrix\engStressExp';

% Calculate stress from this data
engStressMRML = CoeffMatrix*C10C01;
%Plot
plot(engStrain, engStressExp,'*', engStrain, engStressMRML, '-');
legend('Experimental data','Curve fit');
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Elasto-Plastic Materials

The Elasto-Plastic Material Settings dialog box is prepared for directly entering three 
types of hardening models: perfectly plastic hardening, isotropic hardening, and 
kinematic hardening. You also have the choice to use von Mises or user-defined yield 
functions. The implementation of elasto-plastic material models in the Structural 
Mechanical Module works best for strains within the small strain range and permits 
large deformations.

To specify a hardening function for an elasto-plastic material model with isotropic 
hardening, enter it as an expression or use a function specified by a function table. In 
both cases the hardening function is a function of the effective plastic strain, εpe, and 
has to describe the behavior starting at the yield stress of the material. For the 
derivation of the hardening function, note that the experimental stress curve is a 
function of the total strain, which is the sum of the plastic strain and the elastic strain. 
Thus, the total effective strain can be written as

 (4-4)

0 0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4
0

0.5

1

1.5

2

2.5
x 10

6

 

 
Experimental data
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where σe is the effective stress and E is the Young’s modulus for the material. Based 
on the experimental stress function, σexp, the hardening function can now be defined 
as

 (4-5)

where σys is the yield stress for the material.

E X A M P L E :  U S E  O F  S T R E S S - S T R A I N  C U R V E  A S  H A R D E N I N G  F U N C T I O N

The following steps show how to specify a hardening function based on a stress-strain 
curve from a uniaxial tension test. The model shows the loading under tension of a thin 
plate with a hole in the center. Due to symmetry analyze only a quarter of the plate.

1 In the Model Navigator select 2D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module>Plane 

Stress>Static analysis elasto-plastic material; then click OK.

Create the geometry for the model. First, draw a rectangle, then a circle, and finally 
take the difference of these two objects to get the geometry for the plate.

3 Hold down the Shift key and click the Rectangle/Square button on the Draw toolbar. 
Enter 0.22 in the Width edit field and enter 0.45 in the Height edit field. Click OK.

4 Hold down the Shift key and click the Ellipse/Circle (Centered) button on the Draw 
toolbar. In the Radius edit field enter 0.11. Click OK.

5 With both objects selected click the Difference button on the Draw toolbar.

Continue by defining the experimental stress strain data as an interpolation function 
based on a table.

σyhard σexp εeff( ) σys σexp εpe
σe
E
-----+⎝ ⎠

⎛ ⎞ σys–=–=

Distributed load

Symmetry
boundary
condition
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6 Select Options>Functions. Click New in the dialog box that opens. Enter 
stress_strain_curve in the Function name edit field and select the Interpolation 
option button. Make sure that Table is selected in the Use data from list box and click 
OK.

7 In the Functions dialog box select Cubic spline from the Interpolation method and 
enter the data shown in the figure below in the x and f(x) columns.

8 Click the Plot button to see a plot of both the entered data points and the 
interpolated curve.
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9 Click OK to close the Functions dialog box.

Next define the constants for the material parameters and the expression for the 
hardening function, based on the second part of Equation 4-5.

10 Select Options>Constants to open the Constants dialog box and enter the following 
constants; click OK when finished.

11 Select Options>Expressions>Scalar Expressions and enter the expression from the 
following table. Click OK when finished.

The variables epe_smps and mises_smps are the effective plastic strain and the 
effective stress according to von Mises, respectively. The suffix changes depending 
on the application mode, in this case _smps denotes the Plane Stress application 
mode.

12 Select Physics>Subdomain Settings. In the Subdomain selection list select Subdomain 
1 and enter E in the E edit field and nu in the ν edit field.

NAME EXPRESSION DESCRIPTION

E 71.2e9 Young’s modulus

nu 0.31 Poisson’s ratio

sigma_yield 260e6 Yield strength

Area 0.45*0.002 Area of cross section

NAME EXPRESSION DESCRIPTION

sigma_hard stress_strain_curve(epe_
smps+mises_smps/E)-
sigma_yield

Stress increase from the 
yield stress level due to 
hardening
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13 Click the Elasto-Plastic Material Data button to open the Elasto-Plastic Material 

Settings dialog box. Enter sigma_yield in the σys edit field. Click the Hardening 

function data option button and enter sigma_hard in the σyhard(εp) edit field.

Now enter the material parameters and boundary conditions for the model.

14 Click OK and then click OK again in the Subdomain Settings dialog box.

15 Select Physics>Boundary Settings. In the Boundary selection list select Boundaries 1 
and 3. On the Constraint page select Symmetry plane from the Constraint condition 
list box.

16 Select Boundary 2 and on the Load page enter Load/Area in the Fy edit field. Click 
the Edge load is defined as fore/area using the thickness button; then click OK.

The last step is to define the load parameter and solve the problem.

17 Click the Solver Parameters button on the Main toolbar. Enter Load in the Parameter 

names edit field and enter range(10e3,10e3,45e3) 49e3 54e3 
range(55e3,10e3,145e3) range(147e3,10e3,167e3) in the Parameter list edit 
field. Click OK.

18 Click the Solve button on the Main toolbar to solve the problem.

To visualize the solution you can plot the plastic strain.

19 Click the Plot Parameters toolbar button.

20 In the dialog box that opens switch to the Surface page.

21 From the Predefined quantities list, select Plane Stress (smps)>effective plastic strain.
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22 Click OK.

Viscoelastic Materials

For viscoelastic materials the generalized Maxwell model is used. The material can be 
described as consisting of branches with a spring and a dashpot parallel to a linear 
elastic material. For each branch the shear modulus and the relaxation time are entered 
into a table. For more information, see “Viscoelastic Materials” on page 189. For an 
example model, see “Viscoelastic Damper” on page 222 of the Structural Mechanics 
Module Model Library.

Mixed Formulation

As described in the section “Mixed Formulation” on page 181, the negative mean 
stress becomes an additional dependent variable when you select the Use mixed U-P 

formulation check box on the Material page of the Subdomain Settings dialog box. Select 
this setting when the Poisson’s ratio of a material is close to 0.5, which means that the 
material is nearly incompressible. The mixed formulation is useful not only for elastic 
materials but also for elasto-plastic, hyperelastic materials, and viscoelastic materials.
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Note that not all iterative solvers work together with mixed formulation because the 
stiffness matrix becomes indefinite. You can find recommendations on solver settings 
for the mixed formulation in “Solver Settings” on page 149. It is also important to 
remember that because the shape function for the pressure must be one order less than 
the shape functions for the displacements, it is not possible to use linear elements for 
the displacement variables on the subdomains where mixed formulation is turned on.

User-Defined Materials

For most cases when a material model is not readily available in the graphical user 
interface, you can implement it by modifying or adding necessary equations and 
expressions.

For example, you can define a new hyperelastic material model by following these short 
steps of entering constants and variables and editing the strain energy function:

• Define the material parameters that you want to use in the strain energy function. 
Do this in the Constants dialog box that you open from the Options menu.

• Specify additional strain invariants to use in the strain energy expression, if 
applicable. Read about application mode variables in the Structural Mechanics 
Module Reference Guide. To include custom strain invariants in the strain energy 
function enter these as expressions. For example, choose Options>Expressions>Scalar 

Expressions to enter expressions that becomes available on the current geometry.

• Edit the definition of the strain energy function. Choose 
Physics>Equation Systems>Subdomain Settings and in the dialog box that opens click 
the Variables tab. Locate and edit the expression for the variable named Ws_smsld, 
which is the strain energy function. The index appended to the name Ws may be 
different depending on the application mode’s name.

It is also possible to use other types of constitutive equations in your models. Read 
about modeling thermally induced creep in metals in the section “Thermally Induced 
Creep” on page 333 of the Structural Mechanics Module Model Library. This model 
provides an example on how to set up custom constitutive equations.
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Ma t e r i a l  L i b r a r i e s

A useful feature in COMSOL Multiphysics is the Materials/Coefficients library. In 
addition to the Basic Material Properties library the Structural Mechanics Module 
extends this library with two extra material libraries:

• MEMS Material Properties, an extended solid material library for MEMS 
applications. See “MEMS Material Properties Library” on page 130.

• Piezoelectric Material Properties, a material library with 23 common piezoelectric 
materials. See the section “Piezoelectric Material Properties Library” below.

The Basic Material Properties library is included with COMSOL Multiphysics and 
contains properties for a limited number of basic solid materials, given as constants, 
and temperature-dependent properties for air and water, given as functions.

For more information about using the Materials/Coefficients Library dialog box, see 
“Using the Materials/Coefficients Library” on page 228 in the COMSOL 
Multiphysics User’s Guide.

Piezoelectric Material Properties Library

The Piezoelectric Material Properties library ships with the Acoustics Module, MEMS 
Module, and Structural Mechanics Module. It contains the following piezoelectric 
materials:

MATERIAL

Barium Sodium Niobate

Barium Titanate

Barium Titanate (poled)

Lithium Niobate

Lithium Tantalate

Lead Zirconate Titanate (PZT-2)

Lead Zirconate Titanate (PZT-4)

Lead Zirconate Titanate (PZT-4D)

Lead Zirconate Titanate (PZT-5A)

Lead Zirconate Titanate (PZT-5H)

Lead Zirconate Titanate (PZT-5J)
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All materials define the following material properties needed for piezoelectric 
modeling:

MEMS Material Properties Library

The MEMS Material Properties library contains 33 materials commonly used in 
MEMS applications. The materials are divided into the following groups: Metals, 
Semiconductors, Insulators, and Polymers.

The basic structure of this library comes from the book Microsensors, MEMS, and 
Smart Devices (Ref. 1). The material properties come from two primary sources: the 
CRC Handbook of Chemistry and Physics (Ref. 2) and MacMillan’s Chemical and 
Physical Data (Ref. 3). Some of the mechanical properties in the library are instead 
more MEMS-specific values from The MEMS Handbook (Ref. 4), and most of the 

Lead Zirconate Titanate (PZT-7A)

Lead Zirconate Titanate (PZT-8)

Quartz

Rochelle Salt

Bismuth Germanate

Cadmium Sulfide

Gallium Arsenide

Tellurium Dioxide

Zinc Oxide

Zinc Sulfide

Ammonium Dihydrogen Phosphate

Aluminum Nitride

MATERIAL PROPERTY DESCRIPTION

 cE Elasticity matrix

 e Coupling matrix, stress-charge

 εrS Relative permittivity, stress-charge

 sE Compliance matrix

 d Coupling matrix, strain-charge

 εrT Relative permittivity, strain-charge

 ρ Density

MATERIAL
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semiconductor properties are values from Ref. 5. Ref. 6 provides a valuable resource 
for cross-checking the insulation material properties.

The table below lists the materials and their corresponding groups:

MATERIAL GROUP

Aluminium (Al) Metals

Silver (Ag) Metals

Gold (Au) Metals

Chrome (Cr) Metals

Copper (Cu) Metals

Indium (In) Metals

Titanium (Ti) Metals

Iron (Fe) Metals

Nickel (Ni) Metals

Lead (Pb) Metals

Palladium (Pd) Metals

Platine (Pt) Metals

Antimon (Sb) Metals

Tungsten (W) Metals

C [100] Semiconductors

GaAs Semiconductors

Ge Semiconductors

InSb Semiconductors

Si(c) Semiconductors

Poly-Si Semiconductors

Silicon (single-crystal) Semiconductors

Al2O3 Insulators

SiC (6H) Insulators

Si3N4 Insulators

SiO2 Insulators

ZnO Insulators

Borosilicate Insulators

Nylon Polymers

PMMA Polymers
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Polymide Polymers

Polyethylene Polymers

PTFE Polymers

PVC Polymers

MATERIAL GROUP
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Mu l t i p h y s i c s  Mode l i n g

In this section you find modeling tips about how to create multiphysics models with 
the Structural Mechanics Module. A good place to start reading about how to create 
all types of multiphysics models is Chapter 14, “Multiphysics Modeling,” on page 65 
of the COMSOL Multiphysics Modeling Guide, where you can see how to add or 
remove different physics in a model, how to set the properties for the different physics 
and how to manage the solution components. See also Chapter 12, “Predefined 
Multiphysics Couplings,” on page 383 for more information about the predefined 
multiphysics couplings for thermal-structure interaction, fluid-structure interaction, 
acoustic-structure interaction, and thermal-electric-structural interaction.

Thermal-Structural Interaction

The Structural Mechanics Module provides a predefined one-way coupling for 
thermal-structure interaction (thermal expansion), which combines a continuum 
application mode from the Structural Mechanics Module with a heat transfer 
application mode from the Heat Transfer Module or COMSOL Multiphysics; see 
“Thermal-Structural Interaction” on page 384.

You can also manually set up such a coupling using the temperature described by a heat 
transfer application mode to define the strain temperature. On the Load page in the 
Subdomain Settings dialog box in the structural mechanics application mode, select the 
Include thermal expansion check box, and enter the dependent variable for temperature 
from the heat transfer application mode, typically T, in the Temp edit field for the strain 
temperature. 

Note: A special approach is required if the structural analysis is performed in the 
frequency domain. This includes the following analysis types: Frequency response, 
Eigenfrequency, and Damped eigenfrequency. The coupled displacement-
temperature field presents thermoelastic oscillations of small amplitude, which are 
initialized to zero. You need to set the strain reference temperature Tempref to zero, 
and use a special form of the heat balance equation. For more details, see the model 
“Thermal Loading of a Viscoelastic Tube” on page 569 of the Structural Mechanics 
Module Model Library.
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By default, COMSOL Multiphysics takes advantage of the one-way coupling and 
solves the problem sequentially using the segregated solver: first solve for temperature 
and then perform the stress-strain analysis using the computed temperature field from 
the heat transfer equation. Note that this approach, using a single iteration, does not 
produce a correct result if there are thermal properties that depend on the 
displacements (for example, mechanical heating), making it a two-way coupled 
problem.

See Chapter 13, “Thermal-Structure Interaction,” in the Structural Mechanics 
Module Model Library for models that exemplify thermal-structure interaction.

Fluid-Structure Interaction

Fluid-structure interaction models usually include a two-way coupling between the 
solid and fluid domains. The fluid exerts a force on the solid domain, while the 
deformation of the solid affects the geometry of the fluid domain. The Fluid-Structure 
Interaction (FSI) predefined multiphysics coupling enables this interaction by 
combining fluid flow with structural mechanics and using a Moving Mesh (ALE) 
application mode. You can find a description of this multiphysics coupling on page 386 
of this book. See Chapter 9, “Fluid-Structure Interaction,” in the Structural 
Mechanics Module Model Library for models that exemplify thermal-structure 
interaction.

A first thing to consider is whether your FSI problem really needs two-way coupling 
between the physics. If you do not expect the deformation of the solid domain to 
influence the flow problem, the ALE application mode is not necessary. This way you 
can greatly simplify your model. A good example where this method is applied is the 
model “Fluid-Structure Interaction in a Network of Blood Vessels” on page 102 of the 
Structural Mechanics Module Model Library.

When using the Moving Mesh (ALE) application mode it can happen that, as the mesh 
is deforming, you get inverted elements, which result in convergence problems. There 
are several ways to avoid this:

• Try to start with a different mesh. It is often preferable to start from a reasonably 
uniform mesh.

• Try the remeshing algorithm. This allows you to create a new mesh before the one 
you are working with becomes too distorted.
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• Try a different smoothing algorithm. Winslow smoothing is slightly slower, more 
memory consuming, and is usually, but not always, better than Laplace smoothing.

• Another technique you can try is to draw help lines along which you can control the 
mesh deformation.

You find a more detailed description of the above techniques in the COMSOL Support 
Knowledge Base; see Ref. 1.

If you are using the transient solver with a coupled model and you experience 
convergence problems for the initial time step it is most likely due to the instantaneous 
application of a boundary condition, like the velocity. To help the problem to converge 
at the initial time step you can use a smoothed step transition function, like flc1hs (a 
smoothed Heaviside function), when defining the boundary condition. This way both 
the velocity and its derivative are zero for t = 0. You can read about using smoothed 
step functions in the COMSOL Support Knowledge Base; see Ref. 2.

Acoustic-Structure Interaction

By coupling application modes from the Structural Mechanics Module to an acoustics 
application mode from either the Acoustics Module or COMSOL Multiphysics you 
can solve acoustic-structure interaction. Coupling to an acoustics application mode 
from COMSOL Multiphysics enables you to analyze the sound field in an interior 
space. By using an acoustics application mode from the Acoustics Module you can have 
additional tools like a transient solver and means to simulate absorbing or radiation 
boundary conditions. See “Acoustic-Structure Interaction” on page 391. You can find 
models, including step-by-step instructions, on acoustic-structure interaction in 
Chapter 2, “Acoustic-Structure Interaction,” of the Structural Mechanics Module 
Model Library.

Use the Acoustic-Structure Interaction predefined multiphysics coupling to simplify 
modeling of acoustic-structure interaction. It provides a structural mechanics 
application mode and an acoustics application mode and also defines group settings for 
the solid domain and the fluid domain as well as for the fluid load from the acoustics 
pressure and the structural acceleration from the displacements at the fluid-solid 
boundaries.

Coupled acoustic-structure models have symmetric matrices, which means you can 
take advantage of the SPOOLES solver to reduce memory requirements.

When coupling acoustics time-harmonic and structural mechanics frequency response 
application modes make sure that the excitation frequencies for these are set to the 
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same value. You can find these variables in the Application Scalar Variables dialog box, 
which opens if you select Physics>Scalar Variables. One more thing to look out for is 
the mesh size where the acoustics application modes are active. A good rule of thumb 
is that the mesh should have about 10–12 elements per wavelength.

Thermal-Electric-Structural Interaction

The thermal-electric-structural interaction combines thermal expansion, which is a 
one-way coupling that includes a continuum application mode from the Structural 
Mechanics Module and a heat transfer application mode from the Heat Transfer 
Module or COMSOL Multiphysics, with Joule heating and temperature-dependent 
electrical conductivity, which is a two-way coupling that includes a continuum 
application mode from the Structural Mechanics Module and a heat transfer 
application mode from the Heat Transfer Module or COMSOL Multiphysics. See the 
section “Thermal-Electric-Structural Interaction” on page 394.

By default, COMSOL Multiphysics takes advantage of the one-way coupling and solve 
the problem sequentially using the segregated solver: first solve for temperature and 
electric potential using a coupled approach and then perform the stress-strain analysis 
using the computed temperature field from the heat transfer equation. Note that these 
settings, using a single iteration, does not produce a correct result if there are thermal 
properties that depend on the displacements, making the thermal-structure part into 
a two-way coupling.

References

1. COMSOL Support Knowledge Base, Solution no. 970, http://www.comsol.com/
support.

2. COMSOL Support Knowledge Base, Solution no. 905, http://www.comsol.com/
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Con t a c t  Mode l i n g

In the Structural Mechanics Module you can create models involving contact, with or 
without friction, between parts. Contact is implemented based on the augmented 
Lagrangian method, which is described in “Contact Modeling—Theory 
Background” on page 201 in the “Continuum Application Modes” chapter. When 
modeling contact between structural parts you need to set up contact pairs, which 
define where the parts may come into contact. A contact pair consists of two sets of 
boundaries, which are the master domains and the slave domains. The 2D and 3D 
structural continuum application modes use the pairs to set up equations that prevent 
the slave boundaries to penetrate the master boundaries. The present section provides 
some advice regarding important aspects of creating contact models. You can find tips 
regarding solver settings for contact models in the section “Solver Settings for Contact 
Modeling” on page 152.

In the section “Contact Modeling” on page 235 you can read about how to specify 
contact pairs and define the physics for these in the graphical user interface.

When creating contact models it can often be to advantage to set up a prototype in 2D 
before attempting a 3D model. Similarly it is often good to start using linear elements 
to ease convergence toward a solution. When you have got this working, you can 
switch to quadratic elements if you want to.

You can find contact models complete with step by step instructions in Chapter 6, 
“Contact and Friction Models,” of the Structural Mechanics Module Model Library.

Constraints

Make sure that the bodies are sufficiently constrained, also in the initial position. If the 
bodies are not in contact in the initial configuration, and there are no constraints on 
the bodies, you have an underconstrained state. This causes the solver to fail. One way 
to fix this problem is to set initial values for the displacement variables so that you have 
a small penetration in the initial configuration. Another way is to use a displacement-
controlled model rather than a force-controlled one.

Contact Pairs

For efficiency, only include those boundaries that may actually come in contact in the 
slave. For the master, it is often a bit more efficient to make it so large that every slave 
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point “has” a corresponding master point. Note that the corresponding master point 
is obtained by following the normal to the slave until it reaches the master.

To decide which boundaries to assign as master and slave in a contact pair consider the 
following guidelines:

• Make sure that the master boundary stiffness in the normal direction is higher than 
the slave boundary stiffness. This is especially important if the difference in stiffness 
is quite large (for example, over ten times larger). Keep also in mind that for elasto-
plastic or hyperelastic materials there can be a significant change in stiffness during 
the solution process, and choose the master and slave boundaries accordingly. For 
such materials you might have to also adjust the penalty factor as the solution 
progresses.

• When the contacting parts have approximately the same stiffness, you can instead 
consider the geometry of the boundaries. Make a concave boundary the master and 
a convex boundary the slave rather than the opposite.

Once you have chosen the master and slave boundaries, mesh the slave finer than the 
master. Do not make the slave mesh just barely finer than the master because this often 
causes unphysical oscillations in the contact pressure. Make the slave at least two times 
finer than the master.

Boundary Settings for Contact Pairs

P E N A L T Y  F A C T O R S

Note that in the augmented Lagrangian method, the value of the penalty factor does 
not affect the accuracy of the final solution, like it does in the penalty method. When 
running into convergence problems, check the penalty parameters. If the iteration 
process fails in some of the first augmented iterations, lower your penalty parameters. 
If the model seems to converge but very slowly, consider increasing the maximum 
value of your penalty parameters. 

Increasing the penalty factor can lead to an ill-conditioned Jacobian matrix and 
convergence problems in the Newton iterations. You can often see this by noting that 
the damping factor becomes less than 1 for many Newton iterations. If this occurs, 
decrease the penalty factors.

The default values for the penalty factors, using Young’s modulus, only work for linear 
isotropic materials, for which the Young’s modulus is defined. For other types of 
materials you need to substitute E with a suitable value or define it as a constant or 
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expression variable. For elasto-plastic materials you may find that the default value 
works fine until there is a significant decrease in stiffness due to plastic deformation. 
This can give rise to convergence problems for the nonlinear solver because the penalty 
factor becomes too large. To aid convergence you can specify an expression for the 
stiffness that depends, for example, on the solver parameter.

I N I T I A L  V A L U E

In force-controlled contact problems where no other stiffness prohibits the 
deformation except the contact, the initial contact pressure is crucial for convergence. 
If it is too low the parts might pass through each other in the first iteration. If it is too 
high they never come into contact.

Multiphysics Contact

Multiphysics contact problems are often very ill conditioned, which leads to 
convergence problems for the nonlinear solver. For example, take heat transfer 
through the contact area, where initially only one point is in contact. The solution for 
the temperature is extremely sensitive to the size of the contact area (that is, the 
problem to determine the temperature is ill conditioned). Therefore it is important to 
resolve the size of the contact area accurately, that is, to use a very fine mesh in the 
contact area. If the contact area is larger, you do not need as fine mesh because then 
the temperature solution is not that sensitive to the size of the contact area. If possible, 
start with an initial configuration where the contact area is not very small.
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Damp i n g

Damping is important in time-dependent and frequency response analysis. This section 
describes how to model damping using different damping models.

Rayleigh Damping

A common model for viscous damping is Rayleigh damping, which uses the 
assumption that the damping is proportional to a linear combination of the stiffness 
and mass. To illustrate this, consider a system with a single degree of freedom. The 
following equation of motion describes the dynamics of such a system with viscous 
damping:

.

The Rayleigh damping model defines the damping parameter c in terms of the mass m 
and the stiffness k as

where αdM and βdK are the mass and stiffness damping parameters, respectively.

The problem with the Rayleigh damping model is getting good values for the damping 
parameters. A much more physical damping measure is the damping ratio—the ratio 
between actual and critical damping, often expressed as a damping factor in percentage 
of the critical damping. You can find commonly used values of damping factors in the 
literature.

It is possible to transform damping factors to Rayleigh damping parameters. For a 
specified damping factor ξ at a frequency f 

 (4-6)

Using this relationship at two frequencies f1 and f2 with different damping factors ξ1 
and ξ2 results in an equation system

md2u
dt

---------- cdu
dt
------- ku+ + f t( )=

c αdMm βdKk+=

ξ 1
2
---

αdM
2πf
----------- βdK2πf+⎝ ⎠
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Using the same damping factors ξ1 and ξ2 does not result in the same damping factors 
in the interval. It can be shown that the damping parameters have the same damping 
at the two frequencies and less damping in between (see the following figure).

In most applications you can leave αdM to zero (the default value) and define damping 
only using the βdK coefficient. Then according to Equation 4-6 you get linearly 
increasing damping. Using two parameters, a frequency f0 where you want to define 
damping and the damping ratio ξ(f0) or loss factor η(f0), you can define

which results in a well-defined, linearly increasing damping that has the defined 
amount of damping at the given frequency.

Note: All structural mechanics application modes use zero default values for αdM and 
βdK. You must change these default values to meet the specific modeling situation; 
the default settings mean that there is no damping.

1
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Loss Factor Damping

Loss factor damping (sometimes referred to as material or structural damping) takes 
place when viscoelasticity is modeled in the frequency domain. The complex modulus 
G*(ω) is the frequency-domain representation of the stress relaxation function of 
viscoelastic material. It is defined as

where G' is the storage modulus, G'' is the loss modulus, and their ratio ηs = G''/G' is 
the loss factor. The term G' defines the amount of stored energy for the applied strain, 
whereas G'' defines the amount of energy dissipated as heat; G', G'', and ηs can all be 
frequency dependent.

In COMSOL Multiphysics, the loss information appears as a multiplier of the total 
strain in the stress-strain relationship:

.

For hyperelastic materials, the loss information appears as a multiplier in the first Piola-
Kirchhoff stress, P:

Loss factor damping is available for frequency response analysis and damped 
eigenfrequency analysis in all application modes, but it is not defined for elasto-plastic 
materials.

Viscoelastic Materials

If you select the viscoelastic material model in a continuum application mode, the 
viscoelastic branches include damping automatically, and no more damping is 
required. In the frequency-domain the damping using a viscoelastic material model 
corresponds to loss factor damping; see “Viscoelastic Materials” on page 189.

Equivalent Viscous Damping

Although equivalent viscous damping is independent of frequency, it is only possible 
to use it in a frequency response analysis. Equivalent viscous damping also uses a loss 

G∗ G′ jG″+ 1 jηs+( )G′= =

σ D 1 jηs+( )ε εth– ε0–( ) σ0+=

P 1 jηs+( )
Whyp∂
∇u∂

-----------------=
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factor ηs as the damping parameter, but its implementation is different from the actual 
loss factor damping.

The piezoelectric application modes have built-in support for this type of damping. For 
the other application modes, you can model it using the stiffness damping parameter 
βdK, defined as the loss factor, η, divided by the excitation frequency:

You must also set the mass damping factor, αdM, to zero.

Piezoelectrical Losses

H Y S T E R E T I C  L O S S

The equivalent viscous and loss factor damping are special cases of a more general way 
of defining damping: hysteretic loss. Generally, and independently of the microscopic 
origin of the loss, you can model the dissipative behavior of the material using 
complex-valued material properties. For the case of piezoelectric materials, this means 
that you write the constitutive equations as follows:

For the stress-charge formulation

 (4-7)

and for the strain-charge formulation

 (4-8)

where , , and  are complex-valued matrices, where the imaginary part defines 
the dissipative function of the material.

Similarly to the real-valued material data, it is not possible to freely define the complex-
valued data. Instead the data must fulfill certain requirement to represent physically 
proper materials. A key requirement is that the dissipation density is positive; that is, 
you do not get any power gain from the passive material. This requirement sets rules 
for the relative magnitudes for all material parameters, and you must be aware of this, 
especially when defining the coupling losses.

βdK
η

2πf
--------- η

ω
----= =

σ c̃Eε ẽ
T

E–=

D ẽε ε̃SE+=

ε s̃Eσ d̃
T

E+=

D d̃σ ε̃TE+=

cE d̃ ε̃
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In COMSOL Multiphysics you can type the complex-valued data directly, or you can 
use the concept of loss factors. Similarly to the loss factor damping, the complex data 

 is represented as pairs of a real-valued parameter  and a loss factor 
, the ratio of the imaginary and real part, and the complex 

data is then: 

 (4-9)

where the sign depends on the material property used. The loss factors are specific to 
the material property, and thus they are named according to the property they refer to, 
for example, ηcE. For a structural material without coupling, simply use ηs, the 
structural loss factor.

Depending on the field, different terminology is in use. For example, you might refer 
to the loss tangent tan δ, especially when working with electrical applications. The loss 
tangent has the same meaning as the loss factor. Often you see that the quality factor 
Qm is defined for a material. The quality factor Qm and the loss factor ηi are inversely 
related: ηi = 1 / Qm, where ηi is the loss factor for cE, sE, or the structural loss factor 
depending on the material.

The piezoelectric application modes use a formulation that assumes that a positive loss 
factor corresponds to a positive loss. The complex-valued data is then based on sign 
rules. For piezoelectric materials, the following equations apply (m and n refer to 
elements of each matrix):

 (4-10)

The losses for other than piezoelectric materials are more straightforward to define. 
Again, using the complex stiffness and permittivity, the following equations describe 
the lossy material:

X X real X( )=

ηX imag X( ) real X( )⁄=

X X 1 jηX±( )=

c̃E
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cE
m n, 1 jηcE
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 (4-11)

Often you do not have access to fully defined complex-valued data. The piezoelectric 
application modes allow you to define the loss factors as full matrices or as scalar 
isotropic loss factors independently of the material and the other coefficients.

For more information about hysteretic losses, see Refs 1–4.

T H E  L O S S  F A C T O R  U S I N G  D I F F E R E N T  D A M P I N G  T Y P E S

The following damping types use an isotropic loss factor ηs:

• Loss factor damping

• Equivalent viscous damping

• Isotropic loss

In each case the meaning of the loss factor is the same: the fractional loss of energy per 
cycle.

The difference between these damping types is how the loss enters the equation 
system. Using the isotropic loss, ηs is used to build complex-valued material 
properties, whereas when using the loss factor damping, ηs appears in a complex-
valued multiplier in the stress-strain relation. In the equivalent viscous damping, ηs 
appears in a complex-valued and frequency-dependent expression for βdK of the 
Rayleigh damping model.

E L E C T R I C A L  C O N D U C T I V I TY  A N D  D I E L E C T R I C  L O S S E S

In the piezoelectrical application modes, for frequency response and damped 
eigenfrequency analyses, you can define the electrical conductivity of the piezoelectric 
and decoupled material (see Ref. 2, Ref. 5, and Ref. 6). Depending on the formulation 
of the electrical equation, the electrical conductivity appears in the variational 
formulation (the weak equation) either as an effective electric displacement

(the actual displacement variables do not contain any conductivity effects) or in the 
total current expression

D
˜ m n,

1 jηm n,
+( )D

m n,
=

ε̃e
m n,

1 jηe
m n,

–( )εe
m n,

=

D
˜ εrε0E j

Jp

ω
------–=

J Jd Jp+=
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where Jp = σeE is the conductivity current and Jd is the electric displacement current.

You can define both a dielectric loss factor (Equation 4-10, Equation 4-11) and the 
electrical conductivity at the same time. In this case, ensure that the loss factor refers 
to the alternating current loss tangent, which dominates at high frequency, where the 
effect of ohmic conductivity vanishes (Ref. 7).

The use of electrical conductivity in a damped eigenmode analysis leads to a nonlinear 
eigenvalue problem because the material is frequency dependent. This means that the 
first solution is not correct (although usually close to the correct solution), and you 
need to iterate the solution one mode at a time. To work with the iteration scheme use 
the linearization point of the eigenfrequency solver defined on the Eigenvalue page in 
the Solver Parameters dialog box: For the first solution type in an initial guess and then 
compute the solution. Use the found eigenfrequency as the linearization point and 
then solve again.

Explicit Damping

It is possible to defined damping by modeling the dissipative behavior of the material 
using complex-valued material properties. In COMSOL Multiphysics you can type the 
complex-valued data directly, using i or sqrt(-1) for the imaginary unit.

Another way to model damping is to specify it explicitly as a viscous force. In a transient 
analysis you do so by specifying a force that depends on the velocities with opposite 
signs:

where v is the velocity vector

and ut is the velocity component in the x direction, typically named ut.

By specifying damping locally, it is possible to define explicit damping on all domain 
levels.

In a frequency response analysis you define explicit damping in a similar way, but the 
name of the velocity variable changes and includes the application mode name, for 
example, u_t_smsld for the Solid, Stress-Strain application mode.

F c v⋅–=

v

ut

vt

wt

=
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No Damping

To create an undamped model, you can also select to use No damping from the Damping 

model list. This is the default setting.

Example Models

For an example of Rayleigh damping, see the transient analysis in the section “Various 
Analyses of an Elbow Bracket” staring on page 35. For an example of loss factor 
damping, see “Thermal Loading of a Viscoelastic Tube” on page 569 of the 
Structural Mechanics Module Model Library.
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F a t i g u e  Ana l y s i s

The Structural Mechanics Module includes a suite of tools for performing script-based 
fatigue analysis. The fatigue analysis tools require MATLAB.

The fatigue analysis capabilities in the Structural Mechanics Module consists of a 
number of script functions that compute fatigue damage or fatigue life from input 
consisting of loading data and material fatigue data. A typical function takes all stress 
tensor components in the form of a matrix as input and delivers the fatigue damage or 
fatigue life as result.

A typical fatigue analysis consists of the following steps:

1 Perform a finite element analysis of your structure, using COMSOL Multiphysics 
and the Structural Mechanics Module.

2 Calculate the stress field on a matrix format in MATLAB.

3 Calculate the fatigue damage from the stress field, and the fatigue material data 
using a fatigue-analysis script function.

4 Plot the result.

Fatigue analysis is divided into high-cycle and low-cycle fatigue depending of the 
number of load cycles. The Structural Mechanics Module as delivered can handle the 
following cases for both high-cycle and low-cycle fatigue:

• Proportional loading, constant amplitude

• Nonproportional loading, constant amplitude

• Proportional loading, nonconstant amplitude

You find a detailed description of how to perform fatigue analysis together with a 
comprehensive background to the subject and a theoretical descriptions of the 
different methods in the chapter “Fatigue Analysis” on page 397. Model examples are 
available in the section “Fatigue Models” on page 237 in the Structural Mechanics 
Module Model Library.
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S o l v e r  S e t t i n g s

A large selection of solver settings are available in COMSOL Multiphysics. To make it 
easier for you to use a suitable solver and its associated solver parameters, the various 
application modes provide different default settings depending on the analysis type. In 
some situations you must change the default settings. This section helps you select a 
solver and its settings to solve structural mechanics and related multiphysics problems. 
Further details about all solver settings appear in the chapter “Solving the Model” on 
page 377 of the COMSOL Multiphysics User’s Guide.

Symmetric Matrices

The Matrix symmetry list appears on the General page in the Solver Parameters dialog 
box. Here you specify if the assembled matrices (stiffness matrix, mass matrix) resulting 
from your equations are symmetric or not.

Normally the matrices from a single-physics structural mechanics problem are 
symmetric, but there are exceptions, including the following cases:

• Multiphysics models solving for several physics simultaneously, for example, heat 
transfer and structural mechanics. Solving for several structural mechanics 
application modes, such as shells combined with beams, does not create 
unsymmetric matrices.

• Elasto-plastic analysis.

• Viscoelastic material models.

One of the benefits of using the symmetric solvers is that they use less memory and are 
faster. The default option is Automatic, which means the solver automatically detects if 
the system is symmetric or not. Some solvers do not support symmetric matrices and 
always solve the full system regardless of symmetry. The default solver in 2D, 
UMFPACK, does not support symmetry—but it is faster than SPOOLES, the default 
solver in 3D. SPOOLES uses less memory, but memory is usually not a major issue in 
2D.

Note: Selecting the Symmetric option for a model with unsymmetric matrices 
produces incorrect results.
S O L V E R  S E T T I N G S  |  149



150 |  C H A P T E
Complex matrices can be unsymmetric, symmetric, or Hermitian. Hermitian matrices 
do not appear in structural mechanics problems.

Note: Selecting the Hermitian option for a model with complex-valued symmetric 
matrices produces incorrect results.

Selecting Iterative Solvers

The Linear system solver list appears on the General page in the Solver Parameters dialog 
box. The default solver in the Structural Mechanics Module is Direct (SPOOLES) in 3D 
and Direct (UMFPACK) in 2D. For large problems (several hundred thousands or 
millions of degrees of freedom) it is beneficial to use iterative solvers when possible to 
save time and memory. The drawback is that they are more sensitive and might not 
converge if the mesh quality is low.

The iterative solvers have more options than the direct solvers. The following table 
makes suggestions on which iterative solver and preconditioner to use for different 
analyses for large problems.

For eigenfrequency analyses, specifying a positive shift greater than the lowest 
eigenfrequency results in indefinite matrices.

The conjugate gradients iterative solver does not work for indefinite matrices.

You find more details about solver settings in Chapter 6, “Selecting a Solver,” of the 
COMSOL Multiphysics User’s Guide.

ANALYSIS LINEAR SYSTEM SOLVER PRECONDITIONER

Static analysis, single physics Conjugate gradients Geometric multigrid

Quasi-static transient analysis, single 
physics

Conjugate gradients Geometric multigrid

Parametric analysis, single physics Conjugate gradients Geometric multigrid

Eigenfrequency analysis, single physics Conjugate gradients Geometric multigrid

Static analysis, multiphysics GMRES Geometric multigrid

Eigenfrequency analysis, multiphysics GMRES Geometric multigrid

Frequency response analysis GMRES Geometric multigrid

Elasto-plastic analysis GMRES Geometric multigrid

Time-dependent analysis Conjugate gradients Geometric multigrid
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Note: Check the mesh quality when using the geometric multigrid (GMG) 
preconditioner. It does not work well when using the option to scale the geometry 
before meshing (on the Advanced page in the Free Mesh Parameters dialog box). When 
using extruded meshes, you might need to create the mesh cases manually.

The conjugate gradients solver does not work together with a mixed formulation 
because it results in an indefinite stiffness matrix. For this type of problems the 
following solver combinations work:

When using the Vanka smoother for a mixed-formulation problem, specify the 
pressure as the Vanka variable. Get more information about using the Vanka smoother 
in the section “The Vanka Algorithm” on page 570 of the COMSOL Multiphysics 
Reference Guide.

Specifying Absolute Tolerances for the Solution Components

The absolute-tolerance parameters used for time-dependent problems are very 
problem specific. As a rule of thumb, set the absolute tolerance to be at least one order 
of magnitude smaller than the typical displacement.

The default value is 0.001 for all solution components. When solving mixed problems 
with both displacements and pressure, this default results in very small tolerance 
conditions for the pressure. One way to help the solver is to specify individual tolerance 
values for all solution components. This speeds up the solution and usually does not 
affect the accuracy. For example, when solving a model using the 3D Solid, Stress-
Strain application mode for a mixed problem with a typical displacement amplitude of 
10−5 and an internal pressure amplitude of 105, specify u 1e-7 v 1e-7 w 1e-7 p 
1e3 in the Absolute tolerance edit field (that is, use space-separated pairs of variable 
names and the absolute tolerance for that variable). The absolute tolerance values have 
the unit of the corresponding solution component in the model’s unit system. For 
example, if the model uses the MPa unit system, the displacement component’s 
absolute tolerance values have the unit millimeter.

LINEAR SYSTEM SOLVER PRECONDITIONER SMOOTHER

GMRES GMG Vanka

GMG - Vanka

GMRES Incomplete LU -
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Solver Settings for Contact Modeling

To solve contact problems, use the augmented Lagrangian method. The augmented 
solution components are specified on the Stationary page in the Solver Parameters 
dialog box. The augmented solution components are the contact pressure and the 
friction traction components. By default the solver finds these components 
automatically.

If the model includes friction, some solution components from the previous solution 
step are needed. You specify these variables on the Parametric page in the Solver 

Parameters dialog box. The components are the master coordinates, the contact 
variable, and, if dynamic friction is modeled, the time. By default the program finds 
these components automatically.

M A N U A L  S C A L I N G

You need to use manual scaling if the parts are not in contact initially (initial value of 
contact pressure is zero) or if the model includes friction. Select Manual from the Type 

of scaling list on the Advanced page in the Solver Parameters dialog box. In the Manual 

scaling edit field, enter the name of all the solution components together with their 
approximate order of magnitude. For example, solving a plane stress problem with one 
contact pair including friction, where the displacements in both directions are around 
10−3, the contact pressure is around 1000, and the friction traction components are 
around 100. Then enter u 1e-3 v 1e-3 Tn_cp1_smps 1000 Ttx_cp1_smps 100 
Tty_cp1_smps 100 (using space-separated pairs of variable names and scaling factors) 
in the Manual scaling edit field. The units of the values for the solution components in 
the specification of the scaling are the units of the model’s basic unit system. For 
example, using the SI unit system, the displacements are in meters; using the MPa 
system, you specify the displacements in millimeters.

To get the list of degrees of freedom in the model, go to the Solver Manager dialog box 
and look at the Solve For page. For each degree of freedom, use a positive value that is 
of the order of the typical value of that variable. You need not specify scaling factors 
for the friction history variables containing _old, for instance 
contact_cp1_old_smps, xm_old_cp1_smps, ym_old_cp1_smps.

You can read more about how to prevent ill-conditioned matrices by scaling of 
variables and equations on page 531 of the COMSOL Multiphysics Reference Guide.
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TO L E R A N C E S

You find tolerance settings for both the augmented Lagrangian solver and the 
nonlinear solver on the Stationary page of the Solver Parameters dialog box.

Specify the tolerance for the augmented Lagrangian solver (augtol) in the Tolerance 
edit field under the Augmented Lagrangian solver group label. It controls the accuracy 
of the so-called augmentation components Tn, Ttx, Tty (that is, the contact pressure 
and the friction tractions). The accuracy in these components is the product of the 
manual scaling value with augtol. For example, if the manual scale for Tn is set to 108, 
the default augtol = 10−3 gives an error 108·10−3 = 105 or about 0.1% in Tn.

The tolerance for the nonlinear solver (ntol) controls the accuracy of the displacement 
variables (and other variables in a multiphysics model). You can change its value in the 
Relative tolerance edit field in the Nonlinear settings area.

Do not use a too coarse ntol, especially if the body is stiff, because this causes too large 
errors in the determination of the contact tractions, which leads to nonconvergence in 
the augmented Lagrangian iterations. You can estimate ntol by looking at the scaling 
of the dependent variables and the penalty factors:

 (4-12)

where Tmin denotes the minimum of the contact traction scales, pmax the maximum 
penalty factor, and umax the maximum of the displacement scale factors. Calculate the 
maximum penalty factor according to Equation 6-25 on page 240. For example, for a 
material with Young’s modulus of 1011, a minimum mesh size of 10−2, and with the 
manual scaling set to

u 1e-4 v 1e-3 Tn_cp1_smps 1e8 Ttx_cp1_smps 1e6 Tty_cp1_smps 1e6

using the default values for the penalty factors, the nonlinear tolerance is

When your model contains multiple contact pairs, estimate the nonlinear tolerance for 
each pair, then enter a value smaller than the smallest of the estimates in the Relative 

tolerance edit field.

A U G M E N T E D  L A G R A N G I A N  S O L V E R

You select the augmented Lagrangian solver from the Solver list on the Stationary page 
of the Solver Parameters dialog box. This solver controls the updating of the contact 

ntol Tmin augtol⋅
pmax umax⋅

-------------------------------------<

ntol 106 10 3–⋅

1013 10 3–⋅
----------------------------< 10 7–

=
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tractions in each augmented Lagrange iteration. Because these degrees of freedom are 
rather few there is no performance issue here. The default lumped solver is used for 2D 
problems because this gives less undershoots in the contact tractions at the ends of the 
segments in contact. The lumped solver is an approximation that replaces the 
boundary mass matrix with a lumped diagonal matrix.

In 3D, the UMFPACK solver is used as default because lumping does not work for 
quadratic elements.
R  4 :  S T R U C T U R A L  M E C H A N I C S  M O D E L I N G



 5
A p p l i c a t i o n  M o d e  G u i d e
The application modes in the Structural Mechanics Module form a complete set 
of simulation tools for various modeling situations in structural and solids 
mechanics. Select an application mode that describes your structure by analyzing 
the loading conditions and any possible engineering assumptions.
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APPLICATI S

B
O

U
N

D
A

RY

S
U

B
D

O
M

A
IN

CONTINUU
MODES

Solid, Str  √  √

Plane Str  √  √

Plane Str  √  √

Axial Sym
Stress-Str

 √  √
Ove r v i ew

The following table lists the application modes available in the Structural Mechanics 
Module. For a detailed description of any of them, refer to the corresponding section 
on the page listed in the table.

The column for the dependent variables shows the field variables that formulate the 
PDEs or weak form equations. Depending on the engineering assumptions, these 
variables might be a subset of the displacements u, v, and w in the global coordinate 
system, or the rotations , , and  about the global axes. In the piezoelectric 
application modes the electric potential V is included. For axisymmetric simulations, 
COMSOL Multiphysics uses a variable transformation to avoid a singularity at the 
symmetry axis.

For each application mode, the table indicates the availability of various analysis 
capabilities.

Finally the table lists the domains where you can specify application mode data such as 
material properties, loads, and constraints. Note that edges exist only in 3D 
geometries.
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M APPLICATION 167

ess-Strain smsld 168 u, v, w, p  √  √  √  √  √  √  √  √  √  √  √  √

ess smps 169 u, v, p  √  √  √  √  √  √  √  √  √  √  √

ain smpn 170 u, v, p  √  √  √  √  √  √  √  √  √  √  √

metry 
ain

smaxi 171 uor, v, p  √  √  √  √  √  √  √  √  √  √  √
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MINDLIN P  √  √
BEAMS

In-plane E  √

3D Euler 

TRUSSES

2D Truss  √

3D Truss

SHELL  √

PIEZO APP

Piezo Sol  √  √

Piezo Plan  √  √

Piezo Plan  √  √

Piezo Axi  √  √
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To change the type of simulation for a given set of parameters, simply modify the 
analysis type, which is an application mode property. The analysis type sets up the 
coefficients in the underlying equations. The available analysis types depend on the 
application mode. Static, eigenfrequency, damped eigenfrequency, transient, and 
frequency response are common for all application modes.

When starting to work on a model, select the application mode from the Model 

Navigator. You can add application modes to an existing model to create a multiphysics 
model. One example is adding Euler beams to a thin plate modeled in the Plane Stress 
application mode to account for various stiffening structures in the plate.

LATE smdrm 245  w, ,  √  √  √  √  √  √  √  √

271

uler Beam smeulip 296  u,v,  √  √  √  √  √  √  √  √

Beam smeul3d 297  u, v, w, 
, ,

 √  √  √  √  √  √  √  √  √

299

smtr2d 319  u, v  √  √  √  √  √  √  √  √  √  √

smtr3d 320  u, v, w  √  √  √  √  √  √  √  √  √  √  √

smsh 324  u, v, w, 
, ,

 √  √  √  √  √  √  √  √  √

LICATION MODES 339

id smpz3d 376  u, v, w, V  √  √  √  √  √  √  √

e Stress smpps 377  u, v, V  √  √  √  √  √  √

e Strain smppn 377  u, v, V  √  √  √  √  √  √

al Symmetry smpaxi 378  uor, w, V  √  √  √  √  √  √
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When using the Axial Symmetry application mode it is important to note that the 
horizontal axis represents the r direction and the vertical axis the z direction. The 
entire geometry must lie in the half plane r > 0.

Next note that the excitation frequency freq used in frequency response analysis is 
given as an application scalar variable in the GUI. 

Depending on the application mode, you can specify parameters defining a problem 
on points, edges (3D), boundaries, and subdomains. It is possible to specify loads and 
constraints on all available domain types, but you can specify material properties only 
for the subdomain, except for shells and in-plane Euler beams, where they are defined 
on the boundary, and 3D Euler beams, where they are defined on the edge level.

All domain-setting dialog boxes—Point Setting, Edge Settings, Boundary Settings, and 
Subdomain Settings—have a common layout. In each of these dialog boxes, you specify 
a problem using the tabbed pages Constraints, Loads, Material, Cross Section, Init, and 
Element. The Material, Init, and Element pages are available only on the subdomain 
level, except for shells and in-plane Euler beam, where they exists on the boundary, and 
3D Euler beam, where they exists on edge level. In contrast, the Load and Constraint 
pages exist on all available domains, making it possible to define constraints and loads 
on all levels. You set the loads and constraints independently of each other, so it is 
possible to apply loads on constrained domains. Such loads do not affect the 
computation’s final result.
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AP

So

Sh

3D

3D

Pla
The Cross Section page is available only for the beam application modes. On the 
Postprocessing page you can indicate at which depth you want to postprocess results 
for plate and shell elements.

Selecting the Correct Application Mode

The Structural Mechanics Module supplies the following application modes:

PLICATION MODE PICTURE USE TO MODEL

lid, Stress-Strain 3D solids, not thin or slender.

ell Thin 3D structures.

 Euler Beam Slender 3D structures. Typical examples are 
frameworks and latticeworks.

 Truss Slender 3D structures with components capable 
to withstand axial forces only. Typical example is 
latticeworks.

ne Stress In-plane loaded thin plates.
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Pla

 

Ax  

M

2D

2D  
 

Pie

AP
ne Strain In-plane loaded structures whose extent out of 
the plane is large compared to the in-plane 
dimensions, or when the z-displacement is in 
some way restricted. A typical example is a long
tunnel.

ial Symmetry Stress-Strain Axisymmetric structures exposed to symmetric
loads and constraints.

indlin Plate Out-of-plane loaded thin plates.

 Euler Beam Slender 2D structures. Typical examples are 
plane frameworks and latticeworks

 Truss Slender 2D structures with components capable
to withstand axial forces only. Typical example is
plane latticeworks.

zo Solid 3D solids, of piezoelectric material

PLICATION MODE PICTURE USE TO MODEL
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Pie

Pie

Pie

AP
The following chapters present a detailed description of the above-mentioned 
application modes together with an introductory example for each one. For a 
description of the command-line use of the application modes, see the corresponding 
entries in the section “Application Mode Programming Reference” on page 116.

Analysis Capabilities

The Structural Mechanics Module performs static, eigenfrequency, damped 
eigenfrequency, transient, frequency response, parametric, quasi-static, and viscoelastic 
transient initialization analyses. The analysis types require different solvers and 
equations. In the Application Mode Properties dialog box you select an analysis type, 
each of which has a predefined solver. You can disable the choice of a predefined solver 
by clearing the Auto select solver check box in the Solver Parameters dialog box. The 
following table lists the different analysis types with their predefined solver:

zo Plane Stress In-plane loaded thin plates of piezoelectric 
material

zo Plane Strain In-plane loaded structures of piezoelectric 
material whose extent out of the plane is large 
compared to the in-plane dimensions, or when 
the z-displacement is in some way restricted.

zo Axial Symmetry Axisymmetric structures of piezoelectric 
material exposed to symmetric loads and 
constraints.

PLICATION MODE PICTURE USE TO MODEL

ANALYSIS TYPE SOLVER

Static Stationary

Static elasto-plastic Parametric

Eigenfrequency Eigenfrequency/Eigenvalue

Damped eigenfrequency Eigenfrequency/Eigenvalue
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To manually change to a different solver, make a new selection in the Solver Parameters 
dialog box. Read through the following solver descriptions to help find good 
candidates for your application.

S T A T I C  A N A L Y S I S

A static analysis solves for stationary displacements, rotations, and temperature 
(depending on the type of application mode). All loads and constraints are constant. 
The equations include no mass or mass moment of inertia.

E I G E N F R E Q U E N C Y  A N A L Y S I S

An eigenfrequency analysis solves for the undamped eigenfrequencies and the shape of 
the eigenmodes. When performing an eigenfrequency analysis, you can specify 
whether to look at the mathematically more fundamental eigenvalue, λ, or the 
eigenfrequency, f, which is more commonly used in a structural mechanics context.

You control the way to specify eigenvalues from the Application Mode Properties dialog 
box from the Physics menu.

D A M P E D  E I G E N F R E Q U E N C Y  A N A L Y S I S

A damped eigenfrequency analysis solves for the damped eigenfrequencies and the 
shape of the eigenmodes. When performing a damped eigenfrequency analysis, you 
can specify whether to look at the mathematically more fundamental eigenvalue, λ, or 
the eigenfrequency, f, which is more commonly used in a structural mechanics context.

You control the way to specify eigenvalues from the Application Mode Properties dialog 
box (choose Properties from the Physics menu).

Transient Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static Time dependent

Linear buckling Eigenvalue

Viscoelastic initialization Time dependent

ANALYSIS TYPE SOLVER

f Im λ( )
2π

----------------–=

f Im λ( )
2π

----------------–=
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In addition to the eigenfrequency you can also look at the quality factor, Q, and decay 
factor, δ, of your model.

TR A N S I E N T  A N A L Y S I S

A transient analysis solves a time-dependent (unsteady) problem where loads and 
constraints can vary in time.

For transient analysis, COMSOL Multiphysics models damping with the Rayleigh 
damping model, which assumes that the damping matrix C is a linear combination of 
the stiffness matrix K and the mass matrix M:

You can specify the Rayleigh damping parameters locally.

F R E Q U E N C Y  R E S P O N S E  A N A L Y S I S

A frequency response analysis solves for the steady-state response from harmonic loads. 
For this analysis type, you can model damping using Rayleigh damping (in the same 
way as in a transient analysis) or using loss factor damping, where you specify a loss 
factor.

For a frequency response analysis, the Structural Mechanics Module divides harmonic 
loads into two parts:

• The amplitude, F

• The phase (FPh)

Together they define a harmonic load whose amplitude and phase shift can depend on 
the excitation angular frequency ω or excitation frequency f.

For a frequency response analysis, you can choose either the stationary linear or 
nonlinear solvers, setting the excitation frequency in the Application Scalar Variables 

dialog box. An easier way to perform a frequency sweep is to choose the parametric 
solver with freq as the named parameter. You set the sweeping frequency in the List 

Q Im λ( )
2Re λ( )
-------------------=

δ Re λ( )=

C αdMM βdKK+=

Ffreq F ω( ) ωt FPh ω( ) π
180
----------⋅+⎝ ⎠

⎛ ⎞cos⋅=

ω 2πf=
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of parameter values edit field, which appears on the Parametric page in the Solver 

Parameters dialog box.

The result of a frequency response analysis is a complex time-dependent displacement 
field, which can be interpreted as an amplitude uamp and a phase angle uphase. The 
actual displacement at any point in time is the real part of the solution:

COMSOL Multiphysics allows the visualization of the amplitudes and phases as well 
as the solution at a specific angle (time). The Solution at angle parameter makes this 
task easy. When plotting the solution, the program multiplies it by , where  is the 
angle in radians that corresponds to the angle (specified in degrees) in the Solution at 

angle edit field. COMSOL Multiphysics plots the real part of the evaluated expression:

The angle  is available as the variable phase (in radians) and is allowed in plotting 
expressions. Both freq and omega are available variables.

Note: In a frequency response analysis, everything is treated as harmonic: prescribed 
displacements, velocities, accelerations, thermal strains, and initial stress and strains; 
not only the forces.

Q U A S I - S T A T I C  A N A L Y S I S

A quasi-static transient analysis neglects mass effects, assuming the time scale in the 
structural mechanics problem is much smaller than other dynamics. An example is a 
transient thermal problem where the time scale in the thermal problem is often much 
longer than that of the structural dynamics.

P A R A M E T R I C  A N A L Y S I S

A parametric analysis finds the solution dependence from the variation of a specific 
parameter. The parameter could be, for instance, a material property or the position of 
a load. The equations are static.

L I N E A R  B U C K L I N G  A N A L Y S I S

A linear buckling analysis includes the stiffening effects from stresses coming from 
nonlinear strain terms. The two stiffnesses coming from stresses and material define an 

u uamp 2πf t uphase+⋅( )cos=

eiφ φ

u uamp φ uphase+( )cos=

φ
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eigenvalue problem where the eigenvalue is a load factor that, when multiplied with 
the actual load, gives the critical load in a linear context. The linear buckling analysis 
uses the eigenvalue solver.

Another way to calculate the critical load is to include large deformation effects and 
increase the load until the solver fails because the load has reached its critical value.

Linear buckling analysis is available only in the continuum and Truss application 
modes.

V I S C O E L A S T I C  T R A N S I E N T  I N I T I A L I Z A T I O N

A viscoelastic transient initialization precomputes initial states for transient and 
quasi-static transient analyses when the viscoelastic material model is used. It is a 
regime of instantaneous deformation and/or loading.

Viscoelastic transient initialization is available only in the continuum application 
modes.

L A R G E  D E F O R M A T I O N S

The Structural Mechanics Module allows you to include large deformations with the 
restriction of small strains in all fully dimensional application modes. This effect is also 
sometimes referred to as a nonlinear geometric effect. Using large deformation, the 
application mode replaces the normal strain with the Green strain and replaces the 
stress with the second Piola-Kirchhoff stress. It solves the problem using a total 
Lagrangian formulation.

T H E R M A L  C O U P L I N G S

Solids expand with temperature, which causes thermal strains to develop in the 
material. These thermal strains combine with the elastic strains from structural loads 
to form the total strain:

Thermal strain depends on the temperature, T, the stress-free reference temperature, 
Tref, and the thermal-expansion coefficient, α:

Thermal expansion affects displacements, stresses, and strains. Thermal coupling is 
available as an option in all application modes except the piezoelectric application 
modes. You need only specify the thermal expansion coefficient and the two 
temperature fields, T and Tref. These temperatures can be any mathematical expression 

ε εel εth+=

εth α T Tref–( )=
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and are typically other variables solved for in another COMSOL Multiphysics 
application mode, for instance, the heat transfer application modes. You can use 
temperature coupling in any type of analysis.

Note: A special approach is required if the structural analysis is performed in the 
frequency domain. This includes the following analysis types: frequency response, 
eigenfrequency, and damped eigenfrequency. The coupled displacement-temperature 
field presents thermoelastic oscillations of small amplitude, which are initialized to 
zero. You need to set the strain reference temperature Tempref to zero and use a 
special form of the heat balance equation. For more details, see the example “Thermal 
Loading of a Viscoelastic Tube” on page 569 of the Structural Mechanics Module 
Model Library.
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C o n t i n u u m  A p p l i c a t i o n  M o d e s
Continuum in this context means that no simplifications are available and that you 
solve for the displacements without involving rotations.

The following application modes in the Structural Mechanics Module are of the 
continuum type:

• Solid, Stress-strain

• Plane Stress

• Plane Strain

• Axial Symmetry, Stress-Strain

Continuum application modes are formulated on planes in 2D and volumes in 3D. 
In the continuum application modes you can use Lagrange elements of arbitrary 
order.
 167
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S o l i d ,  S t r e s s - S t r a i n

The degrees of freedom (dependent variables) in this application mode are the global 
displacements u, v, and w in the global x, y, and z directions, respectively, the pressure 
p (only used if mixed formulation is selected), and the viscoelastic strains (only used 
for viscoelastic materials).

Loads and constraints applied to a 3D solid using the Solid, Stress-Strain application 
mode.
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P l a n e  S t r e s s

Use the Plane Stress application mode to analyze thin in-plane loaded plates. It solves 
for the global displacements (u, v) in the x and y directions, the pressure p (only used 
for mixed formulation), the displacement derivative in the perpendicular direction 
(only used for hyperelastic materials), and the viscoelastic strains (only used for 
viscoelastic materials). For a state of plane stress, this mode assumes the σz, τyz, and τxz 
components of the stress tensor are zero.

The Plane Stress application mode models plates where the loads are only in the plane; it 
does not include any out-of-plane stress components.

This application mode allows loads in the x and y directions, and it assumes that these 
are constant throughout the material’s thickness, which however can vary with x and 
y. The plane stress condition prevails in a thin flat plate in the xy-plane loaded only in 
its own plane and without any z direction restraint.
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P l a n e  S t r a i n

The Plane Strain application mode solves for the global displacements (u, v) in the x 
and y directions, the pressure p (only if mixed formulation is used), and the viscoelastic 
strains (only used for viscoelastic materials). The assumption that defines a state of 
plane strain is that the εz, εyz, and εxz components of the strain tensor are zero.

A geometry suitable for plane strain analysis.

Loads in the x and y directions are allowed. The loads are assumed to be constant 
throughout the thickness of the material, but the thickness can vary with x and y. The 
plane strain condition prevails in geometries, whose extent is large in the z direction 
compared to in the x and y directions, or when the z displacement is in some way 
restricted. One example is a long tunnel along the z-axis where it is sufficient to study 
a unit-depth slice in the xy-plane.
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Ax i a l  S ymme t r y ,  S t r e s s - S t r a i n

The Axial Symmetry, Stress-Strain application mode uses cylindrical coordinates r, 
 (phi), and z. It solves equations for the global displacement (uor, w) in the r and 

z directions, the pressure p (only used for mixed formulation), and the viscoelastic 
strains (only used for viscoelastic materials). The dependent variable uor ≡ u/r is 
introduced to avoid division by r, which causes problems on the axis where r = 0. This 
application mode assumes that the displacement v in the  direction together with the 

, , , and  components of the stresses and strains are zero. Loads are 
independent of , and this application mode allows loads only in the r and 
z directions.

You can view the domain where the application mode solves the equations as the 
intersection between the original axially symmetric 3D solid and the half plane , 
r ≥ 0. Therefore you draw the geometry only in the half plane r ≥ 0 and recover the 
original 3D solid by rotating the 2D geometry about the z-axis.

Rotating a 2D geometry to recover a 3D solid.

Note: r = 0 is the symmetry axis. In the Axisymmetry, Stress-Strain application mode 
x → r and y → z.

ϕ

ϕ
τrϕ τϕz γrϕ γϕz

ϕ

ϕ 0=
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Th eo r y  Ba c k g r ound

Strain-Displacement Relationship

The strain consists of thermal (εth), elastic (εel), and initial (ε0) contributions so that

The strain conditions at a point are completely defined by the deformation 
components—u, v, and w in 3D—and their derivatives. The precise relation between 
strain and deformation depends on the relative magnitude of the displacement.

S M A L L  D I S P L A C E M E N T S

Under the assumption of small displacements, the normal strain components and the 
shear strain components are related to the deformation as follows:

 (6-1)

To express the shear strain, use either the tensor form, εxy, εyz, εxz, or the engineering 
form, γxy, γyz, γxz. 

The symmetric strain tensor ε consists of both normal and shear strain components:

The strain-displacement relationships for the axial symmetry case for small 
displacements are

ε εel εth ε0+ +=

εx x∂
∂u

=

εy y∂
∂v

=

εz z∂
∂w

=

εxy
γxy
2

-------=
1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞=

εyz
γyz

2
-------=

1
2
---

z∂
∂v

y∂
∂w

+⎝ ⎠
⎛ ⎞=

εxz
γxz
2

-------=
1
2
---

z∂
∂u

x∂
∂w

+⎝ ⎠
⎛ ⎞ .=

ε
εx εxy εxz

εxy εy εyz

εxz εyz εz

=

εr r∂
∂u,= εϕ

u
r
--- ,= εz z∂

∂w, and= γrz z∂
∂u

r∂
∂w

+=
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L A R G E  D E F O R M A T I O N S

For large-displacement analysis, the deformation is not small and you calculate the 
strains without this restriction. The resulting strains are known as Green or Green-
Lagrange strains, and large displacement is sometimes referred to as geometric 
nonlinearity or nonlinear geometry.

Green strains are defined with reference to an undeformed geometry. Hence, they 
represent a Lagrangian description.

In a small-strain, large rotational analysis, the Green strain corresponds to the 
engineering strain in directions that follow the deformed body. The Green strain is a 
natural choice when formulating a problem in the undeformed state.

The Green strain components, εij, are

 (6-2)

A N A L Y S I S  O F  D E F O R M A T I O N  A N D  T H E  D E F O R M A T I O N  G R A D I E N T

As a start, consider a certain physical particle, initially located at the coordinate X. 
During deformation, this particle follows a path

For simplicity, assume that undeformed and deformed positions are measured in the 
same coordinate system. Using the displacement u, it is then possible to write

When studying how an infinitesimal line element dX is mapped to the corresponding 
deformed line element dx, the deformation gradient,  F, defined by

is used.

The deformation gradient contains the complete information about the local straining 
and rotation of the material. It is a positive definite matrix, as long as material cannot 
be annihilated. The ratio between current and original volume (or mass density) is

εij
1
2
---

ui∂
xj∂

--------
uj∂
xi∂

--------
uk∂
xi∂

---------
uk∂
xj∂

---------⋅+ +⎝ ⎠
⎛ ⎞=

x x X t,( )=

x X u+=

dx x∂
X∂

-------dX F dX= =

dV
dV0
-----------

ρ0
ρ
------ det F( ) J= = =
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As a consequence, a deformation state where J = 1 is said to be incompressible. From 
the deformation gradient, it is possible to define the right Cauchy-Green tensor as

The most commonly used definition of strain is the engineering strain, ε; see 
Equation 6-1.

As can be shown by simple insertion, a finite rigid body rotation will cause nonzero 
values of the engineering strain. This is not in correspondence with the intuitive 
concept of strain, and it is certainly not useful in a constitutive law. There are several 
alternative strain definitions in use that do have the desired properties. The Green 
strain, ε, is defined as

Using the displacements, the Green strain can be also written as shown in Equation 6-
2. 

The deformation gradient and its inverse are available as variables and can be used, for 
instance, to model follower loads; see the model Hyperelastic Seal on page 322 in the 
Structural Mechanics Model Library for an example.

Stress-Strain Relationship

The symmetric stress tensor σ describes stress in a material:

This tensor consists of three normal stresses (σx, σy, σz) and six (or, if symmetry is used, 
three) shear stresses (τxy, τyz, τxz).

For large deformations and hyperelastic material models there are more than one stress 
measure:

• Cauchy stress σ (the components are denoted sx, … in COMSOL Multiphysics) 
defined as force/deformed area in fixed directions not following the body. 
Symmetric tensor.

C FTF=

ε 1
2
--- C I–( ) 1

2
--- FTF I–( )= =

σ
σx τxy τxz

τyx σy τyz

τzx τzy σz

= τxy τyx= τxz τzx= τyz τzy=
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• First Piola-Kirchhoff stress P (the components are denoted Px, … in COMSOL 
Multiphysics). This is an unsymmetric tensor used only for hyperelastic material 
models.

• Second Piola-Kirchhoff stress S (the components are denoted Sx, … in COMSOL 
Multiphysics). This is a symmetric tensor, for small strains same as Cauchy stress 
tensor but in directions following the body.

The stresses relate to each other as 

E L A S T I C  M O D U L I

The elastic moduli are used to describe the relationship between the stress and strain 
in a material. Different elastic moduli are common in different material models, but as 
long as two of them are defined, the others can be computed according to Table 6-1.

L I N E A R  E L A S T I C  M A T E R I A L S

The stress-strain relationship—or the constitutive equation—for linear conditions 
including initial stress and strain, initial pressure (pi), and thermal effects reads:

TABLE 6-1:  EXPRESSIONS FOR THE ELASTIC MODULI.

DESCRIPTION VARIABLE  f(E,ν)   f(K,G)  f(λ,µ)
Young’s modulus  E

Poisson’s ratio  ν

Bulk modulus  K

Shear modulus  G  µ

Lamé constant λ  λ

Lamé constant µ  µ  G

S F 1– P=

σ J 1– PFT J 1– FSFT
= =

9KG
3K G+
------------------- µ3λ 2µ+

λ µ+
--------------------

1
2
--- 1 3G

3K G+
-------------------–⎝ ⎠

⎛ ⎞ λ
2 λ µ+( )
---------------------

E
3 1 2ν–( )
------------------------ λ 2µ

3
-------+

E
2 1 ν+( )
---------------------

Eν
1 ν+( ) 1 2ν–( )

--------------------------------------- K 2G
3

--------–

E
2 1 ν+( )
---------------------

σ Dεel σ0 lpi–+ D ε εth– ε0–( ) σ0 lpi–+= =
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where D is the 6-by-6 elasticity matrix and the stress and the strain are both given in 
column vector form and l is a column vector:

Note: In the following descriptions σ and ε denote either the stress and strain vectors 
or the corresponding tensors depending on the circumstances.

The stress can also be expressed using the pressure p (the negative mean stress), by 
separating the stress in a deviatoric part, σd,  and a mean part, −p:

 (6-3)

where 

Mixed Formulation
Mixed formulations are used for nearly incompressible materials. Such materials are 
difficult to resolve using the displacement variables only. The reason is that in the 

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

= l

1
1
1
0
0
0

=

σ σd lp– Dd ε εth– ε0–( ) σ0 lpi– lp0 lp–+ += =

σd Dd ε εth– ε0–( ) σ0d+=

σ0 lpi– σ0d lp0–=

p0
1
3
--- σ0x σ0y σ0z+ +( )– pi+=

p 1
3
--- σx σy σz+ +( )–=

l

1
1
1
0
0
0

=
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limiting incompressible case, the displacement gradient components become not all 
independent; one of them is determined through the incompressibility condition. To 
take care of this situation, the program treats the pressure p as a new dependent 
variable.

Note: The mixed formulation creates indefinite matrices, which affects the selection 
of iterative solvers. See “Selecting Iterative Solvers” on page 150 for more 
information.

The mixed formulation can be used effectively not only for linear elastic material but 
also for elasto-plastic, hyperelastic, and viscoelastic materials.

In the mixed formulation, the pressure is interpolated using a polynomial of one order 
less than the one used for the displacement variables.

I S O T R O P I C  M A T E R I A L S

The definition of the elasticity matrix D—or the more basic flexibility (or compliance) 
matrix, the inverse of D—is different for isotropic, orthotropic, and anisotropic 
materials. For an isotropic material, the flexibility matrix looks like

where E is the modulus of elasticity or Young’s modulus, and ν is Poisson’s ratio, 
which defines the contraction in the perpendicular direction. Inverting D−1 results in 
the following elasticity matrix:

D 1– 1
E
----

1 ν– ν– 0 0 0
ν– 1 ν– 0 0 0
ν– ν– 1 0 0 0

0 0 0 2 1 ν+( ) 0 0
0 0 0 0 2 1 ν+( ) 0
0 0 0 0 0 2 1 ν+( )

=
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For isotropic materials Equation 6-3 simplifies to

where

 (6-4)

and

D E
1 ν+( ) 1 2ν–( )

---------------------------------------

1 ν– ν ν 0 0 0
ν 1 ν– ν 0 0 0
ν ν 1 ν– 0 0 0

0 0 0 1 2ν–
2

---------------- 0 0

0 0 0 0 1 2ν–
2

---------------- 0

0 0 0 0 0 1 2ν–
2

----------------

=

σ Dd

εx

εy

εz

εxy

εyz

εxz

εx0

εy0

εz0

εxy0

εyz0

εxz0

– εth– σ0 lp0 lp–++=

Dd G

4
3
--- 2

3
---–

2
3
---– 0 0 0

2
3
---–

4
3
--- 2

3
---– 0 0 0

2
3
---–

2
3
---–

4
3
--- 0 0 0

0 0 0 2 0 0
0 0 0 0 2 0
0 0 0 0 0 2

=

p lTK ε εth– ε0–( ) p0+=

K E
3 1 2ν–( )
------------------------=

p0
1
3
--- σ0x σ0y σ0z+ +( )–=
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G is the shear modulus, and K is the bulk modulus.

Mixed Formulation
For the mixed formulation, the equation for the pressure is on the form

If loss factor damping is used with frequency response analysis, the loss information 
appears also in the pressure equation. The equation with loss factor damping for 
isotropic material is

O R T H O T R O P I C  A N D  A N I S O T R O P I C  M A T E R I A L S

For an orthotropic material, the D−1 matrix takes the form

where you supply the values of Ex, Ey, Ez, νxy, νyz, νxz, Gxy, Gyz, and Gxz in designated 
edit fields in the user interface. The software deduces the remaining components—νyx, 
νzx, and νzy—by using the fact that the matrices D and D−1 are symmetric.

p
K
---- lT ε εth– ε0–( )

p0 pi+( )
K

----------------------–+ 0=

p
1 jη+( )K

------------------------- lTε
lT εth ε0+( )

1 jη+( )
------------------------------

p0 pi+( )
1 jη+( )K

-------------------------––+ 0=

D 1–

1
Ex
------

νyx
Ey
--------–

νzx
Ez
--------– 0 0 0

νxy
Ex
--------–

1
Ey
------

νzy
Ez
--------– 0 0 0

νxz

Ex
--------–

νyz

Ey
--------–

1
Ez
------ 0 0 0

0 0 0 1
Gxy
--------- 0 0

0 0 0 0 1
Gyz
--------- 0

0 0 0 0 0 1
Gxz
---------

=
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Note: The definitions of the components νij can vary depending on the application 
field. When specifying the material properties, make sure you use the definitions just 
given. If necessary, transform your material data so that it conforms with the above 
conventions before entering it in the user interface.

Inverting D−1 using only the Ex, Ey, Ez, νxy,νyz, νxz, Gxy, Gyz, and Gxz coefficients 
results in the symmetric D matrix

where the components are as follows:

where

For an anisotropic material, you provide the symmetric D matrix explicitly.

D

D11 D12 D13 0 0 0

D12 D22 D23 0 0 0

D13 D23 D33 0 0 0

0 0 0 D44 0 0

0 0 0 0 D55 0

0 0 0 0 0 D66

=

D11
Ex

2 Ezνyz
2 Ey–( )

Ddenom
----------------------------------------,= D12

ExEy Ezνyzνxz Eyνxy+( )
Ddenom

-----------------------------------------------------------------,–=

D13
ExEyEy νxyνyz νxz+( )

Ddenom
----------------------------------------------------------,–= D22

Ey
2 Ezνxz

2 Ex–( )
Ddenom

----------------------------------------,=

D23
EyEz Eyνxyνxz Exνyz+( )

Ddenom
-----------------------------------------------------------------,–= D33

EyEz Eyνxy
2 Ex–( )

Ddenom
-----------------------------------------------,=

D44 Gxy= ,    D55 Gyz= ,  and D66 Gxz=

Ddenom EyEzνxz
2 ExEy– 2νxyνyzνxzEyEz ExEzνyz

2 Ey
2νxy

2
+ + +=
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Mixed Formulation
For orthotropic and anisotropic materials, the implementation of the mixed 
formulation uses some scaling to get a system of equations that produces symmetric 
matrices. The equations for the stress and the pressure become

where n, Dd, and m are defined as

This produces symmetric matrices.

If loss factor damping is used with frequency response analysis, the loss information is 
included in the pressure equation according to

σ σd mod, np–=

σd mod, σd l n–( )p–=

σd mod, Dd ε εth– ε0–( ) σ0d mod,+=

σ0 σ0d mod, np0–=

p0
1
3
--- σ0x σ0y σ0z+ +( )– pi+=

9p
Dsum
-------------- mT ε εth– ε0–( )

9p0
Dsum
--------------–+ 0=

mi
3di

Dsum
--------------=

ni mi= i 1 … 3, ,=

ni 0.5mi= i 4 … 6, ,=

Dsum Dij

i 1 … 3, ,=

j 1 … 6, ,=

∑=

di D1i D2i D3i+ +=

Ddij Dij
didj

Dsum
--------------–= i 1 … 3, ,= j 1 … 6, ,=

Ddij Dij 0.5
didj

Dsum
--------------–= i 4 … 6, ,= j 1 … 6, ,=
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where η is the loss factor.

E L A S T O - P L A S T I C  M A T E R I A L S

The first material model with a nonlinear behavior is the elasto-plastic material, where 
the stress-strain relationship is

or formulated with the pressure

where εp is the plastic strain vector and:

The variable εp and a vector κ of state parameters describe the state of a plastic 
deformation. To describe the evolution of these variables, use the rate equations 

where v is a vector whose variables form the solution vector (with parameters such as 
displacements and temperature) and λ is the plastic multiplier. The dot stands for 
differentiation with respect to pseudo-time or time. The plastic multiplier is 
determined by the complementarity conditions 

where F is the yield function. The functions F, G, and H often take a simpler form 
when expressed in terms of the generalized stress, Σ,

where σ is the vector of stress components, and χ is the vector of conjugate forces. The 
function f1 is often a linear function (matrix D). For associated plasticity, which is the 
rule,

9p
1 jη+( )Dsum

----------------------------------- mTε
mT εth ε0+( )

1 jη+( )
---------------------------------

9p0
1 jη+( )Dsum

-----------------------------------––+ 0=

σ Dεel σ0+ D ε εp εth–– ε0–( ) σ0 lpi–+= =

σ Dd ε ε– p εth– ε0–( ) σ0 lp0 lp–+ +=

p0
1
3
--- σ0x σ0y σ0z+ +( )–=

ε· p λH εp κ v, ,( ) κ· λG εp κ v, ,( )=,=

F εp κ v, ,( ) 0 λ 0 F εp κ v, ,( )λ,≥,≤ 0=

Σ σ
χ

f1 ε εp v,–( )

f2 εp κ v, ,( )
= =
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For non-associated plasticity, which is uncommon, 

where Q is a plastic potential.

Now consider some special cases where the effective stress function, , is often the 
von Mises stress.

Perfect (or Ideal) Plasticity

 

where Y0 is the yield stress.

Isotropic Hardening

where εpe is the effective plastic strain, and Y is the yield stress. The function f2 is 
often nonlinear.

Kinematic Hardening

where f3 often is a linear function.

In cases with kinematic hardening, the plastic strain is a subset of the state parameters. 
Then you only need the rate equation 

and the complementarity conditions 

You can thus write the generalized stress, Σ, as

H σ χ,( )
σ∂

∂ F σ χ,( ) G σ χ,( )
χ∂

∂ F σ χ,( )–=,=

H σ χ,( )
σ∂

∂ Q σ χ,( ) G σ χ,( ) –=,
χ∂

∂ Q σ χ,( )=

φ

κ empty F, φ σ( ) Y0– H
σ∂

∂F
= = =

κ εpe χ, Y f2 εpe( )= F σ Y,( ), φ σ( ) Y– G
σ∂

∂F
– 1= = = = =

κ εp χ, σshift f3 εp( )= F φ σ σshift–( ) Y0–= G, ,
σshift∂

∂F
–= = =

κ· λG κ v,( )=

F κ v,( ) 0 λ 0 F κ v,( )λ,≥,≤ 0=
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These formulas also hold for cases without kinematic hardening if you enlarge the 
vector of state parameters to include the plastic strain. From now on this discussion 
assumes this definition of κ, leading to the following special cases:

Perfect (or Ideal) Plasticity

Isotropic Hardening

where εpe is the effective plastic strain, and Y is the yield stress. The function f2 is often 
nonlinear.

Kinematic Hardening

where f3 often is a linear function.

Postprocessing
The effective plastic strain is calculated from the equation

The plastic strain can be calculated in the node points like any other variable but this 
may cause problems because evaluating the plastic strain involves solving an equation 
system.

For postprocessing purposes, Gauss-point variables are an alternative to the stresses, 
plastic strains, and effective plastic strain discussed above. Gauss-point variables are 

Σ σ
χ

f κ v,( )= =

κ εp F, φ σ( ) Y0– G,
σ∂

∂F
= = =

κ
εp

εpe

χ, Y f2 εpe( )= F, φ σ( ) Y,– G σ∂
∂F

Y∂
∂F

–

= = = =

κ εp χ, σshift f3 εp( )= F φ σ σshift–( ) Y0–= G, ,
σ∂

∂F
= = =

εpe ε· pe td

0

t

∫=

ε· pe
2

3
------- ε· px ε· py–( )

2
ε· py ε· pz–( )

2
ε· px ε· pz–( )

2
6ε· pxy

2
6ε· pyz

2
6ε· pxz

2
+ + + + +=
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normally better because they are the values that were calculated during the solution 
process. The Gauss-point variables have the suffix Gp appended to their names, for 
example, sxGp instead of sx.

The elasto-plastic material model requires that you use a solver that can follow the load 
history; that is, you need to use the parametric or transient solver. You cannot use the 
static solver together with an elasto-plastic material model.

H Y P E R E L A S T I C  M A T E R I A L S

A hyperelastic material is defined by its strain energy function Ws, which is a function 
of the strain state. In a total Lagrangian formulation it is convenient to use the right 
Cauchy-Green tensor C = FTF for the representation of the strain. Thus,

For an isotropic material, Ws is a function of the strain invariants only. Hence, one can 
write

 (6-5)

where

with J ≡ det ( F  ). 

The stress in a hyperelastic material is computed using derivatives of the strain energy 
function Ws; the function is often referred to as the elastic potential.

Instead of the conjugate pair formed by the second Piola-Kirchhoff stress and the 
Green-Lagrange strain, one cane use the first Piola-Kirchhoff stress P and its conjugate 
strain, the displacement gradient . The first Piola-Kirchhoff stresses are calculated 
as

The variation of the energy can then be expressed as

Ws Ws C( )=

Ws Ws I1 I2 I3,,( )=

I1 trace C( ) C11 C22 C33+ += =

I2
1
2
--- I1

2 trace C2( )–( )=

I3 det C( ) J2
= =

u∇

P
∇u∂

∂Ws=
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COMSOL Multiphysics calculates the first Piola-Kirchhoff stress P by symbolic 
differentiation of the strain energy expression. The second Piola-Kirchhoff stress S, 
and the Cauchy stress σ can then be calculated from the first Piola-Kirchhoff stress as

and σ = J−1PFT.

Due to the incompressibility, it is often a good idea to work with modified invariants, 
where the two first invariants have no dependency on the volume change. Such 
invariants can be defined as

Mixed Formulation
Materials that are nearly incompressible are hard to solve using only the displacement 
variables. The remedy is to introduce the pressure as an extra dependent variable. The 
hyperelastic material model supports the normal displacement-based formulation as 
well as the mixed formulation, which includes the pressure.

In the fully incompressible limit,

which indicates no change of the volume. Equation 6-5 gives then

 (6-6)

To separate the volumetric effects, introduce the following scaling:

Then

For nearly incompressible materials, the energy is separated as

xj∂
∂ui

⎝ ⎠
⎜ ⎟
⎛ ⎞

test

Pij

i j,
∑

S F 1– P=

I1 I1J

2
3
---–

,= I2 I2J

4
3
---–

=

I3 C( ) J2 1= =

Ws Ws I1 I2,( )=

C J

2
3
---–

C=

I1 J

2
3
---–

I1,= I2 J

4
3
---–

I2,= I 3 1=
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where U( J ) presents the volumetric component, and  has the same 
functional dependence as in the fully incompressible case given by Equation 6-6. The 
simplest form of the volumetric energy function is

 (6-7)

where κ is the bulk modulus.

The pressure is introduced as

When the formula Equation 6-7 is used, it becomes

 (6-8)

on the weak form

Thermal Expansion
If thermal expansion is present, a stress-free volume change occurs. In this case, J in 
the constitutive relations above must be replaced by the elastic part of the total volume 
change, that is

Material Models
The following hyperelastic material models are directly supported:

Neo-Hookean   

In the mixed formulation, the energy function is written in terms of pressure using 
Equation 6-7 and Equation 6-8:

Ws Ws I1 I2,( ) U J( )+=

Ws I1 I2,( )

U J( ) 1
2
---κ J 1–( )2

=

p
J∂

∂U
–=

p κ J 1–( )–=

p̂ 1–
p
κ
--- J+ +⎝ ⎠

⎛ ⎞

Jel
J

Jth
-------- J

1 εth+( )3
-------------------------= =

Ws
1
2
---µ I1 3–( ) 1

2
---κ Jel 1–( )2

+=
T H E O R Y  B A C K G R O U N D  |  187



188 |  C H A P T E
Mooney-Rivlin   

In the mixed formulation,

Murnaghan   

The Murnaghan potential appears in nonlinear acoustoelasticity. It is most 
conveniently expressed in terms of the main invariants of the nonlinear Green strain 
tensor:

Thus

where l, m, and n are the Murnaghan third-order elastic constants, which have been 
found experimentally for many commonly encountered materials such as steel and 
aluminum, among others. The Lamé elastic constants are

where K denotes the bulk modulus.

The invariants of ε and C can be expressed in terms of each other by using the relations

Ws
1
2
---µ I1 3–( ) p Jel 1–( )–

p2

2κ
------–=

Ws C10 I1 3–( ) C01 I2 3–( ) 1
2
---κ Jel 1–( )2

+ +=

Ws C10 I1 3–( ) C01 I2 3–( ) p Jel 1–( ) p2

2κ
------––+=

ε 1
2
--- C I–( ) 1

2
--- FTF I–( )= =

Ws
1
2
--- λ 2µ+( ) I1

ε( )
2

2µI2
ε

–
1
3
--- l 2m+( ) I1( ε )

3
2mI1

εI2
ε

– nI3
ε

+ +=

µ E
2 1 ν+( )
---------------------=

λ Eν
1 ν+( ) 1 2ν–( )

--------------------------------------- K 2
3
---µ–= =
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and

In the mixed formulation,

and finally

Note: You can use both the Neo-Hookean and the Mooney-Rivlin material models 
for modeling nearly incompressible hyperelastic materials such as rubber. The 
Murnaghan material model is more suitable for compressible materials and 
acoustoelastic applications involving wave propagation is solids and structures.

V I S C O E L A S T I C  M A T E R I A L S

Also for a viscoelastic material, the total stress is presented as:

where the pressure (volumetric stress) is given by

I1
ε 1

2
--- I1 3–( )=

I2
ε 1

4
--- I2 2I– 1 3+( )=

I3
ε 1

8
--- I3 I– 2 I1 1–+( )=

I3 1 2I1
ε 4I2

ε
+ 8I3

ε
++=

I1
ε 1

2
--- I1 3–( )=

I2
ε 1

4
--- I2 2 I1– 3+( )=

I3
ε 1

8
--- I( 3 I2– I1 1–+ )=

Ws
1
2
--- λ 2µ+( ) I1

ε
( )

2
2µI2

ε
–

1
3
--- l 2m+( ) I1

ε
( )

3
+=

2mI1
ε
I2

ε
– nI3

ε
p Jel 1–( ) p2

2K
--------––+

σ σd mp–=
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 (6-9)

and K is the bulk modulus.

To simplify the description of the material, the strain is decomposed as

The general linear dependence of the stress deviator on the strain history can be 
expressed by the hereditary integral:

where the function Γ(t) is called the relaxation modulus function that can be found 
by measuring the stress evolution in time when the material is held at a constant strain. 

The relaxation function is often approximated in a Prony series:

A physical interpretation of this approach, which is often called the generalized 
Maxwell model, is shown in Figure 6-1.

Figure 6-1: Generalized Maxwell model.

Hence, τi are the relaxation time constants of the spring-dashpot pairs in the same 
branch, and Gi represent the stiffness of the spring in branch i.

p p0 m–
TK ε ε0 εth––( )=

ε 1
3
---trace ε( )I e+=

σd Γ t t'–( ) e∂
t'∂

------ t'd

0

t

∫=

Γ t( ) 2G Gi
t
τi
----–⎝ ⎠

⎛ ⎞exp

i 1=

N

∑+=

σ

σ

e

η 1

τ1

η 2

τ2

..... .....
η i

τi

G1 G2 Gi
G
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Following the above presented analogy, the abstract variables qi are introduced to 
represent the extension of the corresponding springs. Thus,

 (6-10)

 (6-11)

Note that each of the variables qi is a vector that has as many components as the 
number of strain components of the problem class.

The total stress can be expressed on the same form as the one used for the isotropic 
material if the viscoelastic stress, sq, is added. Dd and m are also for viscoelastic 
materials given by Equation 6-4.

The viscoelastic strain variables qi are treated as additional degrees of freedom. The 
shape functions must be of one order less than those used for the displacements 
because these variables are added to the strains and stresses computed from 
displacement derivatives. The viscoelastic strain variables do not require continuity, so 
it is possible to use discontinuous shape functions.

For an exmple model using a viscoelastic material model, see “Viscoelastic Damper” 
on page 222 of the Structural Mechanics Module Model Library.

Mixed Formulation
When the strains grow large, the near incompressibility can cause numerical problems 
if only displacements are used in the interpolating functions. In such cases, use a mixed 
formulation; a mixed formulation treats the pressure as an independent variable, while 
Equation 6-9 is only fulfilled in a weak sense.

The interpolation functions used for the variables q and the pressure (if used) must be 
one order lower than what is used for the displacements because these variables are 
added to the strains and stresses computed from displacement derivatives.

σd 2Ge 2Giqi

i 1=

N

∑+=

q· i
1
τi
----qi+ e·=

σ Dd ε ε0–( ) σ0 mp0 mp– sqx++ +=

sqx 2Giqi

i 1=

N

∑=
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Temperature Effects
For many materials, the viscoelastic properties have a strong dependence on the 
temperature. A common assumption is that the material is thermorheologically simple 
(TRS). In a material of this class, a change in the temperature can be transformed 
directly into a change in the time scale. The reduced time is defined as

where aT(T) is a shift function. The implication is that the problem can be solved using 
the original material data, provided that the time is transformed into the reduced time. 
One commonly used shift function is defined by the WLF (Williams-Landel-Ferry) 
equation:

where a base-10 logarithm is assumed.

Note that aT(T0) = 1, so that T0 is the temperature at which the original material data 
is given. Usually T0 is taken as the glass transition temperature of the material. If the 
temperature drops below T0 − C2, the WLF equation is no longer valid. The constants 
C1 and C2 are material dependent, but with T0 as the glass temperature the values 
C1 = 17.44 and C2 = 51.6 K are reasonable approximations for many polymers. 

You can think of the shift function as a multiplier to the viscosity in the dashpot in the 
Maxwell model. Equation 6-11 for a TRS material is modified to

Frequency Domain Analysis and Damping
Frequency decomposition is performed as

Equation 6-10 and Equation 6-11then give

tr
t'd

aT T t'( )( )
------------------------

0

t

∫=

aT( )log
C– 1 T T0–( )

C2 T T0–( )+
-----------------------------------=

q· m
1

aT T( )τm
-----------------------qm+ e·=

σd Real σ̂d jωt( )exp( )=

e Real e jωt( )exp( )=

σ̂d 2 G' jG''+( )ê=
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where

are often referred to as the dynamic storage modulus and the dynamic loss modulus, 
respectively.

The internal work of viscous forces averaged over the time period 2π/ω can be 
computed as

Note: When you have selected the viscoelastic material model, no additional damping 
is available because the viscoelasticity itself provides all the damping necessary. The 
viscoelastic material model does not support large deformations, and it is therefore 
not possible to use follower loads.

Thermal Strain

Thermal strain depends on the present temperature, T, the stress-free reference 
temperature, Tref, and the thermal expansion vector, αvec

Depending on the material model, you set up αvec up differently: For isotropic, elasto-
plastic, hyperelastic, and viscoelastic materials

G' G Gm
ωτm( )2

1 ωτm( )2
+

----------------------------

m 1=

N

∑+=

G'' Gm
ωτm

1 ωτm( )2
+

----------------------------

m 1=

N

∑=

Qd ωG'' ê Conj ê( )⋅( )=

εth

εx

εy

εz

γxy

γyz

γxz th

αvec T Tref–( )= =
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for an orthotropic material

and for an anisotropic material you enter the full thermal expansion vector as input:

E N T R O PY

For a linear thermoelastic solid, the entropy per unit volume is:

where T0 is the reference temperature, the volumetric heat capacity ρCP is assumed 
independent of the temperature, and

 (6-12)

where σ is the stress vector, and αvec is the thermal expansion vector. For an isotropic 
material, Equation 6-12 simplifies into

αvec

α
α
α
0
0
0

=

αvec

αx

αy

αz

0
0
0

=

αvec

αx

αy

αz

2αxy

2αyz

2αxz

=

S ρCP T T0⁄( )log Selast+=

Selast αvec σ⋅=
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  (6-13)

The entropy is a function of state and thus independent of the strain rate. The stress 
vector σ in the definitions Equation 6-12 and Equation 6-13 corresponds to no 
damping when used in a frequency response analysis, because the damping represents 
the rate-dependent (viscoelastic) effects in the material.

If you model the damping in the structural analysis via the loss factor, use the following 
definition for the elastic part of the entropy:

where η is the loss factor, and j is the imaginary unit. For more details, see “Loss Factor 
Damping” on page 142, and the example “Thermal Loading of a Viscoelastic Tube” 
on page 569 of the Structural Mechanics Module Model Library.

Initial Stress and Strain

Initial stress refers to the stress before the system applies any loads, displacements, or 
initial strains, written as

The initial strain is the one before the system has applied any loads, displacements, or 
initial stresses

Selast α σx σy σz+ +( )=

Selast αvec σ jηDε–( )⋅=

σ0

σx0

σy0

σz0

τxy0

τyz0

τxz0

=

ε0

εx0

εy0

εz0

2εxy0

2εyz0

2εxz0

=
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Initial stresses and strains are given in the material coordinate system.

Follower Loads

Follower loads are loads that change direction as the body deforms. They are only 
meaningful if large deformations are studied, implying that they cannot be used with 
the viscoelastic material model. The most common type of follower load is a pressure 
acting on a surface. In this case the force changes size due to the stretching of the 
surface and direction due to the change in normal direction. The following section 
only considers this type of follower loads.

T H E O R Y

The continuum application modes are formulated in the reference frame (the default). 
All forces must be specified as force/undeformed area in a fixed coordinate system (not 
in a system following the body). This makes it difficult to model a pressure acting on 
a surface because the force changes direction due to the deformation. There is also an 
area effect due to surface stretching, so a relation between the deformed area, da, and 
the undeformed area, dA, is needed. To handle this, the software uses a deformed 
frame that computes both the deformed area and the deformed normal direction, n. 
The force is calculated as

where P is the follower pressure.

Plane Stress
In a plane stress condition the out-of-plane deformation causes the thickness to 
change, and this area effect is included explicitly. The equation transforms to

Axial Symmetry
To account for the deformation, the extra r in the circumferential integration of the 
force expressions is transformed to r + uaxi, where uaxi denotes the radial 
displacement.

FdA Pnda Pn da
dA
--------dA–=–=

FdA Pn da
dA
--------dA 1

z∂
∂w

+⎝ ⎠
⎛ ⎞–=
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Implementation

The COMSOL Multiphysics implementation of these equations in the application 
modes for structural analysis is based on the principle of virtual work expressed in 
global or local stress and strain components. The principle of virtual work states that 
the sum of virtual work from internal strains is equal to work from external loads.

The total stored energy, W, for a linear material from external and internal strains and 
loads equals:

The principle of virtual work states that 

,

and in order to derive the expression for the variation of W you differentiate 
symbolically, reaching the expression

The principle of virtual work for the axial symmetry case reads

To avoid division by r, the true radial displacement, u is replaced in the above equation 
by a new dependent variable

W 1
2
--- ε– xσx εy– σy εz– σz 2εxy– τxy 2εyzτyz– 2εxz– τxz( ) utFV+⎝ ⎠
⎛ ⎞ vd

V
∫=

utFS s utFL l U
p
∑

t
FP .+d

L
∫+d

S
∫+

δW 0=

δW ε– xtestσx εytestσy– εztestσz– 2εxytestτxy–(
V
∫=

2εyztestτyz– 2εxztestτxz– utest
t FV+ )dv

utest
t FS sd

S
∫ utest

t FL ld
L
∫ Utest

t Fp

p
∑+ + +

Wδ r ε– rtestσr εϕtestσϕ εztestσz––(
A
∫=

2εrztestτrz– r uor⋅ testFr wtestFz )dA+ +

r r uor⋅ testFr wtestFz+( ) sd
S
∫

r uor⋅ testFr wtestFz +( )
2π

-------------------------------------------------------------------+ +
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.

If you define the material in a local user-defined coordinate system, the variational 
equation in COMSOL Multiphysics is expressed in local instead of global stresses and 
strains.

To create the strain tensor in local coordinates, transform the global strain tensor

where T is the local-to-global coordinate-system transformation matrix.

Then calculate the local stress tensor from the local strain, and the global stress tensor 
by transforming the local stress tensor

S E T T I N G  U P  E Q U A T I O N S  F O R  D I F F E R E N T  A N A L Y S E S

All continuum application modes support static, eigenfrequency, damped 
eigenfrequency, transient, frequency-response, parametric, and quasi-static transient 
analyses as well as linear buckling and viscoelastic transient initialization. Each type 
might solve a different equation or employ a different solver. You control this choice 
with the Analysis type property that appear in the Application Mode Properties dialog 
box for the corresponding application mode and in the Solver Parameters dialog box.

Static and Parametric Analysis
These analyses use the same equation, the difference being what solver that is used. In 
the following, static analysis is used as short for all the above analyses because they use 
the same equations.

COMSOL Multiphysics’ implementation is based on the stress and strain variables. 
The normal and shear strain variables depend on the displacement derivatives 
(described in general 3D terms in the section “Theory Background” on page 172); the 
normal and shear stress variables depend on the strains (described in general 3D terms 
in the section“Stress-Strain Relationship” on page 174). 

Using the shear and stress variables, you can express the principle of virtual work as

uor u
r
---=

εl TTεgT=

σg TσlT
T

=
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If you describe the material in a local coordinate system, δW is expressed in local 
stresses and strains. 

Quasi-Static Transient Analysis
The quasi-static transient analysis uses the same equation as the static analysis (but a 
different solver) for all material models but the viscoelastic. For a viscoelastic material 
the viscoelasticity is retained, but as for the other material models the inertia effects are 
neglected. 

Viscoelastic Transient Initialization
The equations using the viscoelastic material model corresponds to a static analysis, 
with added viscoelasticity.

Transient Analysis
For transient problems consider Newton’s second law

.

It defines the equation of motion with no damping. To model viscous damping, 
COMSOL Multiphysics uses Rayleigh damping, where you specify two damping 
coefficients. As an example, consider a system with a single degree of freedom. The 
equation of motion for such a system with viscous damping is

.

In the Rayleigh damping model, you express the damping parameter ξ in terms of the 
mass m and the stiffness k as

δW ε– xtestσx εytestσy– εztestσz– 2εxytestτxy–(
V
∫=

2εyztestτyz– 2εxztestτxz– utest
t FV+ )dv

utest
t FS sd

S
∫ utest

t FL ld
L
∫ Utest

t Fp

p
∑+ + +

ρ∂2u

∂t2
---------- ∇– c u∇⋅ F=

md2u

dt2
---------- ξdu

dt
------- ku+ + f t( )=

ξ αdMm βdKk+=
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The Rayleigh damping proportional to mass and stiffness is added to the static weak 
term. The default value for both αdM and βdK is zero; that is, the default settings add 
no damping.

Frequency Response Analysis
You specify harmonic loads using two components:

• The amplitude value, Fx

• The phase, FxPh

To derive the equations for the steady-state response from harmonic excitation loads

assume a harmonic response with the same angular frequency as the excitation load

You can also describe this relationship using complex notation

where

Fxfreq Fx f( ) ωt FxPh f( ) π
180
----------+⎝ ⎠

⎛ ⎞cos=⎝ ⎠
⎛ ⎞

Ffreq

Fxfreq

Fyfreq

Fzfreq

=

u uamp ωt φu+( )cos=

u
u
v
w

=

u Re uampe
jφuejωt( ) Re ũe

jωt
( )  where ũ uampe

jφu= = =

u Re ũe
jωt

( )=

Fxfreq Re Fx ω( )e
jFxPh f( ) π

180
----------

ejωt

⎝ ⎠
⎜ ⎟
⎛ ⎞

Re Fx
˜ ejωt( )= =

Fx
˜ Fx f( )e

jFxPh f( ) π
180
----------

=
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Eigenfrequency Analysis
The eigenfrequency equations are derived by assuming a harmonic displacement field, 
similar as for the frequency response formulation. The difference is that this analysis 
type uses a new variable jω explicitly expressed in the eigenvalue.

The eigenfrequency f is then derived from jω as

Damped Eigenfrequency Analysis
This analysis type is similar to the eigenfrequency analysis except that it adds viscous 
damping terms to the equation. In addition to the eigenfrequency you can also look 
at the quality factor, Q, and decay factor, δ, for the model:

Contact Modeling—Theory Background

COMSOL Multiphysics solves contact problems using an augmented Lagrangian 
method. This means that the software solves the system in a segregated way. 
Augmentation components are introduced for the contact pressure Tn and the 
components Tti of the friction traction vector Tt. An additional iteration level is added 
where the usual displacement variables are solved separately from the contact pressure 
and traction variables. The algorithm repeats this procedure until it fulfills a 
convergence criterion.

In the following equations F is the deformation gradient matrix. When looking at 
expressions evaluated on the slave boundaries, the expression map(E) denotes the 
value of the expression E evaluated at a corresponding master point, and g is the gap 
distance between the slave and master boundary. 

F
˜

Fx
˜

Fy
˜

Fz
˜

=

jω λ–=

f Im jω( )
2π

-------------------=

Q Im λ( )
2Re λ( )
-------------------=

δ Re λ( )=
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Both the contact map operator map(E) and the gap distance variable are defined by 
the contact element elcontact (see the documentation of elcontact on page 54 of 
the COMSOL Multiphysics Reference Guide for details). For each slave point where 
the operator or gap is evaluated, a corresponding master point is sought by searching 
in the direction normal to the slave boundary.

Note that before the boundaries come in contact, the master point found is not 
necessarily the point on the master boundary closest to the slave point. However, as 
the boundaries approach one another, the master point converges to the closest point 
as the gap distance goes to zero.

Using the special gap distance variable, the penalized contact pressure Tnp is defined 
on the slave boundary as

 (6-14)

where g is the gap distance between the slave and master boundary, and pn is the user-
defined normal penalty factor.

The penalized friction traction Ttp is defined on the slave boundary as:

 (6-15)

where Tttrial is defined as

 (6-16)

and

Master

Slave

x

m(x)

g

Tnp

Tn png– if g 0≤

Tne

png
Tn

---------–

otherwise⎩
⎪
⎨
⎪
⎧

=

Ttp min
Ttcrit
Tttrial
-------------------- 1,⎝ ⎠
⎛ ⎞Tttrial=

Tttrial Tt pt– map F( ) xm xm
old–( )=
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 (6-17)

where x are the space coordinates. 

In Equation 6-16, pt is the user-defined friction traction penalty factor, and xm
old is 

the value of xm in the last time step, and 

 (6-18)

is the vector of slip since the last time step (approximated using a backward Euler step). 

Ttcrit is defined as

 (6-19)

In Equation 6-19 µ is the friction coefficient, cohe is the user-defined cohesion sliding 
resistance, and Ttmax is the user-defined maximum friction traction.

In the following equation δ is the variation (represented by the test operator in 
COMSOL Multiphysics). The contact interaction gives the following contribution to 
the weak equation on the slave boundary:

 (6-20)

where wcn and wct are contact help variables defined as:

 (6-21)

 (6-22)

where i is the augmented solver iteration number and friction is a Boolean variable 
stating if the parts are in contact.

F R I C T I O N

The friction model is either no friction or Coulomb friction.

The friction coefficient µ is defined as

 (6-23)

xm map x( )=

map F( ) xm xm
old–( )

Ttcrit min µTnp cohe+ Ttmax,( )=

Tnpδg Ttp m F( )δxm⋅+( ) A wcnδTn wct δTt⋅+( ) Ad
slave
∫+d

slave
∫

wcn Tnp i, Tn i 1+,–=

wct friction Ttp n Ttp⋅( )n–( )( )i Tt i 1+,–=

µd µs µd–( )e dcfric vs–   if dynamic friction+

µs                    otherwise
⎩
⎪
⎨
⎪
⎧
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where µs is the static coefficient of friction and µd is the dynamic friction coefficient. 
vs is the slip velocity, and dcfric is a decay coefficient.
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a model using the continuum application modes. 
It reviews the following subsections:

• Application mode properties

• Scalar variables

• Material

• Constraints

• Loads

• Thermal coupling

• Damping

• Initial stresses and strains

• Perfectly matched layers (PMLs)

• Contact
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Properties

To set or examine application mode properties, go to the Physics>Properties menu to 
open the Application Mode Properties dialog box. Here you control various global 
settings for the model:

Application Mode Properties dialog box for the structural mechanics application modes.

•  Default element type: The selected finite element type that makes up the discretized 
finite element model is the default on all new subdomains, and the choice does not 
affect subdomains already created. Available elements are:

-  Lagrange - Linear

-  Lagrange - Quadratic

-  Lagrange - Cubic

-  Lagrange - Quartic

-  Lagrange - Quintic

-  Lagrange - U2P1

-  Lagrange - U3P2

-  Lagrange - U4P3

-  Lagrange - U5P4

•  Analysis type: This drop-down list shows the various analyses you can perform; the 
default is Static. Your choice affects both the equations and which solver COMSOL 
Multiphysics uses when the Auto select solver option in the Solver Parameters dialog 
box is active.

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Static elasto-plastic Parametric
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•  Large deformation: This list controls whether or not the model should include large 
deformations, which only the Principle of virtual work supports (see next item). The 
default is Off.

•  Specify eigenvalues using: This list controls how to work with eigenmode analyses. 
Here you should specify Eigenvalue or Eigenfrequency for eigenfrequency and 
damped eigenfrequency analysis and Eigenvalue or Critical load factor for linear 
buckling.

•  Create frame: This list controls whether or not to create a deformed frame. The 
default is Off. A deformed frame is needed in contact modeling and to define 
follower forces but can also be used in a multiphysics context to define some other 
physics on.

•  Weak constraints: Controls whether or not weak constraints are active. When weak 
constraints are enabled, all constraints are weak by default, but it is possible to 
change this setting for individual domains.

•  Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 351 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are up to six different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Initial condition for the time in the previous time step, t_old_ini, which is 
applicable only for contact modeling using dynamic friction.

Eigenfrequency Eigenfrequency/Eigenvalue

Damped Eigenfrequency Eigenfrequency/Eigenvalue

Transient Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

Linear buckling Eigenvalue

Viscoelastic initialization Stationary

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
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• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency.

• Reference point coordinates, used for applied and reaction moment computations.

The Application Scalar Variables dialog box in a frequency response analysis.

When you select a frequency response analysis, the parametric solver becomes the 
default solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case, choose Solve>Solver Parameters, and in the 
dialog box that appears go to the General page. In the Parameter area, enter 
freq_smsld in the Parameter names edit field. Values that you enter in the Parameter 

values edit field override the excitation frequency you might have entered in the 
Application Scalar Variables dialog box.

To access the excitation frequency, f, use the variable freq, and to access the angular 
excitation frequency, ω, use omega.

Specify the coordinates of the point around which you want both your reaction and 
applied moments to be calculated in the refpnt edit fields.
R  6 :  C O N T I N U U M  A P P L I C A T I O N  M O D E S



Material Properties

You define material properties on the Material page in the Subdomain Settings dialog 
box. This page has two lists: Material model and Coordinate system. Now consider the 
options available for each of these lists:

•  Material model: When you select the type of material, a set of appropriate material 
properties appear in the dialog box.

-  Isotropic: This material has the same properties in all directions.

Material properties for an isotropic material.

-  Orthotropic: This material has different material properties in different directions, 
and its stiffness depends on the properties Ei, νij, and Gij (see “Stress-Strain 
Relationship” on page 174 for details). In addition, thermal expansion depends 
on the parameter αi (see “Thermal Strain” on page 193 for details).
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Material properties for an orthotropic material.

-  Anisotropic: This material has different material properties in different directions, 
and the stiffness comes from the symmetric elasticity matrix, D (see “Stress-
Strain Relationship” on page 174 for details). Thermal expansion depends on the 
thermal expansion vector, αvec (see “Thermal Strain” on page 193 for details).
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Material properties for an anisotropic material.

The Elasticity Matrix dialog box for entering the components of the D matrix for an 
anisotropic material.

-  Elasto-plastic: A nonlinear material with possible hardening (see “Elasto-plastic 
Materials” on page 182 for details).
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Material properties for an elasto-plastic material.

The Elasto-Plastic Material Settings dialog box for specification of elasto-plastic material 
data.

-  Hyperelastic: A hyperelastic material based on a strain energy density function, 
often used to model rubberlike materials, but also used in acoustoelasticity (see 
the section “Hyperelastic Materials” on page 185 for details).
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Material properties for a hyperelastic material.

-  Viscoelastic: For viscoelastic materials, the application modes use the generalized 
Maxwell model. You can describe the material as consisting of branches with a 
spring and a dashpot parallel to a linear elastic material. For each branch you enter 
the shear modulus and the relaxation time into a table (see “Viscoelastic 
Materials” on page 189 for details).

Material properties for a viscoelastic material.
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•  Coordinate system: In this second list on the Material page you select the coordinate 
system on which the material properties are defined. Use it for orthotropic and 
anisotropic materials that are defined in another coordinate system other than the 
global system or if you need stresses and strains in a local coordinate system for 
postprocessing. The Coordinate system list is disabled if no user-defined coordinate 
systems are available. To open the Coordinate System Settings dialog box, go to the 
Options menu and choose Coordinate Systems.

•  Use mixed U-P formulation (nearly incompressible material): Controls whether to use 
a mixed formulation adding the negative mean pressure as a dependent variable to 
solve for. You can also specify a mixed formulation from the Predefined element list 
on the Element page by selecting an element type that includes the pressure. Nearly 
incompressible materials means a Poisson’s ratio close to 0.5; see “Mixed 
Formulation” on page 181 for details.

TABLE 6-2:  MATERIAL PROPERTIES FOR VARIOUS MATERIAL MODELS

PARAMETER VARIABLE DESCRIPTION MATERIAL MO

 E E Young's modulus Isotropic/ 
elasto-plast

 ν nu Poisson's ratio Isotropic/ 
elasto-plast

 ρ rho Density All

 α alpha Thermal-expansion coefficient Isotropic

  th thickness The thickness of the geometry All 

 Ei Ei Young's modulus in the xi direction Orthotropi

 νij nuij Poisson's ratio for the xixj-plane Orthotropi

 Gij Gij Shear modulus for the xixj-plane Orthotropi

 αi alphai Thermal-expansion coefficient in the 
xi direction

Orthotropi

 D Elasticity matrix for the anisotropic case Anisotropic

 αvec Thermal-expansion vector for the 
anisotropic case

Anisotropic

 σys Sys Yield stress level Elasto-plast

 σyfunc Syfunc Yield function Elasto-plast

 σyhard Syhard Hardening function for isotropic hardening Elasto-plast

 ETiso ETiso Isotropic-tangent modulus Elasto-plast

 ETkin ETkin Kinematic-tangent modulus Elasto-plast

 C10 C10 Mooney-Rivlin material parameter Hyperelasti
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The index i in the parameters Ei and αi in Table 6-2 refers to the space coordinates xi 
and represents the following names for the different application modes:

Example: Ei for axisymmetry stress-strain means Er, , and Ez.

The parameter νij in Table 6-2 refers to the space coordinates xixj and is defined for 
the following combinations of i and j for the different application modes:

and the parameter Gij is defined for these combinations:

 C01 C01 Mooney-Rivlin material parameter Hyperelasti

 µ mu Initial shear modulus Hyperelasti

 κ kappa Initial bulk modulus Hyperelasti

 l lMurn Murnaghan constant l Hyperelasti

 m mMurn Murnaghan constant m Hyperelasti

 n nMurn Murnaghan constant n Hyperelasti

 λ lambLame Lamé constant λ Hyperelasti

 µ muLame Lamé constant µ Hyperelasti

 K K Bulk modulus Viscoelastic

 G G Shear modulus Viscoelastic

 Gm Gm Shear modulus, branch m Viscoelastic

τm taum Relaxation time, branch m Viscoelastic

TABLE 6-2:  MATERIAL PROPERTIES FOR VARIOUS MATERIAL MODELS

PARAMETER VARIABLE DESCRIPTION MATERIAL MO

APPLICATION MODE  x1  x2  x3

Plane Stress and Plane Strain  x  y  z

Solid, Stress-Strain  x  y  z

Axial Symmetry, Stress-Strain  r  z

APPLICATION MODE  x1x2  x2x3  x1x3

Plane Stress and Plane Strain  xy  yz  xz

Solid, Stress-Strain  xy  yz  xz

Axial Symmetry, Stress-Strain  r z  rz

APPLICATION MODE  x1x2  x2x3  x1x3

Plane Stress and Plane Strain  xy

ϕ

Eϕ

ϕ ϕ
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Note: You can change the default names for the space coordinates in the same way as 
you can the names of the dependent variables.

Now examine the various material properties in Table 6-2.

Young’s modulus   It defines a material’s modulus of elasticity, E. For an isotropic 
material it is the spring stiffness in Hooke’s law, which in 1D form is

where σ is the stress and ε is the strain. An orthotropic material uses one value of 
Young’s modulus for each direction, Ei as defined in the section “Stress-Strain 
Relationship” on page 174.

Poisson’s ratio   Denoted by ν, it defines the normal strain in the perpendicular 
direction, generated from a normal strain in the other direction and follows the 
equation

.

An orthotropic material defines three values of νij.

Note: νij is defined differently depending on the application field, so review “Stress-
Strain Relationship” on page 174 for the definition within COMSOL Multiphysics. It 
is easy to transform among definitions, but you must check which one your material 
uses.

Shear modulus orthotropic material   Denoted by Gij, it defines the relationship 
between engineering shear strain and shear stress. It is applicable only to an 
orthotropic material and follows the equation

Solid, Stress-Strain  xy  yz  xz

Axial Symmetry, Stress-Strain  rz

APPLICATION MODE  x1x2  x2x3  x1x3

σ Eε=

ε⊥ υεl l–=
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Density   This entry specifies ρ, the material’s density. 

Thermal expansion coefficient    It defines how much a material expands due to an 
increase in temperature following the equation

where εth is the thermal strain, and α is the thermal expansion coefficient. With it you 
model thermal strain for an isotropic material. For an orthotropic material, three values 
of αi are defined for the three perpendicular directions.

Thickness (th)   This property defines the out-of-plane thickness of the geometry for 
the Plane Stress and Plane Strain application modes.

Elasticity matrix   It defines the elasticity matrix, D, for anisotropic materials (see 
“Linear Elastic Materials” on page 175 for details). For the Plane Stress and Plane 
Strain application modes D is defined as a 4-by-4 matrix because the out-of-plane shear 
stress and shear strain components are zero.

Thermal expansion vector   It defines the thermal expansion vector, αvec, for 
anisotropic materials (see “Thermal Strain” on page 193 for details).

Yield stress level (σys)   This parameter gives the stress level where plastic deformation 
starts. In the theory section this parameter is named Y0.

Yield function (σfunc)   This function detects if plasticity has occurred. In the theory 
section this parameter is named . 

Isotropic tangent modulus   This parameter is the tangent modulus used for isotropic 
hardening. This parameter together with σys defines the f2 function from the theory 
section as

εij
τij
Gij
--------=

εth α T Tref–( )=

φ

f2 εpe( ) σys
ETiso

1
ETiso

E
--------------–

------------------------εpe+=
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Kinematic tangent modulus   This parameter is the tangent modulus used for kinematic 
hardening. This parameter is used to calculate the σshift parameter from the theory 
section as

Hardening function (σyhard)   This hardening function applies to isotropic hardening. 
This parameter together with σys defines the f2 function from the theory section as 

This definition implies that you have to subtract the yields stress level (σys) when 
defining your hardening function.

Mooney-Rivlin material parameters   Hyperelastic material model parameters.

Initial shear modulus   Used for Neo-Hookean hyperelastic material model.

Initial bulk modulus   Used for Neo-Hookean and Mooney-Rivlin hyperelastic material 
models.

Murnaghan constants   Third-order elastic constants used in the Murnaghan 
hyperelastic material model.

Lamé constants   Second-order elastic constants related to Young’s modulus and 
Poisson’s ratio. Used in the Murnaghan hyperelastic material model.

Shear modulus   The ratio of shear stress to shear strain. Used in the viscoelastic 
material model.

Bulk modulus   The bulk modulus determines the change in volume of a solid as the 
pressure on it is changed. Used in the viscoelastic material model.

Relaxation time   Time constant related to the stress evolution in time of a viscoelastic 
branch when the material is held at constant strain.

σshift
ETkin

1
ETkin

E
---------------–

------------------------- 2
3
---εp⋅=

f2 εpe( ) σys σyhard εpe( )+=
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Constraints

A constraint specifies the displacement of certain parts of a structure. You can define 
constraints on all domain levels: points, edges, faces/boundaries, and subdomains in 
3D; points, boundaries, and subdomains in 2D. To control a constraint, go to the 
Constraint page that appears in the following dialog boxes that you find in the Physics 
menu: Physics>Subdomain Settings, Physics>Boundary Settings, Physics>Edge Settings, 
and Physics>Point Settings. The following figure shows the Boundary Settings dialog 
box for the Solid, Stress-Strain application mode, but the Constraints settings area has 
the same appearance in all structural mechanics continuum application modes.

An example of a typical Constraint page, taken here from the Solid, Stress-Strain 
application mode Boundary Settings dialog box.

Within the dialog box the Constraint condition list lets you control what type of 
constraint you want to define. You can choose from the following options:

CONSTRAINT CONDITION BOUNDARY SUBDOMAIN USE WHEN

Free  √  √ The domain has no constraint

Fixed  √  √ The displacement in the domain is fixed
in all directions

Roller  √ The normal displacement is constrained

Axial symmetry  √ The symmetry axis (only available in the
Axial Symmetry, Stress-Strain 
application mode)

Prescribed displacement  √  √ The displacement in any direction need 
to be prescribed
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The symmetry or antisymmetry condition has the following interpretation:

Use the Coordinate system list to choose the coordinate system that you want to use 
for defining the constraint. Available options are:

• Global coordinate system

• Tangent and normal coordinate system (available only on boundaries)

• User-defined coordinate systems if any local coordinate systems are defined.

Symmetry plane  √ The boundary is a symmetry plane

x-y symmetry plane  √ The selected coordinate system’s xy-
plane is a symmetry plane

y-z symmetry plane  √ The selected coordinate system’s yz-
plane is a symmetry plane

x-z symmetry plane  √ The selected coordinate system’s xz-
plane is a symmetry plane

Antisymmetry plane  √ The boundary is an antisymmetry plane

x-y antisymmetry plane  √ The selected coordinate system’s xy-
plane is an antisymmetry plane

y-z antisymmetry plane  √ The selected coordinate system’s yz-
plane is an antisymmetry plane

x-z antisymmetry plane  √ The selected coordinate system’s xz-
plane is an antisymmetry plane

Prescribed velocity  √  √ The velocity in any direction need to be
prescribed, only available for frequency 
response analysis

Prescribed acceleration  √  √ The acceleration in any direction need 
to be prescribed, only available for 
frequency response analysis

CONSTRAINT CONDITION BOUNDARY SUBDOMAIN USE WHEN

CONDITION X-DISPLACEMENT Y-DISPLACEMENT Z-DISPLACEMENT

x-y symmetry plane  √

y-z symmetry plane  √

x-z symmetry plane  √

x-y antisymmetry plane  √  √

y-z antisymmetry plane  √  √

x-z antisymmetry plane  √  √
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When you select Prescribed displacement a number of new options appears in the dialog 
box, and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation (select this option by clicking the Standard notation button), 
you constrain each displacement direction independently. The check boxes adjacent 
to the Rx, Ry, and Rz edit fields activate the constraint, whereupon you enter the 
value/expression of the displacement (the default value is 0).

• In general notation (select this option by clicking the General notation, Hu=R 
button), you can specify constraints as any linear combination of displacements 
components. For instance, in the 2D case, use the relationship

.

Enter values for the H matrix and R vector in corresponding dialog boxes by 
clicking the corresponding Edit buttons. For example, to achieve the condition 
u = v, use the settings

H u
v

R=
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,

which force the domain to move only diagonally in the xy-plane.

The H Matrix dialog box for the example in the text.

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify a prescribed 
velocity or acceleration in the same way as Prescribed displacement using Standard 

notation by first selecting Prescribed velocity or Prescribed acceleration in the Constraint 

condition list.

Constraint page showing the Prescribed acceleration settings.

Loads

Load is a general term for a force applied to a structure. In the Structural Mechanics 
Module you can specify loads on all domain types using the Load page that appears in 
the following dialog boxes that you find on the Physics menu: Subdomain Settings, 
Boundary Settings, Edge Settings, and Point Settings.

H 1 1–

0 0
,= R 0

0
=
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The Boundary Settings dialog box for the Plane Strain application mode shown here is 
representative of load pages for all domain levels in all structural mechanics application 
modes.

The loads on all levels except the point level are given as distributed loads using a force 
density such as force/length, force/area, or force/volume. 

For boundaries you have the option to specify between different types of loads using 
the Type of load list. You select between distributed load and follower load (distributed 
load is the default setting).

F O L L O W E R  L O A D S

Follower loads are loads that depend on the deformation. The most common case is a 
pressure directed along the negative normal direction to a surface that deforms. In the 
following, follower loads imply such a load. Follower loads are only available on 
boundaries.

All loads must be applied in the undeformed reference frame; the software then 
computes the follower load using a frame that deforms with the structure. Both the 
direction and the size of the load change as the structure deforms. The Create frame 
application mode property is automatically set to On as soon as you specify a follower 
force.

Follower loads are only meaningful in a large deformation analysis and it is therefore 
not possible to use such loads for viscoelastic materials. The Large deformation 
application mode property is automatically set to On as soon as you specify a follower 
force.
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IN

me (N/m3) 
rea (N/m2)

me (N/m3)

me (N/m3)
You select Follower load from the Type of load list on the Load page. You specify the 
pressure in the P edit field.

The Boundary Settings dialog box for the Plane Strain application mode showing the 
follower load setting.

D I S T R I B U T E D  L O A D S

Distributed load is the default setting on boundaries. On all other levels a distributed 
load is the only way to specify a load. For boundaries you select between distributed 
loads and follower loads using the Type of load list.

For plane stress and plane strain, two option buttons allow you to choose how to 
specify the load using the thickness. The following table shows how to define the loads 
on different domains in different application modes; the entries give the SI unit in 
parenthesis.

Within the dialog box, the Coordinate system list lets you control in which coordinate 
system you want to define the load. Available options are:

• Global coordinate system

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMA

Plane Stress, 
Plane Strain

force (N) force/area (N/m2) or 
force/length (N/m)

force/volu
or force/a

Axisymmetry, 
Stress-Strain

total force along the 
circumferential (N)

force/area (N/m2) force/volu

Solid, Stress-
Strain

force (N) force/length 
(N/m)

force/area (N/m2) force/volu
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• Tangent and normal coordinate system (available only on boundaries)

• User-defined coordinate systems, if any local coordinate systems are defined

For a frequency response analysis you have additional input data. To control the 
analysis type, use the Application Mode Properties dialog box. When frequency response 
is the analysis type, the Load page takes on this appearance:

The Load page that appears for frequency response analysis.

For frequency response analysis, the application mode splits the harmonic load into 
two parameters:

• The amplitude, F

• The phase (FPh)

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency, f

.

For subdomains, you have additional options to control if and how the analysis should 
include thermal strains (explained in the following section).

Thermal Coupling

Material expands with temperature, causing thermal strains to develop in the material. 
The thermal strains, taken together with the initial strains and elastic strains from 
structural loads, form the total strain

Ffreq F f( ) 2πf FPh f( )+( )cos⋅=
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where 

.

Thermal coupling means that the analysis includes thermal expansion. Details on 
thermal coupling appear in the section “Thermal Strain” on page 193. You specify 
thermal effects on the Load page in the dialog box that appears when you choose 
Physics>Subdomain Settings.

You specify thermal effects on the Load page.

The Include thermal expansion check box instructs the model to add thermal effects. 
Specify the strain temperature, T, and reference temperature, Tref, in the Temp and 
Tempref edit fields, but you specify the thermal expansion coefficient on the Material 
page (see “Thermal expansion coefficient” on page 217). T and Tref can be any 
expression and are typically another dependent variable for temperature solved for in a 
COMSOL Multiphysics heat transfer application mode. Any type of analysis can use 
this predefined temperature coupling.

For viscoelastic materials, the viscoelastic properties often have a strong dependence 
on the temperature. This dependence can be described as a shift in the time scale. You 
can specify the shift on the Load page by selecting the Use WLF shift function check box 
and enter values for Twlf, C1wlf, and C2wlf.

ε εel εth ε0+ +=

εth α T Tref–( )=
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The Load page for a viscoelastic material.

Note: A special approach is required if the structural analysis is performed in the 
frequency domain. This includes the following analysis types: Frequency response, 
Eigenfrequency, and Damped eigenfrequency. The coupled displacement-temperature 
field presents thermoelastic oscillations of small amplitude, which are initialized to 
zero. You need to set the strain reference temperature Tempref to zero, and use a 
special form of the heat balance equation. For more details, see the example “Thermal 
Loading of a Viscoelastic Tube” on page 569 of the Structural Mechanics Module 
Model Library.

Initial Pressure

Initial pressure adds a hydrostatic stress field to the stress-strain relation:

where pi is the initial pressure and

σ Dεel σ0+ D ε εth– ε0–( ) σ0 lpi–+= =
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Details on initial pressure appear in the section “Stress-Strain Relationship” on page 
174. You specify the initial pressure on the Load page in the dialog box that appears 
when you choose Physics>Subdomain Settings.

Specify initial pressure on the Load page.

Select the Include initial pressure check box to add initial pressure. Specify the initial 
pressure pi in the pi edit field. The initial pressure is typically used for poroelastic 
materials, where it couples the structure with the pressure from the flow field.

Damping

In transient, damped eigenfrequency, and frequency response analyses you have the 
possibility to model undamped or damped problems. In the Structural Mechanics 
Module you can specify damping on the subdomain level using the Damping page that 
appears in the Subdomain Settings dialog box. From the Damping models list you can 

l

1
1
1
0
0
0

=

R  6 :  C O N T I N U U M  A P P L I C A T I O N  M O D E S



select No damping, Rayleigh, or Loss factor, and the contents of the dialog box changes 
for each of these damping models.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response and damped 
eigenfrequency analysis. If you choose transient analysis and loss factor damping, 
COMSOL Multiphysics solves the model with no damping.

Table 6-3 and the subsequent text describe the parameters that define damping:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

TABLE 6-3:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 ηs eta_s Loss factor Loss factor
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Initial Stress and Strain

An analysis can include initial stress and strain, which is the stress/strain state in the 
structure before the model applies any constraint or load. Initial strain can, for 
instance, describe moisture-induced swelling, and initial stress can describe stresses 
from heating. In fact, you can think of initial stress and strain as different ways to 
express the same thing. To specify them, go to the Initial Stress and Strain page in the 
Physics>Subdomain Settings dialog box.

Dialog box for setting up initial stress and strain.

You control the option to include initial stress and strain independently using like-
named two check boxes. The initial stress and strain are defined in the material 
coordinate system.

In the following table, the index l for parameter σ0l/sli and ε0l/eli refers to the 
space coordinates xl.

PARAMETER VARIABLE DESCRIPTION

 σ0l sli Initial normal stress

 τ0lk slki Initial shear stress

 ε0l eli Initial normal strain

 ε0lk elki Initial shear strain
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The index l runs over the following coordinate names for the different application 
modes.

Example: σ0l for axial symmetry stress-strain means σ0r, , and σ0z.

The parameters σ0lk/slki and ε0lk/elki in the first table refer to the space 
coordinates xlxk and are defined for the following combinations of l and k for the 
different application modes:

Perfectly Matched Layers (PMLs)

In frequency response analysis or elastic waves, you can use perfectly matched layers to 
simulate absorbing boundaries. A PML is strictly speaking not a boundary condition 
but an additional domain that absorbs the incident radiation without producing 
reflections. It provides good performance for a wide range of incidence angles and is 
not particularly sensitive to the shape of the wave fronts. The PML formulation 
introduces a complex-valued coordinate transformation under the additional 
requirement that the wave impedance should not be affected. The following sections 
describe how to create Cartesian, cylindrical, and spherical PMLs for elastic waves.

For an account of elastic waves in solids, see Chapters 4 and 5 of Ref. 1. For 
background information about PMLs in elastodynamics, see Ref. 2.

P M L  I M P L E M E N T A T I O N

For a PML that absorbs waves in the coordinate direction ξ, the implementation uses 
the following coordinate transformation inside the PML:

 (6-24)

APPLICATION MODE   x1   x2   x3 

Plane Stress and Plane Strain  x  y  z

Solid, Stress-Strain  x  y  z

Axial Symmetry, Stress-Strain  r  z

APPLICATION MODE  x1x2  x2x3  x1x3 

Plane Stress and Plane Strain  xy

Solid, Stress-Strain  xy  yz  xz

Axial Symmetry, Stress-Strain  rz

ϕ

σ0ϕ

ξ' sign ξ ξ0–( ) ξ ξ0–
n L

δξn
--------- 1 i–( )=
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The scaled PML width, L; the coordinate of the inner PML boundary, ξ0; and the 
(actual) width of the PML, δξ, are input parameters for each orthogonal absorbing 
coordinate direction.

The scaling exponent, n is an input parameter for each PML subdomain. The default 
value of n is 1, giving a linear scaling that works well in most cases, and the useful range 
is roughly between 1 and 2; increasing the exponent allows you to use fewer mesh 
elements to resolve wavelengths much smaller than the scaled PML width.

Usually, set L equal to one wavelength. The wavelength depends on the type of elastic 
wave you are considering. For example, for longitudinal (acoustic) waves, the 
wavelength is given by (Ref. 1)

where f is the frequency, E is Young’s modulus, ν is Poisson’s ratio and ρ is the density. 
If your analysis includes several wave types of different wavelengths, set L to the 
longest one. For this case, you can also try to set the scaling exponent, n, equal to 2.

The parameters ξ0 and δξ get default settings that the software deduces from the drawn 
geometry and stores in variables referred to as guess variables. You can inspect the 
values of the guess variables on the Variables page of the Subdomain Settings - Equation 

System dialog box or at the corresponding node of the Model Tree.

The default settings defined by the guess variables work nicely in most cases, but they 
might fail for PML subdomains of nonstandard shape. Examples of geometries that 
work nicely are shown in the following figures for each of the available PML types:

• Cartesian—PMLs absorbing in Cartesian coordinate directions.

• Cylindrical—PMLs absorbing in cylindrical coordinate directions from a specified 
axis. For axisymmetric geometries the cylinder axis is the z-axis.

• Spherical—PMLs absorbing in the radial direction from a specified center point.

For each of the above PML types, you can choose the coordinate directions in which 
the PML absorbs waves, that is, for which directions a coordinate transformation of 

λ 1
f
--- 1 ν–( )

1 ν+( ) 1 2ν–( )
---------------------------------------E

ρ
----=
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the type Equation 6-24 applies. To allow complete flexibility in defining a PML 
there is, in addition, a fourth option:

• User defined—General PMLs or domain scaling with user-defined coordinate 
transformations.

Figure 6-2: A cube surrounded by typical PML regions of the type “Cartesian.”

Figure 6-3: A cylinder surrounded by typical cylindrical PML regions.
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Figure 6-4: A sphere surrounded by a typical spherical PML region.

S E T T I N G  U P  A  P M L

To model an absorbing boundary using PMLs, you need an auxiliary subdomain 
outside the boundary. On the PML page in the Subdomain Settings dialog box, you can 
select different types of PMLs depending on what kind of wave you have:

The PML type None is default. To add a PML, select one of the other types.

Cartesian PMLs
When choosing the Cartesian PML type you can use a user-defined coordinate system 
to define the directions. If you want a curved coordinate system you must use the 
cylindrical or spherical PML type.

PML TYPE APPLICATION MODE DESCRIPTION

None all No PML

Cartesian Solid, Stress-Strain; Plane 
Stress; and Plane Strain

Absorbs waves in the 
specified Cartesian 
coordinate directions

Cylindrical all Absorbs cylindrical waves

Spherical Solid, Stress-Strain; Axial 
Symmetry, Stress-Strain

Absorbs spherical waves

User defined all Define your own scaled 
space variables
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Select the check box for the directions in which you want the waves to be absorbed. 
For each of these directions, enter the scaled PML width, L in the associated edit field. 
Make sure all material properties are the same in the PML as in the adjacent 
subdomain.

Cylindrical PMLs
In 2D, a cylindrical PML always absorbs waves in the radial direction. In the other 
dimensions, you can decide how the PML absorbs the wave: in the radial direction, the 
z direction, or both.

Select the directions in which you want the PML to absorb the waves and enter the 
scaled PML widths in those directions. To define a cylindrical PML you also need to 
enter the center point of the cylindrical coordinates and, in 3D, the cylinder axis 
direction.

Spherical PMLs
A spherical PML always absorbs waves in the radial direction. Enter the scaled PML 
width, L. Define the spherical coordinates by entering the center point.

User-Defined PMLs
When using a PML, the algorithm scales the equation in this domain so that instead 
of the coordinates used in the rest of the model, the coordinates PMLx, PMLy, and 
PMLz appear in the equation. If you want to scale the equation in some other way than 
the automatic PML options provide, use a user-defined PML. In this case you enter 
your own User-defined PML coordinates.

Contact Modeling

You can model contact between two boundaries. The boundaries need to be 
connected to a subdomain active in the same application mode. To be able to model 
contact you need the following:

• An application mode modeling the deformation that supports contact modeling: 
The Plane Strain; Plane Stress; Axial Symmetry, Stress-Strain; or the Solid Stress-
Strain application mode.

• A deformed frame controlled by the application mode. This is done by setting the 
application mode property Create frame to On. The program does this automatically 
when you add a contact pair.
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• Use of assembly mode, if the parts are in contact initially. In this case choose Use 

Assembly from the Draw menu. Read more about assemblies in the section “Using 
Assemblies” on page 405 in the COMSOL Multiphysics Modeling Guide.

• A contact pair. A contact pair consists of a number of slave and master boundaries. 
The slave is constrained not to penetrate the master boundary. You can create 
contact pairs from the Contact Pairs dialog box, which you open from the Physics 
menu. A description of how to create contact pairs appears later in this section. 
Additionally, if some parts of the boundaries are in initial contact, you can use the 
Create Pairs dialog box to automatically detect and define contact pairs. For more 
information about the Create Pairs dialog box, see the section “Creating Pairs” on 
page 407 in the COMSOL Multiphysics Modeling Guide.

• Contact parameters, specified to suit your model. You can inspect and change the 
contact parameters in the Boundary Settings dialog box by selecting the appropriate 
contact pair on the Pair page. There are three different pages, described further on 
in this section, to do this on:

-   Contact

-   Contact, Initial

-   Contact, Advanced

• Solver parameters, specified to suit your model. You can set the parameters for the 
augmented and nonlinear solvers in the Solver Settings dialog box, which is 
described in the section “Nonlinear Solver Settings” on page 389 in the COMSOL 
Multiphysics User’s Guide. You can find recommendations for solver settings 
specifically for contact models on page 152 of this book.

Note: The current version supports contact in the continuum application modes: 
Plane Stress; Plane Strain; Axial Symmetry, Stress-Strain; and Solid, Stress-Strain.

Note: You cannot use contact pairs together with the transient solver. Use the 
parametric solver with the time t as the parameter to solve contact problems with 
friction.

This section provides information about how to set up contact pairs and specify contact 
parameters. You can read about the theory behind the implementation of the contact 
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modeling method in the section “Contact Modeling—Theory Background” on page 
201 and about tips for creating a contact model on page 137.

For general information about modeling with pairs, see the section “Specifying Physics 
Settings on Pairs” on page 415 in the COMSOL Multiphysics Modeling Guide.

T H E  C O N T A C T  P A I R S  D I A L O G  B O X

To define contact pairs, choose Physics>Contact Pairs. This opens the Contact Pairs 
dialog box.

Boundaries Page
Each pair has a name. The application modes use this name to refer to the pair. The 
name must be unique.

The two boundary lists show the master and slave domains of the pair selected in the 
list to the left. The check boxes beside the domain numbers indicate which domains 
belong to the master and the slave, respectively.

Clicking the Check Selected buttons below the lists selects the check boxes of the 
boundaries highlighted in the list. This is equivalent to selecting the individual check 
boxes and is a quick way to select multiple check boxes. Clicking the Clear Selected 

buttons similarly clear the check boxes of the selected domains.

Use the buttons Select Master and Select Slave to select the master and slave domains 
in the main window and in the selection lists.

Clicking the arrow button between the selection lists interchanges the master and slave 
domains.
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To get the best results, consider the guidelines on page 137 when selecting your master 
and slave boundaries.

Advanced Page
On the Advanced page in the Contact Pairs dialog box you can define the names of the 
contact pair’s coupling operators.

When creating a contact pair COMSOL Multiphysics automatically defines the 
operators and gives them a name. The names have to be unique within the whole 
model. The application modes use the operators to set up the contact condition 
preventing the slave from penetrating the master.

A map operator evaluates its argument on one side of the pair and makes the result 
available on the other side. In the previous figure you can see two operators: 
mst2slv_cp2, mapping from the master of the pair to the slave, and slv2mst_cp2, 
mapping in the other direction. For example, if u is a variable on the master side you 
can use the expression mst2dst_cp2(u) on the slave side.

The application modes create a number of variables on the boundaries of the contact 
pair. To make the variable names unique the software adds a suffix to them. You can 
edit the suffix name in the Suffix for contact variables edit field. A special variable is the 
contact variable stating if the boundaries are in contact or not, which you can use in 
logical expressions. The expression if(contact_cp1,1,2) on the slave side evaluates 
to 1 for points where the boundaries are in contact and to 2 in the other points. You 
can edit the name of the contact variable in the Contact variable determining contact 
edit field.
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B O U N D A R Y  S E T T I N G S  D I A L O G  B O X

The Boundary Settings dialog box, which you can open from the Physics menu, has 
three pages dedicated for contact settings: the Contact; Contact, Initial; and Contact, 

Advanced pages. In the following you can find a description of these.

Contact Page
You specify the most important settings for your contact problem on the Contact page.

The Contact page for the Plane Stress application mode.

The Active pair check box lets you select if you want to use the contact pair in this 
application mode or not. If you want to model friction between the contact pairs, select 
Coulomb from the Friction model list.

The following table specifies the contact pair parameters on the Contact page:

PARAMETER DESCRIPTION SI UNIT NO FRICTION COULOMB

offset An optional offset specifying 
at what distance from the 
geometrical boundary 
contact appears, positive in 
the normal direction

m  √  √

pn The normal penalty factor Pa/m  √  √

pt The tangential penalty factor Pa/m  √

 µstat Static friction coefficient  √

cohe Cohesion sliding resistance, 
the friction force at zero 
contact pressure

Pa  √
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The convergence is sensitive to the value of the penalty factors. Their value should be 
of the same order as the stiffness of the boundary divided by a typical length scale, that 
is, the mesh size. The default values for both the normal and tangential penalty factors 
are set according to

 (6-25)

The Young’s modulus on the slave side is denoted E and the smallest mesh size on the 
slave boundary, hmin, is included in order to get a typical length scale. The 
auglagiter variable is the iteration number in the augmented Lagrange solver. It is 
used to make the penalty parameter soft at the beginning (to help the solver get 
started) and to gradually make it stiffer (to speed up convergence).

The default values, using Young’s modulus only work for linear isotropic materials, for 
which the Young’s modulus is defined. For other types of materials you need to 
substitute E with a suitable value or define it as a constant or expression variable. Read 
more about selecting the penalty factor on page 138.

If you select the Exponential dynamic friction model check box you get a friction 
coefficient that varies between the static and dynamic friction coefficient depending on 
the slip velocity and the dcfric decay coefficient in the following way.

 (6-26)

Ttmax The maximum tangential 
traction

Pa  √

 µdyn Dynamic friction coefficient, 
only used with the dynamic 
friction option

 √

dcfric Decay coefficient, only used 
with the dynamic friction 
option

s/m  √

PARAMETER DESCRIPTION SI UNIT NO FRICTION COULOMB

p E
hmin
------------ min 10 3– 5auglagiter⋅ 1( , )⋅=

µdyn µstat µdyn–( )e dcfric vs–
+
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Contact, Initial Page
You specify the initial conditions for your contact problem on the Contact, Initial page.

The Contact, Initial page for the Plane Strain application mode.

The following table specifies the contact pair parameters on the Contact, Initial page:

Turn to “Initial Value” on page 139 to read about how the initial contact pressure can 
influence your contact model.

PARAMETER DESCRIPTION SI UNIT NO FRICTION COULOMB

Tn The initial value for the 
contact pressure.

Pa  √  √

contactold The initial value for the 
contact variable in the 
previous step.

 √

Ttxi The initial value for the 
friction force components.

Pa  √

ximold The initial value for the 
coordinates of the master 
point in the previous step.

m  √
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Contact, Advanced Page
You have the option to specify more advanced contact pair settings on the Contact, 

Advanced page.

The Contact, Advanced page for the Plane Strain application mode.

You specify what search method to use in the Search method list. The default option is 
Fast. Under some rare circumstances this method can fail to detect contact and find the 
corresponding master points. If this happens, select the more robust but slower option 
Direct instead.

The contact tolerance specifies at what distance two bodies are regarded as being in 
contact (used for friction and multiphysics contact). In the Contact tolerance list, you 
have two options for the contact tolerance: Automatic and Manual. Automatic means 
that the software calculates the tolerance from the size of the bounding box of the total 
geometry. Manual means that you specify the value yourself in the mantol edit field.

In a similar way as for the contact tolerance you have the option to specify the Search 

distance. The search distance sets the radius from any slave point within which the 
software looks for possible contact between the slave and master boundary. A shorter 
distance speeds up the search algorithm because the vast majority of boundary 
elements can quickly be excluded from the search process. But a too small value might 
result in missed contact detection.

The Automatic setting means that the program calculates the search distance from the 
size of the bounding box of the total geometry. If the total size of the geometry is not 
representative for the size of the contact areas, you can use the Manual setting and 
specify the value yourself in the mandist edit field. A suitable search radius is usually on 
the order of the largest mesh elements involved in the contact process.
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 7
M i n d l i n  P l a t e s
A plate is a thin planar structure, its thickness as a rule being less than one tenth 
of its width. In contrast to the plane stress and plane strain 2D cases, the forces are 
either applied in the direction normal to the plate, or as moments about directions 
 245
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in the plane where the plate lies. The main deformation takes place in the out-of-plane 
direction. There are two main groups of plates:

• Thin plates

• Thick plates

In thin plate theory the transverse shear deformation is neglected, in the same way as 
Euler beams neglect shear deformations. 

In thick plate theory the transverse shear deformation is included. The Mindlin plate 
is based on the following engineering assumption: a plane originally perpendicular to 
the mid surface remains plane after loading, but not necessarily perpendicular to the 
deformed mid surface. The change in angle accounts for the transverse shear 
deformation.

The element in this application mode is a discrete Reissner-Mindlin triangle. This 
element has six nodes and a total of twelve degrees of freedom. These are the two 
rotations and one transversal displacement at each corner node and the normal 
rotations at the triangle midsides; see O. C. Zienkiewicz (Ref. 1) for details.

Variables and Space Dimensions

The dependent variables are the global displacement w in the z direction and the 
rotations θx and θy around the global x- and y-axes.

Reference

1. O. C. Zienkiewicz: “Plate bending elements with discrete constraints: new 
triangular elements,” Computer & Structures, vol. 35, no. 4, 1990.
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Th eo r y  Ba c k g r ound

Shape Function

The degrees of freedom are defined by a shape function object shdrm. The degree of 
freedom names and variable names are constructed from the input arguments.

shdrm('w','thx','thy')

The shdrm shape function object defines the following dependent variables, derivatives 
of dependent variables and shear strain components.

The shape functions are of order 1 for the out-of-plane displacements, partly order 2 
for rotations (rotations about triangle sides vary linearly), and partly order 1 for shears 
(shear components along triangle sides are constant). See shdrm on page 176 in the 
Structural Mechanics Module Reference Guide for details.

VARIABLE NAME DOF DESCRIPTION

 w w w Global displacement in z direction

 θx thx thx Rotation about global x-axis

 θy thy thy Rotation about global y-axis

thn thn Midside rotation about axis perpendicular 
to side (with a direction convention)

thxx x derivative of rotation about global x-axis

thxy y derivative of rotation about global x-axis

thyy y derivative of rotation about global y-axis

thyx x derivative of rotation about global y-axis

 γxz gxz Shear strain component

 γyz gyz Shear strain component

∂θx

∂x
---------

∂θx
∂y
---------

∂θy
∂y
---------

∂θy

∂x
---------
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In-Plane Strain-Displacement/Rotation Relation

The in-plane strain components depends on the rotation derivatives defined by the 
shdrm shape function and the z coordinate in the plate.

The total strain ε consists of thermal (εth), initial (εi), and elastic strains(εel)

Transverse Strain Components

The average transverse shear components is defined directly by the shdrm shape 
function. 

In-Plane Stress-Strain Relation

The in-plane stress components in the plate are described by the symmetric stress 
tensor

consisting of 2 normal stresses (σx and σy) and two or, if the symmetry is used, one 
shear stress τxy. The stress-strain relation for linear conditions including initial stress 
and strain and thermal effects reads:

 (7-1)

where Dp is the 3-by-3 elasticity matrix in plane stress form. The stress and strain 
components are described on vector form with the three stress and strain components 
in column vectors defined as

ε
εx

εy

γxy

z

∂θy
∂x
---------

∂θx

∂y
---------–

∂θy
∂y
---------

∂θx
∂x
---------–⎝ ⎠

⎛ ⎞

zΘ= = =

ε εel εth εi+ +=

σ
σx τxy

τyx σy

= τxy τyx=

σ Dpεel σi+ Dp ε εth– εi–( ) σi+= =
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Note: In the following descriptions the compact notation σ and ε will be used 
meaning either the stress/strain vector or tensor depending on the situation.

The in-plane elasticity matrix Dp and the more basic matrix, the flexibility or 
compliance matrix Dp

−1 (the inverse of Dp), are defined differently for isotropic, 
orthotropic, and anisotropic materials. For isotropic material the Dp

−1 matrix looks 
like

where E is the modulus of elasticity or Young’s modulus and ν is Poisson’s ratio, 
defining the contraction in the perpendicular direction. Inverting Dp

−1 symbolically 
results in

where E is Young’s modulus and ν is Poisson’s ratio. For an orthotropic material the 
Dp

−1 matrix looks like.

σ
σx

σy

τxy

= ε
εx

εy

γxy

=

Dp
1– 1

E
----

1 ν– 0
ν– 1 0

0 0 2 1 ν+( )

=

Dp
E

1 ν2
–

---------------

1 ν 0
ν 1 0

0 0 1 ν–
2

------------

=

Dp
1–

1
Ex
------

νyx
Ey
--------– 0

νxy

Ex
--------–

1
Ey
------ 0

0 0 1
Gxy
---------

=
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The Dp
−1 matrix is symmetric so the material is defined using the coefficients on the 

lower-diagonal part of the matrix. It is important that the material data has been 
derived using the same definition of ν as above; if not, the material data need to be 
transformed.

Note: νij is defined in different ways depending on the application field. It is easy to 
transform between the different definitions but you need to check what definition 
your material uses.

Inverting the Dp
−1 matrix symbolically using only the Ex, Ey, νxy, and Gxy coefficients 

results in the following symmetric Dp matrix.

where the components are as follows 

 

where 

For an anisotropic material the symmetric Dp matrix is given explicitly.

Note: For an anisotropic material the Dp matrix should be given in plane stress form, 
using the equation σz = 0 to eliminate εz. If material data is given in full 3D form they 
need to be transformed to plane stress form using the σz=0 condition.

Dp

Dp11 Dp12 0

Dp12 Dp22 0

0 0 Dp33

=

Dp11
Ex

2

Ddenom
--------------------= Dp12

ExEyνxy

Ddenom
----------------------=

Dp22
ExEy

Ddenom
--------------------= Dp33 Gxy=

Ddenom Ex Eyνxy
2

–=
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Transverse Stress-Strain Relation

The average shear strain γm is defined as

where:

• G is the shear modulus

• Q is the plate shear force/length

• th is the thickness of the plate

• Sf is the shear factor

The shear factor is defined so that the average strain and the real strain should result in 
equal virtual work through the thickness.

Assuming a parabolic stress and strain distribution through the plate results in Sf = 1.2, 
this holds for homogeneous plates.

For the general case the relation looks like

Where Ds looks as follows for the different material models:

• Isotropic

• Orthotropic

γm
Q

G th
Sf
------⋅

---------------=

γτ zd
th
∫ th Q⋅ γm=

Qy

Qx

th D⋅ s
γyzm

γxzm

=

Ds

E
2 1 ν+( )Sf
--------------------------- 0

0 E
2 1 ν+( )Sf
---------------------------

=
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• Anisotropic: The full elasticity matrix including shear factors Ds is given explicitly.

Thermal Strain

The thermal strain is only included for the in-plane strain components. The 
temperature is assumed to vary linearly through the thickness.

The plate can only handle the temperature difference through the plate, ∆T. The 
thermal strain as a function of the z-coordinate and the temperature gradient is

 (7-2)

Depending on the material model, αvec is set up differently:

• Isotropic

• Orthotropic

• Anisotropic: The full thermal expansion vector is given as input.

Ds

Gyz
Sfyz
----------- 0

0
Gxz
Sfxz
-----------

=

T T0 ∆T z
th
------+=

εth

εx

εy

γxy th

αvec∆T z
th
-----= =

αvec

α
α
0

=

αvec

αx

αy

0

=
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Initial Load and Strain

I N - P L A N E  M O M E N T S  A N D  C U R V A T U R E

The initial stress means the stress before any loads, displacements, and initial strains 
have been applied.

The initial stress distribution is given as initial plate moments.

The initial strain is the strain before any loads, displacements, and initial stresses have 
been applied.

The initial strain distribution is given as initial curvature and warping.

I N I T I A L  S H E A R  F O R C E S  A N D  TR A N S V E R S A L  S T R A I N S

The out-of-plane initial shear stress is given as shear forces.

The initial shear strain is given as average shear strains γyzi and γxzi.

Implementation

The implementation is based on the principle of virtual work. The principle of virtual 
work states that the virtual work from any variation in internal strain and external loads 

σi

σxi

σyi

τxyi

=

Mxpi σxiz zd
th
∫= Mypi σyiz zd

th
∫= Mxypi τxyiz zd

th
∫=

εi

εxi

εyi

2εxyi

zΘi= =

εxi zθyxi= εxi z– θxyi= εxyi
z
2
--- θyyi θxxi–( ) z

2
---θyymxxi= =

Qyi τyzi zd
th
∫= Qxi τxzi zd

th
∫=
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are zero. The in-plane part of the virtual work is expressed using the internal plate 
moments

The out-of-plane part is expressed using the internal shear forces:

The variation of the total stored energy W from external and internal strain and load is

If the material is described in a local user-defined coordinate system, the variational 
equation is expressed in local instead of global plate moments and shear forces. 

The rotational derivatives can be transformed as a tensor.

where Tcoord is the local to global coordinate system transformation matrix.

The local plate moments are then calculated from the local rotational derivatives.

The global plate moments are calculated by transforming the local plate moments.

Mp

Mxp

Myp

Mxyp

z Dp ε εth– εi–( ) σi+[ ] zd
th
∫= =

z2 Dp Θ
αvec∆T

th
--------------------– Θi–⎝ ⎠

⎛ ⎞ zd Mpi+

th
∫=

th( )3

12
-------------- Dp Θ

αvec∆T
th

--------------------– Θi–⎝ ⎠
⎛ ⎞ Mpi+=

Qp
Qyp

Qxp

zτ zd
th
∫ th D⋅ s

γyzm

γxzm

γyzi

γxzi

– Qpi+= = =

δW
∂θy

∂x
---------⎝ ⎠
⎛ ⎞

test
Mxp

∂θx

∂y
---------⎝ ⎠
⎛ ⎞

test
– Myp

∂θy
∂y
---------

∂θx
∂x
---------–⎝ ⎠

⎛ ⎞
test

Mxyp

2Qypγyztest 2Qxpγxztest wtestFzg θxtestMxg θytestMyg

+

+ + + + +

⎝

⎠

⎛

⎞ Ad

A
∫–=

θyx
1
2
--- θyy θxx–( )

1
2
--- θyy θxx–( ) θ– xy

l

Tcoord
T

θyx
1
2
--- θyy θxx–( )

1
2
--- θyy θxx–( ) θ– xy

Tcoord=
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The shear strains transforms as

The global shear forces are calculated by transforming the local shear forces.

Mp TcoordMplTcoord
T

=

γxz

γyz l

Tcoord
T γxz

γyz

=

Qxp

Qyp

Tcoord
Qxp

Qyp l

=
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a Mindlin Plate model. It is divided into the 
following sections:

• Properties

• Scalar Variables

• Material

• Constraint

• Load

• Thermal Coupling

• Initial Stress and Strain

• Postprocessing

Properties

The Application Mode Properties dialog box is opened from the Physics menu.

In the Application Mode Properties dialog box you control different global settings for 
the model.

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers.

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary

Eigenfrequency Eigenfrequency/Eigenvalue

Damped Eigenfrequency Eigenfrequency/Eigenvalue

Transient Time dependent
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• Weak constraints: Controls whether or not weak constraints are active. When weak 
constraints are enabled, all constraints are weak by default, but it is possible to 
change this setting for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 351 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are up to 4 different scalar variables:

• Excitation frequency, freq, applicable only for frequency response analysis.

• Complex angular frequency, jomega, applicable only for eigenfrequency analysis. 
You normally do not need to edit the complex angular frequency. 

• Reference point coordinates, used for applied and reaction moment computations.

The Application Scalar Variables dialog box in a frequency response analysis.

The excitation frequency is the frequency of the harmonic loads in a frequency 
response analysis.

When you select a frequency response analysis, the parametric solver becomes the 
default solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case, choose Solve>Solver Parameters, and in the 
dialog box that appears go to the General page. In the Parameter area, enter 
freq_smsld in the Parameter names edit field. Values that you enter in the Parameter 

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
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values edit field override the excitation frequency you might have entered in the 
Application Scalar Variables dialog box.

To access the excitation frequency, f, use the variable freq, and to access the angular 
excitation frequency, ω, use omega.

Specify the coordinates of the point around which you want both your reaction and 
applied moments to be calculated in the refpnt edit fields.

Material

The material properties are defined on the Material page in the Subdomain Settings 

dialog box.

The Material page has two lists:

• Material model: Select the type of material. Depending on the selection, different 
material properties are shown reflecting the chosen material model.

- Isotropic: The material has the same material properties in all directions. The 
Material page for an isotropic material is shown above.

- Orthotropic: The material has different material properties in different directions. 
The in-plane stiffness is defined from the material properties Ex, Ey, νxy, and Gxy; 
see page 248 for details. The out-of-plane shear stiffness is defined from the 
properties Gyz, Gxz, Sfyz, Sfxz; see page 251 for details. The thermal expansion is 
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defined from the αx and αy; see page 252 for details.The Material page for an 
orthotropic material is shown below.

- Anisotropic: The material has different material properties in different directions, 
and the stiffness is defined from the symmetric elasticity matrices Dp and Ds; see 
page 248 and page 251 for details. The thermal expansion is defined from the 
thermal expansion vector αvec; see page 252 for details. The Material page for an 
anisotropic material is shown below.
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IAL 

pic

pic

pic

pic

tropic 

tropic 
• The Elasticity matrix dialog boxes for entering of the Dp and Ds matrices 
components are shown below.

• The Thermal expansion vector dialog box for entering of the αvector is shown below.

• Coordinate system: Select the coordinate system where the material properties are 
defined. This is used for orthotropic and anisotropic materials defined in another 
coordinate system than the global or if postprocessing variables are needed in a local 
coordinate system. The Coordinate system list is disabled if no user-defined 
coordinate systems are available. The Coordinate System Settings dialog box is found 
on the Options menu. You can read more about creation of coordinate systems and 
their use in “Coordinate Systems” on page 98.

The material properties for the union of all different material models are shown in the 
table below.

PARAMETER VARIABLE DESCRIPTION MATER
MODEL

 E E Young's modulus Isotro

 ν nu Poisson's ratio Isotro

 Sf Sf Shear factor Isotro

 ρ rho Density All

 th thickness Thickness All

 α alpha Thermal expansion coefficient Isotro

 Ex, Ey Ex, Ey Young's modulus in the x and y directions Ortho

 νxy nuxy Shear modulus for the xy-plane Ortho
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tropic 

tropic 

tropic

tropic

tropic

tropic

IAL 
Young’s modulus    Defines the modulus of elasticity, E, of the material. For an isotropic 
material, it is the spring stiffness in Hooke’s law, shown below in 1D form 

 

where σ is the stress and ε is the strain. Orthotropic material uses one value of Young’s 
modulus for each direction, Ei defined on page 248.

Poisson’s ratio   Denoted by ν, Poisson’s ration defines the normal strain in the 
perpendicular direction, generated from a normal strain in the other direction.

For orthotropic material νxy is defined, see page 248 for details.

Note: νij is defined in different ways depending on the application field (see page 248 
for details on the definition in the Structural Mechanics Module). It is easy to 
transform between the different definitions, but you need to check what definition 
your material uses.

Shear factor   Denoted by Sf, affects the out-of-plane shear stiffness, for homogeneous 
material Sf = 1.2.

Shear modulus orthotropic material   Denoted by Gij, defines the relation between 
engineering shear strain and shear stress, it is only used for orthotropic material.

 Gxy, Gyz, Gxz Gxy, Gyz, Gxz Poisson's ratio for the xy-, yz-, and xz-planes Ortho

 Sfyz, Sfxz Sfyz, Sfxz Shear factor for the yz- and xz-planes Ortho

 αx, αy alphax, 
alphay

Thermal expansion coefficient in the x and y 
directions

Ortho

 Dp In-plane elasticity matrix for the anisotropic case Aniso

 Ds Out-of-plane elasticity matrix for the anisotropic 
case

Aniso

 αvec Thermal expansion vector for the anisotropic 
case

Aniso

PARAMETER VARIABLE DESCRIPTION MATER
MODEL

σ Eε=

ε⊥ νεl l–=
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Density   This material property, ρ, specifies the density of the material. 

Thickness   Defines the thickness of the plate.

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature. 

where εth is the thermal strain, ∆T is the temperature difference through the plate, and 
α is the thermal expansion coefficient. It is used to model thermal strain for an 
isotropic material. For an orthotropic material two different thermal expansion 
coefficients, αi, are defined for the two perpendicular directions.

Shear factor orthotropic material   Denoted by Sfyz and Sfxz, these individual shear 
factors for orthotropic materials affect the out-of-plane shear stiffness.

In-plane elasticity matrix   Defines the in-plane elasticity matrix Dp, used for 
anisotropic materials. See page 248 for details.

Out-of-plane elasticity matrix   Defines the out-of-plane elasticity matrix Ds, used for 
anisotropic materials. See page 251 for details.

Thermal expansion vector   Defines the thermal expansion vector αvec, used for 
anisotropic materials. See page 252 for details.

Constraint

A constraint specifies the out-of plane displacement and rotations of certain parts of a 
plate. Constraints can be defined on all domain levels such as points, boundaries, and 
subdomains. The constraint is controlled from the Constraint page in the Subdomain 

Settings, Boundary Settings, and Point Settings dialog boxes. Normally, you only apply 
constraints to boundaries.

γij
τij
Gij
--------=

εth α∆T z
th
------=
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Below is the Boundary Settings dialog box.

With the Coordinate system list you control in what coordinate system the constraint is 
defined. Available options are:

• Tangential and normal coordinate system.

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in “Coordinate Systems” on page 
98.

Using the tangential and normal coordinate system you select the constraint condition 
on the boundary. Available conditions are:

• Free

• Simply supported—the displacement is constrained and the normal rotation is set to 
zero. 

• Fixed—the displacement and tangential rotation is constrained.

• Rotation constrained—the tangential rotation is constrained.

• General notation—the H matrix and R vector in the relation Hu = R is specified.

 H
w
θt

θn

R=
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Note: For the simply supported, fixed, and rotational constrained condition the 
normal rotation is set to zero, resulting in better convergence.

For other coordinate systems the Constraint page looks like any other Constraint page 
in the Structural Mechanics Module.

The constraint can be described using standard or general notation. You select the type 
of notation using the Standard notation button and the General notation, Hu=R button.

In standard notation you constrain the displacement and rotations independently. The 
check box in front of Rz, Rx, and Ry activates the constraint, and you can then enter the 
value or expression for the displacement in the edit fields. The default value is 0.

In general notation, the H matrix and R vector in the relation

make it possible to specify constraints as any linear combination of displacement and 
rotation component. The H matrix and R vector are entered in special matrix dialog 
boxes by clicking the corresponding Edit buttons. For example, you can achieve the 
condition θx = θy using the settings

H
w
θx

θy

R=
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/m2), 
The H Matrix dialog box for the above example is

Loads

Load is a general name for forces and moments applied to the structure. You can 
specify loads on all domain types. To do so, click the Load tab in the Subdomain Settings, 
Boundary Settings, and Point Settings dialog boxes. The following picture shows the 
Point Settings dialog box, but the page looks similar on all domain levels.

In the subdomain and boundary domains dialog boxes you have an option to specify 
the load in different ways using the thickness. The loads can be defined on different 
domains in the following way. The SI unit is shown in parenthesis.

H
0 1 1–

0 0 0
0 0 0

,= R 0
0

=

POINT BOUNDARY SUBDOMAIN

force (N), 
moment (Nm)

force/area (N/m2), moment/area (N/m) or 
force/length (N/m), moment/length (N)

force/volume (N/m3), moment/
volume (N/m2) or force/area (N
moment/area (N/m)
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With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Global coordinate system

• Tangential and normal coordinate system, only available on boundaries

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

The frequency response analysis type requires additional input. The analysis type is 
controlled from the Application Mode Properties dialog box. When frequency response 
is selected as analysis type, the Load page changes appearance:

For frequency response analysis the harmonic load is split into 3 different parameters:

• The amplitude value, F

• The amplitude factor, FAmp (a dimensionless number; the default value is 1)

• The phase (FPh). 

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency, f:

On subdomains additional options are available controlling if and how thermal strains 
should be included in the analysis. They are explained in the next section.

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
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Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The plate can only handle temperature difference through the plate. The 
thermal strains together with the initial strains and elastic strains from structural loads 
form the total strain.

where 

Thermal coupling means that the thermal expansion is included in the analysis. For 
details on thermal coupling, see page 252. Thermal effects are specified on the Load 
page in the Subdomain Settings dialog box.

The Include thermal expansion check box adds thermal effects. In the dT edit field the 
temperature difference through the plate, ∆T is specified. The thermal expansion 
coefficient is specified on the Material page described in “Material” on page 258. ∆T 
can be any expression and is typically another variable solved for in a COMSOL 
Multiphysics heat transfer application mode. The temperature coupling can be used in 
any type of analysis.

ε εel εth εi+ +=

εth α∆T z
th
------=
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Damping

In transient, damped eigenvalue, and frequency response analyses you have the 
possibility to model undamped or damped problems. In the Structural Mechanics 
Module you can specify damping on the subdomain level using the Damping page that 
appears in the Subdomain Settings dialog box. From the Damping models list you can 
select No damping, Rayleigh, or Loss factor, and the layout of the dialog box changes for 
each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response and damped 
eigenfrequency analysis. If you choose transient analysis and loss factor damping, 
COMSOL Multiphysics solves the model with no damping.

Table 7-1 and the subsequent text describe the parameters that define damping:

TABLE 7-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 ηs eta_s Loss factor Loss factor
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Mass damping parameter   It defines the Rayleigh damping model’s mass damping, 
αdM.

Stiffness damping parameter   It defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   It defines the loss factor η for the loss factor damping model.

Initial Load and Strain

Initial stress and strain can be included in the analysis. For the plate formulation this 
transforms to initial internal plate moments and shear forces and initial curvatures and 
initial average shear strains. Initial load and strain can be viewed as different ways to 
express the same thing. Initial load and strain are specified on the Initial Load and Strain 
page in the Subdomain Settings dialog box.

The option to include initial forces and moments and initial curvature and strain is 
controlled independently using the two check boxes Include initial forces and moments 
and Include initial strain and curvature.

Postprocessing

The predefined postprocessing variables include: all non-zero stress and strain tensor 
components, principal stresses and strains, in-plane and out-of-plane forces, bending 
and torsional moments, and von Mises and Tresca effective stresses. The stress and 
strain tensor components and effective stresses can be evaluated at an arbitrary distance 
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from the mid surface. This height is controlled from the Postprocessing page in the 
Subdomain Settings dialog box.

With the Evaluate at list you control where the stress and strain should be evaluated, 
available options are:

• Top of plate (default)

• Midplane of plate

• Bottom of plate

• Specified height

Select Specified height to specify a postprocessing height explicitly using the height edit 
field.

The displacement and rotations in radians and, for a transient analysis, the velocity and 
angular velocity can be plotted.
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B e a m s
A beam is a slender structure which is assumed to be fully described by the 
properties—area, moments of inertia, density—of the cross section. Beams are the 
choice for modeling reinforcements in 3D solids and shell structures, as well as in 
2D solids under the plane stress assumption. Naturally, they can also model lattice 
works, both planar and three-dimensional.

Beams can sustain loads and moments in any direction, both distributed and on 
individual nodes. The beam’s ends and interconnections can be free, simply 
supported, or clamped. In fact, the simplified boundary conditions are usually 
responsible for most of the difference that may be found between a beam solution 
and a full 3D solid simulation of the same structure. Point constraints are 
well-behaved, in contrast to the solid case. Discrete point masses and mass 
moments of inertia can be used.

The Structural Mechanics Module’s beam application modes are based on the 
principle of virtual work. The resulting equation can equivalently be viewed as a 
weak formulation of an underlying PDE. The beam application modes use special 
shape function classes to define stresses and strains, which are used in setting up the 
weak form equation.
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Th eo r y  Ba c k g r ound

Shape Functions

The degrees of freedom are defined by a shape function object, different shape 
functions for the in-plane and 3D Euler beam.

I N - P L A N E  E U L E R  B E A M

The shape function object for the in-plane Euler beam application mode is

appl.shape{1}=sheulbps('u','v','th')

The shape function class defines the following variables:

See sheulbps on page 182 of the Structural Mechanics Module Reference Guide for 
details.

3 D  E U L E R  B E A M

The shape function object for the 3D Euler beam application mode is:

appl.shape{1}=sheulb3d('u','v','w','thx','thy','thz',point)

The shape function class defines the following variables.

VARIABLE NAME DESCRIPTION

 u u Global displacement in x direction

 v v Global displacement in y direction

 θ th Rotation angle about an axis pointing out from the xy-plane 
(global z-axis)

ths Tangential derivative along the edge direction of the rotation 
angle θ

thss The second tangential derivative of the rotation angle θ

uvts The tangential derivative of the axial displacement in the edge 
direction

VARIABLE NAME DESCRIPTION

 u u Global displacement in x direction

 v v Global displacement in y direction

∂θ
∂s
------

∂2θ
∂s2
---------

∂uaxi
∂s

--------------
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See sheulb3d on page 178 of the Structural Mechanics Module Reference Guide for 
details.

Strain-Displacement/Rotation Relation

The axial strain depends on the rotation derivative and axial displacement derivative 
defined by the shape function and the z coordinate in the beam. For the 2D case it 
becomes

 w w Global displacement in z direction

 θx thx Rotation angle about the global x-axis

 θy thy Rotation angle about the global y-axis

 θz thz Rotation angle about the global z-axis

 ul ul Displacement in local x direction

 vl vl Displacement in local y direction

 wl wl Displacement in local z direction

 θxl thxl Rotation angle about the local x-axis

 θyl thyl Rotation angle about the local y-axis

 θzl thzl Rotation angle about the local z-axis

thxs Tangential derivative along the edge direction of the rotation 
angle about the local x-axis

thys Tangential derivative along the edge direction of the rotation 
angle about the local y-axis

thyss The second tangential derivative of the rotation angle about 
the local y-axis

thzs Tangential derivative along the edge direction of the rotation 
angle about the local z-axis

thzss The second tangential derivative of the rotation angle about 
the local z-axis

uvwts The tangential derivative of the axial displacement in the edge 
direction

VARIABLE NAME DESCRIPTION

∂θxl
∂s

----------

∂θyl
∂s

----------

∂2θyl

∂s2
-------------

∂θzl
∂s

----------

∂2θzl

∂s2
-------------

∂uaxi
∂s

--------------
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The total strain ε consists of thermal (εth), initial (εi), and elastic strains(εel)

For the 3D case there are two rotational derivatives.

Stress-Strain Relation

The stress-strain relation in the beam is described by 

The stress-strain relation for linear conditions including initial stress and strain and 
thermal effects reads:

where E is known as Young’s modulus or the modulus of elasticity.

Thermal Strain

The temperature is assumed to vary linear across the beam’s cross section. For the 
in-plane beam it becomes

The thermal strain as a function of the z-coordinate and the temperature gradient is

In the 3D beam the temperature depends on both y and z:

ε z∂θ
∂s
------

∂uaxi
∂s

--------------+=

ε εel εth εi+ +=

σ Eε=

σ Eεel σi+ E ε εth– εi–( ) σi+= =

T Tm ∆T z
hz
------+=

εth α Tm ∆T z
hz
------ Tref–+⎝ ⎠

⎛ ⎞=

T Tm ∆Tz
z
hz
------ ∆Ty

y
hy
------+ +=

εth α Tm ∆Tz
z
hz
------ ∆Ty

y
hy
------ Tref–+ +⎝ ⎠

⎛ ⎞=
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Initial Load and Strain

The initial stress means the stress before any loads, displacements, and initial strains 
have been applied.

The initial stress distribution is given as initial moment and initial normal force, for the 
2D beam 

In 3D there is an additional bending moments and a torsional moment.

The initial strain is the strain before any loads, displacements, and initial stresses have 
been applied. The initial strain distribution is given as initial curvature and initial axial 
strain, for the 2D beam

In 3D there are two initial rotational derivatives and an initial torsional derivative.

Implementation

The implementation is based on the principle of virtual work, which states that the sum 
of virtual work from internal strains and external loads equals zero:

In 2D the beam moment is defined as

Mi σiz Ad
A
∫= Ni σi Ad

A
∫=

εi z ∂θ
∂s
------⎝ ⎠
⎛ ⎞

i

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
+=

δW δ ε– elσ uTF Vd+( )
V
∫ 0= =

M σz Ad
A
∫ z Eεel σi+( ) zd

A
∫

z E z∂θ
∂s
------

∂uaxi
∂s

--------------+⎝ ⎠
⎛ ⎞ z ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
+⎝ ⎠

⎛ ⎞–

α Tm ∆T z
hz
------ Tref–+⎝ ⎠

⎛ ⎞

–

σi+

⎝

⎠

⎜

⎟

⎛

⎞
zd

A
∫

z2 E ∂θ
∂s
------ ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i
– α∆T

hz
--------–⎝ ⎠

⎛ ⎞ Ad
A
∫ σiz zd

A
∫+ EIyy

∂θ
∂s
------ ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i
– α∆T

hz
--------– Mi+

= = =

=

=
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In 3D there is an additional bending moment and torsional moment.

The torsion of the beam is defined using a torsional constant J given by

In a similar way as for the bending part a torsional moment is defined as

The normal force is defined as

Using the beam moment and normal force the expression for the virtual work becomes 
very compact, for the 2D beam it becomes

For 3D it becomes

J M
Gθ
--------l=

Mxl GJ
∂θxl
∂s

----------
∂θxl
∂s

----------⎝ ⎠
⎛ ⎞

i
–⎝ ⎠

⎛ ⎞ Mxi+=

N σ Ad
A
∫ Eεel σi+( ) zd

A
∫

E z∂θ
∂s
------

∂uaxi
∂s

--------------+⎝ ⎠
⎛ ⎞ z ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
+⎝ ⎠

⎛ ⎞– α Tm ∆T z
hz
------ Tref–+⎝ ⎠

⎛ ⎞– σi+
⎝ ⎠
⎜ ⎟
⎛ ⎞

zd
A
∫

E
∂uaxi

∂s
--------------

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
–⎝ ⎠

⎛ ⎞ α Tm Tref–( )–⎝ ⎠
⎛ ⎞ Ad

A
∫ σi zd

A
∫+

EA
∂uaxi

∂s
--------------

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
–⎝ ⎠

⎛ ⎞ α Tm Tref–( )– Ni+

= = =

=

=

δW M ∂θ
∂s
------⎝ ⎠
⎛ ⎞

test
N

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

test
+⎝ ⎠

⎛ ⎞ xd
L
∫=

δW Myl
∂θyl
∂s

----------⎝ ⎠
⎛ ⎞

test
Mzl

∂θzl
∂s

----------⎝ ⎠
⎛ ⎞

test
N

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

test
Mxl

∂θxl
∂s

----------⎝ ⎠
⎛ ⎞

test
+ + +⎝ ⎠

⎛ ⎞ xd
L
∫=
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App l i c a t i o n  Mode De s c r i p t i o n

This section describe how to define a beam model. It is divided into the following 
sections:

• Properties

• Scalar Variables

• Material

• Cross Section

• Constraint

• Load

• Discrete Mass

• Thermal Coupling

• Initial Load and Strain

• Postprocessing

Properties

To open Application Mode Properties dialog box, choose Physics>Propertries.

In the Application Mode Properties dialog box you control global settings for the model.

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers. 

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenfrequency/Eigenvalue
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• Weak constraints: Controls whether or not weak constraints are active. When weak 
constraints are enabled, all constraints are weak by default, but it is possible to 
change this setting for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 351 of the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency.

• Reference point coordinates, used for applied and reaction moment computations.

The Application Scalar Variables dialog box in a frequency response analysis.

The excitation frequency is the frequency of the harmonic loads in a frequency 
response analysis.

When you select a frequency response analysis, the parametric solver becomes the 
default solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case, choose Solve>Solver Parameters, and in the 
dialog box that appears go to the General page. In the Parameter area, enter 

Damped Eigenfrequency Eigenfrequency/Eigenvalue

Transient Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
R  8 :  B E A M S



freq_smsld in the Parameter names edit field. Values that you enter in the Parameter 

values edit field override the excitation frequency you might have entered in the 
Application Scalar Variables dialog box.

To access the excitation frequency, f, use the variable freq, and to access the angular 
excitation frequency, ω, use omega.

Specify the coordinates of the point around which you want both your reaction and 
applied moments to be calculated in the refpnt edit fields.

Material Properties

The material properties are defined on the Material page in the Boundary Settings dialog 
box for the 2D in-plane Euler beam and in the Edge Settings dialog box for the 3D 
Euler beam.

The material properties are shown in the table below.

Young’s modulus    Defines the modulus of elasticity, E of the material. It is the spring 
stiffness in Hooke’s law, shown below in 1D form 

PARAMETER VARIABLE DESCRIPTION COMMENT

 E E Young's modulus 

 ν nu Poisson's ratio Only 3D Euler beam

 ρ rho Density

 α alpha Thermal expansion coefficient
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where σ is the stress and ε is the strain.

Poisson’s ratio   Denoted by ν, defines the normal strain in the perpendicular direction, 
generated from a normal strain in the other direction.

Used to calculate the shear modulus G, used in the torsional part of the 3D Euler 
beam.

Density   This material property, ρ, specifies the density of the material. 

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature. 

where εth is the thermal strain, ∆Ty and ∆Tz are the temperature difference over the 
cross section of the beam in the y and z directions, and α is the thermal expansion 
coefficient. Tm is the temperature in the middle and Tref is the stress free reference 
temperature.

σ Eε=

ε⊥ υεl l–=

εth α Tm ∆Tz
z
h
--- ∆Ty

y
h
--- Tref–+ +⎝ ⎠

⎛ ⎞=
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Cross Section

The cross-sectional properties are defined on the Cross-Section page in the Edge Settings 
or Boundary Settings dialog box.

The following table lists the cross-section properties:

3D beams modeled on edges need a local coordinate system for a number of reasons:

• Input data—you need a coordinate system to specify input data such as area moment 
of inertia.

PARAMETER VARIABLE DESCRIPTION COMMENT

 A A Cross-sectional area

 Iyy Iyy Area moment of inertia about local y-axis

 Izz Izz Area moment of inertia about local z-axis 3D Euler beam o

 J J Torsional constant 3D Euler beam o

 heighty (hy) heighty Total section height in the y direction

 heightz (hz) heightz Total section height in the z direction 3D Euler beam o

 localxp localxp x-coordinate for point defining local xy-plane 3D Euler beam o

 localyp localyp y-coordinate for point defining local xy-plane 3D Euler beam o

 localzp localzp z-coordinate for point defining local xy-plane 3D Euler beam o
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• Postprocessing—if you want to look at bending moments or shear forces, you must 
know the direction of the coordinate system.

• Loads—if you want to apply loads in a local coordinate system you need to be able 
to specify it.

If your beam’s cross section is a square or circle (solid or tube), the area moments of 
inertia are the same independent of direction, so the beam is totally symmetric and you 
do not need to worry about the local coordinate system unless you are interested in 
looking at results defined using the local coordinate system. Such results are bending 
moments, shear forces, local displacements and rotations. 

The coordinate system is defined in the following way. The x direction is in the edge 
direction. The positive edge direction can be checked by plotting the edge arc length 
parameter s1 and see in what direction it increases. You can also plot the tangential 
variable t1x, t1y, and t1z to check the direction of the edge. The coordinates of an 
additional point (localxp, localyp, and localzp), specified on the Cross-Section 
page in the Edge Settings dialog box, defines the local xy-plane with the positive 
y direction defined so that the point lies in the positive quadrant. See the previous 
dialog box and the following figure.

For the creation of a local coordinate system to be possible, the point cannot coincide 
with the edge or the edge extension. If you do this you get an error message: Point 

defining beam local xy-plane coincides with edge.
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This error might occur even if you have a totally symmetric cross section and do not 
have to worry about the direction. If this happens you must enter coordinates far away 
from your edge and not along the edge extension. You can do this for a number of 
edges at the same time using a point far away from the geometry.

Note: The default settings for the global coordinates of the point are [1,1,0].

Usually a number of edges in a plane have the same orientation. It is then easy to select 
all edges and specify a point anywhere in the same plane, not coinciding with an edge 
or an edge extension.

Constraint

A constraint specifies the displacement and rotation of a certain part of the beam. 
Constraints can be defined on all valid domain levels such as points, edges, and 
boundaries. The constraint is controlled from the Constraint page in the Boundary 

Settings, Edge Settings, and Point Settings dialog boxes.

An example of a beam application mode Constraint page, taken here from the 3D Euler 
Beam application mode Points Settings dialog box.
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CONSTRA

Free

Pinned tion

Fixed fixed 

No rota ns

Prescrib  to be 

Symmetr

x-y symm metry 

y-z symm metry 

x-z symm metry 

Antisym

x-y antis

y-z antis

x-z antis

Prescrib ed to 
e 

Prescrib ection 
 

The figure shows the Constraint page of the Edge Settings dialog box for the 3D Euler 
beam application mode. The page looks similar on all domain levels in both of the 
beam application modes, differing only regarding the variables to constrain:

• For the 2D Euler beam, two displacement and one rotation.

• For the 3D Euler beam, three displacements and three rotations.

Within the dialog box, the Constraint condition list lets you control what type of 
constraint you want to define. You have the following options to choose between:

INT CONDITION POINT BOUNDARY/
EDGE 

USE WHEN

 √  √ The domain has no constraint

 √  √ The displacement in the domain is fixed in all direc

 √  √ The displacement and rotations in the domain are 
in all directions

tion  √  √ The rotations in the domain are fixed in all directio

ed displacement  √  √ The displacement or rotation in any direction need
prescribed

y plane √  (2D only) The boundary is a symmetry plane

etry plane  √  √ The selected coordinate system’s xy-plane is a sym
plane

etry plane  √  √ The selected coordinate system’s yz-plane is a sym
plane

etry plane  √  √ The selected coordinate system’s xz-plane is a sym
plane

metry plane  √ (2D only) The boundary is an antisymmetry plane

ymmetry plane  √  √ The selected coordinate system’s xy-plane is an 
antisymmetry plane

ymmetry plane  √  √ The selected coordinate system’s yz-plane is an 
antisymmetry plane

ymmetry plane  √  √ The selected coordinate system’s xz-plane is an 
antisymmetry plane

ed velocity  √  √ The velocity and angular velocity in any direction ne
be prescribed, only available for frequency respons
analysis

ed acceleration  √  √ The acceleration or angular acceleration in any dir
need to be prescribed, only available for frequency
response analysis
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The symmetry or antisymmetry condition has the following interpretation.

With the Coordinate system list you control in what coordinate system the constraint is 
defined. Available options are:

• Global coordinate system

• Tangential and normal coordinate system, only available on boundaries for the 2D 
Euler beam.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system chapter.

• Beam local coordinate system, only available on edges for the 3D Euler beam.

CONDITION X-DISP. Y-DISP. Z-DISP. X-ROT. Y-ROT. Z-ROT.

x-y symmetry plane  √  √  √

y-z symmetry plane  √  √  √

x-z symmetry plane  √  √  √

x-y antisymmetry plane  √  √  √

y-z antisymmetry plane  √  √  √

x-z antisymmetry plane  √  √  √
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When you select Prescribed displacement a number of new option appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation you constrain each displacement direction independently. The 
check box in front of Rx, Ry, Rz, Rthx, Rthy, and Rthz activates the constraint, the value/
expression of the displacement/rotation can then be entered in the edit fields. The 
default value is 0.

• In general notation, the H matrix and R vector in the relation

make it possible to specify constraints as any linear combination of the available 
variables.

For the 2D Euler beam application mode the relation is

For the 3D Euler beam application mode the relation is

Hu R=

H
u
v
θ

R=
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The H matrix and R vector are entered in special matrix dialog boxes by clicking the 
corresponding Edit buttons. For example the condition u = v in the 2D Euler beam 
application mode can be achieved using the settings

which force the domain to move only diagonally in the xy-plane.

The H Matrix dialog box for the above example is 

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement and rotation but also a harmonic velocity/angular velocity or 

H

u
v
w
θx

θy

θz

R=

H
1 1– 0
0 0 0
0 0 0

= R
0
0
0

=
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acceleration/angular acceleration. You specify the Prescribed velocity and Prescribed 

acceleration in the same way as Prescribed displacement using Standard notation.

Constraint page showing the Prescribed acceleration settings.

Load

Load is a general name for forces and moments applied to, the structure. Loads can be 
specified on all domain types. You specify loads on the Load page in the Boundary 

Settings, Edge Settings, and Point Settings dialog boxes. The following picture shows the 
R  8 :  B E A M S



Boundary Settings dialog box for the 2D Euler beam application mode, but the page 
looks similar on all domain levels.

The loads/moments are defined in the following way. The SI unit is shown in 
parenthesis.

With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Global coordinate system 

• Tangential and normal coordinate system, only available on boundaries for the 2D 
Euler beam.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

• Beam local coordinate system, only available on edges for the 3D Euler beam.

For the frequency response analysis type, additional input data is specified. You control 
the analysis type from the Application Mode Properties dialog box. If you select 
frequency response as analysis type, the Load page changes appearance to looks like the 
following image:

DOMAIN TYPE LOAD (UNIT) MOMENT (UNIT)

point force (N) moment (Nm)

edge, boundary force/length (N/m) moment/length (N)
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For frequency response analysis the harmonic load is split into 3 different parameters:

• The amplitude value (F, M) 

• The amplitude value factor (FAmp, MAmp) (a dimensionless number; the default 
value is 1)

• The phase (FPh, MPh) 

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency f:

On the edge and boundary domain levels additional options are available controlling 
if and how thermal strains should be included in the analysis. They are explained in the 
section “Thermal Coupling” on page 292.

Discrete Mass

Discrete mass or mass moment of inertia are concentrated to a point in contrast to 
distributed mass modeled through the density and area of the beam. You specify 

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
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discrete mass and mass moment of inertia on the Mass page in the Point Settings dialog 
box.

With the Coordinate system list you control in what coordinate system the principal 
mass moment of inertias are defined (only possible for 3D Euler beams). Available 
options are:

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in “Coordinate Systems” on page 
98.

The mass properties are shown in the following table:

PARAMETER VARIABLE DESCRIPTION SI UNIT COMMENT

 m m Mass kg

 Jx Jx Mass moment of inertia about x-axis kg·m2 Only 3D Euler beam

 Jy Jy Mass moment of inertia about x-axis kg·m2 Only 3D Euler beam

 Jz Jz Mass moment of inertia about x-axis kg·m2

 αdM alphadM Mass damping parameter 1/s
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Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The beams can handle any temperature variation along the beam, and linear 
variation across the beam. The thermal strains together with the initial strains and 
elastic strains from structural loads form the total strain.

where

Thermal coupling means that the thermal expansion is included in the analysis. Details 
on thermal coupling is found on page 274. Thermal effects are specified on the Load 
page in the Edge Settings and Boundary Settings dialog boxes.

The Include thermal expansion check box adds thermal effects. In the Temp and Tempref 
edit fields the strain temperature in the middle of the cross section, Tm and stress free 
reference temperature Tref are specified. In the dTy and dTz edit fields the temperature 
difference across the beams cross section, ∆Ty and ∆Tz is specified. The thermal 
expansion coefficient are specified on the Material page, described in the Material 
section on page 279. Tm, Tref, ∆Ty, and ∆Tz can be any expression and are typically 

ε εel εth εi+ +=

εth α Tm ∆Tz
z
hz
------ ∆Ty

y
hy
------ Tref–+ +⎝ ⎠

⎛ ⎞=
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another variable solved for in an application mode. The temperature coupling can be 
used in any type of analysis.

Damping

In transient, damped eigenfrequency, and frequency response analyses you have the 
possibility to model undamped or damped problems. In the Structural Mechanics 
Module you can specify damping in the subdomain level using the Damping page that 
appears in the Boundary Settings (2D) or Edge Settings (3D) dialog box. From the 
Damping models list you can select No damping, Rayleigh, or Loss factor, and the layout 
of the dialog box changes for each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for damped eigenfrequency and frequency 
response analysis. If you choose transient analysis and loss factor damping, the model 
will be solved with no damping.

Table 8-1 and the following text describe the parameters that define damping:

TABLE 8-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh
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Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

Initial Load and Strain

Initial stress and strain can be included in the analysis. For the beam formulations the 
initial stresses transforms to initial internal beam moments, initial torsional moment, 
and initial normal force. The initial strains consists of initial curvatures, initial torsional 
angle derivative, and initial axial strain. Initial load and strain can be viewed as different 
ways to express the same thing. Initial load and strain are specified on the Initial Load 

and Strain page in the Edge Settings and Boundary Settings dialog boxes.

 βdK betadK Stiffness-damping parameter Rayleigh

 ηs eta_s Loss factor Loss factor

TABLE 8-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL
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The option to include initial forces and moments and initial curvature and strain is 
controlled independently using the two check boxes Include initial axial force and 

moments and Include initial strain and curvature.
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I n - P l a n e  Eu l e r  B e am

Use the In-Plane Euler Beam application mode to analyze planar lattice works of 
uniaxial beams.

In-plane Euler beams are defined on edges in 2D. All settings for the application mode 
are described in “Application Mode Description” on page 277.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions and the rotation θ about the global z-axis.
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3D Eu l e r  B e am

Use the 3D Euler Beam application mode to model three-dimensional frameworks of 
uniaxial beams.

3D Euler beams are defined on edges in 3D. All settings for the application mode 
appear in “Application Mode Description” on page 277.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u, v, w in 
the global x, y, z directions and the global rotations θx, θy, and θz about the global x-, 
y-, and z-axes.
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 9
T r u s s e s
Trusses are elements that can only sustain axial forces. They have displacements as 
degrees of freedom. Trusses are sometimes referred to as bars or spars. They live on 
boundaries in 2D and edges in 3D. The truss application modes support the same 
analysis types as the continuum application modes. You can use trusses to model 
truss works where the edges are straight but also to model sagging cables like the 
deformation of a wire exposed to gravity. In such applications trusses are often 
referred to as cable elements.
 299
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Th eo r y  Ba c k g r ound

Trusses is modeled using Lagrange shape function. The Lagrange shape function 
makes it possible to specify both normal strains and Green-Lagrange strains to handle 
small strains as well as large deformations.

Strain-Displacement Relation

The axial strain εn is calculated by expressing the global strains in tangential derivatives 
and projecting the global strains on the edge.

 (9-1)

where t is the edge tangent vector and εgT is defined as

 (9-2)

The strains can be expressed as either engineering strains for small displacements or 
Green strains for large displacements. The Green strain tensor used for large 
displacements is defined as

 (9-3)

The engineering strain tensor used for small displacements is defined as

 (9-4)

The axial strain written out becomes

 (9-5)

εn ttεgTt=

εgT

εxT εxyT εxzT

εxyT εyT εyzT

εxzT εyzT εzT

=

εijT
1
2
---

xj∂
∂ui

T
xi∂

∂uj

T
xi∂

∂uk

T
xj∂

∂uk

T

⋅+ +
⎝ ⎠
⎜ ⎟
⎛ ⎞

=

εijT
1
2
---

xj∂
∂ui

T
xi∂

∂uj

T

+
⎝ ⎠
⎜ ⎟
⎛ ⎞

=

εn tx εxTtx εxyTty εxzTtz+ +( ) +=

ty εxyTtx εyTty εyzTtz+ +( ) +

tz εxzTtx εyzTty εzTtz+ +( )
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Stress-Strain Relation

The constitutive relation for the axial stress including thermal strain and initial stress 
and strain is

 (9-6)

Implementation

Using the principle of virtual work results in the following weak formulation

 (9-7)

where the summation stands for summation over all points in the geometry. Replacing 
the integration over the cross section with the cross-sectional area (A) and the volume 
forces with line forces, the equation becomes

 (9-8)

Straight Edge Option

The optional constraint to enforce the nodes to lie on the straight line between the end 
points of the edge are formulated as follows:

Starting with the large displacement case, let xd1 and xd2 be the deformed position of 
the two end points of the edge

 (9-9)

where ui is the displacement, and xi is the coordinate (undeformed position) at end 
point i. The equation for the straight line through the end points is

 (9-10)

where t is a parameter along the line, and a is the direction vector for the line. a is 
calculated from the deformed position of the end points as 

 (9-11)

σn E εn α T Tref–( )– εni–( ) σni+=

δW d εnσn– utFV+( ) Vd
V
∫ utFPi

i
∑+=

δW εntestσnA– utest
t FL+( ) Ld

L
∫ utest

t FPi

i
∑+=

xdi ui xi+=

x u+ xd1 ta+=

a xd2 xd1–=
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The constraints for the edge is derived by substituting the parameter t from one of the 
scalar equations in Equation 9-10 into the remaining ones. In 2D the constraint 
equations become

 (9-12)

In 3D the two constraints equations become

 (9-13)

To avoid problems when the edge is directed in one of the coordinate axes directions, 
a third constraint is added. This constraint is a linear combination of the two earlier 
constraints:

 (9-14)

You need a linear constraint in order for the solution of the small displacement 
problem to become independent of the solver. The linear relation for the displacement 
is

 (9-15)

where uax is the axial displacement along the edge, and xn are a linear parameter along 
the edge

 (9-16)

Eliminating uax from Equation 9-15 results in the following linear constraint in 2D

 (9-17)

and the following three linear constraints in 3D:

x u xd1–+( )ay y v yd1–+( )ax–

x u xd1–+( )az z w zd1–+( )ax–

y v yd1–+( )az z w zd1–+( )ay–

y v yd1–+( )ax x u xd1–+( )ay–

u
u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ uax x2 x1–( )+=

xn
x x2 x1–( ) y y2 y1–( ) z z2 z1–( )+ +

x2 x1–( )2 y2 y1–( )2 z2 z1–( )2
+ +

--------------------------------------------------------------------------------------------=

u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ u– y2 y1–( ) –

v1 xn2 xn–( ) v2 xn xn1–( )+

xn2 xn1–( )
---------------------------------------------------------------------- v– x2 x1–( ) 0=
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 (9-18)

u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ u– z2 z1–( ) –

w1 xn2 xn–( ) w2 p xn1–( )+

xn2 xn1–( )
----------------------------------------------------------------------- w– x2 x1–( ) 0=

v1 xn2 xn–( ) v2 xn xn1–( )+

xn2 xn1–( )
---------------------------------------------------------------------- v– z2 z1–( ) –

w1 xn2 xn–( ) w2 xn xn1–( )+

xn2 xn1–( )
-------------------------------------------------------------------------- w– y2 y1–( ) 0=

v1 xn2 xn–( ) v2 xn xn1–( )+

xn2 xn1–( )
---------------------------------------------------------------------- v– x2 x1–( ) –

u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ u– y2 y1–( ) 0=
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a truss model. It is divided into the following 
sections:

• Properties

• Scalar Variables

• Material

• Cross Section

• Constraint

• Load

• Thermal Coupling

• Initial Stress and Strain

Properties

To open the Application Mode Properties dialog box, choose Properties from the Physics 
menu.
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In the Application Mode Properties dialog box you control different global settings for 
the model.

• Default element type: The selected finite element type that makes up the discretized 
finite element model is the default on all new boundaries/edges, and the choice 
does not affect boundaries/edges already created. Available elements are:

-  Lagrange - Linear

-  Lagrange - Quadratic

-  Lagrange - Cubic

-  Lagrange - Quartic

-  Lagrange - Quintic

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers:

• Large deformation: This list controls whether or not the model should support large 
deformations.

• Specify eigenvalues using: This list controls how to work with eigenmode analyses. 
Here you should specify Eigenvalue or Eigenfrequency/Critical load factor; this 
property is enabled only for eigenfrequency and linear-buckling analyses.

• Weak constraints: Controls whether or not weak constraints are active. When weak 
constraints are enabled, all constraints are weak by default, but it is possible to 
change this setting for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 351 in the COMSOL Multiphysics Modeling Guide).

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenfrequency/Eigenvalue

Damped Eigenfrequency Eigenfrequency/Eigenvalue

Transient Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

Linear Buckling Eigenvalue
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Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency.

• Reference point coordinates, used for applied and reaction moment computations. 

The Application Scalar Variables dialog box in a frequency response analysis.

The excitation frequency is the frequency of the harmonic loads/constraints in a 
frequency response analysis.

When you select a frequency response analysis, the parametric solver becomes the 
default solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case, choose Solve>Solver Parameters, and in the 
dialog box that appears go to the General page. In the Parameter area, enter 
freq_smsld in the Parameter names edit field. Values that you enter in the Parameter 

values edit field override the excitation frequency you might have entered in the 
Application Scalar Variables dialog box.

To access the excitation frequency, f, use the variable freq, and to access the angular 
excitation frequency, ω, use omega.

Specify the coordinates of the point around which you want both your reaction and 
applied moments to be calculated in the refpnt edit fields.
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Material

The material properties are defined on the Material page in the Boundary Settings dialog 
box for the In-Plane Truss and in the Edge Settings dialog box for the 3D Truss.

The material properties are shown in the table below.

Young’s modulus    Defines the modulus of elasticity, E of the material. It is the spring 
stiffness in Hooke’s law, shown below in 1D form 

 

Density   This material property, ρ, specifies the density of the material. 

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature.

where εth is the thermal strain, T is the strain temperature and Tref is the stress free 
reference temperature.

PARAMETER VARIABLE DESCRIPTION

 E E Young’s modulus 

 ρ rho Density

 α alpha Thermal expansion coefficient

σ Eε=

εth α T Tref–( )=
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The Constrain edge to be straight (truss) and Allow edge to have sag (cable) buttons 
control the addition of an additional constraint, forcing the edge to be straight. The 
default is to add the constraint. Using this additional constraint removes the need to 
use a mesh with only one element per edge. The problem with internal nodes is that 
they makes the problem singular because the truss only has stiffness in the axial 
direction. The same applies when using higher-order elements. The additional 
constraint increases the solution time, especially for large 3D and transient problems. 
The remedy to this is to turn off the constraint option (click the Allow edge to have sag 

(cable) button) and use linear elements together with a very coarse mesh consisting of 
only one element/edge. 

For problems where you want to model the sag and do not have a straight line between 
the edge points, click the Allow edge to have sag (cable) button and use that setting 
together with the Large deformation option and a suitable mesh with internal nodes.

Cross-Section Properties

You define cross-sectional properties on the Cross Section page in the Edge Settings/
Boundary Settings dialog box.

The only cross-section property in these application modes is the cross-section area:

PARAMETER VARIABLE DESCRIPTION COMMENT

 A A Cross-section area
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Constraints

A constraint specifies the displacement of a certain part of the truss. Constraints can be 
defined on all valid domain levels such as points and edges/boundaries. You control 
the constraints from the Constraint page in the Boundary Settings, Edge Settings, and 
Point Settings dialog boxes.

The following figure shows the Boundary Settings dialog box for the 3D Truss 
application mode, but the page looks similar on all domain levels in both truss 
application modes.

An example of a truss Constraint page, taken here from the 3D Truss application mode 
Edge Settings dialog box.

Within the dialog box, use the Constraint condition list to specify the type of constraint. 
You can choose from the following options:

CONSTRAINT CONDITION POINT BOUNDARY/
EDGE

USE WHEN

Free  √  √ The domain has no constraint

Pinned  √ √ The displacement in the domain is fixed 
in all directions

Roller  √ (2D only) The normal displacement is constrained

Prescribed displacement  √  √ The displacement in any direction need 
to be prescribed

Symmetry plane  √ (2D only) The boundary is a symmetry plane
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The symmetry or antisymmetry condition has the following interpretation.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system 

• Tangential and normal coordinate system, only available on boundaries for the in-
plane truss.

x-y symmetry plane  √ The selected coordinate system’s xy-
plane is a symmetry plane

y-z symmetry plane  √ The selected coordinate system’s yz-
plane is a symmetry plane

x-z symmetry plane √ The selected coordinate system’s xz-
plane is a symmetry plane

Antisymmetry plane √ (2D only) The boundary is an antisymmetry plane

x-y antisymmetry plane  √ The selected coordinate system’s xy-
plane is an antisymmetry plane

y-z antisymmetry plane  √ The selected coordinate system’s yz- 
plane is an antisymmetry plane

x-z antisymmetry plane  √ The selected coordinate system’s xz-
plane is an antisymmetry plane

Prescribed velocity  √  √ The velocity in any direction need to be 
prescribed (only available for frequency 
response analysis)

Prescribed acceleration  √  √ The acceleration in any direction need 
to be prescribed (only available for 
frequency response analysis)

CONSTRAINT CONDITION POINT BOUNDARY/
EDGE

USE WHEN

CONDITION X-DISPLACEMENT Y-DISPLACEMENT Z-DISPLACEMENT

x-y symmetry plane  √

y-z symmetry plane  √

x-z symmetry plane  √

x-y antisymmetry plane  √  √

y-z antisymmetry plane  √  √

x-z antisymmetry plane  √  √
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• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the section “Coordinate 
Systems” on page 98.

When you select Prescribed displacement a number of new options appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation you constrain each displacement direction independently. The 
check box in front of Rx, Ry, and Rz activates the constraint, and you can then enter 
the value or expression for the displacement in the corresponding edit fields. The 
default value is 0 (no displacement).

• In general notation, the H matrix and R vector in the relation

make it possible to specify constraints as any linear combination of the available 
variables.

For the In-Plane Truss application mode the relation is

For the 3D Truss application mode the relation is

Hu R=

H u
v

R=
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To enter the H matrix and the R vector, use special matrix dialog boxes that you 
open by clicking the corresponding Edit buttons. For example, you can achieve the 
condition u = v in the In-Plane Truss application mode using the settings

,

which force the domain to move only diagonally in the x-y plane.

The H Matrix dialog box for the above example is

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify your Prescribed 

velocity and Prescribed acceleration in the same way as Prescribed displacement using 
Standard notation.

Constraint page showing the Prescribed acceleration settings.

H
u
v
w

R=

H 1 1–

0 0
= R 0

0
=

R  9 :  TR U S S E S



Loads

A load is a general name for all forces applied to the structure. You can specify loads 
on all domain types using the Load page in the Boundary Settings, Edge Settings, and 
Point Settings dialog boxes. The following picture shows the Boundary Settings dialog 
box for the In-Plane Truss application mode, but the page looks similar on all domain 
levels.

The loads are defined in the following way. The SI unit is shown in parenthesis.

With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Global coordinate system 

• Tangential and normal coordinate system, only available on boundaries for the in-
plane truss.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the section “Coordinate 
Systems” on page 98.

POINT EDGE, BOUNDARY

force (N) force/length (N/m)
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For the frequency response analysis type, you need to specify additional input data. The 
analysis type is controlled from the Application Mode Properties dialog box. When 
frequency response is selected as analysis type, the Load page changes appearance to

For frequency response analysis the harmonic load is split into 3 different parameters:

• the amplitude value, F

• the amplitude factor, FAmp (a dimensionless number; the default value is 1)

• the phase (FPh)

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency f.

On the edge and boundary domain level additional options are available controlling if 
and how thermal strains should be included in the analysis. They are explained in the 
section “Thermal Coupling” on page 315.

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
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Discrete Mass

Discrete mass is concentrated to a point in contrast to distributed mass modeled 
through the density and area of the truss. You specify discrete mass on the Mass page 
in the Point Settings dialog box.

The mass properties are shown in the table below.

Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The trusses can handle any temperature variation along the truss. The 
thermal strains together with the initial strains and elastic strains from structural loads 
form the total strain.

where 

PARAMETER VARIABLE DESCRIPTION SI UNITS

 m m Mass kg

 αdM alphadM Mass damping parameter 1/s

ε εel εth εi+ +=

εth α T Tref–( )=
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Thermal coupling means that the thermal expansion is included in the analysis. Details 
on thermal coupling is found on page 301. Thermal effects are specified on the Load 
page in the Edge Settings or Boundary Settings dialog box.

The Include thermal expansion check box adds thermal effects. In the Temp and Tempref 
edit fields you specify the strain temperature T and stress free reference temperature 
Tref, respectively. Use the Material page to define the thermal expansion coefficient 
(described in “Material” on page 307). T and Tref can be any expression and can be a 
dependent variable for temperature from another application modes solving the heat 
transfer problem. The temperature coupling can be used in any type of analysis.

Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping on the subdomain level using the Damping page that appears in the Boundary 

Settings (2D) or Edge Settings (3D) dialog box. From the Damping models list you can 
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select No damping, Rayleigh, or Loss factor, and the layout of the dialog box changes for 
each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response and damped 
eigenfrequency analysis. If you choose transient analysis and loss factor damping, 
COMSOL Multiphysics solves the model with no damping.

Table 9-1 and the following text describe the parameters that define damping:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

TABLE 9-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 ηs eta_s Loss factor Loss factor
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Initial Stress and Strain

The analysis can include initial stress and strain. You specify the initial stress and strain 
on the Initial Stress and Strain page in the Edge Settings or Boundary Settings dialog box.

It is possible to control the options to include initial stress and strain independently 
using the Include initial stress and Include initial strain check boxes.
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I n - P l a n e  T r u s s  App l i c a t i o n  Mode

Use the In-Plane Truss application mode to analyze planar lattice trusses or sagging 
cable-like structures.

In-Plane Truss application modes are defined on edges in 2D. All settings for the 
application mode are described in “Application Mode Description” on page 304.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, respectively.
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3D T r u s s  App l i c a t i o n  Mode

Use the 3D Truss application mode to model three-dimensional trusses or sagging 
cable-like structures.

3D Truss application modes are defined on edges in 3D. All settings for the application 
mode appear in “Application Mode Description” on page 304.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u, v, and 
w in the global x, y, and z directions, respectively.
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S h e l l s
A shell is a thin-walled structure in 3D where you can assume a simple form for 
the displacement’s variation through the thickness. Using this approximation, it is 
possible to develop a model for the deformation that is closer to the 2D plane stress 
and Mindlin plate application modes than to the 3D solid. For this to give accurate 
results it is important that the structure can really be described as thin-walled. 
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When modeling using shells it is important to remember that the faces should be 
defined in the midplane of the real geometry.

A Shell application mode can be active either on free surfaces embedded in 3D or on 
the boundary of a solid 3D object. In the latter case, it can be used to model a 
reinforcement that stiffens the surface of a 3D solid.

The shell is described by its thickness and the material properties E, ρ, ν, αdM, and βdK. 
All properties are evaluated as constant within any mesh element but can vary from one 
element to the next.

The element used for the shell application mode is of Mindlin-Reissner type, which 
means that transverse shear deformation is accounted for. Because the element is a 
flat-faceted triangle, the membrane and bending actions are uncoupled. The 
membrane action is modeled by a constant-strain triangle with true drilling rotations 
(Allman triangle, D. J. Allman; see Ref. 1). The bending action is modeled by the 
bending part of an Argyris TRIC triangle element; see J. Argyris et al. (Ref. 2) and C. 
Pacoste (Ref. 3) for further details.

Note: The shell application mode requires a triangular mesh and will not work with a 
quadrilateral mesh.

The dependent variables are the displacements u, v, and w in the global x, y, and z 
directions, and the rotations θx, θy, and θz about the global coordinate axes. The 
degrees of freedom defined by the shell element correspond to the values of the 
dependent variables in the three triangle vertices.

In contrast to the rest of the Structural Mechanics Module, the Shell application mode 
contains a mixture between a user-modifiable variational equation and a low-level 
element. The stiffness and mass matrices are assembled directly by the low-level shell 
element class (see the documentation of elshell_arg2 in the COMSOL Multiphysics 
Reference Guide for details), but the constraints and loads are assembled by linear 
Lagrange elements. Therefore the Shell application mode has somewhat limited 
multiphysics capabilities: The presence of dependent variables in expressions for the 
material properties are not accounted for in the Jacobian. It is possible, however, to 
use the dependent variables of another application mode in the loads on the shell.
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a shell model. It is divided into the following 
sections:

• Properties

• Scalar Variables

• Material

• Constraint

• Load

• Postprocessing

Properties

The Application Mode Properties dialog box is opened from the Physics menu.

In the Application Mode Properties dialog box you control different global settings for 
the model.

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers. 

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenfrequency/Eigenvalue

Damped Eigenfrequency Eigenfrequency/Eigenvalue

Transient Time dependent

Frequency response Parametric
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• Specify eigenvalues using: Controls if eigenvalues or eigenfrequencies should be used 
when specifying parameters for the eigenvalue solver and if the result is returned as 
eigenvalues or eigenfrequencies.

• Weak constraints: Controls whether or not weak constraints are active. When weak 
constraints are enabled, all constraints are weak by default, but it is possible to 
change this setting for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 351 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency.

• Reference point coordinates, used for applied and reaction moment computations. 

The Application Scalar Variables dialog box in a frequency response analysis.

The excitation frequency is the frequency of the harmonic loads in a frequency 
response analysis. 

When you select a frequency response analysis, the parametric solver becomes the 
default solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case, choose Solve>Solver Parameters, and in the 
dialog box that appears go to the General page. In the Parameter area, enter 

Parametric Parametric

Quasi-static transient Time dependent

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
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freq_smsld in the Parameter names edit field. Values that you enter in the Parameter 

values edit field override the excitation frequency you might have entered in the 
Application Scalar Variables dialog box.

To access the excitation frequency, f, use the variable freq, and to access the angular 
excitation frequency, ω, use omega.

Specify the coordinates of the point around which you want both your reaction and 
applied moments to be calculated in the refpnt edit fields.

Material

The material properties are defined on the Material page in the Boundary Settings dialog 
box.

The material properties are shown in the table below.

PARAMETER VARIABLE DESCRIPTION

 E E Young's modulus 

 ν nu Poisson's ratio 

 Sf Sf Shear factor

 ρ rho Density

 α alpha Thermal expansion coefficient
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Young’s modulus    Defines the modulus of elasticity, E of the material. For an isotropic 
material, it is the spring stiffness in Hooke’s law, shown below in 1D form

 

where σ is the stress and ε is the strain.

Poisson’s ratio   Denoted by ν, defines the normal strain in the perpendicular direction, 
generated from a normal strain in the other direction.

Shear factor   Denoted by Sf, the shear factor affects the shear stiffness. For a 
homogeneous material, Sf = 1.2.

Density   This material property, ρ, specifies the density of the material.

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature:

where εth is the thermal strain and α is the thermal expansion coefficient. The thermal 
expansion coefficient models thermal strain in the material.

Thickness   Defines the thickness of the shell.

Mass damping parameter   Defines the Rayleigh damping models mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping models stiffness damping, 
βdK.

Constraint

A constraint specifies the displacements and rotations of certain parts of a shell. 
Constraints can be defined on all domain levels such as points, edges, and faces. The 

 th thickness Thickness

 αdM alphadM Mass damping parameter

 βdK betadK Stiffness damping parameter

PARAMETER VARIABLE DESCRIPTION

σ Eε=

ε⊥ υεl l–=

εth α T Tref–( )=
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CONSTRA

Free

Pinned tions

Fixed fixed 

No rota ns

Prescrib  to be 

Symmet

x-y symm metry 

y-z symm metry 
constraint is controlled from the Constraint page in the Boundary/Edge/Point Settings 
dialog boxes.

Below is the Boundary Settings dialog box.

The Constraint page from the Boundary Settings dialog box.

Within the dialog box the Constraint condition list lets you control what type of 
constraint you want to define. You have the following options to choose between:

INT CONDITION EDGE BOUNDARY USE WHEN

 √  √ The domain has no constraint

 √  √ The displacement in the domain is fixed in all direc

 √  √ The displacement and rotations in the domain are 
in all directions

tion  √  √ The rotations in the domain are fixed in all directio

ed displacement  √  √ The displacement or rotation in any direction need
prescribed

ry plane  √ The boundary is a symmetry plane

etry plane  √  √ The selected coordinate system’s x-y plane is a sym
plane

etry plane  √  √ The selected coordinate system’s y-z plane is a sym
plane
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x-z symm metry 

Antisym

x-y antis

y-z antis

x-z antis

Prescrib ed to 
e 

Prescrib ction 
 

CONSTRA
The symmetry or antisymmetry condition has the following interpretation.

With the Coordinate system list you control in what coordinate system the constraint is 
defined. Available options are:

• Tangential and normal coordinate system, only applicable on faces.

• Shell local coordinate system, only applicable on faces.

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

etry plane  √  √ The selected coordinate system’s x-z plane is a sym
plane

metry plane  √ The boundary is an antisymmetry plane

ymmetry plane  √  √ The selected coordinate system’s x-y plane is an 
antisymmetry plane

ymmetry plane  √  √ The selected coordinate system’s y-z plane is an 
antisymmetry plane

ymmetry plane  √  √ The selected coordinate system’s x-z plane is an 
antisymmetry plane

ed velocity  √  √ The velocity and angular velocity in any direction ne
be prescribed, only available for frequency respons
analysis

ed acceleration  √  √ The acceleration or angular acceleration in any dire
need to be prescribed, only available for frequency
response analysis

INT CONDITION EDGE BOUNDARY USE WHEN

CONDITION X-DISP Y-DISP Z-DISP X-ROT Y-ROT Z-ROT

x-y symmetry plane  √  √  √

y-z symmetry plane  √  √  √

x-z symmetry plane  √  √  √

x-y antisymmetry plane  √  √  √

y-z antisymmetry plane  √  √  √

x-z antisymmetry plane  √  √  √
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When you select Prescribed displacement a number of new option appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

The constraint can be described using standard or general notation. This is controlled 
with the Standard notation button and the General notation, Hu=R button.

In standard notation you constrain the displacement and rotations independently. The 
check box in front of Rx, Ry, Rz, Rthx, Rthy, and Rthz activates the constraint, the value/
expression of the displacement can then be entered in the edit fields. The default value 
is 0.

In general notation, the H matrix and the R vector, related by the equation

let you specify constraints as any linear combination of displacement and rotation 
components. You enter the H matrix and the R vector in special matrix dialog boxes 

H

u
v
w
θx

θy

θz

R=
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by clicking the corresponding Edit buttons. For example the condition θx = θy can be 
achieved using the settings

The H Matrix dialog box for the above example is

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement and rotation but also a harmonic velocity/angular velocity or 
acceleration/angular acceleration. You specify your Prescribed velocity and Prescribed 

acceleration in the same way as Prescribed displacement using Standard notation.

Constraint page showing the Prescribed velocity settings.

H

0 0 0 1 1– 0
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0

,= R 0
0

=
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Loads

Load is a general name for forces and moments applied to the structure. You can 
specify loads on all domain types. To do so, click the Load tab in the Boundary Settings, 
Edge Settings, and Point Settings dialog boxes. The following picture shows the Point 

Settings dialog box, but the page looks similar on all domain levels. 

In the Boundary Settings and Edge Settings dialog boxes you have an option to specify 
the load in different ways using the thickness. The loads can be defined on different 
domains in the following way. The SI unit is shown in parenthesis.

With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Tangential and normal coordinate system, only applicable on faces.

• Shell local coordinate system, only applicable on faces.

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

POINT EDGE BOUNDARY/FACE

force (N), 
moment (Nm)

force/area (N/m2), moment/area (N/m) or 
force/length (N/m), moment/length (N)

force/volume (N/m3), 
moment/volume (N/m2) or 
force/area (N/m2), moment/
area (N/m)
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For the frequency response analysis type, additional input is specified. The analysis type 
is controlled from the Application Mode Properties dialog box. When frequency 
response is selected as analysis type, the Load page changes appearance:

For frequency response analysis the harmonic load is split in three different parameters:

• The amplitude value, F

• The amplitude factor, FAmp (a dimensionless number; the default value is 1)

• The phase (FPh). 

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency f.

Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The thermal strains together with elastic strains from structural loads form 
the total strain.

where 

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=

ε εel εth+=
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Thermal coupling means that the thermal expansion is included in the analysis.

The temperature is assumed to vary linearly through the thickness of the shell.

Thermal effects are specified on the Load page in the Subdomain Settings dialog box.

The Include thermal expansion check box adds thermal effects. In the Temp, Tempref, 
and dT edit fields the strain temperature T, reference temperature Tref, and 
temperature difference through the shell dT are specified. The thermal expansion 
coefficient are specified on the Material page described in the Material section on page 
326. T, Tref, and dT can be any expression and are typically another variable solved for 
in a heat transfer application mode. The temperature coupling can be used in any type 
of analysis.

Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping on the subdomain level using the Damping page that appears in the Boundary 

εth α T Tref–( )=

T T0 ∆T
zl

th
------+=
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Settings dialog box. From the Damping models list you can select No damping, Rayleigh, 
or Loss factor, and the layout of the dialog box changes for each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response and damped 
eigenfrequency analysis. If you choose transient analysis and loss factor damping, 
COMSOL Multiphysics solves the model with no damping.

Table 10-1 and the following text describe the parameters that define damping:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

TABLE 10-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 ηs eta_s Loss factor Loss factor
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Loss factor   Defines the loss factor η for the loss factor damping model.

Postprocessing

The predefined postprocessing variables include all nonzero stress and strain tensor 
components, principal stresses and strains, in-plane and out-of-plane forces, bending 
and torsional moments, and von Mises and Tresca effective stresses. The stress and 
strain tensor components and effective stresses can be evaluated at an arbitrary distance 
from the mid surface. This height is controlled from the Postprocessing page in the 
Boundary Settings dialog box.

With the Evaluate at list you control where the stress and strain should be evaluated, 
available options are:

• Top of shell (default)

• Midplane of shell

• Bottom of shell

• Specified height

Select Specified height to specify a postprocessing height explicitly using the height edit 
field.

The displacements and rotations in radians and, for a transient analysis, the velocities 
and angular velocities can be plotted.
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On the Postprocessing page, you can also specify a local coordinate system. The 
evaluation height, including the top and bottom of shell options, refer to the z axis 
direction in this coordinate system. In postprocessing mode some of the 
postprocessing variables can be plotted in the shell local coordinate system (that is, not 
the local coordinate system (t1, t2, n) defined by the geometry face object). The shell 
local system can be used to specify loads and constraints on faces. The local system is 
defined by a point and a vector in the following way:

The point defines the side of the shell to where the local z-axis is pointing. The local 
z-axis coincides either with the normal vector or with its mirror image with respect to 
the surface. See also the figure below. 

A face geometry object has a unit normal vector n with the components nx, ny, and 
nz. The default setting of the point uses these components and the independent 
variables x, y, and z so that the direction of the local z-axis coincides with n. For 
example the x coordinate’s default setting is nx + x. 

The normal of a face geometry object can switch from one face to the next. The point 
is introduced as a means to specify the direction of the local z-axis irrespective of the 
details of the geometry representation. The point specifies the side where the local 
z-axis is positive.

The vector is used for defining the local x-axis. The vector is denoted xlocal and the 
components of the vector are denoted xlocalx, xlocaly, and xlocalz. The xlocal vector is 
projected onto the boundary surface. The projected vector xl defines the direction of 
A P P L I C A T I O N  M O D E  D E S C R I P T I O N  |  337



338 |  C H A P T E
the local x-axis. The default settings use the geometry vector t1 as xlocal vector, for 
example the x component’s default setting is t1x.
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P i e z o e l e c t r i c  A p p l i c a t i o n  M o d e s  
This chapter describes the application modes for modeling piezoelectric effects in 
the Structural Mechanics Module.
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Th eo r y  Ba c k g r ound

The Piezoelectric Effect

The piezoelectric effect manifests itself as a transfer of electric to mechanical energy 
and vice-versa. It is observable in many crystalline materials, while some materials such 
as quartz, Rochelle salt, and lead titanate zirconate ceramics display the phenomenon 
strongly enough for the phenomenon to be of practical use.

The direct  piezoelectric effect consists of an electric polarization in a fixed direction 
when the piezoelectric crystal is deformed. The polarization is proportional to the 
deformation and causes an electric potential difference over the crystal.

The inverse piezoelectric effect, on the other hand, constitutes the opposite of the 
direct effect. This means that an applied potential difference induces a deformation of 
the crystal.

P I E Z O E L E C T R I C I T Y  C O N V E N T I O N S

The documentation and the user interface use piezoelectricity conventions as far as 
possible. These conventions differ from those used in other structural mechanics 
application modes. For instance, the numbering of the shear components in the 
stress-strain relation differs, as the following section describes. However, the names of 
the stress and strain components remain the same as in the other structural mechanics 
application modes.

Piezoelectrical Constitutive Relations

It is possible to express the relation between the stress, strain, electric field, and electric 
displacement field in either a stress-charge or strain-charge form:

S T R E S S - C H A R G E

S T R A I N - C H A R G E

T cES eTE–=

D eS εSE+=

S sET dTE+=

D dT εTE+=
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The naming convention differs in piezoelectricity theory compared to structural 
mechanics theory, but the piezoelectrical application modes use the structural 
mechanics nomenclature. The strain is named ε instead of S, and the stress is named σ 
instead of T. This makes the names consistent with those used in the other structural 
mechanics application modes.

The numbering of the strain and stress components is also different in piezo and 
structural mechanics theory, and it is quite important to keep track of this aspect in 
order to give the correct material data. In structural mechanics the following is the 
most common numbering convention, and it is also the one used in the other 
structural mechanics application modes:

In contrast, textbooks on piezoelectric effects and the IEEE standard on piezoelectric 
effects use the following numbering convention:

The piezoelectrical application modes employ the immediately preceding piezo 
numbering convention to make it easier to work with materials data and avoid 
mistakes.

The constitutive relation using COMSOL Multiphysics symbols for the different 
constitutive forms are thus:

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

εx

εy

εz

2εxy

2εyz

2εxz

= =

σ

σx

σy

σz

τyz

τxz

τxy

= ε

εx

εy

εz

γyz

γxz

γxy

εx

εy

εz

2εyz

2εxz

2εxy

= =
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S T R E S S - C H A R G E

S T R A I N - C H A R G E

Most material data appears in the strain-charge form, and you can easily transform into 
the stress-charge form. COMSOL Multiphysics allows you to use both constitutive 
forms; simply select one, and COMSOL Multiphysics makes any necessary 
transformations. The following equations transform strain-charge material data to 
stress-charge data

Material Models

In addition to modeling piezoelectric materials, the piezoelectrical application mode 
provides different material models for easier modeling of piezo components. This 
means, that in the subdomain settings of the application mode, you can define the 
material of each domain as:

• Piezoelectric

• Decoupled, isotropic

• Decoupled, anisotropic

The piezoelectric material operates as described in the chapter above, whereas using 
the two other material models, you can model structural and electrical problems or 
either of them independently.

The structural part of the Decoupled, isotropic and Decoupled, anisotropic material 
operates as the linear elastic material with small deformations as described in 
“Continuum Application Modes” on page 167. However, the initial stress and strain 
and thermal expansion are not supported within the piezoelectrical application mode.

σ cEε eTE–=

D eε ε0εrSE+=

ε sEσ dTE+=

D dσ ε0εrTE+=

cE sE
1–

=

e d sE
1–

=

εS ε0εrT d sE
1– dT

–=
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For the Decoupled, isotropic material you define the material using the Young’s 
modulus, E, and the Poisson ratio, ν. For the Decoupled, anisotropic material you 
define the full 6-by-6 elasticity matrix D. Note here, that you define D using the 
standard structural mechanics ordering. Thus the ordering of the D is different from 
the ordering of the piezoelectric cE matrix. 

Depending on the value of the Electrostatics formulation property (See “Electrical 
Formulations”  below), the electrical part of the Decoupled, isotropic and Decoupled, 
anisotropic material solves either the electrostatics equation:

where ε0 is the electrical permittivity of free space, εr is the relative electrical 
permittivity, and ρv is the volume charge density, or the quasi-static electric currents 
equation:

where σe is the electrical conductivity of the material (note that σ is used also for the 
structural stress vector).

In frequency response analysis the conductivity appears also into the electrostatics 
equation:

and thus you can define and use conductivity of the material independently of the 
Electrostatics formulation property.

For a Decoupled, isotropic material you define εr and σe as scalars, but for a Decoupled, 
anisotropic material you define them as 3-by-3 matrices. Also, in the case of a 
Piezoelectric material, you define σS or σT using 3-by-3 matrices.

Electrical Formulations

The default formulation of the equations in the piezoelectrical application modes is 
such that the resulting equation system with piezoelectric material is symmetric. This 
allows reduced memory requirements with solvers that utilize symmetry information. 

The drawback of this design is that by default the piezoelectrical application modes are 
not electrically compatible with the Electrostatics application mode found in the  

∇ ε0εr∇V( )⋅– ρv=

∇ σe jωε0+ εr( )∇V( )⋅– 0=

∇
σe
jω
------ ε+

0
εr⎝ ⎠

⎛ ⎞∇V⎝ ⎠
⎛ ⎞⋅– ρv=
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AC/DC Module and the MEMS Module, nor is it compatible with the Quasi-Statics 
-Electric, Electric currents application modes in the AC/DC Module.

The piezoelectrical application modes support an application mode property, Electrical 
formulation, which makes them compatible with the electrostatic or quasi-static 
application modes so that it is possible to couple them in a model. The Electrical 
formulation property has the following choices:

• Symmetric, Electrostatics: The default implementation creates a symmetric equation 
system, but the application mode is not compatible with the other application 
modes.

• Unsymmetric, Electrostatics: This implementation creates an unsymmetric equation 
system which is compatible with the Electrostatics application modes.

• Unsymmetric, Electric currents: This implementation creates an unsymmetric 
equation system which is compatible with the Quasistatics - Electric, Electric 
currents application modes.

At the equation level the difference between these formulation is the following. The 
default formulation is that the variational electrical energy is written using a positive 
sign:

Here D is the electric displacement vector, and  is the test function for the electric 
field. Ω is the integration domain.

On the other hand, the formulation compatible with the Electrostatics application 
mode uses variational electrical energy with the negative sign: 

Finally, the electric currents formulation uses the following variational electrical 
energy: 

where J is the electric current density vector, and  is the test function for the 
potential gradient.

The use of the Unsymmetric, electric currents formulation sets certain limitations: you 
cannot model any charges, and any boundary conditions that use charges or electric 

δWe D E
ˆ

⋅( ) Ωd∫=

E
ˆ

δWe D E
ˆ

⋅( ) Ωd∫–=

δWe J ∇V̂⋅( ) Ωd∫=

∇V̂
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displacement are written in terms of electric current. Also, this formulation only 
appears in the frequency response analysis.

Piezoelectric Dissipation

In order to define dissipation in the piezoelectric material for a time-harmonic analysis, 
all material properties in the constitutive relations can be complex-valued matrices 
where the imaginary part defines the dissipative function of the material.

As described in “Piezoelectrical Losses” on page 143 you can define complex-valued 
data directly in the edit fields for the material properties, or you can define a real-valued 
material X and a set of loss factors ηX, which together form the complex-valued 
material data

 (11-1)

See “Piezoelectrical Losses” on page 143 for an explanation of the sign convention.

It is also possible to define the electrical conductivity of the piezoelectric material: σS 
or σT depending on the constitutive relation. Electrical conductivity does not appear 
directly in the constitutive equation, but it appears as an additional term in the 
variational formulation (weak equation).

Note: The conductivity does not change during transformation between the 
formulations. σS and σT are used to get fully-defined materials in each formulation.

Initial Stress, Strain, and Electric Displacement

Using the piezoelectrical application modes you can define initial stress (σ0), initial 
strain (ε0), and initial electric displacement (D0) to your model. In the constitutive 
relation for piezoelectric material these additions appear in the stress-charge 
formulation: 

When solving the model, these program does not interpret these fields as a constant 
initial state, but they operate as additional fields that are continuously evaluated. Thus 

X X 1 jηX±( )=

σ cE ε ε0–( ) eTE– σ0+=

D e ε ε0–( ) ε0εrSE D0+ +=
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you can use these initial field to add, for example, thermal expansion or pyroelectric 
effects to your model.

Geometric Nonlinearity

P I E Z O E L E C T R I C  M A T E R I A L S  W I T H  L A R G E  D E F O R M A T I O N S

The linear piezoelectric equations as presented in “Piezoelectrical Constitutive 
Relations” on page 340 with engineering strains (see “Theory Background” on page 
172) are valid if the model undergoes only relatively small deformations. As soon as 
the model contains larger displacements or rotations, these equations produce 
spurious strains that result in an incorrect solution. To overcome this problem, you 
need to use so-called large deformation piezoelectrical equations.

The piezoelectrical application modes implement the large deformation piezoelectrical 
equations according to Yang (Ref. 1). Key items of this formulation are:

• The strains are calculated as the Green or Green-Lagrange strain, εij:

 (11-2)

Green strains are defined with reference to an undeformed geometry. Hence, they 
represent a Lagrangian description. In a small-strain, large rotational analysis, the 
Green strain corresponds to the engineering strain in directions that follow the 
deformed body. 

• Electrical field variables are calculated in the material directions, and the electric 
displacement relation is replaced by an expression that produce electric polarization 
in the material orientation of the solid.

• In the variational formulation, the electrical energy is split into two parts: The 
polarization energy within the solid and the electric energy of free space occupied 
by the deformed solid.

The first two items above result in another set of constitutive equations for large 
deformation piezoelectricity:

εij
1
2
---

ui∂
xj∂

--------
uj∂
xi∂

--------
uk∂
xi∂

---------
uk∂
xj∂

---------⋅+ +⎝ ⎠
⎛ ⎞=

S cEε eTEm–=

Pm eε ε0εrS ε0I–( )Em+=
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where S is the second Piola-Kirchhoff stress; ε is the Green strain, Em and Pm are the 
electric field and electric polarization in the material orientation; I is the identity 
matrix; and cE, e, and εrS are the piezoelectric material constants. The expression 
within parentheses equals the dielectric susceptibility of the solid:

Electric displacement field in the material orientation results from the following 
relation

where C is the right Cauchy-Green tensor

Fields in the global orientation result from the following transformation rules: 

 (11-3)

where F is the deformation gradient; J is the determinant of F; and ρv and ρV are the 
volume charge density in present and material coordinates.  The deformation gradient 
is defined as the gradient of the present position of a material point x = X + u:

D E C O U P L E D  M A T E R I A L S  W I T H  L A R G E  D E F O R M A T I O N S

The large deformation formulation described in the previous section applies directly to 
non-piezoelectric materials if you set the coupling term to zero: e = 0. In that case, the 
structural part corresponds to the large deformation formulation described for the 
continuum (structural) application modes (see “Large Deformations” on page 173).

The electrical part separates into two different cases: For solid domains the electric 
energy consists of polarization energy within the solid and the electric energy of free 
space occupied by the deformed solid—the same as for the piezoelectric materials. For 

χ ε0εrS ε0I–( )=

Dm Pm ε0JC 1– Em+=

C FTF=

E F T– Em=

P J 1– FPm=

D J 1– FDm=

ρv ρVJ 1–
=

F x∂
X∂

-------=
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nonsolid domains this separation does not occur, and the electric displacement in these 
domains directly results from the electric field—the electric displacement relation: 

Note that on nonsolid domains you are not able to know the global orientation of the 
fields unless you use the ALE method as described in the following chapter.

L A R G E  D E F O R M A T I O N  A N D  D E F O R M E D  M E S H

You can couple the piezoelectrical application mode with the Moving Mesh (ALE) 
application mode in a way so that the electrical degrees of freedom are solved in an 
ALE frame. This feature is intended to be used in applications where your model 
contains nonsolid domains, such as modeling of electrostatically actuated structures. 
You do not need this functionality for modeling of piezoelectric or other solid 
materials.

The use of ALE has impacts on the formulation of the electrical large deformation 
equations. The first impact is that with ALE, the gradient of electric potential directly 
results in the electric field in the global orientation, and the material electric field 
results after transformation.

The most visible impact is on the boundary conditions. With ALE any surface charge 
density or electric displacement is defined per the present deformed boundary area, 
whereas for the case without ALE they are defined per the undeformed reference area.

Dm ε0εrEm=
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Th e  P i e z o e l e c t r i c a l  App l i c a t i o n  
Mode s

This section describes the interface for defining a model using the piezoelectrical 
application modes:

• Piezo Solid (in 3D)

• Piezo Plane Stress (in 2D)

• Piezo Plane Strain (in 2D)

• Piezo Axial Symmetry (in axisymmetric 2D)

It consists of the following sections:

• “Application Mode Properties” (the next section)

• “Scalar Variables” on page 351

• “Material Properties” on page 352

• “Electric Boundary Conditions” on page 362

• “Constraints” on page 366

• “Loads and Charges” on page 368

• “Damping” on page 370

Application Mode Properties

To set or examine material properties, go to the Physics menu and open the Application 

Mode Properties dialog box.
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Here you control various global settings for the model, which include:

• Default element type: A list of elements, where the selection becomes the default on 
all new subdomains. The default is to use second-order Lagrange elements.

• Analysis type: A list of analyses to perform. It affects both the equations and which 
solver to use with the Auto select solver option in the Solver Parameters dialog box. 
The default is static analysis. You can also select transient, eigenfrequency, damped 
eigenfrequency, and frequency response analysis types.

• Specify eigenvalues using: A list controlling whether the application mode works with 
eigenvalues or eigenfrequencies.

• Electrical formulation: Select the electrical formulation to use:

- Symmetric, Electrostatic: the default setting.

- Unsymmetric, Electrostatic: for compatibility with the Electrostatics application 
mode.

- Unsymmetric, Electric currents: for compatibility with the application modes for 
electric currents in the AC/DC Module (Electric Currents in 3D, In-Plane 
Electric Currents in 2D, and Meridional Electric Currents in 2D axial symmetry). 
Available for frequency response analysis.

• Large deformation: Turns the formulation for large deformations on or off. Large 
deformation is only available for the Symmetric, Electrostatics and Unsymmetric, 
Electrostatics electrical formulations.

• Weak constraints: Controls whether or not weak constraints are active. Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 351 in the COMSOL Multiphysics Modeling Guide).

• Structural frame: This property defines the frame in which the structural 
deformation variables are solved for. This property is visible only if your model has 
an added frame.

• Electrical frame: This property defines the frame in which the electric potential 
variable is solved for. The default value defines that the frame selected for the 
Structural frame property is used. This property is visible only if your model has an 
added frame.
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Scalar Variables

The piezoelectrical application modes have the following scalar variables:

The variable names and the expressions for Qtot and Wtot have an application mode 
suffix, for example, epsilon0_smpz3d for a Piezo Solid application mode.

You control the scalar variables by going to the Physics menu and choosing Properties 
to open the Application Scalar Variables dialog box.

The excitation frequency (the frequency of the harmonic forces, potential, and 
displacement) is available only for frequency response analysis. The equations and 
documentation describing frequency response use the angular excitation frequency, 
ω = 2π f, which is available as the variable omega. The complex angular frequency is 
available for eigenfrequency analysis and damped eigenfrequency analysis.

When you select Frequency response as the analysis type, the default solver is the 
parametric solver. This default makes it easy to perform a frequency sweep over several 
excitation frequencies in one analysis. In this case enter freq in the Parameter names 
edit field on the General page in the Solver Parameters dialog box. The values you enter 
in the Parameter values edit field override the excitation frequency you might have 
entered in the Application Scalar Variables dialog box.

The Wtot and Qtot variables (for the total stored energy and the total energy dissipation 
in the model, respectively) are used to compute the electromechanical quality factor 

PROPERTY VARIABLE DEFAULT SI UNIT DESCRIPTION

 ε0 epsilon0 8.854187817e-12 F/m Permittivity of vacuum

 f freq 1e6 Hz Excitation frequency

 jω jomega -lambda rad/s Complex angular frequency

 Qtot Qtot Qes_tot W Total power dissipation

 Wtot Wtot Wes_tot J Total stored energy
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Qem of the model using the relation ωWtot / Qtot. If your model contains additional 
application modes, you can add the stored energy and dissipation in those application 
modes to get the correct Qem.

Material Properties

The Subdomain Settings dialog box has two pages where you define the material 
properties: the Structural page and the Electrical page. On top of both pages you find 
the Library material list and the Load button for importing and selecting data from the 
material libraries and the Material model list for selecting the material model for each 
domain. These settings are shared between the pages, and if you change the Structural 
page, the settings change also on the Electrical page. Note that loading a material from 
a material library does not change the material model, so you need to change it 
manually in the Material model list to match the type of material.

Everything else you see and define on the pages depends on the material model you 
select; the following subsections describe the settings available for each of the material 
models.

S U B D O M A I N  S E T T I N G S — P I E Z O E L E C T R I C  M A T E R I A L

The piezoelectric material is a complete structural-electrical material, and thus you 
define all piezoelectric material properties on the Structural page.
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The Structural page has two lists in 3D, three lists in 2D, and three lists in axial 
symmetry:

• Constitutive form: Select the constitutive form from those in the following list. 
Depending on the selection, different material properties are shown in the dialog 
box.

- Stress-charge form: Define the constitutive relation of the material on the 
stress-charge form through the cE, e, and εrS matrices. The previous figure shows 
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the Material page for stress-charge, while the following figure shows the Elasticity 

matrix dialog box for entering the cE matrix.

The figure below shows the Relative permittivity dialog box for entering the εrS 
matrix components.

- Strain-charge form: You define the constitutive relation of the material on the 
strain-charge form through the sE, d, and εrT matrices (see page 342 for details). 
The following figure shows the Material page for strain-charge.

The next graphic shows the Coupling matrix, strain-charge form dialog box for 
entering the d matrix components.
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•  Electrical conductivity: In frequency response analysis and in damped eigenfrequency 
analysis you can also define the electrical conductivity σS or σT depending on the 
material formulation. They are both symmetric 3-by-3 matrices.

• Material orientation (2D and axisymmetry only): Here you select how the 3D 
material properties are oriented relative the 2D/axial symmetric analysis plane. 
There are six options: xy, yz, zx, yx, zy, and the default xz-plane. The plane 
represents how the 3D material is oriented relative the 2D/axial symmetric analysis 
plane: The first letter indicates which 3D direction coincides with the x direction in 
2D or the r direction for axisymmetry; the second letter indicates which 3D 
direction coincides with the y direction in 2D or the z direction for axisymmetry. 
The material coordinates names are fixed and do not depend of the names of the 
space coordinates (independent variables), which have different defaults in 2D and 
axial symmetry.

Figure 11-1:Orientation of 3D material xyz relative the 2D analysis coordinate system XYZ.
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Figure 11-2: Orientation of 3D material xyz relative the axisymmetric analysis 
coordinate system r Z.

• Coordinate system: Select the coordinate system where the material properties are 
defined. This choice is useful if you want to define the material in a coordinate 
system other than the global system, or if you need results in a local coordinate 
system for postprocessing. The Coordinate system list contains only the global 
coordinate system unless you have made available a user-defined coordinate system. 
You find the Coordinate System Settings dialog box on the Options menu. Read more 
about creating a coordinate system and how to use it in “Coordinate Systems” on 
page 98.

The following table shows the material properties for the union of all constitutive 
forms and all piezoelectrical application modes.

PARAMETER VARIABLE DESCRIPTION CONSTITUTIVE FORM

 cE cElk Elasticity matrix Stress-charge

 sE sElk Compliance matrix Strain-charge

 e eik Coupling matrix, stress-charge form Stress-charge

 d Coupling matrix, strain-charge form Strain-charge
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 Elasticity matrix   Defines the stress-strain relation matrix cE

where σ is the stress, and ε is the strain.

 Coupling matrix   Defines the piezo coupling matrix e used in the stress-charge form of 
the constitutive equation

where σ is the stress, ε is the strain, and E is the electric field.

 Compliance matrix   Defines the strain-stress relation matrix sE

where σ is the stress, and ε is the strain.

 Coupling matrix   Defines the piezo coupling matrix d used in the strain-charge form of 
the constitutive equation

where σ is the stress, ε is the strain, and E is the electric field.

 Relative permittivity    The relative permittivity, εrS or εrT, appears in the constitutive 
relation on stress-charge and strain-charge forms, respectively.

 εrS Relative permittivity matrix, 
stress-charge form

Stress-charge

 εrT Relative permittivity matrix, 
strain-charge form

Strain-charge

σS Electrical conductivity, stress-charge 
form

Stress-charge

σT Electrical conductivity, strain-charge 
form

Strain-charge

 ρ rho Density All

 th thickness Thickness of the geometry (2D only) All

PARAMETER VARIABLE DESCRIPTION CONSTITUTIVE FORM

σ cEε=

σ cEε eTE–=

ε sEσ=

ε sEσ dTE+=
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 Electrical conductivity   The electrical conductivity, σS or σT, appears in the weak 
equation to account for conductivity losses in the material.

 Density   This material property, ρ, specifies the material’s density.

 Thickness   This material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

S U B D O M A I N  S E T T I N G S — D E C O U P L E D ,  I S O T R O P I C  M A T E R I A L

With this material model you specify material properties on the Structural page and the 
Electrical page.

You define the structural material properties on the Structural page:

On the first row after the Material model list you find the Enable structural equation 
check box. Use this check box to activate the structural equation or inactivate it to 
model only electrical problems. By default the Enable structural equation check box is 
selected. If this setting is selected you can define the following structural material 
properties:

 Young’s modulus    This material property, E, is the modulus of elasticity of the material. 
It is used to form the elasticity matrix D for the stress strain relationship as described 
in the chapter “Material Models” on page 342.

D eε ε0εrSE+=

D dσ ε0εrTE+=
R  1 1 :  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S



 Poisson’s ratio   This material property, ν, defines the contraction of the structure in the 
perpendicular direction. It is used to form the elasticity matrix D for the stress strain 
relationship as described in the chapter “Material Models” on page 342.

 Density   This material property, ρ, specifies the material’s density.

 Thickness   This material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

You define the electrical material properties on the Electrical page:

On the first row after the Material model list you find the Enable electrical equation 
check box. Use this check box to activate the electrical equation or inactivate it to 
model only structural problems. If you select it and clear the Enable structural equation 
check box, only the electrical equation is active. By default the Enable electrical equation 
check box is selected. If this setting is selected you can define the following electrical 
material properties: 

 Relative permittivity   This material property, εr, defines the isotropic relative electrical 
permittivity of the material.

 Electric conductivity   This material property, σ, defines the isotropic electrical 
conductivity of the material. This setting only appears for frequency response analysis.

 Thickness   This material property, thickness, specifies the material’s thickness and 
appears in 2D only.
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S U B D O M A I N  S E T T I N G S — D E C O U P L E D ,  A N I S O T R O P I C  M A T E R I A L

With this material model you specify material properties on the Structural page and the 
Electrical page.

You define the structural material properties on the Structural page:

On the first row after the Material model list you find the Enable structural equation 
check box. Use this check box to activate the structural equation or inactivate it to 
model only electrical problems. By default, Enable structural equation is selected. If this 
setting is selected you can define the following structural material properties: 

 Material orientation    (2D and axisymmetry only): Here you select how the 3D 
material properties are oriented relative the 2D/axial symmetric analysis plane. There 
are six options: xy, yz, zx, yx, zy, and the default xz. This setting works the way same 
as for the piezoelectric material (see description on page 355).

 Coordinate system    Select the coordinate system where the material properties are 
defined. This setting works the way same as for the piezoelectric material (see 
description on page 356).
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 Elasticity matrix   This material property, D, defines the elasticity matrix of the 
anisotropic material (see “Material Models” on page 342). You define D as a 
symmetric 6-by-6 matrix: 

 Density   This material property, ρ, specifies the material’s density.

 Thickness   This material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

You define the electrical material properties on the Electrical page:

On the first row after the Material model list you find the Enable electrical equation 
check box. Use this check box to activate the electrical equation or inactivate it to 
model only structural problems. By default Enable electrical equation is selected. If this 
setting is selected you can define the following electrical material properties:

 Material orientation    (2D and axisymmetry only) This is the same setting as the 
Material orientation on the Structural page.

 Coordinate system    This is the same setting as the Coordinate system on the Structural 
page.
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 Relative permittivity   This material property, εr, defines the anisotropic relative 
electrical permittivity of the material. You define εr using a symmetric 3-by-3 matrix:

 Electric conductivity   This material property, σ, defines the anisotropic electrical 
conductivity of the material. This setting only appears for frequency response analysis. 
You define σ using a symmetric 3-by-3 matrix:

 Thickness   This material property, thickness, specifies the material’s thickness and 
appears in 2D only.

P I E Z O E L E C T R I C  M A T E R I A L  P R O P E R T I E S  L I B R A R Y

A library of about 25 common piezoelectric materials is available through the Materials/

Coefficients Library dialog box. For more information about these materials, see 
“Piezoelectric Material Properties Library” on page 129.

Electric Boundary Conditions

You specify the electric boundary conditions on the Electric BC page in the Boundary 

Settings dialog box using the Boundary condition list. Depending on the selected 
condition, the software enables different edit fields. The conditions available in the 
Boundary condition list depend on the setting of the Electrical formulation property in 
the Application Mode Properties dialog box.
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B O U N D A R Y  C O N D I T I O N S — E L E C T R O S T A T I C S

For the Unsymmetric, Electrostatic and Symmetric, Electrostatic formulations, the 
boundary conditions include:

Electric Displacement

This boundary condition specifies the normal component of the electric displacement 
at a boundary. Enter the components of the electric displacement D0. With large 
deformation, D0 is defined per the present state of the deformed geometry for models 
with ALE. Otherwise the undeformed geometry is used as the reference.

Surface Charge

This boundary condition specifies the surface charge density ρs at an exterior boundary 
(left equation) or at the interior boundary between two media with electric 
displacement D1 and D2, respectively. With large deformation, the surface charge 
density is defined per the present state of the deformed geometry (ρs) for models with 
ALE. Otherwise the undeformed geometry is used as the references (ρS).

Zero Charge/Symmetry

This boundary condition specifies that the normal component of the electric 
displacement is zero. The Zero charge/Symmetry boundary condition is also useful at 
symmetry boundaries where the potential is symmetric with respect to the boundary. 
This is the default boundary condition on exterior boundaries.

n D⋅ n D0⋅=

n– D⋅ ρs,= n D1 D2–( )⋅ ρs=

n D⋅ 0=
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Electric Potential

This boundary condition specifies the voltage V0 at the boundary. Because the 
application mode computes the electric potential, you must define its value at some 
boundary in the geometry to be fully determined.

Ground

This boundary condition is a special case of the previous one specifying zero potential. 
The Ground boundary condition is also be useful at symmetry boundaries, where the 
potential is antisymmetric with respect to the boundary.

Continuity

This boundary condition specifies that the normal component of the electric 
displacement is continuous across an interior boundary or across a boundary between 
a piezoelectric and an electrostatic domain if you use the Unsymmetric, Electrostatic 
formulation. Using the Symmetric, Electrostatic formulation the Continuity condition 
is only available for interior boundaries, where it is the default.

Floating Potential
This condition the potential on the boundary to a spatially constant value such that the 
total charge on the boundary equals the user defined total charge Q0:

You also define the group index, which defines how the boundaries are grouped in to 
a set of electrodes.

Axial Symmetry

This boundary condition is the natural Neumann boundary condition, which you use 
on the z-axis (r = 0) to maintain the symmetry conditions. The Axial Symmetry 
boundary condition is available only in the Piezo Axial Symmetry application mode.

V V0=

V 0=

n D1 D2–( )⋅ 0=

ρs
∂Ω
∫ Q0=

Er 0=

r∂
∂Ez 0=
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B O U N D A R Y  C O N D I T I O N S — E L E C T R I C  C U R R E N T S

For the Unsymmetric, Electric currents formulations, the boundary conditions 
include:

Ground

This boundary condition is a special case of the previous one specifying zero potential. 
The Ground boundary condition is also be useful at symmetry boundaries, where the 
potential is antisymmetric with respect to the boundary.

Electric Potential

This boundary condition specifies the voltage V0 at the boundary. Because the 
application mode computes the electric potential, you must define its value at some 
boundary in the geometry to be fully determined.

Current Flow

This boundary condition specifies the current flow. Enter the components of the 
current density J0.

Inward Current Flow

This boundary condition specifies the normal current density Jn at an exterior 
boundary.

Electric Insulation

This boundary condition specifies that the normal component of the electric current 
is zero; that is, the boundary is electrically insulated. This is the default boundary 
condition on exterior boundaries.

Current Source
The current source boundary condition

 

is applicable to interior boundaries that represent either a source or a sink of current.

V 0=

V V0=

n J⋅ n J0⋅=

n– J⋅ Jn=

n J⋅ 0=

n J1 J2–( )⋅ Jn=
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Continuity

This boundary condition specifies that the normal component of the electric current 
is continuous across the interior boundary (where it is the default setting) or across a 
boundary between a piezoelectric and an domain with electric currents.

Floating Potential
This condition the potential on the boundary to a spatially constant value such that the 
total current through the boundary equals the user defined total current I0:

You also define the group index, which defines how the boundaries are grouped in to 
a set of electrodes.

Axial Symmetry
This boundary condition is the natural Neumann boundary condition, which you use 
on the z-axis (r = 0) to maintain the symmetry conditions. The Axial Symmetry 
boundary condition is available only in the Piezo Axial Symmetry application mode.

C O N V E R S I O N  O F  E L E C T R I C  B O U N D A R Y  C O N D I T I O N S

Some boundary conditions are applicable only for the formulations for electrostatics, 
whereas others apply only to the formulation for electric currents. Table 11-1 contains 
the boundary conditions that the software converts when changing from one 
formulation to the other:

Constraints

A constraint specifies the displacement or potential of certain parts of a structure. You 
can define constraints for the displacements on all domain levels including points, 
edges, faces/boundaries, and subdomains (in 3D), and points, boundaries, and 

TABLE 11-1:  BOUNDARY CONDITION CONVERSIONS

BOUNDARY CONDITION FOR ELECTROSTATICS BOUNDARY CONDITION FOR ELECTRIC CURRENTS

Electric displacement Current flow

Zero charge/Symmetry Electric insulation

Surface charge (exterior boundaries) Inward current flow

Surface charge (interior boundaries) Current source

n J1 J2–( )⋅ 0=

n J⋅–

∂Ω
∫ I0=
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subdomains (in 2D). In addition, you can define constraints for the potential on points 
and edges in 3D and for points in 2D. To control them, go to the Constraint page in 
the Subdomain Settings, Boundary Settings, Edge Settings, and Point Settings dialog 
boxes, and set constraints on boundaries from the Electric BC page. The following 
figure shows the Boundary Settings dialog box for the Piezo Solid application mode, 
but the page has the same appearance in all piezoelectrical application modes.

Use the Constraint condition list in this dialog box to select the type of constraint that 
you want to define. See “Constraints” on page 81 for details.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system, available only on boundaries

• User-defined coordinate systems, if any local coordinate systems are defined. (Read 
more about creating a coordinate system in the section “Coordinate Systems” on 
page 98.)
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When you select Prescribed displacement a number of new options appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the prescribed displacement options.

The check boxes adjacent to the Rx, Ry, and Rz edit fields activate the constraint, 
whereupon you enter the value/expression of the displacement (the default value is 0).

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify the Prescribed 

velocity and Prescribed acceleration in the same way as Prescribed displacement.

Constraint page showing the prescribed velocity settings.

Loads and Charges

Load is a general name for forces applied to a structure. You can specify loads on all 
domain types. To do so, click the Load tab in the Boundary Settings dialog boxes or the 
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 (N/m3) 
 (N/m2)

 (N/m3)

 (N/m3)
Load/Charge tab in the Subdomain Settings, Edge Settings, and Point Settings dialog 
boxes, where you can also specify a charge density. The formulation for electric 
currents does not include charges, so in that case, the name of the tab is Load also in 
the Subdomain Settings, Edge Settings, and Point Settings dialog boxes. The following 
image shows the Edge Settings dialog box for the Piezo Solid application mode, but the 
tab looks similar on all domain levels in all piezoelectrical application modes.

S P E C I F Y I N G  L O A D S

For plane stress and plane strain, option buttons allow you to specify the load in 
different ways using the thickness. The following table summarizes the options for 
defining loads on different domains in different application modes; the SI unit appears 
in parenthesis.

With the Coordinate system list you control in which coordinate system the load is 
defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system, only available on boundaries

• User-defined coordinate systems, if there are any local coordinate systems defined. 
Read more about creation of coordinate system in the coordinate system section.

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMAIN

Plane Stress,

Plane Strain

force (N) force/area (N/m2) or 
force/length (N/m)

force/volume
or force/area

Axial symmetry total force along the 
circumferential (N)

force/area (N/m2) force/volume

Solid force (N) force/length 
(N/m)

force/area (N/m2) force/volume
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S P E C I F Y I N G  C H A R G E S

Use the Load/Charge page in the Subdomain Settings, Edge Settings, and Point Settings 

dialog boxes to specify a charge when you use a formulation for electrostatics. For 
plane stress and plane strain, option buttons allow you to specify the charge in different 
ways using the thickness. The following table summarizes the options for defining 
charge on different domains in different application modes; the SI units appears in 
parenthesis.

To specify charge density on boundaries, click the Electric BC tab.

The reference dimension to define charge density varies for large deformation 
piezoelectrical applications. On the subdomain level for solid domains you always 
define the charge density per the undeformed initial geometry. On the boundary and 
edge levels, the charge density is defined per the present state of the deformed 
geometry if ALE is used (that is, he true area or shape that results from the use of 
ALE); otherwise the undeformed geometry is used as the reference.

Damping

On the Damping page in the Subdomain Settings dialog box you define structural and 
dielectric losses for decoupled materials and structural, coupling, and dielectric losses 
for piezoelectric materials. Depending on the settings on the Structural and Electrical 

APPLICATION MODE POINT EDGE SUBDOMAIN

Plane Stress, 
Plane Strain

charge (C) charge/volume (C/m3) 
or charge/area (C/m2)

Axial symmetry total charge along 
the circumferential 
(C)

charge density (C/m3)

Solid force (C) charge/length 
(C/m)

charge density (C/m3)
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tabs, you have 1–3 lists from to select the model for each loss. The layout of the dialog 
box depends on the selected damping model.

The Damping page with settings for structural damping, coupling loss, and dielectric loss.

From the Library material list you can select any material loaded into the model. You 
can load materials from the material libraries through the Load button. This affects all 
isotropic and anisotropic loss factors but not the coefficients for Rayleigh damping.

If you want to define a full matrix of loss factors, create a material using the Materials/

Coefficients Library dialog box that you open from the Options menu so that you can 
save it for later use.

The Material row shows the material model defined on the Structural and Electrical 
pages.

S T R U C T U R A L  L O S S

To model structural loss (damping), select the applicable damping model from the 
Structural damping list. The following damping models are available:

•  No damping

•  Rayleigh

•  Loss factor

•  Equivalent viscous

•  Isotropic loss

•  Anisotropic loss
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See “Damping” on page 140 for more information about different damping models.

For time-dependent analysis, you can specify viscous damping (structural damping) 
using Rayleigh damping, where the damping matrix is proportional to the mass and 
stiffness matrix:

For frequency response and damped eigenmode analysis you can specify damping 
using either Rayleigh damping or loss factor damping, or you can choose isotropic loss 
or anisotropic loss to define a complex-valued stiffness matrix or compliance matrix. 
You can use equivalent viscous damping in frequency response analysis.

If you define isotropic loss or anisotropic loss, the parameters you define depend on 
the material model, but for the other damping models the parameters do not depend 
on the material model.

Note: Loss factor damping, isotropic loss, and anisotropic loss are valid for frequency 
response and damped eigenfrequency analysis, and equivalent viscous damping is 
valid only for frequency response analysis. If you choose a transient analysis and either 
of these structural damping types, COMSOL Multiphysics solves the model with no 
damping.

Table 11-2 and the following text describe the parameters that define the structural 
damping:

TABLE 11-2:  PARAMETERS FOR STRUCTURAL DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 ηs eta_s Structural loss factor 
(isotropic)

Loss factor, Equivalent viscous, 
and Isotropic loss with a 
decoupled material

ηs eta_sij Structural loss factor 
(anisotropic)

Anisotropic loss for a 
decoupled material

ηcE eta_cE Loss factor for cE (isotropic) Isotropic loss for piezoelectric 
stress-charge material

c αdMm βdKk+=
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Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Structural loss factor (isotropic)   Defines the structural loss factor ηs for the loss factor 
damping, equivalent viscous damping, and isotropic loss (for a decoupled material) 
models.

Structural loss factor (anisotropic)   Defines the structural loss factor ηs of an 
anisotropic loss for a decoupled material. Click the Edit button to enter the 
components of the ηs matrix in the Structural loss factor dialog box.

Loss factor for cE (isotropic)   Defines the loss factor ηcE of an isotropic loss for 
piezoelectric stress-charge material.

Loss factor for cE (anisotropic)   Defines the loss factor ηcE of an anisotropic loss for 
piezoelectric stress-charge material. Click the Edit button to enter the components of 
the ηcE matrix in the Loss factor for cE dialog box.

Loss factor for sE (isotropic)   Defines the loss factor ηsE of an isotropic loss for 
piezoelectric strain-charge material.

Loss factor for sE (anisotropic)   Defines the loss factor ηsE of an anisotropic loss for 
piezoelectric strain-charge material. Click the Edit button to enter the components of 
the ηsE matrix in the Loss factor for sE dialog box.

ηcE eta_cEij Loss factor for cE 
(anisotropic)

Anisotropic loss for 
piezoelectric stress-charge 
material

ηsE eta_sE Loss factor for sE (isotropic) Isotropic loss for piezoelectric 
strain-charge material

ηsE eta_sEij Loss factor for sE 
(anisotropic)

Anisotropic loss for 
piezoelectric strain-charge 
material

TABLE 11-2:  PARAMETERS FOR STRUCTURAL DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL
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C O U P L I N G  L O S S

From the Coupling loss list you can choose isotropic loss and anisotropic loss. Both 
define complex-valued coupling matrices ηe or ηd depending on the constitutive 
formulation.

Table 11-3 and the following text describe the parameters that define the coupling 
loss:

Loss factor for e (isotropic)   Defines the loss factor ηe of an isotropic coupling loss for 
piezoelectric stress-charge material.

Loss factor for e (anisotropic)   Defines the loss factor ηe of an anisotropic coupling loss 
for piezoelectric stress-charge material. Click the Edit button to enter the components 
of the ηe matrix in the Loss factor for e dialog box.

Loss factor for d (isotropic)   Defines the loss factor ηd of an isotropic coupling loss for 
piezoelectric strain-charge material.

Loss factor for d (anisotropic)   Defines the loss factor ηd of an anisotropic coupling loss 
for piezoelectric strain-charge material. Click the Edit button to enter the components 
of the ηd matrix in the Loss factor for d dialog box.

D I E L E C T R I C  L O S S

From the Dielectric loss list you can choose isotropic loss and anisotropic loss. Both 
define complex-valued electrical permittivity matrices εS, εT, or ε depending on the 
material model and constitutive formulation.

TABLE 11-3:  PARAMETERS FOR THE COUPLING LOSS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

ηe eta_e Loss factor for e (isotropic) Isotropic coupling loss for 
piezoelectric stress-charge 
material

ηe eta_eij Loss factor for e 
(anisotropic)

Anisotropic coupling loss for 
piezoelectric stress-charge 
material

ηd eta_d Loss factor for d (isotropic) Isotropic coupling loss for 
piezoelectric strain-charge 
material

ηd eta_dij Loss factor for d 
(anisotropic)

Anisotropic loss for 
piezoelectric strain-charge 
material
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Table 11-4 and the following text describe the parameters that define the dielectric 
loss:

Loss factor for εS (isotropic)   Defines the loss factor  of an isotropic dielectric loss 
for piezoelectric stress-charge material.

Loss factor for εS (anisotropic)   Defines the loss factor  of an anisotropic coupling 
loss for piezoelectric stress-charge material. Click the Edit button to enter the 
components of the  matrix in the Loss factor for epsS dialog box.

Loss factor for εT (isotropic)   Defines the loss factor  of an isotropic dielectric loss 
for piezoelectric strain-charge material.

Loss factor for εT (anisotropic)   Defines the loss factor  of an anisotropic dielectric 
loss for piezoelectric strain-charge material. Click the Edit button to enter the 
components of the  matrix in the Loss factor for epsT dialog box.

Dielectric loss factor (isotropic)   Defines the loss factor  of an isotropic dielectric 
loss for a decoupled material with the electrical equation enabled.

TABLE 11-4:  PARAMETERS FOR THE DIELECTRIC LOSS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

eta_epsS Loss factor for εS (isotropic) Isotropic dielectric loss for 
piezoelectric stress-charge 
material

eta_epsSij Loss factor for εS 
(anisotropic)

Anisotropic dielectric loss for 
piezoelectric stress-charge 
material

eta_epsT Loss factor for εT (isotropic) Isotropic dielectric loss for 
piezoelectric strain-charge 
material

eta_epsTij Loss factor for εT 
(anisotropic)

Anisotropic dielectric loss for 
piezoelectric strain-charge 
material

eta_eps Dielectric loss factor 
(isotropic)

Isotropic dielectric loss for a 
decoupled material with the 
electrical equation enabled

eta_epsij Dielectric loss factor 
(anisotropic)

Anisotropic dielectric loss for 
a decoupled material with the 
electrical equation enabled

ηεS

ηεS

ηεT

ηεT

ηε

ηε

ηεS

ηεS

ηεS

ηεT

ηεT

ηεT

ηε
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Dielectric loss factor (anisotropic)   Defines the loss factor  of an anisotropic 
dielectric loss for a decoupled material with the electrical equation enabled. Click the 
Edit button to enter the components of the  matrix in the Dielectric loss factor dialog 
box.

Initial Stress, Strain, and Electric Displacement

On the Initial Stress and Strain page in the Subdomain Settings dialog box you define 
initial structural stress and strain and initial electric displacement. Depending on the 
settings on the Structural and Electrical pages you might only define either structural 
or electrical fields. The defined initial fields appear in the equation system as described 
in “Initial Stress, Strain, and Electric Displacement” on page 345.

The Initial Stress and Strain page with settings to define initial stress, strain, and electric 
displacement.

The Piezo Solid Application Mode

Use the Piezo Solid application mode for analysis of 3D structures that exhibit 
piezoelectric effects.

VA R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u, v, and 
w in the global x, y, and z directions, and the electric potential, V.

ηε

ηε
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P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 197.

A P P L I C A T I O N  M O D E  VA R I A B L E S

For information about available application mode variables, see “Piezoelectrical 
Application Modes” on page 83 in the Structural Mechanics Module Reference 
Guide.

The Piezo Plane Stress Application Mode

Use the Piezo Plane Stress application mode to analyze thin in-plane loaded plates that 
exhibit piezoelectric effects.

VA R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, which 
this manual describes in general terms in the section “Implementation” on page 197.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  VA R I A B L E S

For information about available application mode variables, see “Piezoelectrical 
Application Modes” on page 83 in the Structural Mechanics Module Reference 
Guide.

The Piezo Plane Strain Application Mode

Use the Piezo Plane Strain application mode to compute the global displacements (u, 
v) in the x and y directions and the electric potential for a piezoelectric structure in a 
state of plane strain. The plane strain condition assumes that the εz, εyz, and εxz 
components of the strain tensor are zero.
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The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 197.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see “Piezoelectrical 
Application Modes” on page 83 in the Structural Mechanics Module Reference 
Guide.

The Piezo Axial Symmetry Application Mode

Use the Piezo Axial Symmetry application mode to analyze axisymmetric models of 
materials showing piezoelectric effects.

This application mode uses cylindrical the coordinates r,  (phi), and z. It solves the 
equations for the global displacement (u, w) in the r and z directions. It assumes that 
the displacement v in the  direction together with the , , , and  
components of the stresses and strains are zero. Loads are independent of , and it 
allows loads only in the r and z directions.

You can consider the domain where the software solves the equations as the 
intersection between the original axially symmetric 3D solid and the half plane , 
r ≥ 0. Therefore it is necessary to draw the geometry only in the half plane r ≥ 0. The 

ϕ

ϕ τrϕ τϕz γrϕ γϕz
ϕ

ϕ 0=
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software recovers the original 3D solid by rotating the 2D geometry about the z-axis 
as seen in the following figure:

The strain-displacement relations for the axial symmetry case for small displacements 
are:

To avoid division by r (which causes problems on the axis, where r = 0), the program 
automatically transforms the equations by multiplying by r. When using the principle 
of virtual work, you normally do not think of this multiplication as a transformation 
but merely as an integration around the circumference. Integrating over the volume, 
you must multiply the integrand by 2π r. The application mode introduces and solves 
for a new dependent variable

instead of the true radial displacement, u.

Note: r = 0 is the symmetry axis. x → r and y → z in the Piezo Axial Symmetry, 
application mode.

εr r∂
∂u

= εϕ
u
r
---= εz z∂

∂w
= γrz z∂

∂u
r∂

∂w
+=

uor u
r
---=
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VA R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are uor the radial displacement divided 
by r and w the global displacement in the z direction and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 197.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see “Piezoelectrical 
Application Modes” on page 83 in the Structural Mechanics Module Reference 
Guide.

Reference

1. J. Yang, An Introduction to the Theory of Piezoelectricity, Springer 
Science+Business Media, N.Y., 2005, Ch. 1.
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 12
P r e d e f i n e d  M u l t i p h y s i c s  C o u p l i n g s
The Structural Mechanics Module contains predefined multiphysics couplings to 
facilitate easy set up of models with the most commonly occurring couplings. These 
predefined multiphysics couplings automatically add the necessary application 
modes with appropriate settings to your model and define the applicable couplings 
for the interaction between the different types of physics.
 383
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Th e rma l - S t r u c t u r a l  I n t e r a c t i o n

The Thermal-Structural Interaction predefined multiphysics coupling combines a 
continuum application mode with a heat transfer application mode from the Heat 
Transfer Module or COMSOL Multiphysics. The coupling appears on the subdomain 
level, where the temperature from the heat transfer application mode acts as a thermal 
load for the structural mechanics application mode, causing thermal expansion.

Theory Background

Read about constitutive equations including thermal expansion in the section dealing 
with the theory background for the continuum application modes, on page 172 of this 
manual.

Application Mode Description

A combination of the following two application modes makes up the 
Thermal-Structural Interaction predefined coupling:

• A continuum application mode:

- Plane Strain or Plane Stress in 2D

- Axial Symmetry, Stress-Strain in 2D axisymmetry

- Solid, Stress-Strain in 3D

• The General Heat Transfer application mode from the Heat Transfer Module, if 
your license includes that module, or the Heat Transfer by Conduction application 
mode from COMSOL Multiphysics

This section describes settings specific to the Thermal-Structural Interaction 
predefined multiphysics coupling.

Use the following table to locate the sections describing the individual application 
modes.

APPLICATION MODES APPLICATION MODE DESCRIPTION

Continuum application modes, 
Structural Mechanics Module

page 167
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A N A L Y S I S  TY P E S

There are two available analysis types in the Model Navigator: a static analysis type, 
which uses the stationary solver, and a transient analysis type, which use the 
time-dependent solver but treats the structural mechanics part as being quasi-static.

S U B D O M A I N  S E T T I N G S

Both application modes of this predefined multiphysics coupling are active on all 
subdomains of the model. Thermal expansion is enabled for all subdomains in the 
structural mechanics application mode. In the graphical user interface, you can find 
this on the Load page of the Subdomain Settings dialog box for the structural mechanics 
application mode, where the predefined coupling automatically selects the Include 

thermal expansion check box. On the same page, the expression in the Temp edit field 
is the dependent variable for temperature from the heat transfer application mode, 
typically T.

B O U N D A R Y  S E T T I N G S

The Thermal-Structural Interaction predefined coupling does not define any coupled 
constraints or loads on the boundaries. You can set those individually for the structural 
and thermal analyses.

Example Model

.See Chapter 13, “Thermal-Structure Interaction,” of the Structural Mechanics 
Module Model Library for models that exemplify thermal-structural interaction.

General Heat Transfer, Heat Transfer 
Module

page 24 in the Heat Transfer Module 
User’s Guide

Heat Transfer, Conduction, COMSOL 
Multiphysics

page 171 in the COMSOL 
Multiphysics Modeling Guide

APPLICATION MODES APPLICATION MODE DESCRIPTION
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F l u i d - S t r u c t u r e  I n t e r a c t i o n

The Fluid-Structure Interaction (FSI) predefined multiphysics coupling combines 
fluid flow with structural mechanics by using a Moving Mesh (ALE) application mode 
to capture the movement of the fluid domain. The structural mechanics application 
mode uses the large-deformation option, and the fluid flow application mode enables 
weak constraints that provide the fluid loads on the structure. The fluid flow 
application mode is defined on an ALE frame, whereas the structural mechanics 
application mode for the solid is defined on a reference frame. The FSI couplings 
appear on the boundaries between the fluid and the solid, and there are also predefined 
settings for the subdomain properties. These settings are grouped into easily 
identifiable groups that you assign to the relevant subdomains and boundaries.

Theory Background

The fluid flow is described by the Navier-Stokes equations (Equation 6-1 in the 
COMSOL Multiphysics Modeling Guide), which provide a solution for the velocity 
field u. The total force exerted on the solid boundary by the fluid is the negative of 
the reaction force on the fluid,

 (12-1)

where p denotes pressure, η the dynamic viscosity for the fluid, n the outward normal 
to the boundary, and I the identity matrix. Because the Navier-Stokes equations are 
solved in the spatial (deformed) coordinate system while the structural mechanics 
application modes are defined in the reference (undeformed) coordinate system, a 
transformation of the force is necessary. This is done according to

 (12-2)

where dv and dV are the mesh element scale factors for the spatial frame and the 
reference frame, respectively.

The FSI predefined multiphysics coupling computes the reaction force on the fluid by 
turning on the weak constraints option for the fluid application mode, which adds 
Lagrange multipliers as additional dependent variables. Due to the derivatives present 
in the boundary condition for the velocity field, non-ideal weak constraints are used. 

f n– pI η u∇ u∇( )T
+( )+( )⋅=

F f dv
dV
--------⋅=
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You can read about weak constraints in the section “Using Weak Constraints” on page 
350 of the COMSOL Multiphysics Modeling Guide.

Application Mode Description

A combination of the following three application modes make up the FSI predefined 
multiphysics coupling:

• A continuum application mode:

- Plane Strain in 2D

- Axial Symmetry, Stress-Strain in 2D axisymmetry

- Solid, Stress-Strain in 3D

• Moving Mesh (ALE) from COMSOL Multiphysics

• The Incompressible Navier-Stokes application mode from COMSOL Multiphysics 
or the Chemical Engineering Module

This section describes settings specific to the FSI predefined coupling. Use the 
following table to locate the sections describing the individual application modes.

P R O P E R T I E S

The FSI predefined multiphysics coupling change some of the application mode 
properties from their default settings according to the following table:

APPLICATION MODES APPLICATION MODE DESCRIPTION

Continuum application modes in the 
Structural Mechanics Module

page 167

Moving Mesh (ALE), COMSOL 
Multiphysics

page 445 in the COMSOL 
Multiphysics Modeling Guide

Incompressible Navier-Stokes, 
COMSOL Multiphysics

page 134 in the COMSOL 
Multiphysics Modeling Guide

APPLICATION MODE PROPERTY SETTING

Continuum application modes Large deformation On

Moving Mesh (ALE) Smoothing method Winslow

Incompressible Navier-Stokes Weak constraint Off

Constraint type Non-ideal
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A N A L Y S I S  TY P E

There are two available analysis types in the Model Navigator, a static analysis that uses 
the stationary solver and a transient analysis that uses the time-dependent solver.

S U B D O M A I N  S E T T I N G S

From within the Subdomain Settings dialog box for each application mode, you can 
assign a group of settings to each subdomain by selecting it from the Group list. The 
following groups are available:

• Fluid domain. This group contains subdomain settings for the fluid domain.

- In the structural mechanics application mode, the Fluid domain group makes this 
application mode inactive.

- In the Incompressible Navier-Stokes application mode, this group uses the 
default properties for the fluid. Change these properties to match the fluid in 
your model.

- In the Moving Mesh (ALE) application mode, this group defines free mesh 
displacement

• Solid domain. This group contains subdomain settings for the solid domain.

- In the structural mechanics application mode, the this group uses the default 
properties for the solid. Change these properties to match the solid in your 
model.

- In the fluid flow application mode, the Solid domain group makes this application 
mode inactive.

- In the Moving Mesh (ALE) application mode, this group defines physics-induced 
mesh displacement using the displacements from the structural mechanics 
application mode. Note that in 2D axisymmetry, these displacements are defined 
as prescribed mesh displacements because the dependent variables in the Axial 
Symmetry, Stress-Strain application mode differ from the actual displacements, 
which instead are available as variables. The following table shows the applied 
settings for the different space dimensions.

SPACE DIMENSION SELECTION EDIT FIELD EXPRESSION

2D Physics induced displacement dx u

dy v

3D Physics induced displacement dx u

dy v

dz w
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B O U N D A R Y  S E T T I N G S

You can apply predefined boundary settings by selecting a group from the Group list in 
the Boundary Settings dialog box for the application modes. Each of the following 
groups is available only in one of the application modes:

• Fluid load. This group, found in the structural mechanics application mode, defines 
the fluid load on the structure using the variable for the total force per area times a 
factor for the area effect, for example, T_x_ns*dvol_ale/dvol. The expression 
includes a factor for the area effect because the total force variable comes from the 
deformed mesh, whereas the forces in the structural mechanics application mode 
must be based on the undeformed area. This factor is the mesh element scale factor 
for the ALE frame divided by the mesh element scale factor for the reference frame. 
Also, for axisymmetric models, an additional factor (R+uaxi)/R takes the radial 
displacement into account.

• Structural velocity. This group, found in the fluid flow application mode, is only 
applicable for transient analysis, where the time derivatives of the structural 
displacements define the fluid’s velocity. Moving leaking wall is set as Boundary 

condition with components according to the following table.

2D axial symmetry Prescribed displacement dr uaxi_smaxi

dz w

SPACE DIMENSION EDIT FIELD EXPRESSION

2D uw ut

vw vt

3D uw ut

vw vt

ww wt

2D axial symmetry uw uaxi_t_smaxi

vw wt

SPACE DIMENSION SELECTION EDIT FIELD EXPRESSION
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• Structural displacement. Use this setting in the Moving Mesh (ALE) application 
mode at the boundaries of the solid domain. The settings define the mesh 
displacements as the structural displacements, according to the table below.

• Fixed. This group, found in the Moving Mesh (ALE) application mode, defines the 
mesh displacements to be zero. Use this setting at the exterior boundaries of the 
fluid domain.

In addition to these predefined settings, you typically define standard boundary 
conditions such an inflow velocities, slip, and no-slip conditions in the fluid flow 
application mode and one or several fixed boundaries in the structural mechanics 
application mode.

Example Model

“Obstacle in Fluid” on page 296 of the Structural Mechanics Module Model Library 
shows a static 3D FSI simulation.

SPACE DIMENSION EDIT FIELD EXPRESSION

2D dx u

dy v

3D dx u

dy v

dz w

2D axial symmetry dr uaxi_smaxi

dz w
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A c ou s t i c - S t r u c t u r e  I n t e r a c t i o n

Acoustic-structure interaction refers to a multiphysics phenomenon where the fluid’s 
pressure causes a fluid load on the solid domain, and the structural acceleration affects 
the fluid domain as a normal acceleration across the fluid-solid boundary.

The Acoustic-Structure Interaction predefined multiphysics coupling provides entry 
points in the Model Navigator that simplify the modeling of acoustic-structure 
interaction. The predefined multiphysics coupling adds an application mode for the 
pressure acoustics and a structural mechanics application mode. It also adds predefined 
groups for the fluid domain and the solid domain as well as the fluid load and structural 
acceleration for use on the fluid-solid boundaries.

Implementation

The Acoustic-Structure Interaction predefined multiphysics coupling adds an 
application mode for acoustic pressure in the fluid domain and a structural mechanics 
application mode for the solid domain. It also adds predefined groups for the fluid 
domain and the solid domain as well as the fluid load and structural acceleration for 
use on the fluid-solid boundaries.

Acoustic-Structure Interaction is available in the following space dimensions:

• In 2D using a plane strain analysis, adding the Plane Strain application mode from 
the Acoustics Module or, if the license includes any of those modules, the Structural 
Mechanics Module or the MEMS Module

• In 2D axisymmetry, the predefined coupling uses the Axial Symmetry, Stress-Strain 
application mode

• In 3D, the Solid, Stress-Strain application mode from the Acoustics Module or, if 
the license includes any of those modules, the Structural Mechanics Module or the 
MEMS Module, describes the elastic solid

The predefined multiphysics coupling uses the Acoustics Pressure application mode in 
the Acoustics Module if avaialable; otherwise it uses the Acoustics application mode in 
COMSOL Multiphysics. The structural mechanics application mode comes from the 
Acoustics Module or—if the license includes either of them—the Structural Mechanics 
Module or the MEMS Module; these two modules provide a version of the application 
modes for structural mechanics that also include nonlinear structural effects.
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The following analysis types are avaialable:

• Eigenfrequency analysis

• Transient analysis

• Frequency response analysis (the default analysis type).

S U B D O M A I N  S E T T I N G S

Two predefined groups are available in the Subdomain Settings dialog boxes:

• Fluid domain. Selecting this group in the Pressure Acoustics application mode 
makes it active in the domain. Selecting this group in the structural mechanics 
application mode makes that application mode inactive (turned off) in the domain.

• Solid domain. Selecting this group in the structural mechanics application mode 
makes it active in the domain. Selecting this group in the Pressure Acoustics 
application mode makes that application mode inactive (turned off) in the domain.

B O U N D A R Y  S E T T I N G S

Two predefined groups are available in the Boundary Settings dialog boxes:

• Fluid load: Available in the structural mechanics application mode for the 
boundaries between the solid and the fluid. It sets the pressure load (force per unit 
area) Fp = −ns  p on the boundaries where you choose this group. In this expression, 
ns is the outward-pointing unit normal vector seen from inside the solid domain.

• Structural acceleration: Available in the Pressure Acoustics application mode for the 
boundaries between the solid and the fluid. Sets the boundary condition to Normal 
acceleration with the acceleration based on the second derivatives of the structural 
displacements u with respect to time: an = n · utt.

To start a model using the Acoustic-Structure Interaction predefined multiphysics 
coupling, first open the Acoustic-Structure Interaction folder in the Acoustics Module, 
Structural Mechanics Module, or MEMS Module part of the Model Navigator (depending 
on which modules the license includes). Next, optionally choose one of the following 
alternatives:

•  Eigenfrequency analysis

•  Transient analysis

•  Frequency response analysis (the default)

Finally, click OK.
R  1 2 :  P R E D E F I N E D  M U L T I P H Y S I C S  C O U P L I N G S



Example Model

Acoustic-Structure Interaction on page 22 in the Structural Mechanics Module 
Model Library uses the Acoustic-Structure Interaction predefined multiphysics 
coupling.
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Th e rma l - E l e c t r i c - S t r u c t u r a l  
I n t e r a c t i o n

The Thermal-Electric-Structural Interaction predefined multiphysics coupling 
combines a continuum application mode for structural analysis with the Conductive 
Media DC application mode from COMSOL Multiphysics or the AC/DC Module 
and a heat transfer application mode from the Heat Transfer Module or COMSOL 
Multiphysics. The predefined couplings include Joule heating and thermal expansion.

Theory Background

Read about constitutive equations including thermal expansion in the section dealing 
with the theory background for the continuum application modes, on page 172 of this 
manual.

The Joule heating follows from Joule’s law, which states that

where Q is the heat generated by an electric current I that flows through a conductive 
media with an electrical resistance R for a time t.

Application Mode Description

A combination of the following three application modes makes up the 
Thermal-Electric-Structural Interaction predefined coupling:

• A continuum application mode:

- Plane Strain or Plane Stress in 2D

- Axial Symmetry, Stress-Strain in 2D axisymmetry

- Solid, Stress-Strain in 3D

• Conductive Media DC

• The General Heat Transfer application mode from the Heat Transfer Module, if 
your license includes that module, or the Heat Transfer by Conduction application 
mode from COMSOL Multiphysics

Q I2Rt=
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This section describes settings specific to the Thermal-Electric-Structural Interaction 
predefined multiphysics coupling.

Use the following table to locate the sections describing the individual application 
modes.

A N A L Y S I S  TY P E S

There are two analysis types available in the Model Navigator: a static analysis type, 
which uses the stationary solver, and a transient analysis type, which uses the 
time-dependent solver but treats the structural mechanics part as being static (the 
structural mechanics application mode uses the quasi-static transient analysis type).

S U B D O M A I N  S E T T I N G S

All application modes of this predefined multiphysics coupling are active on all 
subdomains of the model.

Thermal expansion is enabled for all subdomains in the structural mechanics 
application mode. In the graphical user interface, you find this on the Load page of the 
Subdomain Settings dialog box for the structural mechanics application mode, where 
the predefined coupling automatically selects the Include thermal expansion check box. 
On the same page, the expression in the Temp edit field is the dependent variable for 
temperature from the heat transfer application mode, typically T. 

For the Joule heating, the heat source in the heat transfer application mode contains 
the variable for the resistive heating, typically Q_emdc or Q_dc. Also, the conductivity 
relation in the Conductive Media DC application mode is the linear temperature 
relation. If you want to use another temperature-dependent conductivity, select 
Conductivity from the Conductivity relation list.

In the Conductive Media DC application mode, the definition of the conductivity σ 
uses the thermal heating model 1/(ρ0(1+α(T−T0))), where T is the dependent variable 

APPLICATION MODES APPLICATION MODE DESCRIPTION

Continuum application modes, Page 167

Conductive Media DC Page 85 in the COMSOL Multiphysics 
Modeling Guide or page 157 in the 
AC/DC Module User’s Guide,

General Heat Transfer, Heat Transfer 
Module

Page 24 in the Heat Transfer Module 
User’s Guide

Heat Transfer by Conduction, COMSOL 
Multiphysics

Page 171 in the COMSOL 
Multiphysics Modeling Guide
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for temperature from the heat transfer application mode. The values for ρ0 (resistivity 
at reference temperature), α (temperature coefficient), and T0 (reference temperature) 
are default values that you can change to match your modeling situation.

For the plane stress case, the General Heat Transfer application mode includes 
out-of-plane heat transfer (the corresponding application mode property is turned on).

Note: It is important that all material properties are consistent across all application 
modes. By default using this predefined multiphysics coupling, the following 
properties in the structural mechanics (continuum) application mode are those of 
copper: Young’s modulus (elasticity modulus), Poisson’s ratio, thermal expansion 
coefficient, and density.

B O U N D A R Y  S E T T I N G S

The Thermal-Electric-Structural Interaction predefined coupling does not define any 
coupled constraints or loads on the boundaries. You can set those individually for the 
structural, electric, and thermal analyses.
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F a t i g u e  A n a l y s i s
This chapter describes how to perform fatigue analysis using the Structural 
Mechanics Module together with MATLAB.
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Ba c k g r ound and I n t r o du c t i o n  t o  
F a t i g u e  Ana l y s i s

The term fatigue is used for describing the phenomenon where a component fails after 
repeated loadings and unloadings, even though the magnitude of each individual load 
is smaller than the ultimate stress of the material. The term was coined in the middle 
of the nineteenth century, when a number of railroad accidents draw attention to the 
subject. A vast majority of all structural failures even today are attributed to fatigue, so 
dimensioning against fatigue is of the utmost importance.

When a fatigue failure occurs, the process can be divided into three stages:

1 During a large number of load cycles (repeated loadings and unloadings), damage 
is accumulated on the micromechanical scale, and after some time a crack of 
macroscopic size is formed.

2 The macroscopic crack grows for each new load cycle.

3 When the crack has reached a certain size, the remaining material can no longer 
sustain the peak load, and the component fails.

Usually, the last two stages are considered within the topic of fracture mechanics, and 
the term fatigue applies mainly to Stage 1. Because the largest part of the life of the 
component is spent before it is possible to observe a macroscopic crack, most designs 
aim to avoid ever getting such a crack.

Phenomenology and Testing

The underlying reason for fatigue must be sought on the micromechanical scale, on 
which materials are not homogenous. In an alloy there are grains, whose boundaries 
cause stress concentrations. In a casting, there might even be pores that are formed 
during the solidification. Thus, on a local scale, the strains might be much larger than 
their macroscopic average values, and dislocations within the crystals are activated.

Because the location of these micromechanical irregularities are more or less randomly 
distributed, there is a large scatter in the number of cycles that a certain type of 
component can be subjected to, even if the external load is well defined. This scatter 
R  1 3 :  F A T I G U E  A N A L Y S I S



makes it necessary to test many specimens when looking for fatigue data. Two 
examples of these statistical effects are:

• If two sets of bars with different diameters are tested in tension with the same 
nominal stress, the larger one will appear to have a shorter lifetime. The reason is 
that within a larger volume of material, the risk of finding a microscopic defect of a 
certain size is larger.

• If the same type of bar is tested in both tension and bending giving the same peak 
stress, the one tested in bending will appear to have longer lifetime. During bending 
only a small volume of the material is subjected to the highest stress.

A pioneer in the field of fatigue was the German engineer August Wöhler who 
presented a classical work in 1870. His name is used for diagrams showing stress 
amplitude (see Equation 13-2 on page 400) versus number of cycles to fatigue. They 
are called Wöhler curves or S-N curves. An example appears in Figure 13-1.

Figure 13-1: Example of an S-N curve.

You usually obtain an S-N curve by testing at different stress levels and recording the 
number of cycles to failure. Several specimens are tested at each level, so that average 
and scatter can be computed, giving one point of the curve. Note that because the S-N 
curve gives the level at which a certain percentage (often 50%) of a population can be 
expected to fail, that value cannot always be directly used for dimensioning. 
Knowledge of the scatter in terms of the standard deviation is necessary to transform 
the given data to another, acceptable, level. For a certain number of cycles, a certain 
stress level is then connected to a probability of failure. The acceptable probability (and 
thus stress level) in a design of course differs between a passenger aircraft and a lawn 
mower.
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There are two different regimes of the fatigue phenomena: Low-cycle fatigue (LCF) 
and high-cycle fatigue (HCF). The border between the two is in no way exact, but 
usually a cycle count larger than 104 is considered as “high cycle.” Characteristic of 
LCF is that significant plastic strains occur on the macroscopic scale.

For some materials (for example, many steel and titanium alloys) a lowest stress level 
exists, below which fatigue does not occur irrespective of the number of load cycles. 
This level is called the fatigue limit or endurance limit. Many other materials such as 
aluminum and copper do not appear to have such a limit.

For a material having a fatigue limit, the S-N curve has a horizontal asymptote at large 
cycle numbers. Fatigue limits are often of the order of half the ultimate tensile 
strength.

Even for a material without a fatigue limit, such values are sometimes given. They 
actually represent the value of the S-N curve at a certain large number of cycles, for 
example, 5·107.

It is often possible to represent the central part of the S-N curve (which is in the HCF 
regime) by a straight line in a log-log diagram. This relation is called the Basquin 
equation, which states that

 (13-1)

Here Nf is the number of load reversals, so that 2Nf is the number of full cycles. σ'f 
and b are material parameters.

D E F I N I T I O N S  O F  F A T I G U E  Q U A N T I T I E S

In addition to the stress amplitude, the mean stress is also important for when fatigue 
cracks appear. A tensile mean stress decreases the fatigue life, while a compressive stress 
increases it. If σmax is the maximum stress over the cycle, and σmin is the minimum 
stress, the following definitions are used:

Stress amplitude:

 (13-2)

Stress range

 (13-3)

Mean stress:

σa σ'f 2Nf( )b
=

σa
σmax σmin–

2
--------------------------------=

∆σ σmax σmin–=
R  1 3 :  F A T I G U E  A N A L Y S I S



 (13-4)

R-value:

 (13-5)

The R-value is the most commonly used parameter for describing the mean stress level.

The most common fatigue test is the one where the loading is fully reversed, that is 
having a zero mean stress (R = −1). The second fundamental test is the pulsating test, 
where the load varies between zero and a maximum value (R = 0). For cases with 
nonzero mean stresses, note that the S-N curve can be defined in terms of either the 
stress amplitude or the maximum stress. The functions used in the Structural 
Mechanics Module is specified through the stress amplitude and R-value.

Figure 13-2: Example of cyclic loading.

M E A N  S T R E S S  E F F E C T S

The mean stress effects can be represented in a Haigh diagram, a plot of the stress 
amplitude versus the mean stress for different number of load cycles (see Figure 13-3). 
Unfortunately, it is rare that enough data are available, so in practice rather crude 
simplifications are made. The most common mean stress corrections are the Goodman 
and the Gerber corrections. The Goodman correction approximates the curve in the 
Haigh diagram by a straight line, and the Gerber correction approximates it by a 
parabola. The simplified diagram appears in Figure 13-4. If data is available for both 

σm
σmax σmin+

2
---------------------------------=

R
σmin
σmax
-------------=
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R = −1 and R = 0, it is possible to use the bilinear approximation that Figure 13-4 also 
includes.

Figure 13-3: An example of a Haigh diagram.
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Figure 13-4: Simplified Haigh diagram.

There are a number of other factors that can affect the S-N curves:

• Environmental effects. A corrosive environment is negative for the fatigue life. A 
material usually having a fatigue limit might have none in a corrosive environment.

• Surface finish. Most data are obtained from polished specimens. Because 
microscopic irregularities are involved in the formation of fatigue cracks, a rough 
surface decreases fatigue life.

• Statistical size effects, as described earlier in this section.

• Residual stresses from manufacturing. This is sometimes used intentionally, for 
example, by shot peening that results in beneficial compressive stresses in the surface 
of the component.

L O W - C Y C L E  F A T I G U E

Low-cycle fatigue is sometimes referred to as “strain based.” The reason is that the 
relevant parameter for describing LCF is strain rather than stress. Note though that 
physically it is the strain that does the damage in HCF as well. Because HCF occurs in 
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the elastic regime, it is possible to use either stress or strain as the parameter, but the 
use of stress has historical and practical reasons.

The LCF analogy to the Basquin equation is the Coffin-Manson equation

 (13-6)

where ∆εp is the plastic strain range, and ε'f and c are material parameters. The 
implication is that the plastic strain range is a straight line when plotted in a log-log 
S-N–type diagram against the number of cycles.

It is also possible to combine the Basquin and Coffin-Manson equations into a single 
expression, covering the entire range of LCF and HCF:

 (13-7)

The first term represents the elastic strain, the second the plastic strain, and ∆ε is the 
total strain range. The following table lists the parameters in Equation 13-7.

PARAMETER DESCRIPTION

 εf′ Fatigue ductility coefficient

 c Fatigue ductility exponent

 σf′ Fatigue strength coefficient

 b Fatigue strength exponent

∆εp
2

--------- ε'f 2Nf( )c
=

∆ε
2

------
σ′f
E
------- 2Nf( )b ε′f 2Nf( )c

+=
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Figure 13-5: Strain-life curve.

As a criterion of the limit between LCF and HCF, you can use the transition life 2Nt. 
It is the intersection between the lines formed by the Basquin and the Coffin-Manson 
curves.

Because plastic strains are important in LCF, analysis of such problems are more 
complex than the analysis of the corresponding HCF problem. The plastic strain must 
be obtained either from a full elasto-plastic analysis, or from some kind of extrapolation 
of an elastic analysis.

Loading Aspects

So far, the only load considered has constant amplitude, and the effect of it is a uniaxial 
stress.

In reality, the loads often have variable amplitude, and possibly also varying mean 
stress. The reason can be either that the service cycle contains several different well 
defined loadings, or that the load is random by its nature.

It is known that the order in which different loads are applied can have an effect, but 
most fatigue analyses ignore this fact due to the difficulties involved in such an analysis. 
Instead they treat the effect of each load as independent.
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Assume that you have a set of stress cycles with amplitude/mean value pairs. Using the 
linear cumulative damage rule attributed to Palmgren and Miner, each such pair 
produces a relative damage

 (13-8)

where Ni is the number of cycles to fatigue if only loads from pair i were acting.

In practice, all pairs with similar values are grouped together in classes (“bins”), 
represented by its class midpoint. If the number of cycles stored in bin i is ni, the 
corresponding relative damage is

 (13-9)

The limit for the possible fatigue life is then given by

 (13-10)

which implies infinite fatigue life for cases where this sum is less than 1.

For a random load, some type of cycle counting over a representative time interval 
must be used. This can be done from true measurements, or from a synthesized load 
history if the statistical properties of the load are known. The most commonly used 
method is called rainflow counting (Ref. 1), a procedure indicated in Figure 13-7. In 
the Structural Mechanics Module it is possible to perform a rainflow count on an 
arbitrary signal and split it into any number of amplitude/mean value pairs.

Figure 13-6: An example of a random load.

di
1

Ni
------=

di
ni

Ni
------=

ni
Ni
------

i
∑ 1=
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Figure 13-7: Rainflow counting of the cycles for the random load in the previous figure.

In real-life components the stress state is often multiaxial, in the sense that more than 
one principal stress is nonzero. Triaxial states of stress are unusual in this context, 
however, because fatigue cracks tend to appear on free surfaces, which by definition 
have a state of plane stress. The main exception is where contacting surfaces cause 
compression, so that fatigue cracks may instead develop below the surface.

If the directions of the principal stresses are fixed and the ratio between the principal 
stresses remain constant over the load history, the loading is said to be proportional. 
The problem is then just a matter of transforming uniaxial material data to biaxial 
material data.

In order for the opposite case, nonproportional loading, to occur, at least two 
independent loads must act on the structure. If the components of the stress tensor at 
the point of consideration do not only differ by a scale factor when the individual loads 
are applied, the loading is nonproportional. You find a simple case with 
nonproportional loading in the model Shaft with Fillet on page 238 in the Structural 
Mechanics Module Model Library.
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If, however, the principal axes rotate between the loadings, the situation is much more 
complex. There are many methods suggested in the literature, both for LCF and HCF. 
A family of methods known as critical plane methods are popular, and are used in the 
Structural Mechanics Module; more information and details are available on page 410. 
In a critical plane method, some failure criterion is evaluated in all possible directions 
at a certain material point, and the maximum value is used.

Design Strategies

There are several possible strategies when designing components subjected to 
alternating loads.

1 Design for infinite lifetime by keeping the stresses sufficiently low. “Infinite” should 
here be interpreted as much longer than the service life of the component, so the 
method can be used also for a material without fatigue limit. This is the most 
common approach, and is preferred as long as it is not unfeasible.

2 Design for a fixed life (with sufficiently large factor of safety), after which the 
component is replaced.

3 Damage tolerant design, where the structure is inspected for cracks at regular 
intervals. In this case it is the growth rate of macroscopic cracks that sets the limit 
of the inspection interval, and fracture mechanics methods must be used in the 
analysis.

Summary
As a summary, it is necessary to answer the following questions when performing a 
fatigue analysis:

• Low-cycle or high-cycle fatigue?

• If low-cycle fatigue; will an elastic analysis be sufficient or is an elasto-plastic analysis 
required? An LCF analysis with both methods is shown in the 
cylinder_with_hole model on page 264 in the Structural Mechanics Module 
Model Library.

• Will the load have constant or variable amplitude? In the later case cumulative 
damage summing is required.

• Will the principal axes of the strain tensor be approximately constant or will they 
change between loadings?

• Are reliable material data available? How large is the scatter, and what risk of failure 
is acceptable?
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Using the Structural Mechanics Module, it is possible to analyze both LCF and HCF 
problems. The procedure always starts with a stress analysis, and you then perform the 
evaluation against fatigue criteria as a separate postprocessing step. The fatigue analysis 
tools can handle the following types of loading:

• Proportional loading with constant amplitude

• Nonproportional loading with constant amplitude

• Proportional loading with nonconstant amplitude

Reference

1. “Standard practices for cycle counting in fatigue analysis,” ASTM international, 
ASTM E 1049-85, 2005.

Further Reading

1. R.I. Stephens, A. Fatemi, R.R. Stephens, and H.O. Fuchs, Metal Fatigue in 
Engineering, Wiley-Interscience, 2000.

2. N.E. Dowling, Mechanical Behavior of Materials (3rd Edition), Prentice Hall, 
2006.

3. D.F. Socie and G.B. Marquis, Multiaxial Fatigue, SAE, 1999.
B A C K G R O U N D  A N D  I N T R O D U C T I O N  T O  F A T I G U E  A N A L Y S I S  |  409



410 |  C H A P T E
How t o  P e r f o rm Fa t i g u e  Ana l y s i s

This section provides a detailed description of how to perform fatigue analysis using 
the Structural Mechanics Module. The theoretical background to the different fatigue 
models is also explained.

High-Cycle Fatigue

High-cycle fatigue typically means that the number of load cycles exceeds 104. The 
loading can be divided in nonproportional and proportional loading. The functions in 
the Structural Mechanics Module performing high cycle fatigue analysis are:

• fatiguedamage (see page 190 for details)

• hcfmultiax (see page 193 for details)

S - N  C U R V E S  ( W Ö H L E R  C U R V E S )

Fatigue data for high cycle fatigue are often given as S-N curves—often referred to as 
Wöhler curves—where the stress amplitude S (σa) is given as a function of the number 
of cycles to fatigue, N. Figure 13-8 shows a typical S-N curve. An S-N curve is 
experimentally determined.

Figure 13-8: S-N curve for high-strength Iron Alloy UNS 4340.

The S-N curve depends on the mean stress, which can be characterized by the R value 
defined as
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 (13-11)

Here σmin is the minimum stress value and σmax is the maximum stress value. The 
stress amplitude, σa, is defined as

 (13-12)

The most common fatigue tests are done for alternating loads (R = −1) and pulsating 
loads (R = 0). The allowable stress amplitude decreases with increasing R value.

Figure 13-9: S-N curves for different R-values.

The function fatiguedamage requires the S-N data to be given as names of functions. 
The functions need to reside in a directory included in the MATLAB path. Input to 
the S-N curve is the number of cycles, output is the stress amplitude to fatigue for the 
given number of cycles. Examples of such a function is sn_mat1_r_min1 included in 
the Structural Mechanics Module:

function stressAmp = sn_mat1_r_min1(n)
%SN_MAT1_R_MIN1 Compute stress amplitude to fatigue from number of cycles for
%               4340 (UNS G43400)
%               UTS 200 Ksi - 293K
%               R=-1; unnotched
%
%   STRESSAMP = SN_MAT1_R_MIN1(N) calculates the stress amplitude STRESSAMP 
to fatigue
%   from the number of cycles N

%   Copyright (c) 1998-2008 by COMSOL AB

nExpr = 1;

R
σmin
σmax
-------------=

σa
1
2
--- σmax σmin–( )=
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exprs{1} = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
intervals(1) = 8.000000e+003;
intervals(nExpr+1) = 2.000000e+007;

n = n ;
if (n <= 8.000000e+003 )
  n = 8000;
  stressAmp = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
elseif (n >= 2.000000e+007);
  n = 20000000;
  stressAmp = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
else
  if (n > 8.000000e+003 & n <= 2.000000e+007)
    stressAmp = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
  end 
end 
r = -1.000000e+000;
stressAmp = stressAmp*(1-r)/2;

The fatigue data in the example above is extracted from the COMSOL Material 
Library, which is an add-on product to COMSOL Multiphysics. This is done using the 
matlibfatigue function. For details see matlibfatigue on page 199 in the 
Structural Mechanics Module Reference Guide.

Note: The S-N curves in the Material Library are given on the form σmax as function 
of number of cycles, but the fatigue functions in the Structural Mechanics Module 
requires σa as function of the number of cycles. The transformation is automatically 
handled by the matlibfatigue function.

Using Equation 13-11 and Equation 13-12, σa can be calculated from σmax as

 (13-13)

For R values between two specified S-N curves, the values are calculated by 
interpolating between the two S-N curves. You pass the R values for the specified S-N 
functions to the fatiguedamage function using the rvalue property.

For R values outside the available S-N curves a mean stress correction is calculated by 
interpolating the value for R = − 1 and then using the mean stress correction method 

σa σmax
1 R–( )

2
------------------=
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specified through the method property to the fatiguedamage function. The same 
applies if you only have the S-N curve for R = − 1. There are different mean stress 
correction theories to use if you only have fatigue data for R = − 1, that is, an 
alternating load. The Structural Mechanics Module supports two such methods: 
Gerber and Goodman. The methods are based on the ratio between mean stress and 
the ultimate stress σuts. Figure 13-10 compares the stress amplitude as function of the 
mean stress for the two methods.

Figure 13-10: Mean stress compensation for the Gerber and Goodman methods for a 
material with an ultimate stress of 1000 MPa and an endurance limit of 300 MPa for 
alternating loads.

You specify the ultimate stress to the fatiguedamage function using the params 
property.

N O N P R O P O R T I O N A L  L O A D I N G ,  C O N S T A N T  A M P L I T U D E

Use the function hcfmultiax for this type of analysis. The properties in the following 
section refer to the hcfmultiax function.

Theory Background
Nonproportional loading is defined as any state of time-varying stress in which the 
orientations of the principal stress axes change with respect to axes that are fixed with 
respect to the component. A simple example of nonproportional loading is a shaft 
exposed to both cyclic bending and torsion.

The critical plane is defined as the plane where the fatigue crack occurs. Different 
models use different criteria to determine the critical plane. A successful model must 
be able to predict both the fatigue life and the dominant failure plane. For 
nonproportional loading you need to examine the loading history for all possible 
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planes (directions) in order to find the critical plane. A critical plane model evaluates 
the stresses on different planes (directions) in the material and maximizes some type of 
damage criterion with respect to all possible directions. You control the resolution of 
the direction search with the property anglestep. anglestep is the step in angle 
subdividing the longitude of the unit sphere and controlling the subdivision in the 
latitude direction. This means that the number of searches are inversely proportional 
to the square of the step. The critical plane model in the Structural Mechanics Module 
is the Findley criterion. It can be stated as 

 (13-14)

where k and f are material parameters. You pass these material parameters to the 
hcfmultiax function through the property params. The Findley criterion states stress 
combinations giving the fatigue limit. In Equation 13-14, ∆τ is the maximum shear 
stress range of the cycle, and σn is the maximum normal stress during the cycle. The 
left-hand side of Equation 13-14 must for each material point (for example, a node in 
an FE analysis) be computed for a large number of directions until the maximum value 
is found. The fatigue usage factor fus is the ratio between the Findley criterion and the 
material parameter f. A value below 1 means that the component is loaded below the 
fatigue limit.

 (13-15)

On a given plane the normal stress is a scalar, but the shear stress is a two-dimensional 
vector. This requires an interpretation of ∆τ. The most strict interpretation is that ∆τ 
is the diameter of the smallest circle inscribing the path that the τ vector creates during 
a load cycle. This calculation is nontrivial, however, and takes significant computer 
resources. An alternative is to use the maximum distance between any two points on 
the path instead. This simplified procedure could in extreme cases underestimate ∆τ by 
13%, but in most cases the result is much better. The summation in Equation 13-14 
further reduces the error. The hcfmultiax function supports both these methods for 
calculating ∆τ through the property opt.

To find the two material parameters k and f you need two fatigue tests with different 
loading conditions. This can, for example, be pure tension and pure torsion, but there 
are other possibilities. For axial loading, the following relation is valid:

∆τ
2

------ k σn⋅+⎝ ⎠
⎛ ⎞

max
f=

fus

∆τ
2

------ k σn⋅+⎝ ⎠
⎛ ⎞

max
f

-------------------------------------------=
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 (13-16)

Here σmax, and σmin are the maximum and minimum stresses at the fatigue limit, that 
is, infinite life. In a pure (fully reversed) torsion test with an amplitude τa of the 
torsional shear stress, the corresponding relation is

 (13-17)

If only uniaxial test data with a single R value is available, it is possible to estimate k 
from the ratio between the fatigue limits under different conditions for a similar 
material.

Conducting a Fatigue Analysis
An analysis of high-cycle fatigue with nonproportional loading consists of the 
following steps:

1 Perform a finite element analysis (FEA) for the basic load cases.

2 Calculate all stress components from the FEA model for the different basic load 
cases at the locations where you are interested to find the fatigue damage. You do 
this by calling posteval from the command prompt.

3 Define the loading history by combining the basic load cases.

4 Find appropriate material data in the form of Findley parameters, k and f.

5 Calculate the fatigue usage factor using the hcfmultiax function. You find a 
detailed description in the entry for hcfmultiax on page 193 in the Structural 
Mechanics Module Reference Guide.

6 Plot the fatigue damage and look at the stress history. You can plot the fatigue 
damage using the postdataplot function.

You find an example of a high-cycle fatigue analysis with nonproportional loading in 
the model “Shaft with Fillet” on page 238 of the Structural Mechanics Module Model 
Library.

P R O P O R T I O N A L  L O A D I N G ,  N O N C O N S T A N T  A M P L I T U D E

You use the function fatiguedamage for this type of analysis. The properties in the 
following section refer to the fatiguedamage function.

When the loading history is not deterministic, the question of how to characterize the 
load cycles from a fatigue point of view arises. An example of such a load (or stress) 

σmax σmin–

2
--------------------------------⎝ ⎠
⎛ ⎞

2
k σmax⋅( )2

+ k σmax⋅+ 2f=

τa
f

1 k2
+

--------------------=
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history is shown in Figure 13-11.

Figure 13-11: Example of a nondeterministic load history.

There are several methods for determining cycles having different ranges and possibly 
corresponding mean values. One commonly used method is “Rainflow counting” as 
described in Ref. 1.

If fatigue data, S-N curves are available it is possible to determine the allowable 
number Ni of cycles to fatigue for each such pair i consisting of a mean and amplitude 
stress. Using the linear cumulative damage rule attributed to Palmgren and Miner, 
each such pair would produce a relative damage

 (13-18)

In practice, all pairs with similar values of the mean stress and amplitude are grouped 
together in classes (“bins”), represented by its class midpoint. If the number of cycles 
stored in bin i is ni, the corresponding relative damage is

 (13-19)

The limit for the possible fatigue life is then given by

 (13-20)

In the Structural Mechanics Module there is a function named rainflow, which 
performs a rainflow count on an arbitrary signal and returns the number of occurrences 
in a matrix of (range, mean) bins.

di
1
Ni
------=

di
ni
Ni
------=

ni

Ni
------

i
∑ 1=
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This type of counting is useful only if the principal stresses are not rotating; in practice 
this often means that a single load controls the stress history, or that the critical point 
has a uniaxial stress state. It is theoretically possible to include effects of multiaxiality, 
but usually a single stress component (for example, the largest principal stress) is used.

The total fatigue damage factor damtot calculated by the Structural Mechanics 
Module function fatiguedamage is defined as

 (13-21)

Conducting a Fatigue Analysis
An analysis of high-cycle fatigue with nonconstant amplitude and proportional loading 
consists of the following steps:

1 Perform a finite element analysis for a unit loading factor.

2 Calculate all stress components from your FEA model at the locations where you 
are interested to find the total fatigue damage factor damtot. You do this by calling 
the posteval function.

3 Define the loading history as load factors either from measurements or from 
statistical methods.

4 Perform a Rainflow count of the loading history using the rainflow function. This 
results in a binning of your load. You can plot the result of the count using the stem 
plot function.

5 Find appropriate material data for different mean stresses in form of S-N curves and 
write functions (M-files) returning the stress amplitude giving the number of cycles 
or use a single S-N curve for R = −1 and specify a mean stress correction method 
through the method property.

6 Calculate the total fatigue damage factor damtot and the damage distribution using 
the fatiguedamage function. You find a detailed description of fatiguedamage on 
page 190 in the Structural Mechanics Module Reference Guide.

7 Plot the total fatigue damage factor damtot and the damage distribution.

You find an example of a high-cycle fatigue analysis with proportional loading in the 
model “Frame with Cutout” on page 249 of the Structural Mechanics Module Model 
Library.

damtot
ni

Ni
------

i
∑=
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Low-Cycle Fatigue

When studying low-cycle fatigue, it has been found that it is more relevant to use strain 
as the important parameter in the fatigue laws. There is always significant cyclic plastic 
deformation involved in low-cycle fatigue situations. The functions in the Structural 
Mechanics Module performing low-cycle fatigue analysis are:

• lcfmultiaxlin (see page 195 in the Structural Mechanics Module Reference 
Guide for details)

• lcfmultiaxpla (see page 197 in the Structural Mechanics Module Reference 
Guide for details)

For a uniaxial case, it is often possible to use an expression of the type 

 (13-22)

Here ∆ε is the total strain range, and the two terms on the right-hand side represent 
the elastic and the plastic strain contributions. 2Nf  is the number of load reversals to 
fatigue (so that Nf  is the number of full cycles). In addition to the modulus of elasticity, 
E, there are four independent parameters: two coefficients and two exponents:

There are many related models, considering, for example, mean stress effects, 
differences between shear and tension, or multiaxiality. One popular such model is the 
Smith-Watson-Topper (SWT) model. This is a type of critical plane model, where the 
plane normal to the maximum principal strain range is considered.

 (13-23)

The left-hand side is commonly called the SWT parameter and contains the maximum 
normal stress during the cycle on the used plane. The material parameters in 
Equation 13-22 and Equation 13-23 are the same. You specify these parameters to the 
functions lcfmultiaxlin and lcfmultiaxpla through the property params.

PARAMETER DESCRIPTION

 εf′ Fatigue ductility coefficient

 c Fatigue ductility exponent

 σf′ Fatigue strength coefficient

 b Fatigue strength exponent

∆ε
2

------
σf′
E
------- 2Nf( )b εf′ 2Nf( )c

+=

σn max,
∆ε1
2

---------⋅
σf′

2

E
---------- 2Nf( )2b σf′εf′ 2Nf( )b c+

+=
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In general, the stress and strain in Equation 13-22 and Equation 13-23 must be 
computed using plasticity theory. There are two possible approaches. The first is to 
compute a complete cycle, using a full elasto-plastic analysis. In this type of analysis, it 
is important to model the cyclic plastic behavior of the material appropriately. This 
means that kinematic hardening models are more suitable than isotropic models. It 
might also be necessary to analyze more than one load cycle in order to obtain a 
stabilized stress-strain cycle.

The second case occurs if the highly stressed region is localized. In this common case, 
it is possible to determine the stress and strain range using an elastic analysis and then 
externally compute an approximation to the plastic stresses and strains. Neuber’s rule 
states that for a notch, the product of elastically computed stress and strain is equal to 
the product of the actual, inelastic, stress and strain. Strictly speaking, it is defined in 
terms of a uniaxial stress state. In practice, the stress states are often multiaxial, so here 
Neuber’s rule is expressed in equivalent stresses and strains.

 (13-24)

In Equation 13-24 the left side has an “e” denoting the results of an elastic analysis, 
while the right side contains the actual values.

In strain-based fatigue analysis it is customary to assume an Ramberg-Osgood material 
law when modeling the cyclic plastic behavior

 (13-25)

The parameters in Equation 13-25 must be the cyclic values and not the monotonic 
values obtained from a standard tensile test.

Hoffman and Seeger has developed an algorithm for approximate computation of the 
stress and strain amplitude in a multiaxial case. You specify the material properties to 
the function lcfmutiaxlin through the property params. Initially, Equation 13-24 
and Equation 13-25 are solved together for obtaining the true equivalent (in von 
Mises sense) stresses and strains. It is then possible to approximate the major principal 
strain and corresponding stress as

 (13-26)

σe eq εe eq⋅ σeq εeq⋅=

ε σ
E
---- σ

K
----⎝ ⎠
⎛ ⎞

1
n
---

+=

ε1
1 νa–

1 a– a2
+

----------------------------- εeq⋅=
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 (13-27)

These two relations contain the parameters a and . The latter is an effective Poisson’s 
ratio defined as

 (13-28)

A biaxiality factor, , is computed as the ratio between the two in-plane elastic 
principal strains:

 (13-29)

The parameter a is then defined as

 (13-30)

The stress σ1 and the strain ε1 can now be used for computing the fatigue life using, 
for example, the SWT equation above.

C O N D U C T I N G  A  F A T I G U E  A N A L Y S I S

Depending of whether the highly loaded area can be considered localized or not, two 
different methods can be used.

General Case
An analysis of low cycle fatigue with nonlocalized stresses consists of the following 
steps:

1 Perform a full elasto-plastic FEA analysis for as many cycles as needed to get a 
stabilized stress field.

2 Calculate all stress and strain components during a complete cycle at the locations 
where you are interested to find the fatigue damage. Do this by calling the 
posteval function.

3 Find appropriate material data for the Smith-Watson-Topper (SWT) fatigue model.

4 Calculate the fatigue damage using the lcfmultiaxpla function. You find a 
detailed description in the entry for lcfmultiaxpla on page 197 in the Structural 
Mechanics Module Reference Guide.

σ1
1

1 a– a2
+

----------------------------- σeq⋅=

ν

ν 1
2
--- 1

2
--- ν–⎝ ⎠
⎛ ⎞–

σeq

Eεeq
------------⋅=

φ

φ
εe

2

εe
1

-------=

a φ ν+

1 νφ+
----------------=
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5 Plot the fatigue damage by calling the postdataplot function.

You find an example of a low-cycle fatigue analysis using a full elasto-plastic analysis in 
the model “Cylinder with Hole” on page 264 of the Structural Mechanics Module 
Model Library.

Simplified Analysis
An analysis of low cycle fatigue with localized stresses consists of the following steps:

1 Perform a linear elastic FEA analysis to get the stress field.

2 Calculate the principal stress components at the locations where you are interested 
to find the fatigue damage. Do this calculation by calling the posteval function.

3 Find appropriate material data for the Smith-Watson-Topper (SWT) fatigue model 
and your simplified linear elastic to elasto-plastic calculation.

4 Calculate the fatigue damage using the lcfmultiaxlin function. You find a 
detailed description in the entry for lcfmultiaxlin on page 195 in the Structural 
Mechanics Module Reference Guide.

5 Plot the fatigue damage by calling the postdataplot function.

You find an example of a low-cycle fatigue analysis using a linear elastic analysis in the 
model Cylinder with Hole on page 264 of the Structural Mechanics Module Model 
Library.

References

1. “Standard practices for cycle counting in fatigue analysis,” ASTM international, 
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H O W  T O  P E R F O R M  F A T I G U E  A N A L Y S I S  |  421



422 |  C H A P T E
 R  1 3 :  F A T I G U E  A N A L Y S I S



 14
G l o s s a r y  
This glossary contains finite element modeling terms in a structural mechanics 
context. For mathematical terms, and geometry and CAD terms specific to the 
COMSOL Multiphysics software and documentation see the glossary in the 
COMSOL Multiphysics User’s Guide. For references to more information about a 
term, see the index.
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G l o s s a r y  o f  T e rm s
anisotropy   Variation of material properties with direction. Both global and local user 
defined coordinate systems can be used to define anisotropic material properties.

augmented Lagrangian method   Segregated solution method, where the solver 
switches between solving for the contact pressure and the displacements, used when 
modeling contact.

axial symmetry   Symmetry in both load and geometry, solves for the radial (r) and 
axial (z) displacement.

bar    A line element that only has translational degrees of freedom, capable of 
sustaining axial forces, with no bending moments, torsional moments, or shear forces. 
Can be used on lines in 1D, 2D, and 3D.

beam    A line element having both translational and rotational degrees of freedom. 
Capable of sustaining axial forces, bending moments, torsional moments, and shear 
forces. Can be used on curves in 2D and 3D.

benchmark    Standard test designed to evaluate the accuracy or efficiency of a finite 
element system or model.

body forces   Forces distributed through the volume of a body.

buckling   The sudden collapse or reduction in stiffness of a structure under a critical 
combination of applied loads.

cable   A tension-only truss member used to model large deformation including sag.

Cauchy stress   The most fundamental stress measure defined as force/deformed area 
in fixed directions not following the body.

compliance matrix   The inverse of the elasticity matrix. See elasticity matrix.

constitutive equations   The equations formulating the stress-strain relationship of a 
material.

constraint   Constrains the displacement or rotations to zero or a specified value.
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contact model   The mathematical method to model bodies that come into contact 
with each other.

contact pair   A contact pair consists of some slave and master boundaries and is used 
for contact modeling.

continuum application modes   The application modes that solve for the displacement 
field without involving rotations. Solid, Stress-Strain; Plane Stress; Plane Strain; and 
Axial Symmetry, Stress-Strain are the continuum application modes.

coordinate system   Global Cartesian, local geometrical, application specific, and 
user-defined coordinate systems. Loads, constraints, material properties, and 
postprocessing variables are defined in a specific coordinate system.

creep   Time-dependent material nonlinearity that usually occurs in metals at high 
temperatures in which the effect of the variation of stress and strain with time is of 
interest.

damping   Dissipation of energy in a vibrating structure. A common assumption is 
viscous damping where the damping is proportional to the velocity. See also Rayleigh 
damping.

eigenfrequency analysis   Solving for the undamped natural frequencies and vibration 
modes of a structure.

elasticity matrix   The matrix D relating strain to stresses:

elasto-plastic material   A material model where the material exhibits both elastic and 
plastic behavior. See also plasticity.

equilibrium equation   The equation expressing the equilibrium formulated in the stress 
components.

fatigue   A term describing the phenomena where a component fails after repeated 
loadings and unloadings.

first Piola-Kirchhoff stress   A rather mathematical stress measure used in the 
hyperelastic material model, its conjugate strain is the displacement gradient.

σ Dε=
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flexibility matrix   The inverse of the elasticity matrix. See elasticity matrix.

free vibration   The undamped vibration of a structure after it is displaced from the 
equilibrium position and released. See also eigenfrequency analysis.

frequency response analysis   A harmonic analysis solving for the steady-state response 
from a harmonic excitation. Typically a frequency sweep is performed, solving for 
many excitation frequencies at one time.

geometric nonlinearity   See large deformation.

Green-Lagrange strain   Nonlinear strain measure used in large-deformation analysis. 
In a small strain, large rotation analysis, the Green-Lagrange strain corresponds to the 
engineering strain, with the strain values interpreted in the original directions. The 
Green-Lagrange strain is a natural choice when formulating a problem in the 
undeformed state. The conjugate stress is the second Piola-Kirchhoff stress.

hyperelastic material   Material where the stresses are computed from a strain energy 
density function. Often used to model rubber, but also used in acoustoelasticity.

initial strain   The strain in a stress-free structure before it is loaded.

initial stress   The stress in a non-deformed structure before it is loaded.

isotropic material   A material where the material properties are independent of 
direction.

isotropic hardening   A hardening model for an elasto-plastic material where the yield 
surface increases in size but maintains its original shape.

kinematic hardening   A hardening model for an elasto-plastic material where the 
yield surface is translated to a new position in the stress space as the plastic strain is 
increased, with no change in size or shape.

large deformation   The deformations are so large so the nonlinear effect of the change 
in geometry or stress stiffening need to be accounted for.

linear buckling analysis   Solves for the linear buckling load using the eigenvalue solver.

mass damping parameter   Rayleigh damping parameter, the coefficient in front of the 
mass matrix.
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master boundary   One side of a contact pair, the slave boundary is prohibited to 
penetrate the master boundary.

Mindlin plate   A thick plate including shear deformation. See also plate.

mixed formulation   A formulation where the pressure have been added as a dependent 
variable, used for nearly incompressible materials to avoid numerical problems.

Mooney-Rivlin material model   A hyperelastic material model with three model 
parameters. The model is based on modified strain invariants.

Murnaghan material model   A hyperelastic material model with five model parameters. 
The model is based on modified strain invariants and is typically used in 
acoustoelasticity.

Neo-Hookean material model   A hyperelastic material model with two model 
parameters. The model is based on modified strain invariants.

nonlinear geometry   See large deformations.

orthotropic material   An orthotropic material has at least two orthogonal planes of 
symmetry, where material properties are independent of direction within each plane. 
Such materials require nine independent variables (that is, elastic constants) in the 
constitutive equations. 

parametric analysis   An analysis which finds the solution dependence due to the 
variation of a specific parameter.

pinned   A constraint condition where the displacement degrees of freedom are fixed 
but the rotational degrees of freedom are free, typically used for frames modeled using 
beams and truss elements.

plane strain   An assumption on the strain field where all out-of-plane strain 
components are assumed to be zero.

plane stress   An assumption on the stress field, all out-of-plane stress components are 
assumed to be zero.

plasticity   A time-independent material nonlinearity. Three classes of plastic behavior 
are considered: perfectly plastic, isotropic hardening, kinematic hardening.
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plate   Thin structure loaded in the normal direction.

primary creep   The initial creep stage where the strain rate is decreasing with time.

principle of virtual work   States that the variation in internal strain energy is equal to 
the work done by external forces.

principal stresses/strains   Normal stresses/strains with no shear components that act 
on the principal planes. The magnitude of the principal stresses/strains are 
independent of the coordinate system used.

quasi-static transient analysis   The loads vary slowly so inertia terms can be neglected. 
A transient thermal analysis coupled with a structural analysis can often be treated as 
quasi-static.

Rayleigh damping   A viscous damping model where the damping is proportional to the 
mass and stiffness through the mass and stiffness damping parameters.

rotational degrees of freedom   Degrees of freedom associated with a rotation around 
an axis. Beams, Mindlin plates, and shells have rotational degrees of freedom.

secondary creep   A creep regime where the strain rate is almost constant.

second Piola-Kirchhoff stress   Conjugate stress to Green-Lagrange strain used in 
large deformation analysis.

shell elements   A thin element where both bending and membrane effects are 
included.

slave boundary   One side of a contact pair, the slave boundary is prohibited to 
penetrate the master boundary.

static analysis   An analysis where the loads and constraints are constant in time.

strain   Relative change in length, a fundamental concept in structural mechanics.

stress   Internal forces in the material, normal stresses are defined as forces/area normal 
to a plane, and shear stresses are defined as forces/area in the plane. A fundamental 
concept in structural mechanics.
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stiffness damping parameter   Rayleigh damping parameter, the coefficient in front of 
the stiffness matrix.

strain energy   The energy stored by a structure as it deforms under load.

transient analysis   A time-dependent analysis, taking into account mass, mass moment 
of inertia, and damping.

tertiary creep   The creep stage where the strain rate increases very rapidly, followed by 
eventual failure.

Tresca stress   An effective stress measure that is equal to the maximum shear stress.

truss   See bar.

viscoelastic material   Viscoelastic materials have a time-dependent response, even if 
the loading is constant. Many polymers and biological tissues exhibit such a behavior. 
Linear viscoelasticity is a commonly used approximation where the stress depends 
linearly on the strain and its time derivatives.

viscoelastic transient initialization   A static analysis with viscoelasticity included. Used 
to precompute initial states for transient and quasi-static transient analyses when the 
viscoelastic material model is used. It is a regime of instantaneous deformation and/or 
loading.
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3D Euler Beam application mode 297

3D Truss application mode 320

A absolute tolerances 151

absorbing boundaries 231

acceleration loads 75

acceleration, prescribed 329

acoustic-structure interaction 135, 391

Allman triangle 322

amplitude 44, 164, 266, 314, 333

analysis

dynamic 35

analysis capabilities 156, 161

analysis types 157, 206, 350

damped eigenfrequency 201

eigenfrequency 31, 162

for piezoelectric modeling 350

frequency response 44, 163, 200

harmonic 163, 200

linear buckling 165

parametric 7, 51, 198

quasi-static 164

quasi-static transient 56, 199

static 17, 157, 162, 198

static elasto-plastic material 206

thermal-structural 165

time-dependent 35, 163, 199

transient 35, 163, 199

viscoelastic transient initialization 199

angular excitation frequency 163

anisotropic material 180, 210

antisymmetric loading 82

antisymmetry plane 329

application mode guide 155

application mode properties

analysis type 206, 350

create frame 235

large deformation 207, 305

weak constraints 207

Application Mode Properties dialog box 

162, 206, 349

application modes

3D Euler Beam 297

3D Truss 320

Axial Symmetry, Stress-Strain 171

continuum 172

for beams 296

In-Plane Euler Beam 296

In-Plane Truss 319

Mindlin Plate 245

overview of 156

Piezo Axial Symmetry 378

Piezo Plane Strain 377

Piezo Plane Stress 377

Piezo Solid 376

piezoelectrical 349

Plane Strain 170

Plane Stress 169

selecting 159

Shell 321

Solid, Stress-Strain 168

application scalar variable 158

Application Scalar Variables dialog box 

163

area effects, in FSI models 389

area moment of inertia 281

Argyris TRIC triangle element 322

assembly 236

auglagiter variable 240

augmented Lagrangian method 137, 152, 

201

axial symmetry 82, 158

symmetry axis for 171, 379
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Axial Symmetry, Stress-Strain application 

mode 171

B bars 299

Basquin equation 400

beams 271

application mode description for 277

constraints for 283

cross-section properties for 281

damping 293, 316

initial loads 275, 294

initial strains 275, 294

in-plane Euler beams 296

loads applied to 288

shape functions for 272

theory background 272

thermal couplings in 292

thermal strain in 274

biaxiality factor 420

boundary conditions

for electric currents 365

Boundary Settings dialog box 14, 22, 39, 

158

buckling 8, 165

bulk modulus 175, 179, 218

C cable elements 299, 308

cables 320

CAD import 19

Cauchy stress 174

Cauchy-Green tensor 174, 185, 347

centrifugal acceleration loads 75

charges 368

Coffin-Manson equation 404

cohesion sliding resistance 203

complementarity conditions 182

complex modulus 142

complex notation 200

complex results 49

compliance matrix 177, 356, 357

computing the solution 14

Constants dialog box 12

constitutive equation, for linear 

stress-strain 175

constitutive equations

user-defined 128

constitutive form

for piezoelectric material 353

strain-charge 354

stress-charge 353

constitutive relations 187

constraints 81, 219

coordinate systems for 220, 310, 367

fixed 328

for beams 283

for Mindlin plates 262

for piezoelectricity 366

for shells 327

for trusses 309

general notation for 221

kinematic 83

no rotation 328

pinned 284, 328

standard notation for 221

symbols for 110

symmetry 82

visualization of 81

contact map operator 202

contact modeling 152, 235

friction 203

manual scaling 152

theory for 201

contact pairs 137, 236

continuum 167

continuum application modes 172

Axial Symmetry, Stress-Strain 171

damping 228

Plane Strain 170



Plane Stress 169

Solid, Stress-Strain 168

coordinate system

application mode specific 100

defining using work plane 104

for shells 329

local geometrical 99

user-defined 101

Coordinate System Settings dialog box 

102

coordinate systems 98

constraints definition in 310

defining loads in 224

for 3D Euler beams 285

for constraints 367

for loads 369

for material properties 214, 356, 360

for Mindlin plates 260

for shells 332

in constraints 220

Coulomb friction 203

coupling loss 374

coupling operators 238

critical damping 36

critical plane 413

critical plane methods 408

cross section 281

cross-section area 308

cross-sectional properties 281, 308

cylindrical coordinates 171, 378

D damped eigenfrequency analysis 201

damping 140

beams 293, 316

continuum application modes 228

critical 36

equivalent viscous 142

example 36

explicit 146

factor 140

for viscoelastic materials 142

loss factor 142, 229, 268, 293, 294, 317, 

335

mass 140

matrix 36, 163

Mindlin plate 268

model 36

no damping 229, 268, 293, 317, 335

page for specifying 228, 268, 293, 316, 

334, 370

piezoelectric 370

ratio 36

Rayleigh 36, 140, 199, 229, 268, 293, 317, 

335

shells 334

stiffness 140, 229, 268, 294, 317, 327, 

335, 372

viscous 146

Damping page 228, 268, 293, 316, 334, 370

decay factor 163, 201

deformation gradient 173, 347

deformed frame 196

deformed shape 25

dependent variables 156

dialog box

Application Mode Properties 162, 206, 

349

Application Scalar Variables 163

Boundary Settings 14, 22, 39, 158

Constants 12

Contact Pairs 237

Coordinate System Settings 102

Edge Settings 14, 158

Elasticity Matrix 211, 354

Elasto-Plastic Material Settings 212

Free Mesh Parameters 21

H Matrix 222
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Import CAD Data From File 19

Materials/Coefficients Library 22

Plot Parameters 24

Point Settings 13

Relative permittivity 354

Shear elasticity matrix 260

Solver Parameters 14, 149

Subdomain Settings 14, 21, 39, 47, 158

dielectric loss 374

direct piezoelectric effect 340

discrete mass 290, 315

discrete Reissner-Mindlin shape function 

247

discrete Reissner-Mindlin triangle 246

displacement gradient 185

dissipation, in piezoelectric materials 345

dissipative behavior 143

distributed loads 223

Draw menu 13

Draw toolbar 13

drilling rotations 323

dynamic friction coefficient 204

dynamic loss modulus 193

dynamic storage modulus 193

E Edge Settings dialog box 14, 158

edges, settings for 14

education 6

effective plastic strain 184

effective Poisson’s ratio 420

effective stress function 183

eigenfrequency 162

eigenfrequency analysis 31, 162

solver parameters for 33

eigenmodes, scaled 34

eigenvalue 162

elastic moduli 175

elasticity matrix 176, 177, 217

Elasticity Matrix dialog box 211, 354

elasto-plastic material 182, 206, 211

Elasto-Plastic Material Settings dialog 

box 212

elasto-plastic materials 122

elbow bracket model 16

elcontact element 202

Electric BC page 362

electric boundary conditions 362

electric currents, boundary conditions 

for 365

electric displacement 363

electric potential 364, 365

electromechanical quality factor 351

endurance limit 400

energy dissipation 351

engineering assumption 156

engineering strain 174

entropy 194

equivalent viscous damping 142

Euler beams 296

error message for coinciding points 

282

shape functions for 272

excitation angular frequency 163

excitation frequency 44, 48, 158, 200, 225, 

351

explicit damping 146

F fatigue analysis 148, 398

stress measures for 400

fatigue damage 414

fatigue ductility coefficient 404, 418

fatigue ductility exponent 404, 418

fatigue limit 400

fatigue strength coefficient 404, 418

fatigue strength exponent 404, 418

Findley criterion 414

first Piola-Kirchhoff stress 175, 186

fixed constraint 328



flexibility matrix 177

fluid loads 389

fluid-structure interaction 134, 386

follower loads 75, 174, 196, 223

fracture mechanics 398

frame 235

deformed 196

reference 196

frame structures 9

Free Mesh Parameters dialog box 21

free vibration 6

frequency 158

angular excitation 163

excitation 163

frequency response analysis 44, 163, 200, 

225

amplitude 266, 314, 333

phase 200

friction 203

FSI 134, 386

G gap distance 202

general 3D structure 9

general notation for constraints 221

generalized Maxwell model 190

geometric nonlinearity 173

geometry import 19

Gerber method 401, 413

glass temperature 192

Goodman method 401, 413

gravity loads 75

Green strains 173, 174

Green-Lagrange strains 173

guess variables 232

H H Matrix dialog box 222

Haigh diagrams 401

hardening function 218

hardening models 122

isotropic 183

kinematic 183

harmonic analysis 44

harmonic loads 163, 200

heat capacity 194

heat dissipation 142

heat transfer 334

high-cycle fatigue 400, 410

Hoffman and Seeger algorithm 419

Hooke’s law 307

hydrostatic stress 227

hyperelastic materials 120, 185

Mooney-Rivlin 188, 189

Murnaghan 188

Neo-Hookean 187

hysteretic loss 143

I ideal plastic material 183

ideal plasticity 184

IEEE standard, for piezo theory 341

Import CAD Data From File dialog box 

19

incompressibility 186

initial

curvature 275

load 253

moment 275

normal force 275

shear forces 253

strain 253

initial electric displacement 345

initial pressure 227

initial strain 195, 230, 345

initial strains

for trusses 318

initial stress 195, 230, 345

initial stresses

for trusses 318

initial values 40

in-plane elasticity matrix 260
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In-Plane Euler Beam application mode 

296

In-Plane Truss application mode 319

inverse piezoelectric effect 340

isotropic hardening 122, 183, 184

isotropic material 175, 177, 209, 248

isotropic tangent modulus 217

K kinematic constraints 83

kinematic hardening 122, 183, 184

kinematic tangent modulus 218

L Lagrange elements 167

Lamé constants 175, 188, 218

large deformation 165, 207, 305

large deformations 173

for piezoelectric materials 346

lattice trusses 319

library of materials 22

linear buckling analysis 165

linear elastic material 175

load cases 67

load cycles 398

load symbols 108

loading

nonproportional 413

proportional 415

loads 368

acceleration 75

applied to beams 288

coordinate systems for 224, 369

distributed 223

follower 75

for shells 332

gravity 75

in acoustic-structure interaction 392

on Mindlin plates 265

on trusses 313

page for specifying 222

singular 67

thermal 225, 333

total 80

units for 224, 289, 313, 369, 370

visualization of 81

local coordinate system 99

loss factor 142, 229, 294, 317, 335

loss factor damping 142, 229, 268, 293, 

317, 335

loss modulus 142

loss tangent 144

low-cycle fatigue 400, 418

M manual scaling 152

map operator 238

mass damping parameter 140, 229, 269, 

294, 317, 335, 373

mass matrix 36, 163

mass moment of inertia 291

master boundary 202

master domains 137

material

anisotropic 180, 210

coordinate system 214

elasto-plastic 122, 182, 211

hyperelastic 185

ideal plastic 183

isotropic 175, 177, 209, 248

linear elastic 175

mixed formulation 181

Mooney-Rivlin 188, 189

Murnaghan 188

Neo-Hookean 187

orthotropic 179, 209

piezoelectric 340

viscoelastic 189

material libraries 129

material models 119, 209

Mooney-Rivlin 120

Murnaghan 120



nearly incompressible material 127

Neo-Hookean 120

user-defined materials 128

material orientation, in piezoelectrical 

application modes 355

material properties 21

coordinate system for 356

settings for 352

Materials/Coefficients Library dialog box 

22

matrix

compliance 177, 356, 357

damping 36, 163

elasticity 177

flexibility 177

mass 36, 163

piezo coupling 357

stiffness 36, 163

maximum friction traction 203

mean stress correction theories 413

mean stress corrections 401

MEMS Material Properties library 130

menu

Draw 13

Mesh 14

Physics 13

Postprocessing 14

Mesh menu 14

meshes, initializing 21

Mindlin plate

application mode for 245

constraints 262

coordinate systems 260

damping 268

initial load 253, 269

initial strain 253, 269

loads 265

postprocessing height 270

shape function 247

shear strain components 247

theory for 247

thermal coupling 267

mixed formulation 176, 181, 186, 191

mixed U-P formulation 127

Model Navigator 12

model of an elbow bracket 16

moments 69

Mooney-Rivlin material model 120, 188, 

189

Moving Mesh (ALE) application mode 

134

multiphysics

acoustic-structure interaction 135

creating in Model Navigator 12

fluid-structure interaction 134

predefined 56

thermal-electric-structural interaction 

136

thermal-structural coupling 56

thermal-structural interaction 133

multiphysics contact 139

multiphysics modeling 133

Murnaghan material model 120, 188

N nearly incompressible materials 127, 176

Neo-Hookean material model 120, 187

Neuber’s rule 419

new features in version 3.5a 9

no rotation constraint 328

nonlinear geometry 165, 173

nonproportional loading 407, 413

normal acceleration

in acoustic-structure interaction 392

normal stress 174, 248

O orthotropic material 179, 209

P page
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Constraint 219, 366

Cross Section 159, 281, 308

Damping 228, 268, 293, 316, 334, 370

Initial Stress and Strain 230

Load 222

Postprocessing 336

Palmgren and Miner, damage rule 416

parametric analysis 7, 51, 198

partial differential equations 6

penalized friction traction 202

penalty factors 138

penalty parameter 240

perfectly matched layers 231

perfectly plastic material 184

phase 49, 163, 164

in harmonic loads 200

phase shifts 44, 163

Physics menu 13

Piezo Axial Symmetry application mode 

378

piezo coupling matrix 357

Piezo Plane Strain application mode 377

Piezo Plane Stress application mode 377

Piezo Solid application mode 376

piezoelectric analysis types 350

piezoelectric application modes 339

piezoelectric dissipation 345

piezoelectric effect 340

piezoelectric losses 143

piezoelectric materials 340

piezoelectrical application mode proper-

ties 349

pinned constraint 284, 328

plane strain 170

plane stress 169

plastic strain vector 182

plasticity 182

plates 245

Plot Parameters dialog box 24

plotting deformed shape 25

PMLs

see perfectly matched layers

point mass 290, 315

point mass moment of inertia 291

point settings 13

Point Settings dialog box 13

Poisson’s ratio 175, 214, 216, 279

postprocessing

depth 159

height 270

Mindlin plates 159, 269

shells 159, 336

variables 24

Postprocessing menu 14

Postprocessing page 336

prescribed acceleration 329

prescribed velocity 329

pressure

as dependent variable 186

as Vanka variable 151

defined as negative mean stress 177

pressure, adding initial 227

principle of virtual work 197

Prony series 190

proportional loading 407, 415

Q quality factor 144, 163, 201

electromechanical 351

quasi-static analysis 164

quasi-static transient analysis 56, 199

R rainflow count 416

rainflow counting 406

Ramberg-Osgood material law 419

Rayleigh damping 36, 140, 199, 229, 268, 

293, 317, 335

reaction forces 27, 113

reference frame 196



reference temperature 193

Reissner-Mindlin triangle 246

Relative permittivity dialog box 354

relaxation modulus function 190

relaxation time 190, 218

rotating disk example 75

rotational degrees of freedom 296, 297

rotational joints 92

rotations 322

S sagging cables 319

sagging edges 308

scalar variables 207, 351

scaled eigenmodes 34

second Piola-Kirchhoff stress 142, 175, 

186

segregated solver 201

shape functions for beams 272

shear deformation 322

Shear elasticity matrix dialog box 260

shear factor 261

definition 251

shear factor orthotropic material 262

shear modulus 175, 218, 359

for orthotropic material 216

shear modulus orthotropic material 261

shear strain 172

shear strain components

Mindlin plate 247

shear stress 174, 248

Shell

application mode 321

constraint condition 328

loads 332

local coordinate system 337

shell element 322

shells

constraints 327

coordinate systems 332

damping 334

units for 332

sheulb3dshape function object 272

shift function, WLF 192

singular loads 67

slave boundary 202

slave domains 137

Smith-Watson-Topper model 418

S-N curves 399, 410

solid mechanics 1

solid, stress-strain 168

solver method, augmented Lagrangian 

152, 201

solver parameters 33, 149

absolute tolerance 151

linear system solver 150

manual scaling 152

symmetric matrices 149

Solver Parameters dialog box 14, 149

solver settings 149

for contact modeling 152

spars 299

spring-dashpot 190

St. Venant’s principle 67

standard notation for constraints 221

static analysis 17, 157, 162, 198

static coefficient of friction 204

stiffness damping 229, 268, 294, 317, 327, 

335, 372

stiffness damping parameter 140, 229, 

269, 294, 317, 335, 373

stiffness matrix 36, 163

storage modulus 142

stored energy 351

straight edge option 308

straight edges option 301

strain 172, 174, 248, 252, 273

axial symmetry 172, 379
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effective plastic 184

elastic 172, 248, 274

engineering 174

engineering form 172

Green 174

initial 195, 230

reference temperature 334

shear 172

temperature 334

tensor form 172

thermal 172, 193, 248, 274

transverse shear 248

strain energy 197

strain reference temperature 226

strain temperature 226

strain tensor 172

strain-charge form 354

strain-displacement relation 172, 248, 273

large displacement 173

small displacement 172

stress 174, 248, 252

Cachy 174

first Piola-Kirchhoff 175, 186

initial 195, 230

normal 174, 248

second Piola-Kirchhoff 142, 175, 186

shear 174, 248

tensor 174, 248

stress amplitude 399

stress vector 194

stress-charge form 353

stresses, in fatigue analysis 400

stress-strain curves 123

stress-strain relation 174

structural acceleration 392

structural damping 371

structural loss 371

Structural Mechanics Module 3.5a, new 

features in 9

structure

frame 9

general 3D 9

shell 9

thin-walled 3D 9

Subdomain Settings dialog box 14, 21, 39, 

47, 158

superposition principle 83

surface charge 363

symbols

for constraints 110

for loads 108

symmetric matrices 149

symmetry axis 171, 379

symmetry constraints 82

symmetry planes 82, 329

T temperature loads 79

temperature, reference 193

theory

for beams 272

for contact modeling 201

for Mindlin plates 247

for piezoelectric effects 340

thermal coupling

for Mindlin plates 267

in beams 292

in trusses 315

thermal expansion 79

thermal expansion coefficient 165, 217, 

307

anisotropic 214

isotropic 214

orthotropic 214

thermal expansion vector 193, 217

thermal loads 225, 333

thermal strain 165, 172, 193, 248, 274, 315

in beams 274



thermal-electric-structural interaction 

136

thermal-structural analysis 165

thermal-structural interaction 56, 133, 

384

thermorheologically simple material 192

thin-walled 3D structure 9

time-dependent analysis 163, 199

initial values for 40

torsional constant 276

torsional moment 69, 276

total fatigue damage factor 417

total loads 80

transient analysis 35, 163, 199

initial values for 40

transition life 405

TRS material 192

truss application modes 304

trusses 299

application mode description 304

constraints for 309

cross-section properties for 308

initial strains 318

initial stresses 318

In-Plane Truss application mode 319

loads on 313

straight edge option for 301

thermal coupling in 315

typographical conventions 3

U undamped model 147

units

for loads 289, 313

for shells 332

user-defined coordinate system 101

user-defined materials 128

V variables

phase 49

postprocessing 24

velocity, prescribed 329

viscoelastic material 189

viscoelastic transient initialization 199

viscous damping 146

visualization of loads and constraints 81

volume ratio 173

volumetric heat capacity 194

von Mises effective stress 18, 24

W weak constraints 207

WLF equation 192

WLF shift function 192

Wöhler curves 399, 410

Y yield function 182, 217

yield functions 122

yield stress level 217

Young’s modulus 175, 177, 214, 216, 260, 

279, 307
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